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Foreword

The U.S. Army Corps of Engineers (USACE), Hydrologic Engineering
Center’s (HEC) Statistical Software Package (HEC-SSP) is software that
allows users to perform statistical analyses of hydrologic data.

The first official version of HEC-SSP (Version 1.0) was released in
August of 2008. Version 1.1 was released in April, 2009 and included
improvements to data entry, results visualization and reporting, and added
capability to the volume frequency analysis. Version 2.0 was released in
October 2010 and included three new analyses: a duration analysis, a
coincident frequency analysis, and a curve combination analysis. Version
2.1, released in July 2016, included improvements to the volume
frequency analysis, general frequency analysis, and Bulletin 17B
(Interagency Advisory Committee on Water Data, 1982) flow frequency
analysis in addition to two new analyses: Bulletin 17C (England, et al.,
2015) flow frequency using the Expected Moments Algorithm and a
Balanced Hydrograph analysis. These new features are discussed in the
User’s Manual for Version 2.1.

The HEC-SSP software was designed by Mr. Gary Brunner, Mr. Jeff
Harris, Dr. Beth Faber, Mr. Matthew Fleming, Mr. Michael Bartles, and
Mr. William Lehman. The HEC-SSP user interface and computation code
was programmed by Resource Management Associates. This manual was
written by Mr. Michael Bartles, Mr. Gary Brunner, Mr. Matthew Fleming,
Dr. Beth Faber, and Ms. Julia Slaughter.
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CHAPTER 1

Introduction

Welcome to the U.S. Army Corps of Engineers, Hydrologic Engineering
Center’s (HEC) Statistical Software Package (HEC-SSP). This software
allows users to perform statistical analyses of hydrologic data. The
current version of HEC-SSP can perform flood flow frequency analysis
based on Bulletin 17B (Interagency Advisory Committee on Water Data,
1982) and Bulletin 17C (England, et al., 2015), a generalized frequency
analysis on not only flow data but other hydrologic data as well, a volume
frequency analysis on high and low flows, a duration analysis, a
coincident frequency analysis, and a balanced hydrograph analysis.

HEC-SSP has been implemented using software guidelines established at
HEC. These guidelines will produce more consistent results when using
HEC software in water resources studies. Also, the guidelines facilitate a
common graphical user interface and “look and feel” for HEC software in
the PC environment. Recent HEC software implemented under these
guidelines include: rainfall-runoff analysis (HEC-HMS), river hydraulics
(HEC-RAS), reservoir system analysis (HEC-ResSim), flood damage
analysis (HEC-FDA), flood impact analysis (HEC-FIA), and ecosystem
function analysis (HEC-EFM). HEC software implementation is under the
guidance of Christopher N. Dunn, Director, Hydrologic Engineering
Center.

This chapter discusses the general philosophy of HEC-SSP and gives a
brief overview of the capabilities of the software. An overview of this
manual is also provided.

Contents
¢ General Philosophy of HEC-SSP
e Overview of Program Capabilities
e Overview of this Manual
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General Philosophy of HEC-SSP

HEC-SSP is designed for interactive use in a multi-tasking environment.
The system is comprised of a graphical user interface (GUI), separate
statistical analysis components, data storage and management capabilities,
mapping, graphics, and reporting tools.

Over a period of many years, HEC has supported a variety of statistical
packages that perform frequency analysis and other statistical
computations. Historically, the programs that received the most use within
USACE were HEC-FFA (Flood Frequency Analysis) and STATS
(Statistical Analysis of Time Series Data). HEC-FFA incorporates
Bulletin 17B procedures that are used for flow frequency analysis. The
STATS software package is used for statistical analysis of time series data.
STATS can provide either analytical or graphical frequency analysis,
specified by the user. STATS has the capability of computing monthly
and annual maximum, minimum, and mean values along with computing a
volume-duration analysis. Two other packages that have received a lot of
use within USACE are REGFRQ (Regional Frequency Computation) and
MLRP (Multiple Linear Regression Program). REGFRQ performs
regional frequency analysis and MLRP is a multiple linear regression
analysis tool.

The goal of HEC-SSP is to combine all of the statistical analyses
capabilities of HEC-FFA, STATS, REGFRQ and MLRP while advancing
the realm of statistical hydrology through cutting-edge techniques (such as
the use of the Expected Moments Algorithm). The current version of
HEC-SSP supports performing flood flow frequency analyses based on
Bulletin 17B and Bulletin 17C guidelines, general frequency analyses,
volume frequency analyses, duration analyses, coincident frequency
analyses, and balanced hydrograph analyses. New features and additional
capabilities will be added in future releases.

Overview of Program Capabilities

HEC-SSP is designed to perform statistical analyses of hydrologic data.
The following is a description of the major capabilities of HEC-SSP.

User Interface

The user interacts with HEC-SSP through a graphical user interface
(GUI). The main focus in the design of the interface was to make it easy
to use the software, while still maintaining a high level of efficiency for
the user. The interface provides for the following functions:
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File management

Data entry, importing, and editing
Statistical analyses

Tabulation and graphical displays of results
Reporting facilities

Statistical Analysis Components

Flow Frequency Analysis (Bulletin 17) — This component of the software
allows the user to analytically perform annual peak flow frequency
analyses. The software implements two algorithms for computing annual
peak flow frequencies. The first is contained within Bulletin 17B, which
was published by the Interagency Advisory Committee on Water Data in
1982. The second is contained within Bulletin 17C, which was released in
draft form by the Subcommittee on Hydrology in December 2015. The
Bulletin 17C document is currently being reviewed.

General Frequency Analysis — This component of the software allows the
user to perform peak flow frequency analyses by various methods.
Additionally the user can perform frequency analysis of variables other
than peak flows, such as stage and precipitation data.

Volume Frequency Analysis — This component of the software allows the
user to perform a volume frequency analyses on daily flow or stage data.

Duration Analysis — This component of the software allows the user to
perform a duration analysis on any type of data recorded at regular
intervals. The duration analysis can be used to show the percent of time
that a hydrologic variable is likely to equal or exceed some specific value
of interest.

Coincident Frequency Analysis — This component of the software assists
the user in computing the exceedance frequency relationship for a variable
that is a function of two other variables.

Balanced Hydrograph Analysis — This component provides a tool for the
creation of balanced hydrographs of multiple durations using existing flow
and volume frequency analyses and input hydrograph shapes.

Data Storage and Management

Data storage is accomplished through the use of "text" files (American
Standard Code for Information Interchange; ASCII; and Extensible
Markup Language; XML), as well as the HEC Data Storage System
(HEC-DSS). User input data are stored in flat files under separate
categories of study, analyses, and a data storage list. Gage data are stored
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in a project HEC-DSS file as time series data. Output data is
predominantly stored in HEC-DSS, while a summary of the results is
written to an XML file. Additionally, an analysis report file is generated
whenever a computation is made. This report file is written to a standard
ASCII text file.

Data management is accomplished through the user interface. The
modeler is requested to enter a Name and Description for each study under
development. Once the study name is entered, a directory with that name
is created, as well as a study file. Additionally, a set of subdirectories is
created with the following names: Bulletin17Results,
GeneralFrequencyResults, VolumeFrequencyAnalysisResults,
DurationAnalysisResults, CoincidentFregResults, BalancedHydrograph,
Layouts, and Maps. As the user creates new analyses, an analysis file is
created in the main project directory. The interface provides for renaming
and deletion of files on a study-by-study basis.

Graphical and Tabular Output

Graphics include a map window, plots of the data, and plots of analysis
results. The map window can be used to display background map layers.
Locations of the data being analyzed can be displayed on top of the map
layers. Once data are brought into HEC-SSP, they can be plotted for
visual inspection. The frequency curve plots show the results of the
analyses, which include the analytically computed curve, the expected
probability curve, confidence limits, and the raw data points plotted based
on the selected plotting position method. Tabular output consists of tables
showing the computed frequency curves, confidence limits, and summary
statistics. All graphical and tabular output can be displayed on the screen,
sent directly to a printer (or plotter), or passed through the Windows
Clipboard to other software, such as a word-processor or spreadsheet.

A report file is available for each analysis. This report file includes the
input data, preliminary results, all of the statistical tests (Low and High
Outliers, Broken Record, Zero Flows Years, Incomplete Record, Regional
Skews, and Historic Information), and final results. This report file is
similar to the FFA output file.

Overview of This Manual

This user's manual is the primary documentation on how to use HEC-SSP.
The manual is organized as follows:

e Chapters 1-2 provide an introduction and overview of HEC-SSP, as
well as instructions on how to install the software.

e Chapter 3 provides an overview on how to use the HEC-SSP
software in a step-by-step procedure, including a sample problem
that the user can follow.
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e Chapter 4 explains in detail how to enter and view data.

e Chapter 5 provides a detailed discussion on how to use the Bulletin
17 Analysis editor.

e Chapter 6 provides a detailed discussion on how to use the General
Frequency Analysis editor.

e Chapter 7 provides a detailed discussion on how to use the Volume
Frequency Analysis editor.

e Chapter 8 provides a detailed discussion on how to use the Duration
Analysis editor.

e Chapter 9 provides a detailed discussion on how to use the
Coincident Frequency Analysis editor.

e Chapter 10 provides a detailed discussion on how to use the
Balanced Hydrograph Analysis editor.

e Appendix A contains a list of references.

e Appendix B has a series of example analyses that demonstrate the
various capabilities of HEC-SSP when performing a Bulletin 17B
flow frequency analysis, a General Frequency Analysis, a Volume
Frequency Analysis, a Duration Analysis, a Coincident Frequency
Analysis, and a Balanced Hydrograph Analysis.

e Appendix C has a series of example analyses that demonstrate the
use of HEC-SSP using the Expected Moments Algorithm (EMA) to
fit a Log Pearson Type Il distribution to annual maximum flow data
sets.

e Appendix D has an example detailing the creation of a partial
duration series from a daily flow dataset to illustrate the use of the
Find Peaks tool within HEC-DSSVue as well as comparing the
differences between a partial duration series and an annual maximum
series.
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CHAPTER 2

Installing HEC-SSP

The user can install HEC-SSP using the program installation package
available from HEC’s web site. The setup program installs the software,
documentation, and the example applications. This chapter discusses the
hardware and system requirements needed to use HEC-SSP, how to install
the software, and how to uninstall the software.

Contents
e Hardware and Software Requirements
¢ Installation Procedure
e Uninstall Procedure
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Hardware and Software Requirements

Before installing the HEC-SSP software, make sure that the computer has
at least the minimum required hardware and software. In order to get the
maximum performance from the HEC-SSP software, recommended
hardware and software is shown in parentheses. This version of HEC-SSP
will run on a computer that has the following:

¢ Intel Based PC or compatible machine with Pentium processor or
higher (a Pentium 4 or higher is recommended).

e A hard disk with at least 100 megabytes of free space
e A CD-Rom drive (or CD-R, CD-RW, DVD), if installing from a CD.

e A minimum of 512 megabytes of RAM (1 Gigabyte or more is
recommended).

e A mouse.

e Color Video Display (Recommend running in 1280x1024 or higher
resolution, and as large a monitor as possible). Recommend at least a
17" monitor.

e Microsoft Windows XP or 7 (or later versions).

Installation Procedure

Installation of the HEC-SSP software is accomplished through the use of
the Setup program.

To install the software onto your hard disk do the
following:

1. Download the HEC-SSP setup program from our web page:
www.hec.usace.army.mil.

2. Save the setup file in a temporary directory and then execute the
“HEC-SSP_21_Setup.exe” file to run the setup program.

3. Follow the setup instructions on the screen.

The install creates a program group called HEC. This program group will
be listed under the Programs menu, which is under the Start menu. The
HEC-SSP program icon will be contained within the HEC program group,
within the HEC-SSP subdirectory. The user can request that a shortcut
icon for HEC-SSP be created on the desktop. If the 32-bit application is
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installed in the default directory, the HEC-SSP executable can be found in
the C:\Program Files (x86)\HEC\HEC-SSP\2.1 directory with the name
"HEC-SSP.EXE". If the 64-bit application is installed in the default
directory, the HEC-SSP executable can be found in the C:\Program
Files\HEC\HEC-SSP\2.1 directory with the name "HEC-SSP.EXE”.

The HEC-SSP User’s Manual and example data sets are also installed with
the software. The User’s Manual can be viewed by selecting User’s
Manual from the Help menu. To view the User’s Manual, Adobe
Acrobat Reader must be installed. This viewer can be obtained for free
from the Adobe web page.

A zip file containing the example data sets described in Appendix B and
Appendix C have been installed in the "...\Examples" folder within the
program directory. The example data sets can be installed by selecting the
Install Example Data option from the Help menu. After selecting the
appropriate menu option, a window will open to choose a location to
install the example data sets. The program will create two subdirectories
within your chosen folder called SSP_Examples and
Bulletin_17C_Examples. Project files with an “.ssp” file extension will
be contained in both subdirectories. The test data sets can be loaded by
using the Open Study option from the File menu and then use the file
chooser to select either project file.

Uninstall Procedure

The HEC-SSP Setup program automatically registers the software with the
Windows operating system. To uninstall the software, do the following:

e From the Start Menu select Control Panel.
e Select Add/Remove Programs from within the Control Panel folder.

e From the list of installed software, select the HEC-SSP program and
press the Remove button.

e Follow the uninstall directions on the screen and the software will be
removed from the computer.
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CHAPTER 3

Working With HEC-SSP - An Overview

HEC-SSP is an integrated package of statistical analysis modules, in
which the user interacts with the system through the use of a Graphical
User Interface (GUI). The current version is capable of performing flow
frequency analyses based on Bulletin 17B (Interagency Advisory
Committee on Water Data, 1982) and/or Bulletin 17C (England, et al.,
2015) guidelines, general frequency analyses, volume frequency analyses,
duration analyses, coincident frequency analyses, curve combination
analyses, and balanced hydrograph analyses. This chapter provides an
overview of how a Bulletin 17C flow frequency analyses can be
performed with the HEC-SSP software. General frequency and volume-
duration frequency analyses can be developed in a similar manner as
outlined for the Bulletin 17 analysis.

In HEC-SSP terminology, a Study is a set of files associated with a
particular set of data and statistical analyses being performed. The files
for a study are categorized as follows: study information, data list, and
analysis data.

Contents
e Starting HEC-SSP
e Overview of the Software Layout
e Steps in Performing a Bulletin 17C Frequency Analysis
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Starting HEC-SSP

When you run the HEC-SSP Setup program, a new program group called
HEC and a program icon called HEC-SSP are created. They should
appear in the start menu under the section called All Programs. The user
also has the option of creating a shortcut on the desktop. If a shortcut is
created, the icon for HEC-SSP will look like Figure 3-1.

e

Figure 3-1. The HEC-SSP Icon.

To Start HEC-SSP from Windows:

e Double-click on the HEC-SSP Icon. If you do not have an HEC-SSP
shortcut on the desktop, go to the Start menu and select All
Programs > HEC - HEC-SSP - HEC-SSP 2.1.

Overview of the Software Layout

When you first start HEC-SSP, you will see the main window as shown in
Figure 3-2, except you will not have any study data on your main window.
As shown in Figure 3-2, the main window is laid out with a Menu Bar, a
Tool Bar, and four window panes.

The upper right pane (which occupies most of the window area) is the
Desktop Area (Referred to as the "Desktop" from this point in the
manual). This area is used for displaying maps, data editors, and analysis
windows.

The upper left pane is called the Study Explorer. The Study Explorer
acts like an explorer tree for the study. The top level of the tree is the
study (“SSP Examples” in this example). Below the study is an analysis
branch, a data branch, and a map branch. Under the analysis branch, the
first level is the type of analysis. Under each analysis type will be the
current user-defined analyses for that type. The data branch lists all of the
available data sets that have been brought into the current study.
Generally, a data set represents a piece of data at a specific gage location.
For example, all of the peak annual flows at a single gage would be stored
as a single data set. When an analysis is created, the user selects a data set
to be used for that particular analysis. The map branch of the tree contains
any maps the user has put together for the study. By default there is
automatically a "Base Map" listed under the maps folder.
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The lower left pane, and associated tabs, also belongs to the study
explorer. This window is used to show additional information about items
selected in the study explorer. The tabs are used to switch to different
views within the study explorer window. The first tab, labeled Study,
shows the explorer view of the study. The second tab, labeled Maps, lists
the available maps and map layers associated with each map. The last tab,
labeled Files, shows all of the files that make up the current study.

The lower right pane is called the Message Window. This window is
used to display messages from the software as to what it is doing.
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Figure 3-2. The HEC-SSP Main Window.

At the top of the HEC-SSP main window is a Menu bar with the following
options:




Chapter 3 - Working with HEC-SSP — An Overview

HEC-SSP User's Manual

File: This menu is used for file management. Options available under the

sy R TR

File| Edit View Maps Data Analysis R

Mew Study... Ctri+M
Open Study ... Ctrl+0
Save Study Ctrl+5
Save Study As..  Ctrl+5hift+5
Close Study Ctrl+5Shift+C
Study Properties... Ctrl+5Shift+P

Export

Recent Studies

Exit

File menu include New Study, Open
Study, Save Study, Save Study As,
Close Study, Study Properties,
Export, Recent Studies, and EXit.
The Study Properties option is used
to describe the study. The Export
option is used to export HEC-SSP
results, stored in the study DSS file,
to another DSS file. The Recent
Studies option lists the most recently
opened studies, which allows the user
to quickly open a study that was
recently worked on.

-

-

& cut
Copy
B Paste

Edit: This menu is used for applying the Cut, Copy,

Maps 0O
Cirl+x
Ctri+C
Cirl+Y

and tables.

and Paste clipboard features to data in editable fields

View: The View menu allows the user to control display of the toolbars

L T .

Maps Data Analysis Resuls

Toolbars k
Skudy Explarer
Messages Window

Skakus Window

Toagle Views Chrl4+T
Save Current Lavouk

Restare Layout ]
Layout Manager

Set Study Display Units r

Select Waorking Sets, ..

and the study windows. The user can
also toggle between viewing all of the
panes or just the Main View Pane. The
View menu also has options for saving
the current layout (currently opened
windows and their sizes and locations)
and restoring a previously saved layout.
The Set Study Display Units option
allows the user to switch output between
English and metric units.

The Select Working Sets menu option
allows the user to group items in each
folder and then display only those items
in the user interface. For example,
Figure 3-3 shows the Bulletin 17 folder

in the study explorer. The Edit Working Set editor, Figure 3-4, was used
to group all Bulletin 17 analyses that started with “FFA” into one working
set. The working set was named “FFA Analyses”. This working set was
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activated by right clicking on top of the Bulletin 17 folder in the study
explorer and selecting Select Working Sets>FFA Analyses, as shown in
Figure 3-5. Only the Bulletin 17 analyses within the working set will then
be displayed in the study explorer, as shown in Figure 3-6. To display all
Bulletin 17 analysis, right click on top of the Bulletin 17 folder in the
study explorer and select Select Working Sets=>»No Working Set.

= SSP EXAMPLES

= L. Analysis

= |, Bulletin 17

-8 Resenvoir Inflows
~ATB FFA Test 1

~ATB FFA Test 2

- FFA Test 3

- FFATest 4

- FFATest5

- FFA Test &

Figure 3-3. Study Explorer before Defining a Working Set.

B2 Edit Working Set

Mame: |FFAAnaIyses |

Description: | E]|

(*) UUse Regular Expression

FFa*

() By Mame

Avallable Selected

QK ] [ Cancel

Figure 3-4. Edit Working Set Editor.
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Figure 3-5. Activate a Working Set from the Study Explorer.
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B
178 FFA Test 1

178 FFA Test 2

178 FFA Test 3
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Figure 3-6. Bulletin 17 Folder Only Displays Analyses in Working Set.

The user may also prefer to

. =2 Analysis
group multiple analyses of = T
the same type together using A8 Bern\ 12)  New...
folders. Folders can be -ATB Bern Sort 5
created by right clicking on 178 Berny
the analysis type of interest =y General Select Working Set
and selecting New Folder... | = $F| Ee’“l =
After the user has named the | ThAERE

: Duratmn Remove

folder, analyses can be added

to the new folder by left clicking on the analy5|s holding down the left
mouse button, dragging the analysis to the newly created folder, and
releasing the left mouse button.
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Maps: This menu is used to set the Default Map Properties (Coordinate
system, extents, etc...), define a new map, add map layers to the study,

and remove a map. Additionally,
this menu has the following options
available: Map Window Settings
(allows the user to turn map layers
on and off), Zoom To Entire Map
Extents, Save Map Image, Import,
and Export. The Zoom To Entire
Map Extents option displays the
entire set of map layers within the
map window. The Save Map
Image option can be used to save
the current view of the map to a
file.

Data dnalvsis  Resulks  Tod

Default Map Properties. ..

% Mews Map

#dd Map Lavers...

Remave Map Layers..,

Map Window Setkings

Zoam To Enkire Map Extents

Save Map Image...

Data: The Data menu allows the user to define a new data set, open the

Analyais Results ]
Mevw...

B
Select...
7 Delete fram Study

|d Plot
E[E Tabulate
Edit Metadata. ..
E save
EE Save As..

Fename...

metadata editor, and delete any existing data
sets from the data list. Other options include
opening a plot and table of the data.

Analysis: The Analysis menu is used to create the various statistical

Fesults Tools W

Analysis

Mew »
Open
X Delete from Study

Campute Manager...

analyses available in the software. Each
statistical analysis is saved as a separate file
containing the information that is pertinent to
that specific analysis type. The current
options under this menu item include New,

_ Open, Delete from Study, Save, Save As,
Rename, and Compute Manager. The

(= compute manager allows the user to select
one, several, or all of the analyses, and then
have them all recomputed.
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Results: The Results menu allows the user to graph and tabulate any of

Tools  Window

Graph
Table
Report

Summary Repart

Default Plot Line Styles

the existing analyses that have been computed.
Additionally, the user can request to view the
report file from a analysis. Users must select at
least one analysis in the Study Explorer before
selecting Graph, Table, Report, or Summary
Report. If more than one analysis of the same
type are selected (this is accomplished by
holding down the control key while clicking on
the various analyses), the Graph and Summary

Report options will include results from all analyses that are selected.
However, when multiple analyses are selected, the Table and Report
option bring up separate windows for each of the selected analyses. The
Default Plot Line Styles menu option lets the user change the default line
styles applied to different data types that are plotted in a graph. For
example, the user can change the default line style for high outliers so that
they are displayed as black triangular data points when a plot is opened.

=N Window  Help
My HEC-DSSe

Plok Prabability Lines

Opkions. ..
B3 Console Cutput..,
Memary Manitor

Tools: The Tools menu includes HEC-
DSSVue, Plot Probability Lines, Options,
Console Output, and Memory Monitor. The
HEC-DSSVue option brings up the HEC-
DSSVue program and automatically loads the
current study DSS file. HEC-DSSVue is a
DSS utility to tabulate, graph, edit, and enter
data into DSS. The Plot Probability Lines
option opens an editor, shown in Figure 3-7,
that lets the user add, delete, or edit the

probability lines and axis labels that are displayed in all frequency curve
plots. The Options menu item opens the Options editor that allows the
user to set default HEC-SSP options. The Results tab in the Options
editor, shown in Figure 3-8, allows the user to set the number of decimal
digits that are displayed in all results.
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B2 Plot Probability Lines
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0.99549
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500
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Figure 3-7. Plot Probability Lines Editor.

B Options

| General || System Properties | Resultsgl

] Cancel

FHumber of decimal digits o show in results

Flow Digits:
Precipitation Digits:

Stage Digits:
Stats Digits:

Yolume Digits:

Figure 3-8. Dialog for Controlling the Number of Decimal Digits Shown in

Result Tables and Reports.
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Window: This menu includes Tile, Cascade, Next Window, Previous
Window, Window Selector, and Window. These options are used to
wirdow [ control the appearance of the

o Tike windows in the Desktop area.

When more than one window is

By Cascade open (such as a data importer,
and various analysis windows),
these menu items will help the
] Previous Window  Cir+Shift+Tab user organize the windows, or

Window Selector.,.. quickly navigate to a specific

inclowe » | window. The Tile option can
be used to organize all of the
currently opened windows in either a vertical or horizontal tile. The
Cascade option puts one window on top of the next in a cascading fashion.
The Next Window option brings the next window in the list of currently
opened windows to the top. The Previous Window brings the last window
that was on top back to the top. The Window Selector option brings up a
pick list of the currently opened windows and allows you to select the one
you want. The Window option has a sub menu list of all the opened
windows and allows you to select one.

= Mest Window Ciri+Tab

Help: This menu allows the user to open the HEC-SSP User’s Manual,
install example data sets, read the terms and conditions of use statement,
and display the current version information about HEC-SSP.

Lser's Manual

Install Example Data...

Termms and Conditions For Use
About HEC-S5P

Also on the HEC-SSP main window is a Tool Bar. The buttons on the
tool bar provide quick access to the most frequently used options under the
HEC-SSP File and Edit menus.
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Steps in Performing a Bulletin 17C Frequency Analysis

There are five main steps in performing a Bulletin 17C flow frequency
analysis using HEC-SSP. Similar steps are required when performing
other statistical analyses.

e Starting a new study

e Adding a Background Map (Optional)

e Importing, Entering, and Editing Data

e Performing the Bulletin 17C Frequency Analysis
¢ Viewing and Printing Results

Starting a New Study

The first step in performing a flow frequency analysis with HEC-SSP is to
establish which directory you wish to work in and to enter a title for the
new study. To start a new study, go to the File menu and select New
Study. This will open the Create New Study window as shown in Figure
3-9.

Study Mame:

Description:

Directory: CIA\PROJECTS\
LInit System: Englizh

Coordinate System: Geographic

QK | | Cancel

Figure 3-9. New Study Window.

The user is required to enter a name for the study, select a directory to
work in (a default location is provided), and select the desired units
system. Adding a description of the study is optional. The user should
also define a Coordinate System if background spatial data will be plotted.
Multiple coordinate systems are provided for use. The choice of a
coordinate system will not affect any computed results. Once you have
entered all the information, press the OK button to have the information
accepted. After the OK button is pressed, a subdirectory will be created
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under the user chosen directory. The subdirectory will be labeled with the
same name as the user-entered study name. This study directory is where
the HEC-SSP project file, as well as other study files and directories will
be located. Additionally, a default map window will appear in the Main
View Pane. However, the map window will be blank when it first opens.

Adding a Background Map

By default, when you start a new project in HEC-SSP a default map
window (called Base Map) will open in the Desktop window. Having a
background map is optional in HEC-SSP. Not having a map does not
prevent the user from importing and entering data, or performing an
analysis and viewing results. The map is mostly a visual aid of the study
area. Additionally, when you bring in gage data you can enter the map
coordinates of the gage and it will show up on the map. The user must
supply a coordinate system other than X-Y (i.e. Geographic) for imported
gage data to be displayed properly. Once a gage is located on the map you
can right click on it to open a shortcut menu for viewing the data, or
graphing and tabulating the results.

To add a map layer to the default map, go to the Maps menu and select
Add Map Layers. When this option is selected a file chooser window
will appear, as shown in Figure 3-10, allowing the user to select map
layers to bring into the map. The Create Copy option on the window will
make a copy of the selected map and place it in the Maps subdirectory
within the study folder.

Currently, the HEC-SSP software can load the following types of map
layers: United States Geologic Survey (USGS) DLG, AutoCAD DXF,
shapefile, Raster Image, USGS DEM, Arc Info DEM, ASCII NetTIN, and
Mr Sid.

An example map is shown in Figure 3-11. This map contains a shapefile
of state boundaries and data locations.
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@ Select Map to Add

==

L
=5

Recent ltems

Desktop

I
My Diocume...

A

-

Computer

@

MNetwoark

Lookin:

 TIGER -

? - m,

7 TIGER_US_Coastline.shp

7 TIGER_US_County.shp

1 TIGER_US_Primaryroads.shp
7 TIGER_US_Rails.shp

Ei TiGER Us States.shp

Create Copy

File name: TIGER_US_States shp

Files oftype: | Al Maps

- Cancel

Figure 3-10. Select a Map Layer to add to the Base Map.

LLEGHENY RIVER-KINZLA DAM, PA-FLOWLANHUAL PEAK
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L)
»
L DELAWARE RIVER-MOM
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TULPEHOCKEN BREEK-BERNVILLE, A FLOW-ANHUAL
SUSQUEHANNA RIVER-HARRISBURG, PA-CODE-PEAK FLOW

YOUGHEEHENY RIVER YOUGHIOG HENY RIVERSih, ReeeD OB-REA

i

m

Figure 3-11. Example Background Map.

If more than one map layer is going to be added to a map, then it is up to
the user to ensure that all map layers are in the same coordinate system.
HEC-SSP does not perform coordinate system projections. Also, HEC-
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SSP cannot always determine the coordinate system for all map layers
entered. However, under the Maps menu is an option called Default Map
Properties. This menu option can be used to set the default coordinate
system for the map layers displayed in HEC-SSP. The user should set the
default coordinate system first and then bring in map layers to the study.

Importing, Entering, and Editing Data

Before any analyses can be performed, the user must bring data into the
HEC-SSP study. For a peak flow frequency analysis following guidelines
in Bulletin 17C, the data must consist of peak annual flow values. To
bring data into HEC-SSP go to the Data menu and select New. This will
bring up the Data Importer as shown in Figure 3-12.

[£] Data Importer - = [
Name: | Short ID:
Description: D

Study DES File: | CAPROJECTSISSP_Testing\Projects\Sir _B17C! _B17C\Sinr _B17C.dss
Study DSS Path

Data Source | Details
DataType: | Time Series +
Lacation
HEC-DS3 @ USGS Website WS Excel Manual Text File
USGS Website
DataType: | annual Peak Data -
Retrieve data for:
| Flow Stage
Get USGS Station ID's by State
Import uUsGs Basin Name Location
Data Station ID's (A Part) (B Part)
Ld Plat EE Tabulale Close

Figure 3-12. HEC-SSP Data Importer.

As shown in Figure 3-12, the Data Importer has fields for the Name, Short
Identifier, and the Description of the data at the top of the window.
Additionally, it lists the study DSS file name that the data will be stored in
once it is brought into the study. The study DSS file is always labeled the
same name as your study with the .DSS file extension.

The Data Importer contains two tabs, Data Source and Details. The Data
Source tab is shown first. This tab is used for selecting and defining a
source for bringing data into the HEC-SSP study. Currently, there are five
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ways to bring data into an HEC-SSP study: import from another HEC-
DSS file, import data from the USGS web site, import from a Microsoft
Excel spreadsheet, manually entering the data into a table, and import the
data from a text file. All of these methods will import data into the study
DSS file.

For this example, importing data from the USGS website will be shown.
For a complete description of the data importer see Chapter 4. To import
data from the USGS website, first select the USGS Website option from
the list of five options available in the Location panel. Next, select
Annual Peak Data as the data type and make sure the Flow option is
selected. The next step is to press the button labeled Get USGS Station
ID’s by State. When this button is pressed a window will appear (Figure
3-13) allowing the user to select a state from which to get data.

@ Cbtain stations by state [&J

Select State Pennsylvania | -

Diata Type:  Annual Peak Data

OK ] | Cancel

Figure 3-13. Window to Select a State for Downloading Data.

Once a state is selected, press the OK button and a list of the available
gages from that state will appear in a pick list as shown in Figure 3-14.
Check the boxes for all of the gages you would like to import and then
press the Import to Study DSS File button. Once the import button is
pressed, a process will begin during which the data will be downloaded
from the USGS website and saved to the study DSS file. HEC-SSP will
automatically name the data when importing multiple gages at one time.
The USGS import process will download annual peak flow data, and the
USGS data quality codes. The quality codes will be added as an addition
object to the Data folder.

In addition to the data itself, any metadata that is available will be
downloaded and stored with the data. The metadata can be viewed from
the Details Tab on the Data Importer. Metadata can also be viewed or
edited by opening the Metadata Editor. To open this editor, place the
mouse on top of a data object in the Data folder and click the right mouse
button. The shortcut menu contains an Edit Metadata option, as shown
in Figure 3-15. The metadata editor is shown in Figure 3-16.

3-15



Chapter 3 - Working with HEC-SSP — An Overview

HEC-SSP User's Manual

[-] Data Importer - = [
Name: Short ID
Description: D
Study DSS File: |C:\PROJECTS\SSP_Testing\Projects\Sir ling_B17CASinr 1g_B17C\Sinnemahoning_B17C.dss
Study DSE Path;
Data Source | Details
Data Type :T\me Series -
Location
() HEC-DSS @ USGS Website @) WS Excel ) Manual (© TextFile
USGS Website
Data Type: :Annual Peak Data v: =
Retrieve data for:
Flow [] Stage
Get USGS Station ID's by State Pennsylvania
Import USGSs Basin Name Location Other Qualifier
Data Station ID's (A Part) (B Part) (F Part) 3
[l 01542000 Moshannon Creek Osceola Mills, PA UsGS -
[ 01542500 'WB Susquehanna River Karthaus, PA USG!
01542720 Wilson Run Penfield, PA USG!
01542810 ‘Waldy Run Emporium, PA USG!
[¥] 01543000 Driftwood Br Sinnemahoning Cr Sterling Run, PA USGS
[l 01543500 inr Creek Sinnemahoning, PA USGS L
[ 01543693 East Fork Sinnemahoning ‘Wharton Township, PA USGS
[ 01543700 First Fork Sinnemahoning Creek Wharton, PA USG!
01544000 First Fork Sinnemahoning Cr Sinnemahoning, PA USG:
] 01544450 Germania Branch Germania, PA USG!
M 01544500 Kettle Creek Cross Fork, PA UsGS
[ 01545000 Kettle Creek ‘Westpor, PA USGS \E‘
[ 01545500 ‘West Branch Susquehanna River Renovo, PA USGS
& 01545600 Young Womans Creek Renovo, PA USGS
01545800 'WB Susquehanna River Lock Haven, PA UsGs i
|4 Plot S Tabulate

Figure 3-14. Example of Choosing Gages from a USGS State List to Import.

-0

Data
Driftwoaod Br Sinnemahoning Cr-Sterling Run, PA-FLOW-ANNUAL PEAK

Map
# Base Map

Sinnemahoning Creek-Sinnemahoning, PA-F L OV -/ g
Sinnemahaoning Creek-Sinnemahoning, PA-CODE-
First Fork Sinnemahaoning Cr-Sinnemahoning, PA-F| o=
First Fork Sinnemahaoning Cr-Sinnemahoning, PA-C

|Ld Plot

Tabulate

Edit Metadata...
EH save

Save Az,

Rename...

Figure 3-15. Open the Metadata Editor Using the Right Mouse Click Menu.
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[E] Metadata Editor -Sinnemahoning Creek-Sinnemahoning, PA-FLOW-ANNUAL PEAK Bl 3w
Mame: Sinnemahoning Creek-Sinnemahaning, PA-FLOW-ANNUAL PEAK] Short ID:
Description: Downloaded from USGS website. Station 01543500 &)

Study D335 File: C\PROJECTSVSSP_Testing\Projects\Sinnemahoning_B17CiSinnemahoning_B17C\Sinnemahoning_B17C.dss

Study DSS Path: | sinnemahoning Creek/Sinnemahoning, PAFLOW-ANNUAL PEAKIR-CENTURY/USGS!

State: Pennsylvania County: | Cameron

Stream: Sinnemahoning Creek Location: | sinnemahoning, PA

Drainage Area: |gas DA Units:

Gage Operator: |Jsss USGS No: 1543500
Gage Datum: | g HUC: 02050202

Vertical Datum: | NevD2e -

Description: )

Coordinate Location Data

Coordinate System: || atl ang - | Coordinate ID: i

Harizontal Datum: MADZT » | Datum Units: Degrees Minutes Seconds -

Coordinate X Value: —7z0612 | Coordinate Y Value: 111802
| OK | | Cancel |

Figure 3-16. Metadata can be Viewed or Edited by Opening the Metadata Editor.

As shown in Figure 3-16, the metadata consists of the State, County,
Stream, Location, Drainage Area, DA Units, Gage Operator, USGS Gage
No., Gage Datum, HUC (Hydrologic Unit Code), Vertical Datum, and a
description field. Additionally, the coordinate location of the data is
shown. The coordinate location consists of Coordinate System,
Coordinate ID, Horizontal Datum, Datum Units, Coordinate X Value, and
Coordinate Y Value. Most of the USGS data is retrieved with the
Latitude/Longitude coordinate system as shown in the example. In
addition to editing the metadata, the Metadata Editor allows the user to
change the name of the data, enter a short identifier, and enter a longer
description.

If the metadata does not download automatically, the user has the option
to enter any of the information by hand. Metadata is not generated
automatically for any of the other four data sources. Therefore, entering
the metadata is required if the user wants it to be carried along with the
study.
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After the data is imported into the study, the user can select any one of the
gages in the Data folder and Plot or Tabulate the data. The plot and
tabulate options are available from the Data menu and from a shortcut
menu that opens by clicking the right mouse button when the pointer is
located on top of the gage object in the Data folder. If you select the Plot
option, you will get a plot of the peak flow data for that gage. If you
select the Tabulate option, you will get a table containing the data. Data
values can be edited within the table; however, the editing mode must be
turned on. To turn on editing, select the Edit->Allow Editing menu
option. Use the File->Save or File->Save As menu option to save the
data when you are satisfied with edits.

If the data has coordinate location information, it will then be plotted on
top of the background maps. The software will

Edit Metadata...| convert the coordinates of the point data to the
default coordinate system of the base map. The
L4 Plot user can interact with the plotted points by right
=E Tabulate clicking on the gage icon in the map and a shortcut
menu will appear as shown. The user has the
Rename... option to edit the metadata, plot, tabulate, rename,
X Delete or delete the data.

Performing the Bulletin 17C Flow Frequency Analysis

To perform a Bulletin 17C flow frequency analysis, go to the Analysis
menu and select New = Bulletin 17 Flow Frequency. This will bring up
an empty Bulletin 17 editor. As shown in Figure 3-17, the user must enter
a name for the analysis, a description (optional), and select a flow data set
(gage data stored in study DSS file). The DSS File Name and Report File
are automatically filled in by the program. For now, the DSS File Name
will be the study DSS file and the report file will have the same name as
the analysis.

The editor window contains four tabs: General, Options, EMA Data, and
Tabular Results. The General tab contains settings for Generalized Skew,
Expected Probability Curve, Method for Computing Statistics and
Confidence Limits, Plotting Positions, Confidence limits, a Time Window
Modification, and Low Outlier Test. Default settings are already
established for each of the options on the General tab; however, the user
can change the default settings.

The Options tab contains information on Low Outlier Threshold, Historic
Period Data, and User-Specified Frequency Ordinates. These options are
not required for most analyses but may be necessary depending upon the
data.
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The EMA Data tab contains information specifically related to flow
frequency analyses that make use of the procedures contained within

Bulletin 17C, which uses the Expected Moments Algorithm (EMA) to
compute flow frequency and confidence limits for the associated flow data
set. A detailed description of each of the Bulletin 17C settings and options

can be found in Chapter 5, Performing a Bulletin 17 Flow Frequency

Analysis. The EMA Data tab is shown in Figure 3-18.

Once all of the settings and options have been selected, the user presses

the Compute button to have the computations performed. When the

computations have finished a message window will open stating Compute

Complete. Press the OK button on the message window to close the

window. Once the computations have finished the user can begin to look

at output.

[=] Bulletin 17 Editor - SinnemahoningCreek_B17C

Name SinnemahoningCreek_B17C

FlowData Set. | Sinnemahoning Creek-S8innemahoning, PA-FLOW-ANNUAL PEAK

Description: Bulletin 17C flow-frequency analysis for Sinnemahoning Creek at Sinnemahaning, PA

DSS File Name: | C\PROJECT: P\Projects\Sir | B17C _B17C.dss

Report File CAPROJECTS\8SP\Projects\Sinnemahoning_B17C\Bulletin 17Results\SinnemahoningCreek_B17C\SinnemahoningCreek_B17C rpt

General | Options | EMA Data | Tabular Results

@ Use Station Skew
Use Weighted Skew
Use Regional Skew

Regional Skew.
Reg. Skew MSE:
Expected Probablity Curve Where:

Compute

Do Not Compute Expected Prob. Curve
Method for Computing Statistics and Confidence Limits
@ 17C EMA

17B Methods

Generalized Skew Plotting Position

Cther (Specify A, B)

Plotting position computed using formula

(m-A)(n+1-A-B)

m=Rank, 1=Largest

N=Number of Years

AB=Constants

Confidence Limits
@ Defaults (0.05, 0.95)
User Entered Values
Upper Limit:

Lower Limit:

Time Window Modification

DSSRangeis 18MAR1936 -

Start Date
End Date
Low Qutlier Test
@ Multiple Grubbs-Beck

Single Grubbs-Beck

21MAY2014

‘ Compute || Plot Curve ‘ ‘ View Report ‘ Print

oK Cancel

Figure 3-17. Bulletin 17 Flow Frequency Analysis General Tab.
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[=] Bulletin 17 Editor - SinnemahoningCreek_B17C = =
Name SinnemahoningCreek_B17C
Description: Bulletin 17C flow-frequency analysis for Sinnemahening Creek at Sinnemahoning, PA )]
FlowData Set  sinnemahoning Creek-Sinnemahoning, PA-FLOW-ANNUAL PEAK -
DSS File Name: | C\PROJECTSISSP\Projects\Sinnemahoning_B17C\Sinnemahoning_B17C.dss (]
ReportFile CAPROJECTS\SSP\Projects\Sinnemahoning_B17C\Bulletin17Results\SinnemahoningCreek_B17C\SinnemahoningCrask_B17C rpt =
| General | Options | EMA Data | Tabular Results -
FirstRow in Table Defines the Absolute Time Window for EMA Analysis (start and end dates) 70,
Perception Thresholds
Start Year End Year Low Threshold High Threshold | Comments
1936 2014 o0 inf Total Record 600007 O o
1937 1938 60000.0 inf| Missing Records
=}
50,000
o
° o
40,000+
=]
=}
Apply Thresholds
o E
Flow Ranges 30,000 5 o]
Year Peak Low Value High Value Data Type e @ o
1936 61200.0 61200.0 61200.0| Systematic |- [=] o O e
1937 0.0 60000.0|Censored - o o o o
1938 0.0 60000.0|Censored - e R 000 © % =] %
1939 81200 8120.0 8120.0|Svstematic - oy o Op O m
1940 191000 19100.0 19100.0|Systematic - o o o 6) o ol
10 10 Systematic - 5 co o el
59 £9800.0|Systematic - oooTo o @ @ 2]
28 28300.0|Systematic - o o @ ]
13300. 13300.0| Systematic -
1945 181000 18100.0 18100.0|Systematic >
6 367! 367 367 Systematic - T T T T T T T T
7 4 9410, 9410.0|Syslematic - 1940 1050 1080 1070 1980 1900 2000 2010
8 160! 160 160 Systematic - — 15571038 O Data
9 4! 7450, 7450.0|Systematic -
1950 16000.0 16000.0 16000.0 | Systematic - Dafrach &
{ Compute J { Plot Curve I { View Report I l Print J Appl:

Figure 3-18. Bulletin 17 Flow Frequency Analysis EMA Data Tab.

Viewing and Printing Results

Tabular output can be viewed by selecting the Tabular Results tab.
When this tab is pressed, a set of tables will appear as shown in Figure
3-19. The primary table on the Tabular Results tab consists of percent
chance exceedance, computed flow frequency curve, the expected
probability adjusted curve (if enabled on the General tab), and the 5 and
95 percent confidence limits. The second table (bottom left) contains
general statistics about the data, such as the mean, standard deviation,
station skew, regional skew, weighted skew, and the adopted skew of the
analysis. The third table (bottom right) contains the number of historic
events, high outliers, low outliers, zero or missing values, systematic
events in the data set, and the number of years in the historic period. The
table can be sent to the printer by pressing the Print button at the bottom
of the analysis window. The user can control the number of decimal digits
shown in the result tables and in reports. Select Options from the Tools
menu and then open the Results tab, as shown in Figure 3-19.
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[£] Bulletin 17 Editor - El- [
Name: SinnemahoningCreek_B17C
Description: B17C flow-frequency analysis for Sinnemahoning Creek at Sinnemahoning, PA [}
Flow Data Set | sinnemahoning Creek-Sinnemahoning, PA-FLOW-ANNUAL PEAK -
DS§ File Name: | C\PROJECTSISSP_Testing\Projects\Sinnemahening_B17C\Sinnemahoning_B17C\Sinnemahoning_B17C.dss )
Report File G:PROJECTSISSP_Testing\Projects\Sinnemahoning_B17C\Sinnemanoning_B17C\Bulletin17Resulis\SinnemahoningCreek_B17C\SinnemanoningCreek_B17G.rpt 8]
General | Options | EMA Data| Tabular Results
Frequency Curve for: Sinnemahoning Creek-Sinnemahoning, PA-FLOW-ANNUAL PEAK
5 can . S Confidence Limits
ercen ance ompute urve N
Exceedance Flow in cfs Flow in cfs
0.05 0.95
0.2 102267.5 2128821 733173
0.5 82575.8 1479907 62369.7
1.0 69561.6 1119595 54563.5
20 57969.9 84364.9 47126.6
5.0 44539.8 57635.6 37786.8
10.0 35589.8 42919.6 31016.4,
20.0 27456.8 315548 243924
50.0 173339 19308.5 15561.6
30.0 11461.6 12695.8 10299.5
90.0 9398.6 10437.6 8265.2
95.0 80495 9049.5 6851.9
99.0 6147.9 73847 4807.9
System Statistics Number of Events
Log Transform: Flow Event Number
Value :ws;ogctE‘vents 0
igh Qutliers
Wean 4.253
Standard Dev 0227 how Out\lwzs‘srs and Zero Flows g
Station Skew 0.376| [gooind "gjems =
Regional Skew Vo SMAit
\Welghted Skew Historic Period 79
Adopted Skew 0.37%
[ compute | [ Potcuve | | ViewReport | [ Print | Apply

Figure 3-19. Bulletin 17 Flow Frequency Analysis EMA Tabular Results Tab.

Graphical output can be obtained by pressing the Plot Curve button at the
bottom of the analysis editor. When this button is pressed, a plot will
appear like the one in Figure 3-20. This plot contains the computed
frequency curve, the expected probability adjusted curve (if enabled on the
General tab), the confidence limits, and the data points plotted using the
Hirsch/Stedinger plotting position method. Additionally, a plot title is
listed at the top. The plot title is by default the user-defined name of the
analysis. The user can modify the plot properties by selecting the
Edit->Plot Properties menu option. A plot properties window will open
that lets the user change the line style for each data type, change the axis
labels, modify the plot title, and edit other plot properties. The user can
also edit line styles by placing the mouse on top of the line or data point in
the plot or legend and clicking the right mouse button. Then select the
Edit Properties menu option in the shortcut menu. The plot can be
printed or sent to the windows clipboard by using the Print and Copy to
Clipboard options found under the File menu.

Additional points and lines can be added to a plot by placing the mouse
anywhere in the plot area and clicking the right mouse button. Then select
the Add Marker option to add a line or Add Marker Point to add a
point. Draw properties can be edited for these user-defined lines and
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points by placing the mouse on top of the point or line and clicking the
right mouse button. Then select the Edit Properties option in the shortcut

menu.
[7] Bulletin 17 Plat for SinnemahoningCreek_B17C = | B |
File Edit View Window
Bulletin 17 Plotfar SinnemahoningCreek_B17C
— Return Period
Q 1.0 1.1 2 ] 10 a0 100 a00
1DDDDDDD 1 1 1 1 1 1 1 1 1 1
100000.04
&
z
=
L
10000.04
1000.0 T T T T T T T 1 T
09599 04999 0.949 04 0.4 02 041 0.0z 0008 0.001
Frohability
Computed Curve ——— 5Percent Confidence Limit
— — = 95 Percent Confidence Limit o} Obszerved Events (Hirsch-Stedinger plotting positions)

Figure 3-20. Flow Frequency Curve Plot.

The final piece of output available from a flow frequency analysis is a text
report file. The report file lists all of the input data and user settings,
plotting positions of the data points, intermediate results, each of the
various statistical tests performed (i.e. high and low outliers, historical
data, etc.), and the final results. This file is often useful for understanding
how the software arrived at the final frequency curve. Press the View
Report button at the bottom of the analysis editor to view the report file.
When this button is pressed, a window will appear containing the report as
shown in Figure 3-21.
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@ SinnemahoningCreek_B17C.rpt I — @
File Edit Search Format

File: | Testing\Projects\Sinnemahoning_B17C\Sinnemahoning_B17C\Bulletin 17Results\SinnemahoningCreek_B17C\SinnemahoningCreek_B17C.rpt

Bulletin 17B Fregquency Analys3is
05 Jan 2016 02:07 EM

m

——— Input Data ———

Analysis Name: SinnemahoningCreek B17C | 4
Description: B17C flow-frequency analysis for Sinnemshoning Creek at Sinnemahoning, PA

Data Set Name: Sinnemahoning Creek-3innemahoning, PA-FLOW-ANNUAL FERK
DSS File Name: C:\PROJECTS\SSP Testing\Projects\Sinnemahoning Bl17C\Sinnemahoning B17C\Sinnemshoning Bl7C.dss
D55 Pathname: /Sinnemahoning Creek/Sinnemahoning, PL/FLOW-ANNUAL PERK/01janl900/IR-CENTURY/USGS/

Report File Name: C:\PROJECTIS\SSF Testing\Projects\Sinnemshoning B17C\Sinnemahoning B17C\Bulletinl7Results\Sinnem
XML File Name: C:\PFROJECT5“55F Testing%Projects\5Sinnemahoning B17Ch\Sinnemahoning B17C\Bulletinl7Results‘\S5innemaho

Start Date:
End Date:

Skew Option: Use Station Skew

Regional Skew: -Infinity

Regional Skew MSE: -Infinity

Plotting Position Type: Hirsch-Stedinger

Upper Confidence Lewvel: 0.05
Lower Confidence Level: 0.95

Digplay ordinate values using 1 digits in fraction part of value

——— End of Input Data ---

<< EMA Representation of Data >>
Sinnemahoning Creek-3innemahoning, PA-FLOW-AZNNUAL FERLK

| | Value | Threshold | |
| Year Peak | Low High | Low High | Iype |
[———————————————= [ [ [=—= |
| 1938 61,200.0 | 61,200.0 61,200.0 | 1.0E-939 1.0E9% | Syst |
Wl ([l 1937 — 1.0E-93 &0,000.0 | 60,000.0 1.0E39 | Cens |
| 1938 = | 1.0E-99 €0,000.0 | 60,000.0 1.0E99 | Cens |
| 1339 8,120.0 | g,120.0 8,120.0 | 1.0E-939 1.0E99 | Syst | -
|‘4||nan am o amm oA am amn A 4|n”;|nn A 1 Am An A mmAn o m_e .
01/05/2016 14:07 PM 1111 11

Figure 3-21. Report File from Bulletin 17 Frequency Analysis.
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CHAPTER 4

Using the HEC-SSP Data Importer

The HEC-SSP Data Importer is used to import, enter, and view data and
the corresponding metadata used in an HEC-SSP study. The current
version of HEC-SSP can be used to import annual peak data (flow and
stage) and data stored at regular intervals, like hourly flow data.

Contents
e Developing a New Data Set
¢ Importing Data from an HEC-DSS File
e Importing Data from the USGS Website
¢ Importing Data from an Excel Spreadsheet
e Entering Data Manually
e Entering Data from a Text File
e Metadata
e Plotting and Tabulating Data
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Developing a New Data Set

Before any analyses can be performed in HEC-SSP, the user must import
or enter data into the study. Importing, entering, and viewing data is
accomplished in the Data Importer. To open the data importer, go to the
Data menu and select New from the list of options, which will bring up a
data importer as shown in Figure 4-1.

=
[ Data Importer -

Mame: | Shart ID:
Description: E]

Study DSS File: | ciDocuments and SettingsigOhecmifDesktopisspiSSP_Examples\SSP_EXAMPLES dss
Study DSS Path:
Data Source | Details
Laocation
() HEC-DSS (&) USGS Wehsite ) MS Excel O Manual () Text File
USGS Wehsite
Data Type: | annual Peak Data v ~

Retrieve data for:

Flow [] Stage

[ Get USGS Station ID's hy State

Import LSGE Basin Mame Location COther Qualifier
Data Station 1D's (A Par) (B Par (F Parfy

[ |d Plot H =E Tabulate I
Figure 4-1. HEC-SSP Data Importer.

At the top of the Data Importer, the user can enter a Name for the new
data set. Optionally, the user can enter a short identifier (limited to 16
characters) and a Description of the data set. The study DSS file name is
provided. The DSS file is used for storing the data for the study. The user
does not have to enter a name when importing or manually entering data.
The program will automatically name the data using USGS names or
HEC-DSS pathname parts. If a Name is entered then it will be combined
with the USGS gage name or HEC-DSS pathname parts to create a unique
name. The user can rename a data set by selecting the data set in the study
explorer and clicking the right mouse button. A shortcut menu should
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open with a Rename menu option. The Data menu also contains a
Rename menu option; however, the data set must be selected in the study
explorer before this menu option is active.

The Data Importer contains two main tabs, Data Source and Details. The
Data Source tab is used for importing or entering data manually while the
Details tab is used to describe the data (i.e. metadata). The Data Source
tab contains five options for getting data into the study DSS file:
Importing from an existing HEC-DSS file, importing from the USGS
Website, importing from an Excel spreadsheet, entering the data manually,
and importing from a text file.

Importing Data from an HEC-DSS File

To import data from an HEC-DSS file into the HEC-SSP study DSS file,
first select the HEC-DSS radio button on the data importer. Selecting
HEC-DSS will change the view of the Data Importer to look like Figure
4-2.

[ Data Importer -

Marne: | | Shirt IO |

Description: | C]|

Study DSS File: |c:TemplasP_Examples\S5P_EXAMPLES dss |
Study DSS Path: | |

Diata Source | Details

Lacation
(@) HEC-DES ) UBGS Website ) ME Excel ) Manual () Teut File
HEC-DSS
Selected DSS File: |caTempSSP_ExamplesisSF_EXAMPLES dss ]

Selected DSS Pathname: | |

Search A |FISHKILL CREEK v| o v| E| v
By Parts: g | v| D: ¥| F: | v
Nurmber Part A PartB Part C Part D[ range PartE PartF
2|FISHKILL CREEK BEACON FREG-FLOWY BULLETIN 17B_F...
3|FISHKILL CREEK BEACON FREG-FLOWY MAX ANALYTICAL GEMFREG_GENE...
4|FISHKILL CREEK BEACON FREG-FLOWY GEMFREG_GENE...
5|FISHKILL CREEK BEACON FREG-FLOWY &K GRAPHICAL GEMFREG_GENE...

1 FISHHILL CREEK BEACON FLOWY 0Shar1 9435 - 19hiar1 965 IR-CEMTURY

JFFISHKILL CREEF/BEACONFLOWNSMar1 945 - 19hlar 963AR-CEMTUR™ I ﬁ
W
[ Importto StugyDSSFile | [ Clear Selections |
(v ) [ |

Figure 4-2. Data Importer with HEC-DSS Import Option.
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As shown in Figure 4-2, the user first selects a DSS file to import from by
typing the path and name or by choosing the file browser at the end of the
input field. Once a DSS file is selected, the table of pathnames will be
filled with the records that are contained in that DSS file. The user can
reduce the number of listed pathnames by selecting pathname parts to
filter in the pathname part selection area just above the table. Any
pathname part can be used to filter the list down to a more manageable
number of pathnames to select from. The user can then select pathnames
to import by double clicking on one or more of the listed pathnames in the
table. Each selected pathname will show up in the list below the table.
Once the user has selected all of the pathnames that they want to import,
pressing the Import to Study DSS File button enacts the import process.
An HEC-SSP data set will be developed for each pathname that was
selected.

Importing Data from the USGS Website

The second way to import data into HEC-SSP is to use the USGS Website
option. When this option is selected, the data importer will look like
Figure 4-3.
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[ Data Importer - |:‘|E‘g‘

Narme: “ | Short ID: |

Description: ‘ E]|

Study DSS File:  caDocuments and SettingsigDhecmifDeskiopisspigSP_Examples\35F_EXAMPLES.dss |
Study DS Path: |

Data Source | Details |

Lacation

() HEC-DSS (=) USG5 Wehsite () MS Excel 3 Manual () Text File
U3GS Website

. ~
Data Tve: |annual Peak Data v z
Retrieve data for:
Flaw [] Stage
[ Get USGS Station |D's by State

Import LSGE Basin Mame Location COther Qualifier

Data Station ID's (& Part) (B Parth (F Part)

w e b e
IFl ~
w
[ Laren ) (5 rovue |

Figure 4-3. HEC-SSP Data Importer with USGS Website Import Option.

The first step in using the USGS import option is to select a data type to
import (e.g. Annual Peak Data). Then choose to import Flow and/or
Stage data. Next the user should select the Get USGS Station ID’s by
State button. Selecting this button will bring up a small window that
allows the user to select a state in which to acquire data, as shown in
Figure 4-4.

i Obtain stations by state @

Select State: |Penn5y|var‘|ia

v

Data Type:  Annhual Feak Data

]2 Cancel

Figure 4-4. Window to Select a State for Importing USGS Data.
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Once the user selects a state and presses the OK button, a process will
begin in which all of the gage locations for that state will be downloaded
from the USGS website. A listing of all the gages for that state will then
be displayed in the table at the bottom of the data importer. An example
of the data importer with a list of USGS gages is shown in Figure 4-5.

[ Data Importer -

DER

Name: ‘

| Short ID:

Description: ‘

dl

Study DSS File: \o:xDocuments and SettingsigOhecmifDeskiopisspSSP_Examples\SSP_EXAMPLES dss

Study DSS Path: \

Data Source | Details

Location
() HEC-DSS (&) USGS Wehsite () WS Excel ) Wanual () Text File
U3GS Website
] 03023100 French Cragk Meadville, PA USGE A
I 03023300 wan Horne Creek Kerrtown, PA, 1USGS [
] 03023500 French Creek Carltan, PA IUSGS
] 03024000 French Cragk Utica, PA USGE
IFl 03025000 Sugar Creek Sugarcreek, PA USGE
[] 03025200 Fatchel Run Franklin, PA USGE
] 03025500 Allegheny River Franklin, PA USGE
L 03026400 Richey Run Emlanton, PA USGE
IFl 03026500 Sevenmile Run Rasselas, PA USGS
[¥] 03027500 EE Clarion River EE Clarion River Dam, PA UsGs
[#] 03028000 West Branch Clarion River Wilcox, PA USGE
[] 03028500 Clarion River Johnsonburg, PA USGS
03029000 Clarion River Ridgway, PA USGs
[] 03029200 Clear Creek Sigel, PA USGS
] 03029400 Toms Run Cookshurg, PA USGS
] 03029500 Clarion River Coaokshburg, PA USGS
] 03030500 Clarion River Piney, PA USGE
IFl 03030852 Clarion River Callenshurg, PA USGE —
] 03031000 Clarion River St. Petershurg, PA IUSGS
] 03031500 Allegheny River Parker, PA USGE
[] 03031780 il Creek Brockway, PA USGS
] 03031950 Big Run Sprankie Mills, PA USGS
] 03032500 Redbank Creak 5t. Charles, PA UsGs v
[ importto Stugy DS5 File | 4
v
[ |d Plot ] [ =E Tabulate I

Figure 4-5

. Data Importer with USGS Gages Listed in Table.

The next step is to select the desired gages for importing into the HEC-
SSP study. The user can filter the list to a smaller number of gages by
using the filter drop down boxes at the top of the table. To select a gage
for importing, simply check the box in the left hand column for each gage
location that is to be imported. After all of the desired locations are
selected, press the Import to DSS File button to import the data into the
study DSS file. Pressing this button will start a process of downloading
data from the USGS website. For each selected location, the software will
download the Data Quality Codes if they are available. The program
issues a message that data quality codes are available and adds the codes
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as an additional data set to the Data folder. For an explanation of the
codes, please visit the USGS website.

Warning: all data downloaded from the USGS website should be
reviewed to ensure it is appropriate before any analyses are performed on
the data. Some data stored on the USGS website are estimated, not
measured. The user should check the data on the USGS website and be
aware of the quality of all the data before using it. HEC-SSP will import
the annual peak flow and stage quality codes (the program does not import
quality codes for daily, instantaneous, and real time data). A description
of the quality codes for annual peak flows is contained in Table 4-1 and a
description of the quality codes for annual peak stages are contained in
Table 4-2.

Table 4-1. Quality Codes for USGS Annual Peak Flow Data.

Code | Description

1 Discharge is a Maximum Daily Average

2 Discharge is an Estimate

3 Discharge affected by Dam Failure

4 Discharge less than indicated value which is Minimum
Recordable Discharge at this site

5 Discharge affected to unknown degree by Regulation or
Diversion

6 Discharge affected by Regulation or Diversion

7 Discharge is an Historic Peak

8 Discharge actually greater than indicated value

9 Discharge due to Snowmelt, Hurricane, Ice-Jam or Debris
Dam breakup

A Year of occurrence is unknown or not exact

B Month or Day of occurrence is unknown or not exact

c All or part of the record affected by Urbanization, Mining,
Agricultural changes, Channelization, or other

D Base Discharge changed during this year

E Only Annual Maximum Peak available for this year

Table 4-2. Quality Codes for USGS Annual Peak Stage Data.

Code | Description

1 Gage height affected by backwater

2 Gage height not the maximum for the year

3 Gage height at different site and(or) datum

4 Gage height below minimum recordable elevation
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5 Gage height is an estimate

6 Gage datum changed during this year

Importing Data from an Excel Spreadsheet

The third option for importing data into HEC-SSP is MS Excel. When
this option is selected, the data importer will change as shown in Figure
4-6. Currently, HEC-SSP can only import data from Excel 97-2003
Workbooks (*.xls). The first step in importing data from an Excel
spreadsheet is to select the browse button, [.J, at the end of the Excel File
field. Once an Excel file is selected, a data view window will open
showing the data contained in the selected spreadsheet. An example

Excel® Data Viewer is shown in Figure 4-7.

[ Data Importer -

Marne: | | Short 10

Description: | C]|

Study DSS File: |C.TempiasP_Examples\35P_EXAMPLES.dss

Stuchy DES Path: |

Data Source | Details

Lacation
() HEC-DSS O USGS Website () WS Excel O manual () TextFile
ExcelFile: | ]
Waorkshest: | | Block: | E]|
Data Units: | |
D55 Pathname Parts
A | B | o [FLow-PEAK |
D: | | E|IR-CENTURY v| | |
Pathnarme:  HFLOW-PEAKIR-CENTURYH |
Crdinate Cate Time Walue
Lnits
Type
Mo Excel File selected
[ Lapor ) [ Tobiee |

Figure 4-6. Data Importer with MS Excel Import Option Selected.
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B2 Peak Flow Data

A E
1
2
3
4 Dzte Feak Flows
a 14 My 1935 1204
G 27 Jun1996 TES
¥ 12.Jan1397 2100
a 14Feb1998 1356
L 21Mar1999 1274
10 OZAprz000 ans
11 A0 hdzy2001 1645
12 30 Jun200z ZEa0

Sheetl | Sheetz | Sheet3

[ 0] H Cancel ]

1 I —

Figure 4-7. Example Excel Data Viewer.

The next step is to highlight the date and data values to be imported into
the study (only highlight the data, not the column headings). The data
must be in a format of Date in the first column and Data in the second
column. The date must be in the Day, Month, Year format (ddmmyyyy)
as shown in Figure 4-7. Next, press the OK button and the data will be
placed in the table at the bottom of the editor. The last step before
importing the data is to specify the units of the data, and each of the
pathname parts for storing the data in the study DSS file (make sure to edit
the C-part pathname if data is not annual peaks). Enter units of cfs for
data in cubic feet per second or units of cms for data in cubic meters per
second. The final step is to press the Import to Study DSS File button,
and the data will be imported.

4-9



Chapter 4 - Using the HEC-SSP Data Importer HEC-SSP User's Manual

Entering Data Manually

Another option for getting data into the study is to enter the data manually.
When the Manual option is selected, the window will change to what is
shown in Figure 4-8.

& Data Importer -

Mame: Short 1D:
Description: E]
Study DS File: | C4TempmSSP_Examples\SSP_EXAMPLES dss

Study DS5 Path:

Data Source | Details

Lacation

(O HEC-DES O USGS Website (O MS Excel ® Manuat (O Text File
Pathname Parts
A B: C:
D E: |IR-CENTURY hd F:

Pathnarne: | WHIR-CENTURY

Start Date: Units:

Start Time: Type: |INST-\VAL hd

Manual Entry | Automatic Generation

Ordinate Date Time Value

[ Importto Study DSS File |
| Lapiot | [ ZETabuete |
Figure 4-8. Data Importer with Manual Data Entry Option Selected.

To enter data manually, the user enters a name for the data set at the top,
along with a short identifier and a description (optional). A starting date
and time must be entered. The units of the data must also be defined as
well as the data type. The last step before entering the data is to specify
the pathname parts for how the data will be stored into the study DSS file.
This requires the user to enter a label for the A, B, C, E, and F part of the
DSS pathname. Once all of the data labeling is completed, the data can be
entered into the table at the bottom of the editor. The user must enter the
Date, Time, and data Value for each peak flow value to be entered. After
a Date, Time, and Value are entered into a row, a new row will be
generated in the table when the user leaves the Value field. The date must
be in the Day, Month, Year format (ddmmyyyy). Another option for
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getting data into the table is to copy it to the clipboard and then paste it
into the table. The table supports pasting data one column at a time or you
can paste the date, time, and value information all at once. When all of the
data are entered into the table, the user presses the Import to Study DSS

File button and the data will be stored in the study DSS file.

Importing Data from a Text File

The fifth option for importing data into HEC-SSP is a comma delimited
Text File. When this option is selected, the data importer will change as

shown in Figure 4-9.

-
[ Data Importer -

Name: Short ID:
Description: E]
Study DSS File: | ciDocuments and SettingsigOhecmifDesktopis spiSSP_Examples\SSP_EXAMPLES dss

Study DSS Path:

Data Source | Details

Location

() HEC-DSS O USGS Website () M5 Excel ) Manual @ TextFile
File: [L) Start Date: [L]| StartTirmne:
Data Units:
0SS Pathname Parts
A =R G |[FLOW-PEAK
O E: | IR-CENTURY & F:

Pathname: |[MFLOW-FEAKNR-CENTURY

Ordinate Date Time Walue

Units

Type

[ Larot | [ = Tabuiate |

Close

Figure 4-9. Data Importer with Text File Option Selected.

The first step in importing data from a comma delimited Text File is to
press the Select File, [.J, button at the end of the File field. Once a
comma delimited text file is selected, a data view window will open
showing the data contained in the selected file. An example text file data

viewer is shown in Figure 4-10.
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[ —— -+
Alpha Version. Time Series Columnar import. File: bo040flow.csv |._||E|[Z|
File

Fow i Col

2 4
Date Floww(cfs)

13AG1993 6.346

14AG19493 6.017

18AG1993 5.983

1BALIGT9493 6.218

17ALGT1993 6.493

18ALIGT19493 6.692

19ALIG1 893 7.040

20ALGT1993 716

21ALG1893 7.029

22AG19493 £.952

23AUG19493 6.771

2441051993 T.7h4

28AG19493 20.967

2BALGT1993 7237

2TALGT9493 54922

28AG1993 5.835

29AG19493 6.044

30ALUGT1 993 6.635

IMTAUGT 93 6.974

013EP1993 7.006

02SEP1993 ¥.0ez

035EFP1993 6.635

045EP1993 5.918

NECEP1002 B 02

Figure 4-10. Example Text File Data Viewer.

The next step is to highlight the date, time, and data columns. Only
highlight the data that will be imported, not the column headings. If there
are column headings then they need to be identified. To do this, select the
row or rows that do not contain data to be imported. Then click the right
mouse button and select the Skip Row(s) menu option, as shown in Figure
4-11.
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Alpha Version. Time Series Columnar import. File: boO40flow.csy |Z||E|fz|
File

Fow i Col

Pathnarme Park Row b

Linits R oy

2 4

Date Flow{cfs)
T13ALG1993 6.346
T4A1L0G1993 6.017
T18ALIG1993 5.983
TBALIGT993 6.218

17ALGT993 £.493

18AG1993 6.692

19AG1993 ¥.040

20A10G1993 716

2MAG1993 7.029

22A10G1993 £.958

23AJG1993 6.771

2421051993 7.754

25A10G1993 20.967

2621051993 7237

27AG1993 54922

28A1G1993 5.835

28AG1993 6.044

30ALG1993 6.635

JMALG1993 6.974

01SEP1993 7.006

0ZSEP1993 7.0a2

025EP1993 6.635

045EP1993 54918

oA n ORCEPA Q03 [34-00 B 020

Irpoart ] ’ Cancel

Figure 4-11. ldentify Rows that do not Contain Data to be Imported.

To identify the date and time columns, place the mouse pointer on the
column number at the top of the table and click the right mouse button.
Then move the mouse pointer to the Date — Time Column option to see
an additional menu of options, as shown in Figure 4-12. Figure 4-12
shows that column 2 will be defined as the date column. The date must be
in the Day, Month, Year format (ddmmyyyy). The data viewer will
highlight the date and time columns once they have been defined.
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Alpha Version. Time Series Columnar import. File: boO40flow.csv |Z||E|rz|

File
Fow | Cal 1 2 o g
] Sl Skip Column fs) | 2
3 hondn CReTaNleR il Date - Time Column k Date and Time Column
3 bao0d40 14405195 Set Data Column Crate Column I
4 bo040 18AUG19%  Clear Column Time Colurmn
5 bo040 TBALIGT1993 [24:00 6.218 Day Column
3] bo040 TFALGTE93 [24:00 B.493  Maonth Column
T bo040 T1BALG1993 [24:00 B.692  “vear Column
a bo040 THALGT993 [24:00 7.0400  month-Day Column
g bo040 2041993 (24:00 7116 pay-Month Calumn
10 bo040 21AUG1993 [24:00 7029 panth-Year Column
11 bo040 22AG1993 [24:00 B.958
1 o040 Qonl A 00T 14-00 | |

Figure 4-12. ldentify Date and Time Columns.

To define the data column, place the mouse pointer on the column number
at the top of the table and click the right mouse button. Then choose the
Set Data Column menu option from the shortcut menu. Another editor
will open, as shown in Figure 4-13, that allows the user to define the
pathname parts, data units, and data type. After defining these data
properties, click the Import Now button to import the data and data
properties into the Data Importer. You can edit the data values or data
properties in the data importer before importing the data to the study. The
final step is to press the Import to Study DSS File button, and the data
will be imported.
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Fathname Pars

A:|

O

FPathname: T DAY

Start Date: |13Aug19493 LInits:

Start Time: | 24:00 Type: | IMST-waL

Irmport Moy

Figure 4-13. Editor for Defining the Data Properties.

Metadata

When downloading data from the USGS website, in addition to the raw
data, the software will also attempt to download any metadata available
for each gage location. When using one of the other four methods for
importing data, the user can manually enter metadata by selecting the
Details tab, as shown in Figure 4-14. The metadata consists of the State,
County, Stream, Location, Drainage Area, DA Units, Gage Operator,
USGS Gage No., Gage Datum, HUC (Hydrologic Unit Code), Vertical
Datum, and a description field. Additionally, the coordinate location of
the data is shown. The coordinate location consists of Coordinate System,
Coordinate ID, Horizontal Datum, Datum Units, Coordinate X Value, and
Coordinate Y Value. If coordinate system data are entered, data icons and
text labels will show up on the background map at the specified locations.

Metadata can be viewed and edited any time after the data has been
imported into the study by opening the Metadata Editor. To open the
Metadata Editor, place the mouse pointer on top of a data set in the Data
folder and then click the right mouse button. Choose the Edit Metadata
option from the shortcut menu, as shown in Figure 4-15. The Metadata
Editor will look exactly like the Details tab on the Data Importer. The
Metadata Editor can also be opened from the Data menu and from a
shortcut menu that opens by right clicking on a data icon in a background
map.
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% Data Importer -

Marne: | | Shart D |

Description: | E]|

Study DSS File: |CiTempl35P_Examples\35P_EXAMPLES dss |
Study DSS Path: | |

Diata Source | Details |

State: || | County; | |
Stream: | | Location: | |
Drainage Area; | | DA Units: | |
Gage Operator: | | USGES No: | |
Gage Datum; | | HUC: | |
Vetical Daturn: |No Coordinate Systern v|

Description: | E]|

Coordinate Location Data

Coordinate Systern: |N0 Coordinate Systern v| Coordinate 1D | |
Horizontal Daturn: |N0tSet v| Daturm Units: |Notspeciﬂed v|
Coordinate X Value: | | Coordinate ¥ Value: | |

[ Lariot | [ SETabuiste |

Figure 4-14. Details Tab on the HEC-SSP Data Importer.

=9 Data

FISHKILL CREEK-BEACON-FLOWY |4 Plet
FLOYD RIVER-JAMES 1A-FLOWY ==
KASKASKIA RIVER-VANDALIA, IL-FLC _

ORESTIMEA CREEK-MEYWRMAN, CA—F

RIDLEY CREER-MOYLAM, PA-FLOW

CEDAR RAPIDS, STAGE DATA I save fs...
Rio Grande at Alubguergue UMNREGL
Annual Daily Average Peak Flows Rio Rename. ..

Annual Daily Average Peak Flows Lod ¢ Delete fram Study

-l CHATTAHOOCHEE RIVER-CORMELI
EIE? hap Remnowe From Study

‘. # Base Map Properties...

Figure 4-15. Menu Option for Opening the Metadata Editor.
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Plotting and Tabulating the Data

r

B2 Back Creek-Jones Springs

File Edit

View

After the data is imported into the study, the user can select any one of the
data sets in the study explorer. A shortcut menu will open when clicking
the right mouse button while a data set is selected. The shortcut menu
contains options to change the name, plot, and tabulate the data. These
options are also available from the Data menu; however, the data must be
selected in the study explorer before these options are available. If you
select the Plot option, you will get a plot similar to the one shown in
Figure 4-16.

EX

=]
20,000+
=]
=]
15,000+
%)
E o
L 10,0004 o
b =]
o =]
=] v (=] e ° ¥
[#]
5,000 —1—° o, o o ]
o =) o o o o o =}
=] o DD
=]
=]
| | | | | | | | |
1930 1935 1940 1945 1950 1955 1960 19645 1970
< JORES SPRINGS Wi OBS FLOWY

Figure 4-16. Plot of Peak Annual Flow Data.

If you select the Tabulate option, a table will open with the data listed as
shown in Figure 4-17. Data values in the table can be edited after
selecting the Edit->Allow Editing menu option. To save any edits, select
the File->Save menu option.
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r

— — .-‘
JBACK CREEKJJONES SPRINGS, wv/FLowy... [ |[B][X]
File Edit Yiew

Ordinate

JOMES SPRIM...
FLOWY
OBS

LInits

CFS

Type

IMNST-WAL

1

17 Apr19249

8,750

23 0ct19249

14,600

08 May 1931

4,060

04 Feb 1939

£,300

20 Apr1940

3,130

06 Apr1941

4160

22 May 1942

5,700

16 0ct1942

22,400

24 Mar 1944

3,880

18 Sep 1944

5,050

032 Jun 1946

4,020

15 Mar 1947

1,600

14 Apr 1948

4,460

31 Dec 1944

4,230

02 Feh 1950

3,010

05 Dec 1850

8,140

28 Apr1952

5,100

24 Mow 1952

4,820

02 Mar 1954

£,200

19 Aug 1955

10,700

15 Mar 1956

3,880

10 Feb 1957

3,420

27 Mar 1958

3,240

03 Jun 1959

f,500

09 May 1960

3,740

19 Feh 1961

4,700

22 Mar 1962

4,380

20 Mar 1963

5,180

Figure 4-17. Table Containing Peak Annual Flow Data.
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CHAPTER 5

Performing a Bulletin 17 Flow
Frequency Analysis

The current version of HEC-SSP allows the user to perform flow
frequency analyses using two different methodologies which are
commonly referred to as Bulletin 17B and Bulletin 17C. This chapter
discusses in detail how to perform a Flow Frequency Analysis within
HEC-SSP using either method.

Contents

Bulletin 17B vs. Bulletin 17C

Starting a New Analysis

General Settings, Options, and Computations
Viewing and Printing Results
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Bulletin 17B vs. Bulletin 17C

The Bulletin 17B guidance has guided the development of peak flow
frequency analyses within the United States since the early 1980°s. This
guidance recommended the use of the Log Pearson Type 111 probability
distribution for annual peak flows on unregulated streams fit by the
Method of Moments (Interagency Advisory Committee on Water Data,
1982). Using the Bulletin 17B methodology, distribution parameters are
estimated from the moments of the sample data (i.e. mean, standard
deviation and skew). Bulletin 17B also includes adjustments to those
parameters for non-standard data (missing years, flows below gage base,
or estimated flows), low outliers, and historical events. Adjustments can
be made with a series of specified procedures including the conditional
probability adjustment and the historical adjustment (weighted moments)
procedure. The Bulletin 17B methodology characterizes the peak flow in
each year as either (1) part of the systematic (observed) record, for which
a point estimate of flow exists or (2) an historical event from a time before
a gage was present but for which an estimate of flow can be made.

The Bulletin 17C guidance brings a change to the computation of peak
flow frequency within the United States. This guidance incorporates
changes motivated by four of the items listed as future work within
Bulletin 17B and more than 30 years of post-Bulletin 17B research on
flood processes and statistical methods (England, et al., 2015). As part of
the Bulletin 17C methodology, the moments/parameters of the Log
Pearson Type 11 distribution are estimated using the Expected Moments
Algorithm (EMA). Like Bulletin 17B, the Bulletin 17C/EMA (17C EMA)
methodology also estimates distribution parameters based on sample
moments, but does so in a more integrated manner that incorporates non-
standard, censored, or historical data at once, rather than as a series of
adjustment procedures (Cohn, Lane, & Baier, 1997). The use of Bulletin
17C procedures can also provide improved confidence intervals for the
resulting frequency curve that incorporate diverse information
appropriately, as historical data and censored values impact the
uncertainty in the estimated frequency curve (Cohn, Lane, & Stedinger,
2001). Within the 17C EMA methodology, every annual peak flow in the
analysis period, whether observed or not, is represented by a flow range.
That range might simply be limited to the gaged value when one exists.
However it could also reflect an uncertain flow estimate.
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Starting a New Analysis

A flow frequency analysis can be started in two ways within the software,
either by right clicking on the Bulletin 17 folder in the study explorer and
selecting New, or by going to the Analysis menu and selecting New and

then Bulletin 17 Flow Frequency. When a new flow frequency analysis

is selected, the Bulletin 17 Editor will appear as shown in Figure 5-1.

[] Bulletin 17 Editor - =R
MName:
Description: D
Flow Data Set: -
DSS File Name: =]
ReportFile: D
General
Method for Computing Statistics and Confidence Limits Low Outlier Test Confidence Limits
17C EMA Multiple Grubbs-Becl Defaults (0.05, 0.95
17B Methods Single Grubbs-Beck User Entered Values
Uppe 1
Generalized Skew Plotting Position Uz LI
Use Station Skew Weibull (Aand B= 0, Lower Limit
Median (AandB=03
u
Time Window Modification
u
DSS Range is
Other (Specify A, B Start Date
Ploiting position computed using formula End Date
{m-A)i(n+1-A-B)
Expected Probablity Curve Where
Comn e Ex d Prob. Curve m=Rank, 1=Largest
Lozl 3 slreEie N=Number of Years
Do Mot Compute Expected Prob. Curve AB=Constants
B
| Compute ‘ | Plot Curve ‘ | View Report | ‘ Print ‘ 0K Apply Cancel

Figure 5-1. Bulletin 17 Flow Frequency Analysis Editor.

The user is required to enter a Name for the analysis, while a Description
is optional. An annual peak flow data set must be selected from the
available data sets stored in the current study DSS file (see chapter 4 for
importing data into the study). The list of data that can be selected for a
Bulletin 17 analysis will only include those data that have an irregular
interval, like IR-CENTURY and IR-YEAR (E-part pathname). Once a
Name is entered, and a flow data set is selected, the DSS File Name and
Report File will automatically be populated. The DSS filename is by
default the study DSS file. The report file is given the same name as the
analysis with the extension ".rpt".
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General Settings, Options, and Computations

Once the analysis name and flow data set are selected, the user can begin
setting up the analysis. Four tabs are contained on the Bulletin 17 editor.
The tabs are labeled General, Options, EMA Data (which is non-
selectable unless the analysis is set to use 17C EMA methods), and
Tabular Results.

General Settings

The first tab contains general settings for performing the flow frequency
analysis (Figure 5-1). These settings include:

e Method for Computing Statistics and Confidence Limits
o Generalized Skew

e Expected Probability Curve

e Low Outlier Test

e Plotting Positions

¢ Confidence Limits

e Time Window Modification

Method for Computing Statistics and Confidence Limits

There are two
Method for Computing Statistics and Confidence Limits choices available
for computing flow
frequency statistics
17B Methods and confidence
limits within HEC-
SSP: 17C EMA and 17B Methods. The user is referred to the Bulletin
17C publication for in depth discussions regarding the differences between
Bulletin 17B and Bulletin 17C. In general, 17C EMA will provide the
same computed flow frequency curve as Bulletin 17B methods when there
are no historical events/periods and no low outliers included within the
analysis. Also, the computed confidence intervals will be nearly the same
when using a skew that is near zero.

@ 17CEMA

Choosing either 17C EMA or 17B Methods will invoke different options
throughout the flow frequency analysis (for instance, choosing the 17C
EMA method results in the inability to compute the expected probability
curve). When opening a new Bulletin 17 analysis, the user must select a
method for computing statistics and confidence limits before proceeding
with the analysis. Until a method is selected, all other options will be
inactive.
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Generalized Skew

There are three options contained within the generalized skew setting: Use

Generalized Skew
@ Lse Station Skew
L=e Weighted Skew

lse Regional Skew
Regional Skew:

Reg. Skew M3E:

Station Skew, Use
Weighted Skew, and
Use Regional Skew.
The default skew
setting is Use Station
Skew. With this
setting, the skew of
the computed curve
will be based solely
on computing a skew
from the data points

contained in the data set. No weighting with regional skew will be

performed to compute the final skew.

The Use Weighted Skew option requires the user to enter a generalized
regional skew and a Mean-Square Error (MSE) of the generalized regional
skew. This option weights the computed station skew with the generalized
regional skew based upon the inverse of the mean square error in each
skew estimate. The equation for performing this weighting can be found
in Bulletin 17B (equation 6). If a regional skew is taken from Plate | of
Bulletin 17B (the skew map of the United States), the value of MSE =
0.302. Additional estimates of regional skew to be used in peak flow and
flow-duration statistical analyses are being developed by the USGS and

others; for example, see (Parrett, et al., 2010).

The last generalized skew option is Use Regional Skew. When this
option is selected, the user must enter a generalized regional skew and an
MSE for that skew. The program will ignore the computed station skew

and use only the regional skew.

Expected Probability Curve

This setting has two options: compute the expected probability curve and
do not compute the expected probability curve. The default setting is to

Expected Probablity Curve
Compute Expected Prob. Curve

Do Mot Compute Expected Prob. Curnve

not compute the
expected probability
curve. When using
the 17C EMA
method to compute
statistics and

confidence limits, the expected probability curve is not computed.
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However, when using the Bulletin 17B method and computing the
expected probability curve, this curve will be shown in both the result
tables and the plots as an additional curve. The expected probability
adjustment is a correction for bias in the computed frequency curve. The
bias is caused by uncertainty due to the shortness of the data record. The
Method of Moments estimation of the Log Pearson 11l parameters
produces a median estimate of each frequency curve quantile, and the
adjustment changes to a mean (unbiased) estimate, which is different from
the median because of the skewness of the uncertainty distribution. The
reader may review the discussion in Bulletin 17B about the expected
probability curve adjustment for an explanation of how and why it is
computed.

The use of the expected probability curve is a policy decision. It is most
often used in establishing design flood criteria. The basic flood frequency
curve without the expected probability adjustment is the curve used in
computation of confidence limits, risk, and in obtaining weighted averages
of independent estimates of flood frequency discharge (Interagency
Advisory Committee on Water Data, 1982).

Low Outlier Test

This option allows the user to choose the test that is performed to identify
low-value data points that depart significantly from the trend of the
remaining data and

ST EE inappropriately affect

® Multiple Grubbs-Beck the extreme quantiles

_ in the upper tail of the
Single Grubbs-Beck frequency curve.

There are two options
for testing low outliers within HEC-SSP: Multiple Grubbs-Beck and
Single Grubbs-Beck.

These low-value data points can significantly distort the entire computed
flow-frequency curve due to the use of logarithms within both the 17B and
17C EMA methods. These distortions are more severe with the 17C EMA
method. As part of the development of the Bulletin 17C methodology, the
standard Single Grubbs-Beck low outlier test was expanded to more
successfully identify multiple low outliers (also referred to as potentially
influential low floods, or PILFs). Therefore, the only option available
when using the 17C EMA method within HEC-SSP is the Multiple
Grubbs-Beck test. When low outliers are calculated using the Multiple
Grubbs-Beck test, both perception thresholds and flow ranges are
modified within the 17C EMA framework to prevent excessive influence
on the computed flow frequency curve. Example 2 within Appendix C
presents an instance where multiple low outliers are identified using the
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Multiple Grubbs-Beck test and the resulting modifications that are made
within the 17C EMA framework.

When using the 17B methodology, the default test is the Single Grubbs-
Beck test.

Plotting Positions

Plotting Position
() Weibull (A and B =0)
@ Median (AandB=10.3)

Plotting positions are used for
plotting the input flow data
set on a probability scale

along with the computed
frequency curve and
confidence limits. There are
five options for computing

Hazen (4 and B = 0.5)
HirschiStedinger

Other (Specify A, B)

plotting positions within
HEC-SSP: Weibull, Median,
Hazen, Hirsch/Stedinger, and Where:
user entered coefficients.
The only method available
for computing plotting
positions when using the 17C A:
EMA method is
Hirsch/Stedinger (Hirsch and

Plotting position computed using formula
(m-A){n+1-A-B)

m=Rank, 1=Largest
M=Mumber of Years
A B=Constants

Stedinger, 1987). The default
method when using the Bulletin 17B method is the Median plotting
position formula. When using 17C EMA methods and the
Hirsch/Stedinger plotting position formula, flow data screened as low
outliers (a.k.a. Potentially Influential Low Floods) are assigned a plotting
position using the Median plotting position formula within HEC-SSP.

The generalized plotting position equation is:

_ (m-A)
(n+1-A-B)
where: m = rank of flood values with the largest equal to 1.
n = number of flood peaks in the data set.

A & B = constants dependent on which equation is used (Weibull
A and B=0; Median A and B =0.3; and Hazen A and
B=0.5).

Plotting positions represent estimates of the exceedance probability of
each data point (peak flow). Different plotting position formulas can give
very different values for the probabilities of the highest and lowest points
in the data set. In both the Bulletin 17B and 17C EMA methodologies, the
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plotting of data on the graph by a plotting position method is only done as
a guide to assist in evaluating the computed curve. The plotting position
method selected does not have any impact on the computed curve.

Confidence Limits

The computed flow frequency curve is only an estimate of the probability
distribution of the larger parent population. Confidence limits can be used
to provide a measure of the uncertainty of the estimated exceedance
probability of a selected discharge or a measure of the uncertainty of the
discharge at a selected exceedance probability. Confidence limits
computed when using the 17C EMA methodology are outlined in Bulletin
17C, Appendix 6. Confidence limits computed when using the 17B
methodology are outlined in Bulletin 17B, Appendix 9. Generally
speaking, the confidence intervals computed with 17B procedures are less
accurate than those computed using the 17C EMA methodology. The 17B
methodology neglects the uncertainty in the estimated skew coefficient
and does not recognize or use historical information.

Confidence Limits By default, HEC-

SSP calculates the 90

@ Defaults (0.05, 0.95) percent confidence

User Entered Values interval for all flow

R, frequency analyses
QppErCIotE: (i.e. the 5% and 95%

Lower Limit confidence limits).

By comparison, the

default confidence
interval used within the USGS PeakFQ program is 95% (i.e. 2.5% and
97.5% confidence limits) (Veilleux, Cohn, Flynn, Mason, & Hummel,
2013). The confidence limits must be entered in decimal form (i.e. 95% =
0.95, and 5% = 0.05). The user has the option to override the default
values and enter whatever values they would like for the confidence limits.

Time Window Modification

This option allows the user to narrow the time window used for the
analysis. The
default is to use all
of the annual peak
— flow data contained
S Ll | in the selected data
set. The user can
enter either a start
date for the analysis, and end date, or both a start and end date. If a start
and/or end date are used, they must be dates that are encompassed within

Time Window Modification

D25 Rangeis 100CT1903 - 14JUN2013

End Date ]
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the data stored in the selected data set. The date range for the selected
data set is shown in the editor just above the Start Date field.

Any dates entered within the Time Window Modification will be ignored
when using the 17C EMA Method for Computing Statistics and
Confidence Limits. When using 17C EMA, changes to the start and end
period should be made within the EMA Data tab.

Options

In addition to the general settings, there are also several options available
to the user for modifying the computations of the frequency curves. These
options include:

e Low Outlier Threshold
e Historic Period Data
e User-Specified Frequency Ordinates

When the Options tab is selected, the Bulletin 17 Editor will appear as
shown in Figure 5-2.
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[Z] Bulletin 17 Editor - Tocks _lsland_B17C = |
Name Tocks_lsland_B17C
Description =
FlowData Set | Tocks_Island-Tocks Island-FLOW-ANNUAL PEAK ~
DSSFile Name: |C\PROJECTS\SSP_Testing\Projects\B17C_EMA_testB17C_EMA_testdss ]
Report File: C:PROJECTSISSP_Testing\Projects\B17C_EMA_testiBulletin17Results\Tocks_Island_B17C\Tocks_|sland_B17C.rpt [
| General| Options | EMA Data | Tabular Results
Low Outlier Threshaold Historic Period Data User Specified Frequency Ordinates
|| override Low Outlier Threshold Use Historic Data [] Use Values from Table Below
Value i i
Historic Period Frequency in Percent
Start Year. 0.2
) 05
End Year: 10
Override High Outlier Threshold 20
5.0
— 10.0
Historic Events 20.0
Water Year Peak 50.0
80.0
90.0
95.0
99.0
{ Compute J { Plot Curve J { View Report J { Print J Apply

Figure 5-2. Bulletin 17 Editor with Options Tab Selected.

Low Outlier Threshold

High and low outlier tests are based on the procedures outlined in Bulletin
17B and Bulletin 17C. The calculated outlier thresholds are used as
default values for the high and Low Quflier Threshold

low outlier thresholds in H_EC' [] owerride Low Outlier Threshold
SSP. The user has the option
to enter a different value for the LI
low outlier threshold if the
Single or Multiple Grubbs-Beck low outlier tests do not adequately
identify low outliers. If a value is entered for the low outlier threshold,
then this value will override the computed value. When applying the
outlier tests, HEC-SSP will identify both high and low outliers. However,
only low outliers will be removed from the data set when performing the
analysis. If a high outlier is identified in the data set, the analyst should
try to incorporate historical period information to extend the time period
for which the high outlier(s) is (are) considered to be the maximum
value(s). When using Bulletin 17B procedures, the low outlier threshold
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cannot be set to a value that would censor more than 50 percent of the
peak flows.

To override the computed low outlier threshold, simply check the box and
enter the value.

Historic Period Data

This option is only available when using Bulletin 17B procedures. To
make use of historic data within the 17C EMA procedures, this
information should be entered on the EMA Data tab.

All historic data that provides reliable estimates of flood peaks outside the
systematic record should be used in order to improve the estimated flood
frequency curve.
Flood information
of large events

Historic Period Data

Use Historic Data

Historic Period outside of the
Start Year: systematic record
End Year: can often be used to

extend the record to
a historic period
Historic Events much Ionger than
Water Year Peak that of the
systematic record.
HEC-SSP uses
historic data specified in this table as recommended in Bulletin 17B.

Cwverride High Qutlier Threshold:

However, to use historic data in a 17B analysis within HEC-SSP, check
the box labeled Use Historic Data. The user can enter a starting year for
the historic period, ending year for a historic period, and a high threshold
value. If the user enters a high threshold value, then any value in the
systematic record greater than that value will also be treated as a historical
flood peak. The user can also enter historic flood peaks that are not
contained in the systematic record. This is done in the table at the bottom
labeled Historic Flood Peaks. All years must be entered as water year
values (October 1 through September 30). If a start year is not entered,
then the assumed start year is the earliest year of the systematic record and
any historical values that have been entered. If an end year is not entered,
then the assumed end year is the latest year in the systematic record and
any entered historic values.

Note: The program treats all data in the data set as systematic data when
using Bulletin 17B procedures. If historic events are included in the data
set, then the user must define the analysis time window (General tab —

Time Window Modification) so that it only bounds the systematic record.
Then the user must define the historic events in the Historic Events table.
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The user is directed to Example 6 in Appendix B for an instance of using
the historic data adjustment within a Bulletin 17B analysis.
User Specified Frequency Ordinates

This option allows the user to change or add to the frequency ordinates for
which the resulting frequency curve and confidence limits are computed.

The default values listed in User Specified Frequency Ordinates
percent chance exceedance are

0.2.0.5, 1, 2, 5, 10, 20, 50, 80, Lse Values from Table Below

90, 95, and 99. Check the box i

next to Use Values from Table —
below to change or add 05
additional values. Once this 10
box is checked, the user can 2.0
add/remove rows and edit the 5.0
frequency values. To add or 10.0
remove a row from the table, ——
select the row(s), place the :gg
mouse over the highlighted 90.0
row(s) and click the right 95.0
mouse button. The shortcut 99.0

menu contains options to Insert
Row(s) and Delete Row(s). The program will use the default values, even
if they are not contained in the table, when the Use Values from Table
below option is not checked. Finally, all values in the table must be
between 0 and 100. Note that these values have no impact on the
computed frequency curve, but rather only the values of the curve that are
reported.

EMA Data

The Bulletin 17C methodology represents a shift in the determination of
peak flow frequency and how data is used within peak flow frequency
analyses. When using the 17C EMA methodology, additional data is
required in order to compute peak flow frequency, confidence intervals,
and plotting positions. This new information includes perception
thresholds and flow ranges. Every year in the analysis period must have
perception thresholds and a flow range specified. The additional data that
is required for use within a 17C EMA analysis is accessed/input within the
EMA Data tab, as shown in Figure 5-3.
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[] Bulletin 17 Editor = - [
Name: Tacks_lsland_B17C_
Description: ]
FlowData Set  Tocks_Island-Tocks Island-FLOW-ANNUAL PEAK -
DSSFile Name: |C\PROJECTS\SSP_Testing\Projects\B17C_EMA_testiB17C_EMA_test dss [
Report File: C\PROJECTS\SSP_Testing\Projects\B17C_EMA_test\Bulletin17Results\Tocks_|sland_B17C\Tocks_Island_B17C.rpt [:]
General | Options| EMA Data | Tabular Results|
First Row in Table Defines the Absolute Time Window for EMA Analysis (start and end dates)
| Perception Thresholds
Start Year End Year Low Threshold High Threshold Comments |
=]
[s}
20000
(o]
o
Apply Thresholds Teneny
Flow Ranges o
Year Peak Low Value High Value Data Type
1955 260000.0 260000.0 260000.0|8ystematic »| - °©
1956 Censore: - 100.000] o o
1957 Censore: L3 o .0 o
1958 Censore =|= G5 © ° ®
1959 Censore = o @ O o
1960 Censore = o° %o
1961 Censore: - o
o o
1962 Censore: - o o &
1963 Censore: > o Q| o
1964 Censore: - ‘E? Co
1965 25300.0 25200.0 25300.0|Systemalic >
1966 22000.0 22000.0 22000.0]Systematic -
1967 289000 28900.0 28900 0| Systematic > T ; T T T
1968 48700.0 48700.0 48700.0|Systemalic - 1260 T 15 150 w0 200
1969 50000.0 50000.0 50000.0|Systematic - O pata
1970 59800.0 £9300.0 59800.0| Systemalic >
1971 32200.0 32200.0 32200.0]Systematic -
4070 Eanonnl__ gamsonnl _ @annn i Curtanntiz e Refiesh
[ Compute ] [ Plot Curve ] [ Wiew Report ] [ Print ] [ OK ] [ Cancel ] [ Apply

Figure 5-3. Bulletin 17C Analysis EMA Data Tab.

Perception Thresholds

The EMA procedure introduces the new concept of Perception Thresholds.
Perception thresholds define the range of streamflow for which a flood
event could have been observed. The inherent assumption and
consequence is that any year for which an event was not observed and
recorded must have had a peak flow rate outside of (usually below) the
perception range.

Consider the example of an historical flood in 1882 estimated as 50,000
cfs, and then a gage was installed in 1926. This flood estimate suggests a
perception threshold of 50,000 cfs to infinity, because there is evidence
that a value as low as 50,000 cfs was noted/perceived (with high water
marks, indirect evidence, and/or hydraulic modeling) during the ungaged
period. One can further assume that any flow larger than 50,000 cfs
would also have been perceived, and so any flow not perceived must have
been less than 50,000 cfs. Therefore, for the unobserved period of 1883 to
1925, we assign the complementary flow range of 0 to 50,000 cfs to
represent the likely range of peak flows during the unobserved period.
The perception threshold and flow range for this hypothetical dataset is
shown in Figure 5-4.
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Figure 5-4. Example Showing a Perception Threshold and Flow Range.

The first row within the Perception Thresholds table will automatically be
created to span the entire period of record of the selected Flow Data Set.
The start and end year of this first perception threshold can be modified to
alter the analysis time frame. This first perception threshold must have a
low value of 0 and a high value of infinity. Additional rows within the
perception threshold table supersede the rows above, for the specified time
frame. Within HEC-SSP, perception threshold time frames should not
overlap one another.

For any missing years in the analysis period, perception thresholds other
than zero to infinity must be entered after the first row. The reason for this
requirement is that a perception threshold of zero and infinity presumes
any flow that occurred could have been observed, implying that
unobserved years would not be possible. Therefore, unobserved years
must have a perception threshold with either a lower bound greater than
zero or an upper bound less than infinity. Most commonly, since very
large flows do tend to be observed in some way (as historical events are
estimated based on some evidence in the watershed), a lower bound
greater than zero is chosen.
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TO_aS_SIQn_a \_/alue Of_ Low Threshold High Threshold
infinity within the High 00 inf
Threshold column, double
left-click to begin editing
the desired cell, right-click,
and select Set as INF Set AsINF
(infinity). Use the
Comments column to provide a descriptive note to a perception threshold.
The use of this column is not required. The comment associated with the
first perception threshold will be automatically set to “Total Record”.

Paste

Select All

Multiple rows within the Perception Thresholds table can be sorted using
chronological order by right-clicking within the table and selecting Sort by
Start Year. Similarly, rows can also be inserted or deleted by right-
clicking within the table.

When low outliers are detected using the Multiple Grubbs-Beck test, the
perception threshold low value for systematic events will be changed to
use the smallest non-screened annual peak flow. Further discussion
regarding the impacts of low outliers on perception thresholds is contained
within the Appendix C EMA examples.

Flow Ranges

The Bulletin 17B methodology limited the use of annual peak flow data to
point-value flow estimates or zero flows. The 17C EMA methodology
represents each annual peak flow within the analysis period as a range,
whether it was observed or not. The flow range for a given year is
assumed to be the value itself for an observed value or the complement of
the perception threshold for that same year.

Flow data can be classified within one of three categories: Systematic,
Censored, and Historical. This choice is specified in the Data Type
column of the Flow Ranges table and can be changed by the user. By
default, all flow data contained within the associated Flow Data Set will
be set to Systematic while missing years will be set to Censored.
Historical data generally refers to flood peaks that occurred outside of the
systematic data collection period. Within the USGS NWIS database, a
qualification code of “7” will indicate the presence of an historical peak.
If this flow data is contained within the associated Flow Data Set, it will
be labeled as Systematic by default. The user should change the data type
to Historical.

By default, the low and high value for an observed (gaged/systematic)
flood event is set equal to the gage estimate. The perception thresholds for
these data points are 0 to infinity. However, if there is uncertainty about
the flow estimate, the range can expand to represent the possible value(s).
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Similar to unobserved years in the historical period, if a crest stage gage is
unable to estimate flow below a gage base of perhaps 50 cfs, then the
perception thresholds would be 50 cfs to infinity, and the associated flow
range for an event marked as “limited by gage base” is 0 to 50 cfs, which
is set as the complement of the perception thresholds. The flow range for
all three data types can be manually altered by the user. Figure 5-5
demonstrates several possible flow ranges and data types.

Flow Rlanges
Year Peak Low Value High Value Data Type
g 260000.0 2340000 286000.0|Historical -
1956 0.0 50000.0|Censored -
1957 0.0 50000.0|Censored -
1958 0.0 50000.0|Censored -
1959 0.0 50000.0|Censored -
1960 0.0 50000.0|Censored -
1961 0.0 50000.0|Censored -
1862 0.0 50000.0|Censored -
1963 0.0 50000.0|Censored -
1964 0.0 50000.0|Censored -
1865 25300.0 253000 25300.0| Systematic -
1966 22000.0 22000.0 22000.0| Systematic -

Figure 5-5. Example Flow Range Table with Systematic, Censored, and
Historical Data.

When a flow event is reported as only a high and low value, a peak value
should be estimated by taking the average of the low and high values. The
peak value is used to compute a plotting position as well as within the
Multiple Grubbs-Beck low outlier threshold computation.

The Apply Thresholds button can be used to automatically fill out the flow
range table with the complementary flow
ranges. For example, if a perception threshold is | Apply Thresholds
specified for a period of missing flow data with a low value of 50,000 cfs
and a high value of infinity, the complementary flow range for each
missing year would be set to 0 to 50,000 cfs after hitting Apply
Thresholds. The user should ensure that the peak, low, and high
values within the flow range table are appropriate for use before
computing the analysis.
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will update the plot if
changes are made to either the flow values or Perception Thresholds/Flow
Ranges.

| Refresn |

The user can double left-click the chart to create a separate window
containing the plot. Colors, symbols, and various chart properties can then
be edited.

When low outliers are detected using the Multiple Grubbs-Beck test, the
high value within the flow range for systematic events will be changed to
use the lowest non-screened annual peak flow. Further discussion
regarding the impacts of low outliers on flow ranges is contained within
the Appendix C EMA examples.

National Water Information System Qualification Codes

HEC-SSP will import the National Water Information System
Qualification (NWIS) annual peak flow and stage qualification/quality
codes when available (the program does not import quality codes for daily,
instantaneous, and real time data). A description of the quality codes for
annual peak flows is contained within Table 4-1 and a description of the
quality codes for annual peak stages is contained within Table 4-2. These
qualification codes can be examined by the user to inform the choice of
perception thresholds, flow ranges, and data types.

Figure 5-3 contains an example peak discharge time series and the
treatment of the NWIS qualification codes using EMA (Paretti, Kennedy,
& Cohn, 2014). Within this example, the shaded area represents the
historical period (H) and the nonshaded area represents the systematic
record (S). The seven types of peak streamflow data are:
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1.

Historical discharge (NWIS code 7, Qnist) and historical perception
threshold specified with an upper perception threshold (T1 and T>
thresh upper)-

Mean daily maximum (NWIS code 1) is described with an upper
discharge interval bound (Qz int upper) €qual to a perception threshold
and a known discharge as the lower interval bound (Q1 int lower).

A recorded gage height, missing the corresponding discharge,
could be used to estimate a discharge interval (Qzint) where both
interval bounds are uncertain.

Discharge greater than known maximum discharge (NWIS code 8)
and used as the lower interval bound (Qz int lower) and an upper
interval bound equal to a perception threshold (Q3 int upper).

Missing peak flow data for a portion of the period of record but a
correlated nearby gage could be used to set an upper perception
threshold (T3 thresh upper)-

A discharge less than a known recordable gage base flow (NWIS
code 4) is describable with a lower interval bound (Q4 int lower =
zero) and an upper interval bound (Qa int upper) €qual to the
minimum gage base discharge.

Systematic peak flow discharge (Qsys).
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Figure 5-6. Example Peak Discharge Time Series and the Treatment of the
NWIS Qualification Codes used within the Expected Moments Algorithm
(Paretti, Kennedy, & Cohn, 2014).

Compute

Once the new analysis has been defined, and the user has all of the settings
and options the way they want them, performing the computations is

simply a matter of pressing the Compute button at the
bottom of the Bulletin 17 Editor. If the computations are

Compute

successful, the user will receive a message that says Compute Complete.
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At this point, the user can begin to review the results of the flow frequency
analysis.

Multiple Bulletin 17 analyses can be computed using the Compute
Manager. Select the Analysis=>Compute Manager menu option to open
the Compute Manager. Select the analyses to be computed and then press
the Compute button. Close the compute dialogs and Compute Manager
when the program finished computing the analyses.

Viewing and Printing Results

The user can view output from the flow frequency analysis directly from
the Bulletin 17 Editor. The output consists of tabular results, a frequency
curve plot, and a report documenting the data and computations
performed.

Tabular Output

Once the computations for the flow frequency analysis are completed, the
user can view tabular output by opening the Tabular Results tab. When
this tab is pressed, the results will be displayed as shown in Figure 5-7.
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IE Bulletin 17 Editor - Tocks_Island_B17C = | mSm
Name: Tocks_lsland_B17C
Description: [:]
Flow Data Set: | Tocks_lsland-Tocks Island-FLOW-ANNUAL PEAK v:
DSS File Name: |C:\PROJECTS\SSP_Testing\Projects\B17C_EMA_testiB17C_EMA_test.dss =)
Report File: C\PROJECTS\SSP_Testing\Projects\B17C_EMA_testiBulletin17Results\Tocks_Island_B17C\Tocks_Island_B17C.rpt [:]
| General | options | EnA Data| Tabular Resuits
Freguency Curve for: Tocks_lsland-Tocks |sland-FLOW-ANNUAL PEAK
Confidence Limits
Percent Chance Computed Curve Tt
Exceedance Flow in cfs
0.05 0.95
0.2 435488.6 1424696.4 283276.9
0.5 3371170 846279.6 2345825
1.0 2748749 572478.9 200823.2
20 2215351 388791.3 168486.9
5.0 162565.4] 2352756 1314118
10.0 125220.4/ 162327.6 104506.4/
200 92880.4 111990.5 70646.4
50.0 55208.0 63419.2 47968.6
80.0 350131 39876.4 30350.2
0.0 282855 323428 23613.8
95.0 24008.7 28117.6 19180.8
99.0 18168.7 23686.5 12970.5
System Statistics Mumber of Events
Log Transform: Flow Event Mumber
Statistic Value E‘S:]ﬂgc E_Vemﬁ 1
igh Qutliers
Mean 4762 "
Standard Dev 0254 II:Iow Qutl’l—_Trs and Zero Flows 12
Station Skew 0470 é‘sf'”g : °"E"S : i
Regional Skew Hvstemaplc - V:n s 50
Weighted Skew IStoric Ferio
Adopted Skew 0470
Compute l | Flot Curve | [ View Report ] [ Print ] [ OK ] [ Cancel Apply

Figure 5-7. Bulletin 17 Editor with Tabular Results Tab Active.

Output on the results tab consists of three tables: Frequency Curves,
Statistics, and Number of Events. The Frequency Curve output table
contains the percent chance exceedance ordinates, the computed Log
Pearson 11 frequency curve quantiles, the expected probability adjusted
frequency curve quantiles (if selected on the General tab), and the
computed confidence limits (0.05 and 0.95, by default). Data in the
frequency curve table can be re-sorted. Click the Percent Chance
Exceedance column header (two mouse clicks are required the first time).
The percent chance exceedance ordinates, along with frequency curve and
confidence limits values, will sort so that the lowest values are on top or
the highest values are on top. The Statistics table contains the mean of
the data in log space, standard deviation in log space, station log-space
skew, user entered regional skew, weighted skew (weighted between
station skew and regional skew), and the adopted skew for the analysis.
The Number of Events table tabulates the number of historic events, high
outliers (not calculated when using 17C EMA), low outliers and zero
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flows, missing values, systematic events, and the number of years in the
historic period.

The tabular results can be printed by using the Print button at the bottom
of the Bulletin 17 Editor. When the print button is pressed, a window will
appear giving the user options for how they would like the table to be
printed.

Graphical Output

Graphical output of the frequency curves can be obtained by pressing the
Plot Curve button. When the Plot Curve button is pressed, a frequency
curve plot will appear in a separate window as shown in Figure 5-8. The
user can modify the plot properties by selecting the Edit->Plot Properties
menu option. A plot properties window will open that lets the user change
the line style for each data type, change the axis labels, modify the plot
title, and edit other plot properties. The user can also edit line styles by
placing the mouse on top of the line or data point in the plot or legend and
clicking the right mouse button. Then select the Edit Properties menu
option in the shortcut menu. Both the Y and X-axis properties can be
edited by placing the mouse on top of axis and clicking the right mouse
button. Then select the Edit Properties menu option in the shortcut
menu. For example, the user can turn on minor tic marks for the y-axis
and modify the minimum and maximum scale for the x-axis.
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[] Bulletin 17 Plat for Tocks_Island_B17C = | B |l
File Edit View Window
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Figure 5-8. Example Frequency Curve Plot.

The frequency curve plot can be sent to the printer by selecting the Print
option from the File menu at the top of the window. Additional printing
options available from the File menu are Page Setup, Print Preview, and
Print Multiple (used for printing multiple graphs on the same page). The
graphic can also be sent to the Windows Clipboard by selecting Copy to
Clipboard from the File menu. Additionally, the plot can be saved to a
file by selecting the Save As option from the File menu. When the Save
As option is selected, a window will appear allowing the user to select a
directory, enter a filename, and select the format for saving the file.
Currently, four file formats are available for saving the graphic to disk,
windows metafile, postscript, JPEG, and portable network graphic.

The data contained within the plot can also be tabulated by selecting
Tabulate from the File menu. When this option is selected, a separate
window will appear with the data tabulated. Additional options are
available from the File menu for saving the graphics options as a template
(Save Template) and applying previously saved templates to the current
graphic (Apply Template).
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The Edit menu on the graphic window contains several options for
customizing the graphic. These options include Plot Properties, Configure
Plot Layout, Default Line Styles, and Default Plot Properties.

Also, a shortcut menu will appear with further customizing options when
the user right-clicks on a line on the graph or the legend.

The graphic customizing capabilities within HEC-SSP are very powerful,
but are also somewhat complex to use. The code used in developing the
plots in HEC-SSP is the same code that is used for developing graphics in
HEC-DSSVue and several other HEC software programs. Please refer to
the HEC-DSSVue User’s Manual for details on customizing plots.

Viewing the Report File

When the Bulletin 17 computations are performed, a report file
documenting the statistical computations is created. The report file lists
all of the input data and user settings, plotting positions of the data points,
intermediate results, each of the various statistical tests performed (i.e.
high and low outliers, historical data, etc...), and the final results. This
also includes the EMA estimate of mean square error, effective record
length, the Multiple Grubbs-Beck Test low outlier threshold, and the
variance for each probability quantile. This file is often useful for
understanding how the software arrived at the final frequency curve.

Press the View Report button at the bottom of the Bulletin 17 Analysis
editor to view the report file. When this button is pressed a window will
appear containing the report as shown in Figure 5-9.
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[ Tocks Island_B17C.rpt — [
File Edit Search Format

File: C\PROJECTS\SSP_Testing\Projects\B17C_EMA_testiBulletin17Results\Tocks_Island_B17C\Tocks_|sland_B17C.rpt

Start Date: -

End Date:

Skew Option: Use Station Skew

Regional Skew: 0.203

Regional Skew MSE: 0.077

Plotting Position Type: Hirsch-Stedinger

Upper Confidence Lewvel: 0.05

Lower Confidence Lewvel: 0.95 L

Display ordinate values using 1 digits in fraction part of wvalue

——— End of Input Data --- |

<< EMA Repregentation of Data >>

Tocks_Island-Tocks Island-FLOW-ANNUAL PEAK

| | WValue | Threshold | |

| Year Peak | Low High | Low High | Type |

[———————————————= [ [ [=—= |

| 1855 260,000.0 | 234,000.0 286,000.0 | 1.0E-98 1.0E8% | Hist |

| 1956 == [ 1.0E-92 50,000.0 | 50,000.0 1.0E99 | Cens |

| 1957 = | 1.0E-99 50,000.0 | 50,000.0 1.0E99 | Cens |

| 1958 == [ 1.0E-93 50,000.0 | 50,000.0 1.0E3% | Cens |

| 1859 —— 1.0E-99 50,000.0 | 50,000.0 1.0E99 | Cens |

| 1980 = | 1.0E-99 50,000.0 | 50,000.0 1.0E99 | Cens |

| 1961 == [ 1.0E-93 50,000.0 | 50,000.0 1.0E3% | Cens |

| 1962 == | 1.0E-99 50,000.0 | 50,000.0 1.0E%% | Cens |

| 1963 = | 1.0E-95 50,000.0 | 50,000.0 1.0E99 | Cens |

| 1964 == [ 1.0E-23 50,000.0 | 50,000.0 1.0E3% | Cens |

| 1965 25,300.0 | 25,300.0 25,300.0 | 1.0E-9% 1.0E8% | Syst |

| 1966 22,000.0 | 22,000.0 22,000.0 | 1.0E-9% 1.0E99 | Syst |

| 1967 28,900.0 | 28,900.0 28,900.0 | 1.0E-9% 1.0E3% | Syst |

| 1968 48,700.0 | 48,700.0 48,700.0 | 1.0E-9% 1.0E9%9 | Syst |

| 1969 50,000.0 | 50,000.0 50,000.0 | 1.0E-98 1.0E9% | Syst |

| 1970 59,800.0 | 59, 800.0 59,800.0 | 1.0E-9% 1.0E9% | Syst |

| 1971 32,200.0 | 32,200.0 32,200.0 | 1.0E-9% 1.0E9%9 | Syst |

| 1872 64,200.0 | 64,200.0 64,200.0 | 1.0E-98 1.0E9% | Syst |

| 1973 103,000.0 | 103,000.0 103,000.0 | 1.0E-9% 1.0E9% | Syst |

| 1974 83,000.0 | 83,000.0 83,000.0 | 1.0E-9% 1.0E99 | Syst |

| 1875 69,400.0 | 69,400.0 69,400.0 | 1.0E-9% 1.0E3% | Syst |

| 1876 758,900.0 | 78,900.0 78,900.0 | 1.0E-99 1.0E99 | Syst |

| 1977 85,600.0 | 85,600.0 85,600.0 | 1.0E-9% 1.0E99 | Syst |

| 1978 74,100.0 | 74,100.0 74,100.0 | 1.0E-9% 1.0E3% | Syst |

| 1875 73,000.0 | 73,000.0 73,000.0 | 1.0E-88 1.0E%% | Syst |

| 1980 75,200.0 | 75,200.0 75,200.0 | 1.0E-9% 1.0E99 | Syst |

| 198 82,800.0 | 82,800.0 82,800.0 | 1.0E-9% 1.0E3% | Syst |

| 1982 51,000.0 | 51,000.0 51,000.0 | 1.0E-9% 1.0E8% | Syst |

| 1983 88,100.0 | £8,100.0 88,100.0 | 1.0E-9% 1.0E99 | Syst | i

I 14924 a7 _2nn_n 1 a7 _2nn_n a7 _2nn_n_ | 1 _NF_Ga 1 _NFQQ | Qerot+ | -

< T +
1212212015 15:15 PM 119:43.119:43 119:43

Figure 5-9. Example of the Bulletin 17 Report File.

Plots, tables and reports can also be created by selecting menu options
from the Results menu. At least one Bulletin 17 analysis must be selected
in the study explorer before selecting one of the menu options on the
Results menu. Results from multiple analyses are combined in one graph
if they are selected in the study explorer when the Graph menu option is
selected. The Results=>Summary Report menu option will create a
summary table of statistics and frequency curve ordinates for the selected
analyses as shown in Figure 5-10.
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==

[ Bulletin17bSummary.rpt —— - Pe—— - — — — — —

File Edit Search Format

File: C\PROJECTS\SSP_Testing\Projects\B17C_EMA_testiBulletin17bResults\Bulletin17bSummary.rpt

Bulletin 17B Summary Report
Tue Dec 22 15:20:22 EST 2015

Table 1 Summary of Statistics

Data Mean Std ...l SEEW. e ieeeinnnaannan Hist Outlier Zero/ Syst Hist

Znalysis
Dev stn Rgnl Wght Adpt Evnt Hi Lo Msng Evnt Perd

| [ | Hame Hame

Tocks_Island B17B Tocks_Island-Tocks Island-FLOW-ANNUAL PEAK 4.831 0.244 0.280 0.203 0.231 0.280 L] a o L] 46

Tocks_Island B17C Tocks_Island-Tocks Island-FLOW-ANNUAL PEAK 4.761 0.254 0.473 0.203 NaN 0.479 1 0 4] ] 45 &0

Table 2 Summary of Frequency Curve Ordinates

Znalysis Data Percent Change EXCEEdanCE------—--—--—=-—--—--—-—1
Name Nare 33 35 30 &0 50 20 10 s 2
Tocks_Island B17B Tocks_Island-Tocks Island-FLOW-ANNUAL PERK 20544.6  28121.1 33555.3 41929.4 66010.7 107852.3 141551.6 178600.3 234059.6 281
Tocks Island B17C Tocks Island-Tocks Island-FLOW-ANNUAL PERK 18169.7  24009.6 28285.4  35013.1 55208.9  92880.3 125220.4 162565.4 221535.0 274
« m N r
12/22/2015 15:20 PM 1111 11

Figure 5-10. Summary Table for Selected Bulletin 17 Analyses.
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CHAPTER 6

Performing a General Frequency
Analysis

The current version of HEC-SSP allows the user to perform generalized
frequency analyses of flow and stage data, as well as other data types.
The user can choose between different analytical distributions or perform
a graphical fit to the data. This chapter discusses in detail how to use the
General Frequency Analysis editor in HEC-SSP.

Contents
e Starting a New Analysis
e General Settings and Options
o Analytical Frequency Analysis
e Graphical Frequency Analysis
¢ Viewing and Printing Results
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Starting a New Analysis

A general frequency analysis can be started in two ways, either by right
clicking on the General Frequency Analysis folder in the study explorer
and selecting New, or by going to the Analysis menu and selecting New
and then General Frequency Analysis. When a new general frequency
analysis is selected, the General Frequency Analysis editor will appear as
shown in Figure 6-1.

[=] General Frequency Analysis Editor - El |dm
MName:

Description

< ||@

Data Set

D35 File Name:

@) |@

Report File:

General | Options | Analytical | Graphical =

Log Transform Plotting Position

@ Use Log Transform @ Weibull (A and B = 0)
Median (4 and B = 0.3)
Do Notuse Log Transform

Hazen (Aand B =0.5)
Confidence Limits Other (Specify A, B)
@ Defaults (0.05, 0.95

¢ ) Plotting position computed using formula
User Entered Values (m-A)i(n+1-A-B)
Where:
Upper Limit: m=Rank, 1=Largest
N=Mumber of Years
AB=Constants

Lower Limit:

m

Time Window Modification

DSS Range is
Start Date )
End Date =)
Data Sampling
Partial Duration
Period of Record Years
@ Annual Maximum:
Plot Analytical Plot Graphical I —
Curve Curve ‘ View Report | ‘ @ Print ‘ ‘ OK | | Cancel

Figure 6-1. General Frequency Analysis Editor.

The user is required to enter a Name for the analysis, while a Description
is optional. A data set (flow, stage, or other) must be selected from the
available data sets stored in the current study DSS file (see Chapter 4 for
importing data into the study). The list of data that can be selected for a
general frequency analysis will only include those data that have an
irregular interval, like IR-CENTURY and IR-YEAR (E-part pathname).
Once a Name is entered and a data set is selected, the DSS File Name and
Report File will automatically be filled out. The DSS filename is by
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default the study DSS file. The report file is given the same name as the
analysis with the extension ".rpt".

General Settings and Options

Once the analysis name and data set are selected, the user can begin to
perform the computations. Contained on the General Frequency Analysis
editor are four tabs. The tabs are labeled General, Options, Analytical,
and Graphical. This section of the manual explains the use of the General
and Options tabs.

General Settings
The first tab contains general settings for performing the frequency
analysis (Figure 6-1). These settings include:
e Log Transforms
Confidence Limits
Time Window Modification
Data Sampling
Plotting Positions

Log Transform

There are two options contained within the Log Transform setting: Use
Log Transform and Do not use Log

Transform. If the user selects Use Log | -°9 Transform

Transform then the logs of the data will @ Use Log Transform

be taken first. The frequency analysis

will be performed on the logs of the data. R

If the user selects Do not use Log
Transform, then the frequency analysis will be performed on the raw data
values without taking the logs of the data. The default setting is Use Log
Transform.
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Confidence Limits

Confidence limits provide a measure of the uncertainty in the computed
value for a given exceedance probability. The computation of confidence
limits is outlined in

Bulletin 17B, Confidence Limits
Appgndi_x 9,andis @ Defaults (0.05, 0.95)
applied in the same

manner here in the User Entered Values
genera_l frequency ATt

analysis. By

default, HEC-SSP Lower Limit:
calculates the 90

percent confidence
interval (i.e. the 5% and 95% confidence limits). The confidence limits
must be entered in decimal form (i.e. 95% = 0.95, and 5% = 0.05). The
user has the option to override the default values.

Time Window Modification

This option allows the user to narrow the time window used for the

analysis. The

default is to use all Time Window Modification

of the data _

contained in the DSS Range is )
selected data set. Start Date o
The user can enter —
either a start date e )

and end date or

both a start and end date. If a start and/or end date are used, they must be
dates that are encompassed within the data stored in the selected data set.
The date range for the selected data set is shown in the editor just above
the Start Date field.

Data Sampling

Two methods are available for sampling data within HEC-SSP: Partial
Duration and Annual Maximum. An annual maximum series is ordinarily
used when the
primary interest
lies in the larger Partial Duration
events or when the
second, third,
fourth... n" largest | @ Annual Maximum:

Crata Sampling

Period of Record Years:
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event in any year is of little concern in the analysis. Conversely, a partial
duration series represents the frequency of all independent events of
interest, regardless of whether two or more occurred in the same year.
Partial Duration analyses may be more appropriate for situations where
considerable flood damage is wrought by the second or third largest flood
events in a given year. However, a flow-frequency curve based upon an
annual maximum and a partial duration series will converge to form a
single flow-frequency curve as exceedance probability decreases.
Commonly, this convergence occurs between the 0.1 and 0.01 exceedance
probabilities.

Peak flow data is most often represented by an annual maximum series.
For instance, choosing to download annual peak data from the USGS
website (as is detailed in Section 4) will result in the import of an annual
maximum series. The user is required to produce an appropriate partial
duration series for use in a partial duration analysis. This can be achieved
in several ways. For instance, the user can manually select independent
events from a flow data set with hourly ordinates. However, it is more
expedient to use a peak (or minimum) search algorithm, such as the Find
Peaks tool that can be used within HEC-DSSVue. This tool will allow the
user to filter a continuous data set to find either maximum or minimum
values using user-defined minimum threshold, flow differential, and a
minimum elapsed time interval between events. Figure 6-2 demonstrates
the differences between an hourly flow data set, an annual maximum
series, and a partial duration series for a four year span at a particular
stream gage location. Please see Appendix D for an example use of the
Find Peaks tool to create a partial duration series.

The Period of Record Years is used to extract ranked data points from the
associated data set when using the partial duration data sampling. For
instance, if the Period of Record Years is set to 50, then the top 50 ranked
events will be extracted from the associated data set.

6-5



Chapter 6 - Performing a General Frequency Analysis HEC-SSP User's Manual

‘ JITOCKS ISLAND/FLOW/01JAN1S00/IR-CENTURY/ANNUAL MAXIMUM SERIES - 1DAY/ o S |
File Edit View Help
E] 120,000 "

— TOCKS ISLAND DALY FLOW
= TOCKS ISLAND PARTIAL DURATION SERIES - 1DAY FLOVY
000004 | * TOCKS ISLAND ANNUAL MAXIMUM SERIES - 1DAY FLOW

80,0004

60,000

Flow {cfs)

40,0009,

20,0004

T T T T T T T T T
Jul Jan Jul Jan Jul Jan Jul Jan Jul
2008 | 2009 | 2010 | 2011 | 2012

[x ']

Figure 6-2. Hourly Flow, Annual Maximum, and Partial Duration Series for a
Stream Gage.

Choosing either Partial Duration or Annual Maximum will enable and
disable various other features throughout the General Frequency Analysis.
Annual Maximum is the default.

Plotting Positions

Plotting positions are used for plotting the raw data points on the graph.
Plotting Position There are four options for plotting position
methodologies within HEC-SSP: Weibull,
Median, Hazen, and user entered

Median (AandB=0.3) | coefficients. The default method is the
Hazen (A and B = 0.5) Weibull plotting position formula. The
generalized plotting position equation is:

. (m-A)
~ (n+1-A-B)

@ Weibull (Aand B=10)

Other (Specify A, B)

where: m = rank of flood values with the largest equal to 1.

n = number of flood peaks in the data set.
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A & B = constants dependent on which equation is used (Weibull
A and B=0; Median A and B = 0.3; and Hazen A and
B=0.5).

Plotting positions are estimates of the exceedance probability of each data
point. Different methods can give very different values for the
probabilities of the highest and lowest points in the data set. In the
General Frequency methodology, the plotting of data on the graph by a
plotting position method is only done as a guide to assist in evaluating the
computed curve. The plotting position method selected does not have any
impact on the computed curve.

Options

In addition to the general settings, there are also several options available
to the user for modifying the computations of the frequency curves. These
options include:

e Low Qutlier Threshold

e Historic Period Data

e User-Specified Frequency Ordinates
e Output Labeling

When the Options tab is selected, the General Frequency Analysis editor
will appear as shown in Figure 6-3.
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DSS File Name: | C\PROJECTS\SSP_Testing\Projects\GeneralFrequency_Testing\GeneralFrequency[

] General Frequency Analysis Editor -* IEIE
Name: Tocks Island-1DAY-PDS
Description: 1Day Partial Duration Series analysis for Tocks Island Dam =)
Data Set ‘Tocks Island - 1-Day - PartialDuration-TOCKS ISLAND-FLOW A

Report File: OJECTS\SSP_Testing\Projects\GeneralFrequency_Testing\GeneralFrequencyResu EJ

| General| Options | Analytical | Graphical -
Low Qutlier Threshold Historic Period Data User Specified Frequency Ordinates
[l Override Low Outlier Threshold [] Use Historic Data [] Use Values from Table Below

Value e =
Historic Period Frequency in Percent

Output Labeling EELTEEE 0 0.2

. . 0.5

DSS Data Nameis  FLOW End Year: =
[[] Change Label Override High Qutlier Threshold 2.0 =
5.0 T

i 10.0

D33 Data Units are Historic Events =

[7] change Label Water Year Peak 50.0

80.0

90.0

95.0

99.0

Plot Analytical Plot Graphical
Compute I Curve Curve I View Report I @ Print I OK I I Cancel I I Apply

Figure 6-3. General Frequency Editor with Options Tab Selected.

Low Outlier Threshold

High and low outlier tests

are based on the procedures Low Qutlier Threshold

outlined in Bulletin 17B, and [] override Low Outlier Threshold
are applied in the same
manner in the General
Frequency Analysis. The
calculated outlier magnitudes, by the Bulletin 17B procedure, are used as
default values for the high and low outlier thresholds in HEC-SSP. The
user has the option to enter a different value for the low outlier threshold.
If a value is entered for the low outlier threshold, then this value will
override the computed value from the Bulletin 17B methodology. When
applying the outlier tests, HEC-SSP will identify both high and low
outliers. However, only low outliers will be removed from the data set
when performing the analysis. If a high outlier is identified in the data set,
the analyst should try to incorporate historical period information to
extend the time period for which the high outlier(s) is considered to be the
maximum value(s). Further discussion of outlier thresholds can be found

Value
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in Bulletin 17B. To use the low outlier threshold, simply check the box
and enter the value.

Historic Period Data

All historic data that provides reliable estimates outside the systematic
record should be used in order to improve the frequency computations.
Information outside of the systematic record can often be used to extend
the record of the largest events to a historic period much longer than that

Historic Period Data of the systematic record.
HEC-SSP uses historic
LIl BITELE S data as recommended in
Historic Period Bulletin 17B. This

calculation is applied in
the same manner in the
End Year. 0 General Frequency
Analysis. To use
historic data, check the
box labeled Use
Historic Data. The user
can enter a starting year
for the historic period,
ending year for a historic
period, and a High Threshold value. If the user enters a high threshold
value, then any data in the systematic record greater than that value will
also be treated as a historical annual maximum. The user can also enter
historic data that are not contained in the systematic record. This is done
in the table at the bottom labeled Historic Events. All years must be
entered as water year values (October 1 through September 30). If a start
year is not entered, then the assumed start year is the earliest year of the
systematic record and any historical values that have been entered. If an
end year is not entered, then the assumed end year is the latest year in the
systematic record and any entered historic values. Further discussion of
the use of historical data can be found in Bulletin 17B.

Start Year:

Cwerride High Qutlier Threshaold:

Historic Events
Water Year Peak

Note: The program treats all data in the data set as systematic data. If
historic events are included in the data set, then the user can define the
analysis time window (General tab — Time Window Modification) so that
it only bounds the systematic record. Then define the historic events in
the Historic Events table. Instead of using the Time Window Modification
option, another option is to enter a High Threshold value so that the
historic data point(s) would be treated as historic data (rather than part of
the systematic record). Please see Example 6 in Appendix B for an
example of using the historic data adjustment.
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User Specified Frequency Ordinates

This option allows the user to change the frequency ordinates used in

computing the resulting
frequency curves and confidence
limits. The default values listed
in percent chance exceedance
are0.2,0.5,1, 2, 5, 10, 20, 50,
80, 90, 95, and 99. Check the
box next to Use Values from
Table below to change or add
additional values. Once this box
is checked, the user can
add/remove rows and edit the
frequency values. To add or
remove a row from the table,
select the row(s), place the
mouse over the highlighted
row(s) and click the right mouse
button. The shortcut menu

User Specified Frequency Ordinates

Use Values from Table Below

Frequency in Percent

0.2
0.5
1.0
20
5.0
10.0
20.0
50.0
80.0
80.0
95.0
99.0

contains options to Insert Row(s) and Delete Row(s). The program will
use the default values, even if they are not contained in the table, when the
Use Values from Table below option are not checked. Finally, all values
in the table must be between 0 and 100.

Output Labeling

This option allows the user to change the default labels for data contained

Cutput Labeling
035 Data Mame is  FLOW

Change Label
0335 Data Units are

Change Label

in the output tables and plots.
The user can change both the
name of the data as well as
how the units of the data are
labeled.
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Analytical Frequency Analysis

Once the new analysis has been defined and the user has all of the general
settings and options the way they want them, the user can choose between
performing an Analytical Frequency analysis or a Graphical Frequency
analysis. This section of the manual describes how to use the Analytical
Frequency analysis option.

When the user selects the Analytical tab on the General Frequency
Analysis editor, the window will appear as shown in Figure 6-4. As
shown, three additional tabs will appear on the screen: Settings, Tabular
Results, and Plot.

[] General Frequency Analysis Editor -* = (mESm
Name: Tocks Island-1DAY-PDS
Description: 1Day Partial Duration Series analysis for Tocks Island Dam ]
BEmEE Tocks Island - 1-Day - ParfialDuration-TOCKS ISLAND-FLOW i

DSS File Name: | c:\PROJECTSISSP_Testing\Projects\GeneralFrequency_Testing\GeneralFrequency[.)

Report File: OJECTS\SSF‘_Testing\F'rOJects\GeneraIFrequenc:y_Testing\GeneraIFrequenc:yResuD
Generall Options | Analitical | Graphical| i
Settings | Tabular Results | Plot
Log Transformation: On Generalized Skew
) Use Station Skew
Distribution:
Mone - Use Weighted Skew
Use Reg
Reg
Expected Probablity Curve
Compute Expected Prob. Curve
@ Do Mot Compute Expected Prob. Curve
Plot Analytical Plot Graphical
Compute | Curve Curve | View Report | % Print | OK | | Cancel | | Apply ‘

Figure 6-4. Analytical Analysis Tab of the General Frequency Analysis Editor.
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Settings

The Settings tab contains additional settings for the analytical frequency
analysis. These settings include:

e Distribution

e Generalized Skew

e Expected Probability Curve

Distribution

This option allows the user to select from available analytical distributions

Log Transformation. On to perform the frequency analysis.
The current version of HEC-SSP
Distribulion: contains three distribution choices:
[ —1| None, Normal, LogNormal, Pearson
' .| 111, and LogPearson Ill. If the user
has selected to transform the data to
Loghlormal log space (General tab), then the
LogPearsonill only available choices for

distribution will be None, LogNormal, and LogPearson I1l. If the user did
not select the option to transform the data to log space (General tab), then
the only available choices for distribution will be None, Normal and
Pearson I11. Finally, if the user has selected to use a partial duration series
on the General Tab, then no distributions will be available for use.

Generalized Skew

There are three options contained within the generalized skew setting: Use
Station Skew, Use Weighted Skew, and Use Regional Skew. The default
skew setting is Use Station Skew. With this setting, the skew of the
computed curve will be based solely on computing a skew from the data
points.

To use either of the two other
options requires the use of the Log Generalized Skew
Person I11 distribution. The Use

Weighted Skew option requires the

@ Use Station Skew

user to enter a generalized regional Use Weighted Skew
skew and a Mean-Square Error

(MSE) of the generalized regional GEslE] STT
skew. This option weights the Regional Skew:

computed station skew with the
generalized regional skew. The
equation for performing this

weighting can be found in Bulletin 17B (Equation 6). If a regional skew is

Reg. Skew MSE:
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Compute

taken from Plate | of Bulletin 17B (the skew map of the United States), the
value of MSE = 0.302.

The last generalized skew option is Use Regional Skew. When this
option is selected, the user must enter a generalized regional skew and an
MSE for that skew. The program will ignore the computed station skew
and use only the generalized regional skew.

Expected Probability Curve

This setting has two options: Compute the expected probability curve and
do not compute the expected probability curve. The default setting is to
not compute the expected probability curve. When computed, this curve

Expected Probablity Curve will be shown in both the
tables and the plots as an
Compute Expected Prob. Curve additional curve to the

@ Do Mot Compute Expected Prob. Curve computed curve. The

expected probability

adjustment is a correction for
bias in the computed frequency curve. The bias is caused by the skew in
the uncertainty due to the shortness of the data record. The Method of
Moments estimation of the Log Pearson Il parameters produces a median
estimate of each frequency curve quantile, and the adjustment changes to a
mean (unbiased) estimate, which is different from the median because of a
skewed uncertainty distribution. Please review the discussion in Bulletin
17B about the expected probability curve adjustment for an explanation of
how and why it is computed. The use of the expected probability curve is
a policy decision. It is most often used in establishing design flood
criteria. The basic flood frequency curve without the expected probability
adjustment is the curve used in computation of confidence limits, risk, and
in obtaining weighted averages of independent estimates of flood
frequency discharge (Interagency Advisory Committee on Water Data,
1982).

Once the new analysis has been defined, and the user has all of the
General, Options, and Settings information selected the way they want,
performing the computations is simply a matter of pressing the Compute
button at the bottom of the General Frequency Analysis editor. If the
computations are successful, the user will receive a message that says
“Compute Complete”. At this point, the user can begin to review the
results of the Analytical Frequency computations.

Multiple General Frequency analyses can be computed using the
Compute Manager. Select the Analysis=>Compute Manager menu
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option to open the Compute Manager. Select the analyses to be computed
and then press the Compute button. Close the compute dialogs and
Compute Manager when the program finished computing the analyses.

Tabular Results

The Tabular Results tab will bring up a table of results for the Analytical
Frequency analysis. An example of the results tab is shown in Figure 6-5.

As shown in Figure 6-5, the window contains three tables. The top table
contains results of the computed frequency curve. The very left column of
the top table is the Percent Chance Exceedance for all the computed
values. The next three columns in the top table contain the computed
frequency curve and the 95% and 5% confidence limits that correspond to
that computed curve. The last three columns of the top table contain a
computed frequency curve and confidence limits for an analysis based on
user-adjusted statistics for the mean, standard deviation, adopted skew,
and equivalent years of record. User entered adjusted statistics are an
option that the user can set on the Plot tab, which is discussed in detail in
the next section of this manual. If the user has not entered adjusted
statistics, then these columns will be empty. Data in the frequency curve
table can be re-sorted. Click the Percent Chance Exceedance column
header (two mouse clicks are required the first time). The percent chance
exceedance ordinates, along with frequency curve and confidence limits
values, will sort so that the lowest values are on top or the highest values
are on top.

Two additional tables are shown at the bottom of the window: Statistics
and Number of Events. The Statistics table consists of the mean, standard
deviation, station skew, user entered regional skew, weighted skew
(weighted between station skew and regional skew), and the adopted skew
for the analysis. The Number of Events table contains the number of
historic events, high outliers, low outliers, zero or missing values,
systematic events, and the number of years in the historic period (this
value only comes into play if the user entered historic data).

Additionally, the lower right portion of the table will show if Log
Transform is On or Off, and which analytical distribution was selected for
the analysis.

6-14



HEC-SSP User's Manual

Chapter 6 - Performing a General Frequency Analysis

[ General Frequency Analysis Editor - El S
MName: Tocks Island 1DAY General Freq
Description: 1Day General Frequency Analysis for Tocks Island Dam =
Data Set: Tocks Island - 1-DAY - AnnualMax-TOCKS ISLAND-FLOW -
DSS File Name: |[ECTS\SSP_Testing\Projects\GeneralFrequency_Testing\GeneralFrequency_Testing.ds:(
Report File: lencyResults\Tocks_lsland_1DAY_General_FreqiTocks_Island_1DAY_General_Freq.rpil]
Generall Options | Analytical ‘ Graphical|
Tabular Results | plot
Curve based on Data Curve based on User-Adjusted Statistics
Percent Chance Computed Confidence Limits Computed Confidence Limits
Exceedance Curve FLOW in CFS Curve FLOW in CFS
FLOW in CFS 0.05 0.95 FLOW in CFS 0.95 0.05
0.2 265984.3 3451385 216955.9 2422799 348086.6 1871741
05 2235032 2820585 1856611 2080207 2895267 164083.3
1.0 193967.8 240786.6 163471.6 1534299 2488243 147116.4
2.0 166456.2 2024071 142412.8 159871.5 211004.4 130488.9
5.0 132822.8 156884.1 116021.9 130083.7 165070.6 108808.7
10.0 109081.0 125891.2 96831.2 108307.8 133067.3 92346.0
200 86356.3 973305 T78116 867501 103025.9 753233
50.0 56005.9 61637.0 50865.3 56754.5 54859.0 496626
80.0 369861 41063.7 32794.0 371266 42763.2 31264.6
90.0 29987.7 337432 260334 29739.9 348804 24208.3
95.0 25310.3 28866.7 215438 247615 29603.0 19513.3
99.0 18576.4 21796.7 15195.8 17560.2 218047 128452
System Statistics Number of Events
Statistic Walue Event MNumber
Iean 4.754| |Historic Events 0
Standard Dev 0.219| [High Outliers 0 X
Station Skew 0.153| [Low Outliers 0 L ENHTIEET: @1
Regional Skew Zero Or Missing 0 Distribution: LogPearsonlll
Weighted Skew Systematic Events 76
Adopted Skew 0.153| |Historic Period
Plot Analytical Plot Graphical
Compute Curve Curve [ View Report ] ’ 5 Print ] [ OK ] [ Cancel Apply

Figure 6-5. Tabular Results Tab for Analytical Analysis.

Plot

In addition to tabular results, a Plot tab is available for viewing a graphical
plot of both the computed frequency curve, as well as a computed curve
based on any user-adjusted statistics. When the Plot tab is selected the
window will change to what is shown in Figure 6-6.

6-15



Chapter 6 - Performing a General Frequency Analysis HEC-SSP User's Manual

[ General Frequency Analysis Editor - IEI:&
Name: Tocks Island 1DAY General Freq
Description: 1Day General Frequency Analysis for Tocks Island Dam )
Data Set: Tocks Island - 1-DAY - AnnualMax-TOCKS ISLAND-FLOW v

DSS File Name: |ECTSISSP_Testing\Projects\GeneralFrequency_Testing\GeneralFrequency_Testing.ds{_.]

Report File: lencyResults\Tocks_|sland_1DAY_General_FregiTocks_lsland_1 D.J\Y_GeneraI_Freq.rpﬂ:I

General | Options | Analytical | Graphical

Settings | Tabular Results | Plot

Exceedance Probability for Tocks Island - 1-DAY - Annualiax-TOCKS ISLAND-FLOWY

Log Transformation: On
Retum Period

Distribution: LogPearsonlll
11 2 5 10 a0 200 1000 10000
1000000.0 | | 1 1 Lo 1 L ! Computed Statistics
Mean 4,754 oflogs
Std Dev. g.z219 oflogs
Skew 0.153| oflogs
Adopted Skew 0.153 oflogs
m
[
o User Statistics
=
% 100000.0 7] Mean 4,754 Oflogs
|
- V| Std Dev. 0.219| oflogs
¥ Adpt Skew o| oflogs
Equivalent .
¥rs of Rec [
10000.0 T T T T T L T T
0.9a 1R} 04 02 01 0.02 0.005 0.0001
Praobahility
Computed Curve ——— 5Percent Confidence Limit
— —— 835 Percent Confidence Limit — — — User Stats Computed Curve
""" User Stats 5 Percent Confidence Limit ===-=- User Stats 95 Percent Confidence Limit
o Cbzerved Everts (Median plotting postions)
| 100 ANalytical Plot Graphical |
| Compute | Curve Curve | View Report | & Print | OK | | Cancel |

Figure 6-6. Plot Tab of the General Frequency Analytical Analysis.

As shown in Figure 6-6, the plot contains the computed frequency curve,
95% and 5% confidence limits, and raw data points plotted by the user
selected plotting position method. The computed statistics for the
frequency curve are shown in a table on the right side of the window.
Below the computed statistics is a table labeled "User Statistics”. There is
a check box and a data entry field for the Mean, Standard Deviation,
Adopted Skew, and Equivalent Years of Record. The user can enter
values into any or all of these fields. Turning on the check box then
enables that field to be used in computing a curve with the user entered
statistic overriding the computed value from the raw data. The user
statistics option allows the user to see how the curve would change if any
or all of the statistics were different. When data is entered into the user
statistics fields, and the check boxes are turned on, the user must press the
compute button again in order for the computations to be performed with
the user entered statistics. After the compute button is pressed, both the
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plot and the table on the Tabular Results tab will be updated to reflect any
user entered statistics.

Graphical Frequency Analysis

In addition to an analytical frequency analysis which uses a statistical
distribution fit to the data, the user has the option to graphically fit a curve
to the data. A graphical fit can be very useful when the available
analytical distributions do not provide a good fit to the data. One example
of when a graphical frequency analysis is most appropriate is when
plotting a frequency curve for flow data that is downstream of a flood
control reservoir. Analytical frequency distributions are often not
appropriate for describing flow data that is significantly regulated by
upstream reservoirs. In general, a portion of the flow frequency data for a
highly regulated stream will be very flat in the zone in which upstream
regulation can control the flows for a range of frequencies. This type of
data lends itself to a graphical fit analysis rather than the use of an
analytical equation. Another example of using a graphical fitting
technique over an analytical curve is when trying to compute a frequency
curve for annual peak stage data at a point on a river. Often the stages will
flatten out with decreased frequencies when flows go out into the
overbank and floodplain area. Again, this type of data is fitted much
better using a graphical fit curve instead of an analytical distribution.
Another example of using a graphical fitting technique in lieu of an
analytical curve is when a partial duration series is being used instead of
an annual maximum series.

When the Graphical tab is selected, the editor will display a plot and table
as shown in Figure 6-7. Three points are required to define a graphical
frequency curve. In the plot, the data will be plotted using the user
selected plotting position method. The table to the right of the plot allows
the user to enter data values for the frequency ordinates defined on the
Options tab.

Additionally, the Multi-Point Edit tool can be used to define the
frequency ordinates by drawing a curve. To use this tool, begin
by selecting the tool on the left side of the editor. Then, define
the curve by left clicking within the plot window at the desired locations.
To finish defining the curve, right click. It should be noted that the Multi-
Point Edit tool will not extrapolate flow frequency information; it will
only interpolate to the user-defined frequency ordinates specified on the
Options tab. Bold, dashed lines will be displayed on the plot that
correspond to the frequency ordinates defined on the Options tab. These
vertical lines help to visually identify the locations where flow frequency
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information will be extracted from the drawn curve. Frequency ordinates
must be defined in a decreasing order (when compared to percent chance
exceedance).

The Data Type and Equivalent Years of Record options are required to
compute the confidence limits using the order statistics method that is
discussed in ETL 1110-2-537. If the data is not flow or stage, select the
Flow data type when the graphical frequency curve is approximately
analytic for extreme probabilities (frequency curve is not relatively flat for
extreme probabilities). Select the Stage data type when the graphical
frequency curve is relatively flat for extreme probabilities (U.S. Army
Corps of Engineers, 1997). When the user enters values into the frequency
curve table, those values will be plotted as a line on the plot after the
Compute button is pressed. The idea is to enter values in the table that
will create a best fit line of the data, based on the user’s judgment.

When using a partial duration series, the Axis Type options will become
enabled. By default the Normal (Top N Events) will be set as the default.
The Normal (Top N Events) option will use the Period of Record Years
that was defined on the General Tab to extract and plot the top N events.
For instance, if the user defined a Period of Record Years of 79 on the
Graphical Tab, the top 79 events within the associated partial duration
series will be plotted using the Plotting Position defined on the General
tab. When using the Log (All Events) axis option, all events will be
plotted using the average number of events per year to define the x-axis.
The two different plotting options are shown in Figure 6-8.
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[ General Frequency Analysis Editor - Reg Flow Rio Grande Test @ of x|
Name: Reg Flow Rio Grande Test 9|
Description: Example using a graphical general frequency analysis =
Data Set: :Rio Grande at Alb Reg Flow -

DS5 File Name: |3 ECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.ds{)

Report File: neralFrequencyResults\Reg_Flow_Rio_Grande_Test_9\Reg_Flow_Rio_Grande_Te st_g.rpig

| General | Options | Analytical Graphical

T] General Frequency Graphical Flot for Reg Flow Rio Grande Test 9 R e
Bl R @ MNormal (Top M Events) Log (All Events)
i] 1.1 2 5 10 50 200 100010000 Data Type
1000000 Tt f e e ; -
@ Flow () Stage
[ - | . ' - =g
I 11 | 1T 111
: : : : : : : : : : : : Equivalent Years 29
R R | R I I B ofRecord
: : : : : : : : : : : )I User-Defined Graphical Curve
: : : : : : : : : : I/A Frequency Ordinates
10000.04 I 11 | d—dalel-¥A4"1 Percent Chance
| | ==k = -1 Exceedance DataValue
I 11 | O A o |
@
5 I 10, T Loct 14,300.0
8 | I 485 T 11 0.5 10,300.0
% I I/l/ | | |y R iy I B I | 1.0 7,751.0
1 1 | I | 77
= i /Jl' O 1 B A I o LTse.
ool | | T A O I | 2 L2
JGERES 1 I 1 | I | 10.0 7,510.0
SRR R
50.0 5,400.0
| I I | | I o | 20.0 ,.'500 a
I/ 11 | N I | = seoe
1 [ | I e 90.0 1,650.0
R T e e e R R %5.0 L,200.0
1 111 | N T O I | 95.0 650.0
1 [ | I e
IR EERE T
100.0 T T T T T T T T T T
0.89 0.9 0.5 0.z 01 0.0z 0002 0.0001
Exceedance Probahility
o] Observed Events (Weibull plotting postions) User Curve
— — = 5Percent Conficdence Limit === 85 Percent Confidence Limit

Plot Analytical

Compute | Curve View Report & Print [ OK H Cancel ] Apply

Plot Graphical
Curve

Figure 6-7. Graphical Tab of the General Frequency Analysis Editor.
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[Z] General Frequency Analysis Editer - Tocks Island-1DAY-PDS* = ==
Mame Tocks Island-1DAY-PDS
Description 1Day Partial Duration Series analysis for Tocks Island Dam |
Data Set Tocks Island - 1-Day - PartialDuration-TOCKS ISLAND-FLOW -
DSS File Name: | C\PROJECTS\SSP\Projects\GeneralFrequency_Testing\GeneralFrequency_Testing.dss ()
Report File PROJECTS\SSP\Projects\GeneralFrequency_Testing\GeneralFrequencyResults\Tocks_Island-1DAY-PDS\Tocks _Island-1DAY-PDS. rpiD
‘ General | Options | Analyhcal‘ Graphical
Y General Frequency Graphical Plot for Tocks Island-1DAY-PDS e
Return Period @ nNormal (Top N Events} () Log (All Events)
Q 11 2 4 10 40 2001000 10000 1000000 Data Type
1,000,000 R f I @ Flow ) Stage
I [ | | | . R . A | - -
1 11 | { B N i B | I/I
| [ | e Equivalent Years 7
e el e S I O B e o o e ™
| 11 | | N R N I Y|
| [ | | I | 1/1 Y
1 [ 1 1 1 1A 1 User-Defined Graphical Curve
: : : : : : : : ,1 1, : ’: Frequency Ordinates
1 11 1 [ Pl Percent Chance
o] 1 [ | [ /}/* 11 Exceedance e
L | [ | I ¥d [ —
< 1 [ | | AT 1 =2 406,681.6
= 100,000+ I { I B S S e | 0.5 302,496.1
2 1 111 1 { I | 1.0 241,564.7
B : : : 1 \ : : : : : : 2.0 192,906.6
| R 5.0 133,648.5
CF 11 | [ | 10.0 110,586.4
1 11 1 1 rrrri 20.0 88,311.1
1 [ | Lo e 65,607.2
[ | [ r i3t
| [ | I rrrr = e
1 11 | -1 1rre 90.0 51,838.8
| [ | L rrr 95.0 50,029.8
| [ | I rrrr 99.0 48,859.2
| [ | I rrrrr
10,000 ———4—1 11 | e
0.893 098 0g 0.5 0201 0.020.005 0.0001  0.000001
Exceedance Probability
O Observed Events (Median plotting postions) User Curve
——= 5Percent Confidence Limt —— = 95 Percent Confidence Limit
Plot Analytical Plot Graphical
Compute Curve Curve View Report & Print 0K ] [ Cancel ] [ Apply ]
[ General Frequency Analysis Editor - Tocks Island-1DAY-PDS* = [
Name Tocks Island-1DAY-PDS
Description: 1Day Partial Duration Series analysis for Tocks Island Dam J
Data Set Tocks Island - 1-Day - PartialDuration-TOCKS ISLAND-FLOW -
DSS File Name: | C\PROJECTS\SSP\Projects\GeneralFrequency_Testing\GeneralFrequency_Testing dss =
Report File PROJECTS\SSP\Projects\GeneralFrequency_Testing\GeneralFrequencyResults\Tocks_Island-1DAY-PDS\Tocks_lsland-1DAY-PDS.rpi()
Gsnsrall Options | Analyl\ca\‘ Graphical
Y General Freguency Graphical Plot for Tocks Island-1DAY-PDS AR TR
Q 1,000,000 T T 1T I ) Normal (Top N Events) @ Log (All Events)
L B L i I N S |
WA b i Data Type
L B S L B B I S| @ Flow ) Stage
u %’ T I R N i
AT T
1 : : : : : : Equivalent Years 79
of Record
[ HEREY S Bl N N |
| [ [ | User-Defined Graphical Curve
H LA L il
I’r I I I I : I I Frequency Ordinates
| L S LA R N Percent Chance
g [ N T Exceedance PEEELE
2 1000004 11 e 111 R 0.2 105, 6816
% R I N e T | 0.5 302,496.1
] I A b 1.0 241,564.7
= : : : : : : : : 2.0 192, 906.6
R T TR 5.0 133,648.5
TR R (AL R B [ A 10.0 110,586.4
| || | Il | 1 20.0 88,311.1
R
IO A M A e 34,9524
[T A A O T 80.0 51,838.6
| LA AN M A [ A 95.0 50,029.8
| LLAY TR N LAY SO N AN R | 99.0 48,859.2
| LLAY TR N LAY SO N AN R |
10,000 T T T T
10 1 01 0.01 0.001 1.0E-4 1.0E-5 1.0E-6 1.0E-7
Average Number of Events Per Year
User Curve — == 5Percent Confidence Limt
—— = 95 Percert Confidence Limt O Observed Events (Median pictting positions)
Plot Analytical Plot Graphical
Compute Curve Curve View Report & print [ 0K ] [ Cancel ] [ Apply

Figure 6-8. Axis Type Options on the Graphical Tab.
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Viewing and Printing Results

The user can view output for the frequency analysis directly from the
General Frequency Analysis editor (Tabular and Graphical output) or by
using the plot and view buttons at the bottom of the editor. The output
consists of tabular results, an analytical frequency curve plot, a graphical
frequency curve plot, and a report documenting the data and computations
performed.

Tabular Output

Once the computations for the analytical frequency analysis are
completed, the user can view tabular output by selecting the Tabular
Results tab under the Analytical analysis tab. The details of this table
were discussed under the analytical analysis option above.

The tabular results can be printed by using the Print button at the bottom
of the General Frequency Analysis editor. When the print button is
pressed, a window will appear giving the user options for how they would
like the table to be printed.

Graphical Output

Graphical output of the analytical frequency curve can be obtained by
selecting either the Plot tab under the analytical analysis tab, or by
pressing the button labeled Plot Analytical Curve at the bottom of the
general frequency editor. When the Plot Analytical Curve button is
pressed, a frequency curve plot will appear in a separate window as shown
in Figure 6-9.
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-
@ General Frequency Analytical Plot for General Frequency FFA Test & =RRC X
File Edit View Window
General Frequency Analtical Plot for General Frequency FFA Test B
Return Period
Q 1.1 2 5 10 50 200 1000
1DDUUDD 1 1 1 1 1 1 1 1 1
l
'
i
gy
,f f.//'
10000.04 ,/ [
E - J}/ ,/
L] ,’é/& L=T
= e -//"’
1= [l
=S - -
=] .ﬂ" _—-"
| -
[T _.‘_—' -
1000.0 P rECes
e
- r""‘
100.0 T T T T T T T T
0.9 0.9 0.4 02 01 0.02 0.0050.001
Frobahility
Computed Curve =me=me- Expected Probability Curve
— == 35 Percent Confidence Limit === 83 Percent Confidence Limit
&) Obzerved Events (Median plotting positions) Historic Data

Figure 6-9. Analytical Analysis Frequency Curve Plot.

The analytical frequency curve plot can be sent to the printer by selecting
the Print option from the File menu at the top of the window. Additional
printing options available from the File menu are Page Setup, Print
Preview, and Print Multiple (used for printing multiple graphs on the same
page). The graphic can also be sent to the Windows Clipboard by
selecting Copy to Clipboard from the File menu. Additionally, the plot
can be saved to a file by selecting the Save As option from the File menu.
When the Save As option is selected, a window will appear allowing the
user to select a directory, enter a filename, and select the format for saving
the file. Currently four file formats are available for saving the graphic to
disk: windows metafile, postscript, JPEG, and portable network graphic.

The data contained within the plot can also be tabulated by selecting
Tabulate from the File menu. When this option is selected, a separate
window will appear with the data tabulated. Additional options are
available from the File menu for saving the plot options as a template
(Save Template) and applying previously saved templates to the current
plot (Apply Template).

The Edit menu contains several options for customizing the graphic.
These options include Plot Properties, Configure Plot Layout, Default
Line Styles, and Default Plot Properties. Also, a shortcut menu will
appear with further customizing options when the user right-clicks on a
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line on the graph or the legend. Both the Y and X-axis properties can be
edited by placing the mouse on top of axis and clicking the right mouse
button. Then select the Edit Properties menu option in the shortcut
menu. For example, the user can turn on minor tic marks for the y-axis
and modify the minimum and maximum scale for the x-axis. The graphic
customizing capabilities within HEC-SSP are very powerful, but are also
somewhat complex to use. The code used in developing the plots in HEC-
SSP is the same code that is used for developing plots in HEC-DSSVue
and several other HEC software programs. Please refer to the HEC-
DSSVue User’s Manual for details on customizing plots.

A plot of the graphical frequency curve can be obtained by pressing either
the Graphical tab, or by pressing the button labeled Plot Graphical
Curve at the bottom of the general frequency editor. When the Plot
Graphical Curve button is pressed, a frequency curve plot will appear in a
separate window as shown in Figure 6-10. All of the same options for
tabulating, printing, and sending results to the windows clipboard are
available for this plot as they are for the analytical frequency curve plot.

@

@ General Frequency Graphical Plot for Reg Flow Ric Grande Test 9 I. =NA ﬁ]
File Edit View Window
General Fregquency Graphical Plot for Reg Flow Rio Grande Test 4
Return Period
1.1 2 a 10 an 200100010000
100000.0 |' I |' |' i : :
| | | |
| | | |
| | | |
| | | |
I I I §
| | | V
100000+ | | | |
@ I I t I
ot | | Seil 1 | |
= | | | |
= I | [
5 | -1 de BER
1000.0 |r E”%p : :
' L 3 | |
. | |
L7 [ [
| | | |
| | | |
| | | |
100.0 —1 '. H———
.99 nga 0.5 nz2 o1 0oz 0002 0.0001
Exceedance Probahility
] Obzetved Events (Weibull plotting positions) U=zer Curve
— —= 5 Percent Confidence Limit — —= 83 Percent Confidence Limit

Figure 6-10. Graphical Analysis Frequency Curve Plot.
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Viewing the Report File

When the General Frequency analysis computations are performed, a
report file of the statistical computations is created. The report file lists all
of the input data and user settings, plotting positions of the data points,
intermediate results, each of the various statistical tests performed (i.e.
high and low outliers, historical data, etc...), and the final results. This
file is often useful for understanding and describing how the software
arrived at the final frequency curve.

To view the report file press the View Report button at the bottom of the
General Frequency analysis editor. When this button is pressed, a window
will appear containing the report as shown in Figure 6-11.
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=0

@ General_Frequency FFA_Test B.rpt ———
File Edit Search Format

File: |pendix_B_Examples\SSP_Examples\GeneralFrequencyResults\General_Frequency_FFA_Test S\General_Frequency FFA_Test G.rpt

| Day Mon Year CF5 | Rank Year CFS PFlot Pog | -
e [——————————————————== |
| 31 Dec 1969 15,000.0 | 1 1843 15,000.0 0.53 |
| 28 Mar 1932 891.0 | 2 1951 5,720.0 2.97 |
| 23 Bug 1933 2,680.0 | 3 1955 4,390.0 7.09 |
| 05 Mar 1934 1,080.0 | 4 1938 3,320.0 11.21 |
| 08 Jul 1935 3,000.0 | o 1935 3,000.0 15.34 |
| 03 Jan 1938 1,5%0.0 | [ 1933 2,680.0 19.46 |
| 22 Feb 1937 770.0 | 7 1940 1,770.0 23.58 |
| 23 Jul 1938 3,320.0 | 8 1950 1,5%80.0 27.70 |
| 03 Feb 1939 978.0 | 9 1936 1,5%0.0 31.83 |
| 15 Mar 1940 1,770.0 | 10 1952 1,4%0.0 35.95 |
| 07 Feb 1941 T46.0 | 11 1934 1,080.0 40.07 |
| 13 Rug 1942 1,000.0 | 12 1948 1,040.0 44.19 |
| 30 Dec 1942 980.0 | 13 1945 1,040.0 48.32 |
| 08 Jan 1944 865.0 | 14 1948 1,000.0 52.44 |
| 18 Sep 1945 1,040.0 | 15 1942 1,000.0 56.56 |
| 26 Dec 1945 1,000.0 | 16 1943 980.0 a0. 68 |
| 22 May 1947 483.0 | 17 1939 978.0 64.81 |
| 05 May 1948 740.0 | 18 1953 918.0 68.93 |
| 30 Dec 1948 1,040.0 | 19 1932 g9l1.0 73.05 |
| 03 REug 1950 1,5%0.0 | 20 1944 865.0 77.17 |
| 25 Now 1950 5,720.0 | 21 1937 770.0 81.30 |
| 11 Mar 1952 1,450.0 | 22 1941 746.0 85.42 |
| 22 Now 1952 9lg.0 | 23 1948 740.0 £89.54 |
| 14 Dec 1953 a70.0 | 24 1954 670.0 93.467 |
| 18 REug 1955 4,3%0.0 | 25 1947 483.0 97.79 |
|- |- |
Note: Plotting positions based on historic period (H) = 132

| |
| Number of historic events plus high ocutliers (Z) =1 |
| Weighting factor for systematic ewvents (W) = 5.4583 |

Based on 132 events, mean-sgquare error of station skew = 0.116
Mean-sgquare error of regional skew = 0.302

m

<< Freguency Curve >>
Ridley Creek-Moylan, PA

| Computed Expected | Percent | Confidence Limits |

| Curve Probability | Chance | 0.05 0.85 |

| FLOW, CFS | Exceedance | FLOW, CFS |

|- | |- |

| 17,499.9 28,944.5 | 0.2 | 41,571.2 10,177.3 |

| 12.096.4 17.225.5 | 0.5 | 25.679.7 7.516.8 1 i

4 m 3
01122016 1218 FM 28:35..28:35 28:35

Figure 6-11. General Frequency Analysis Report File.

Plots, tables, and reports can also be created by selecting menu options
from the Results menu. At least one General Frequency analysis must be
selected in the study explorer before selecting one of the menu options on
the Results menu. Results from multiple analyses are combined in one
graph if they are selected in the study explorer when the Graph menu
option is selected. The Results>Summary Report menu option will
create a summary table of statistics and frequency curve ordinates for the
selected analyses as shown in Figure 6-12.
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[ GeneralfrequencySummary.rpt

File Edit Search Format
File: | C\PROJECTSISSP_Testing\Proj ppendix_B_Exampl P_Exar requencyR eralFrequer .ot
General Frequency Summary Report Il
Tue Jan 12 12:20:56 BST 2016
Table 1 Summary of Statistics
Analysis Data Mean S5td .iieieees SHEW..orennnunnanannns Hist Qutlier Zero/ Syst Hist
Name NHame Dew Stn Rgnl Tght 2dpt Evat Hi Lo Msng Evnt Perd
General Frequency FFA Test 1 Fishkill Creek-Beacon, NY 3.378 0.255 0.733 0.600 0.677 0.677 o 1] 0 Q 24
General Frequency FFA Test 2 Floyd River-James IA 3.547 0.447 0.175 -0.300 0.074 0.074 0 1 0 ] 39 82
General Frequency FFA Test 3 Back Creek-Jones Springs 3.741 0.231 0.823 0.500 0.586 0.586 0 4] 1 ] 38
General Frequency FFA Test ¢ Orestimba Creek-Newman, CA 2.975 0.678 -0.578 -0.300 -0.472 -0.472 o 1] 1 & 42
General Frequency FFA Test 5 Kaskaskia River-Vandalia, IL 4.128 0.273 0.409 -0.400 0.182 0.182 0 4] 2 ] &0
General Frequency FFA Test @ Ridley Creek-Moylan, FA 3.120 0.283 l.o088 0.400 0.890 0.890 1 0 0 0 24 132
Table 2 Summary of Frequency Curve Ordinates
Analysis Data Percent Change E
Name Name 99 95 S0 B8O 50 2 10 5 2 1 0.5 0.2 -
General Frequency FFA Test 1 Fishkill Creek-Beacon, NY
General Frequency FFA Test 2 Floyd River-James IA
General Frequency FFA Test 3 Back Creek-Jones Springs
General Frequency FFA Test 4 Orestimba Creek-Newman, CA
General Frequency FFA Test 5 Kaskaskia River-Vandalia, IL
General Frequency FFA Test & Ridley Creek-Moylan, PA 444.5 543.3 622.3 754.3 119%8.0 2181.5 3162.5 4435.9 6724.2 9065.9 12096.4 17500.8
<« [ L3
01/12/2016 12:20 PM 1111 11

Figure 6-12. Summary Table for Selected General Frequency Analyses.
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CHAPTER 7

Performing a Volume Frequency
Analysis

The current version of HEC-SSP allows the user to perform a volume
frequency analysis of flow data. In this type of analysis, frequency curves
are developed using daily average flows. Runoff volumes are expressed
as average flows over a time duration. For example, the 3-day flow is the
average flow over a three day period. The volume from the 3-day flow
would be computed by multiplying the 3-day flow (in cfs) by 259,200
seconds (3-days). Typical volume frequency analyses would develop
frequency curves for a number of volumes (flow-duration), like the 1, 3, 7,
15, 30, 60, 90, 120, and 180 day volumes. The user can choose between
different analytical distributions as well as perform a graphical fit to the
data. This chapter discusses in detail how to use the Volume Frequency
Analysis editor in HEC-SSP.

Contents
o Starting a New VVolume Frequency Analysis
e General Settings and Options
e Extracting the Volume-Duration Data
e Analytical Frequency Analysis
e Graphical Frequency Analysis
¢ Viewing and Printing Results
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Starting a New Volume Frequency Analysis

A volume frequency analysis can be started in two ways within the
software, either by right clicking on the VVolume Frequency Analysis
folder in the study explorer and selecting New, or by going to the Analysis
menu and selecting New and then Volume-Frequency Analysis. When a
new volume frequency analysis is selected, the VVolume Frequency
Analysis editor will appear as shown in Figure 7-1.

Marme: |

Description: =
Data Set -
D55 File Mame: =
Report File: =

General | aptions | Duration Tahle | Analtical | Graphical
Log Transform Plotting Position Time Window Modification

&) Use Log Transfarrm @ Weibull (4 and B=0) End Points

(O Do Motuse Log Transform

Maximum ar Minimum Analysis
() Analyze Maximums

O Analyze Minimums

) Median (& and B= 0.3)
() Hazen (A and B = 0.5)
O Other (Specify A, B

Plotting position computed using
farmula

D385 Range is
[] start Date )
[JEnd Date [

Season

(m-A)(n+1-A-B) Tao Define a Subset ofthe Year
el ST e Season Start: Season End:
m=Rank, 1=Largest
() Water Year (starts Oct 1) MN=Mumher of Years ] [J J
O Calendar Year (starts Jan 1) AB=Cuonstants MOTE: season must he within a vear,
as defined in the Year Specification
O Other
Starting )
PlotYearly Data
Plot Duration Plot Analytical Flot Graphical

Data Curve Curve

View Repart =] [ Ok H Cancel H Apply
Figure 7-1. Volume Frequency Analysis Editor.

The user is required to enter a Name for the analysis; while a Description
is optional. A data set must be selected from the available data sets stored
in the current study DSS file (see Chapter 4 for importing daily flow data
into the study). The list of data that can be selected for a volume
frequency analysis will only include those data that have a regular interval,
like IHOUR and 1DAY (E-part pathname). Once a Name is entered and
a data set is selected, the DSS File Name and Report File will
automatically be filled out. The DSS filename is by default the same

7-2



HEC-SSP User's Manual Chapter 7 - Performing a Volume Frequency Analysis

name as the study DSS file. The report file is given the same name as the
analysis with the extension ".rpt".

General Settings and Options

Once the analysis name and data set are selected, the user can begin
defining the analysis. Five tabs are contained on the VVolume Frequency
Analysis editor. The tabs are labeled General, Options, Duration Table,
Analytical, and Graphical. This section of the manual explains the use of
the General and Options tabs.

General Settings

The first tab contains general settings for performing the frequency
analysis (Figure 7-1). These settings include:

e Log Transforms

¢ Plotting Positions

e Maximum or Minimum Analysis
e Year Specification

e Time Window Modification

Log Transform

There are two options contained within the Log Transform setting: Use
Log Transform and Do not use Log
Transform. If the user selects Use Log
() Use Log Transfarm Transform, then the logs of the data
will be computed first, and the frequency
© Do notuse Log Transfarm | analysis will be performed on the logs of
the data. If the user selects Do not use
Log Transform, then the frequency analysis will be performed on the raw
data values without taking the logs of the data. The default setting is Use
Log Transform.

Log Transform
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Plotting Positions

Plotting positions are used for plotting the raw data points on the graph.

Flotting Position
) Weibull (4 and B = 0
) Wedian (A and B=0.3)

) Hazen ifand B = 0.5)
() Other (Specify & E)

Flotting position computed using formula
(m-A)in+1-A-B)

There are four options for
plotting position within
HEC-SSP: Weibull,
Median, Hazen, and user
entered coefficients. The
default method is the
Weibull plotting position
method.

The generalized plotting
position equation is:

Where:
m=rank, 1=largest _ (m-A)
M=Mumber of Years - (n+1- A-B)
A B=Constants
where: m = rank of
flood values with the
largest equal to 1.
n = number of flood peaks in the data set.

A & B = constants dependent on which equation is used (Weibull
A and B=0; Median A and B = 0.3; and Hazen A and

B=0.5).

Plotting positions are estimates of the exceedance probability for each data
point. Different methods can give different values for the probabilities of
the highest and lowest points in the data set. The plotting of data on the
graph by a plotting position method is only done as a guide to assist in
evaluating the computed curve. The plotting position method selected
does not have any impact on the computed curve.
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Maximum or Minimum Analysis

A volume frequency analysis can be performed using annual maximum or
minimum flows. A maximum flow analysis could be used for determining
the amount of reservoir storage required for a flood of specific frequency.
A minimum flow, or low flow
analysis, could be used determine
if a river could supply a given

Maxirum ar Minimum Analysis

demand. A low flow analysis (%) Analyze Maximums
could also be beneficial for water N
quality and reservoir storage © #nalyze Minimums

projects. There are two options
contained in the Maximum or Minimum Analysis section. If Analyze
Maximums is selected, then the program will extract annual maximum
volumes for all durations. The program will extract annual minimum
volumes for all durations if Analyze Minimums is selected.

Year Specification

This option allows the user to define the beginning and ending date for
what will be considered as the analysis year for extracting the data. These
dates are used for extracting the annual maximum or minimum flows, in
order to get one value for each analysis year. It is important to choose a
start date that captures all flood events from a certain hydrologic regime.
If high flows generally occur between November and May, then the year
should not start between
these months. This will
(%) Water Year (starts Oct 1) minimize the possibility
that the same flood event
is used for consecutive
years. There are three

Year Specification

() Calendar Year (starts Jan 1)

© Other options contained in the
starting O Year Specification
section. If Water Year
[ Plat Yearly Data is selected, the program

uses a starting date of
October 1 and an ending
date of September 30. If
Calendar Year is selected, the program uses a starting date of January 1
and an ending date of December 31. The Other option lets the user define
the starting date. One way to determine when the year should begin is to
plot each year of record on top of one another, as shown in Figure 7-2.
The program will create a graph like the one shown in Figure 7-2 when the
Plot Yearly Data button is pressed. This data set is from an area that
experiences both snowmelt floods and summer/fall rain floods. Starting
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the year on January 1 would be more appropriate for this data set because
a few large flood events occurred around October 1.

=

B2 Rio Grande at Alubquerque UNREGULATED M=
File Edit Wiew

20,000+

Flow: (cfs)

Jan har Iy Jul Sep Moy

Figure 7-2. Plot Showing when Flood Events Typically Occur.

Time Window Modification

This option allows the user to narrow the time window used for the
analysis. When left unchecked, the program will use all of the data
contained in the selected data set. The user can enter either a start or end
date or both a start and end date. If a start and/or end date are used, they
must be dates that are included within the selected data set. The date
range for the selected data set is shown in the editor just above the Start
Date field.

An additional option at the bottom of the time window modification
section allows the user to define a shorter duration, a Season, within the
year in which the program extracts maximum or minimum flows. This
option allows the user to analyze floods that typically occur during a
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specific season, like snowmelt floods. When left unchecked, the program
will examine all flow records during the year. The season start and end
dates must be entered using a two digit day followed by the month,
example 15May. The season start and end dates must fall within a year as
defined in the Year Specification. The user must enter both start and end
dates to define the season subset.

Tirme Window Modification

End Points

D55 Range is

[] start date (]
[]end date [
Season

To define a subset of the yvear
seasan stan: seasan end:

[ [ ()

ROTE: season must be within a year,
as defined in the Year Specification

Options

In addition to the general settings, there are also several options available
to the user for modifying the computation of the volume-frequency curves.
These options include:

e Flow-durations

o User-Specified Frequency Ordinates
e Qutput Labeling

e Low Outlier Threshold

e Historic Period Data

When the Options tab is selected, the Volume Frequency Analysis editor
will appear as shown in Figure 7-3.
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General| Options | Duration Table | Analtical

Flow Durations
Change ot add to default values

Duration in days

Graphical

User Specified Freguency Ordinates

[J Use Values from Table Below

Freguency in Percent

Histaric Period Data

[] Use Historic Data

Historic Period

0.1 Start Year
7 0.2
15 05 End Year.
[<11] 1.0
120 2.0 Duration Owertide High Outlier Thresh
50 1-day
10.0 7-day
20.0 15-day
A0.0 BO-clay
80.0 120-day
90.0
95.0
85.0
Histaric Events
Year 1-day T-day 15-day B0-day
Qutput Laheling Low Qutlier Threshold
D38 Data Name is - FLOW [ override Low Qutlier Threshold
[ Change Lakel Duration Overtide Low Outlier Thre...
DSS Data Units are GFS 1-day
T-day
[[] change Label 15-day
GO-day
120-day
£ bd

Figure 7-3. Volume Frequency Analysis Editor with Options Tab Selected.

Flow-Durations

This option lets the user define which durations are used in the volume
frequency analysis. The program will extract annual maximum or
minimum volumes based on the durations defined in this table. The

Flow Durations

[] change or add to default values

Curation in days

14

a0

G0

a0

120

183

default durations are 1, 3, 7, 15, 30, 60, 120, and
183 days. Check the box next to Change or
add to default values to change or add
additional durations to the analysis. Once this
box is checked, the user can add/remove rows
and edit the duration values. To add or remove
a row from the table, select the row(s), place the
mouse over the highlighted row(s) and click the
right mouse button. The shortcut menu contains
options to Insert Row(s) and Delete Row(s).
The program will use the default durations, even
if they are not contained in the table, when the
Change or add to default values option is not
checked.
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User Specified Frequency Ordinates

This option allows the user to change the frequency ordinates used for

Freguency in Percent

lser Specified Frequency Ordinates

Llse Walues from Tahle below

0.2

0.5

1.0

2.0

5.0

10.0

20.0

50.0

20.0

40.0

85.0

89.0

creating result tables and graphs. The default
values listed in percent chance exceedance are 0.2,
0.5, 1, 2,5, 10, 20, 50, 80, 90, 95, and 99. Check
the box next to Use Values from Table below to
change or add additional values. Once this box is
checked, the user can add/remove rows and edit
the frequency values. To add or remove a row
from the table, select the row(s), place the mouse
over the highlighted row(s) and click the right
mouse button. The shortcut menu contains
options to Insert Row(s) and Delete Row(s). The
program will use the default values, even if they
are not contained in the table, when the Use
Values from Table below option is not checked.
Finally, all values in the table must be between 0
and 100.

7-9



Chapter 7 - Performing a Volume Frequency Analysis HEC-SSP User's Manual

Output Labeling

This option allows the user to change the default labels for data contained
in the output tables and plots. The user can change both the name of the
data and how the units of the data are labeled.

Cutput Labeling

055 Data Mame is

[] Change Lahel
0SS Data Units are

[]change Label

Low Outlier Threshold

High and low outlier tests are based on the procedures outlined in Bulletin
17B, and are applied in the same manner in the VVolume Frequency

Analysis. The :

outlier Lowy Outlier Threshold

magnitudes [ Cverride Lowe Qutlier Threshold

CaICUIated_ by Duration Owerrice Low Outlier Threshold
the Bulletin 1-day

17B procedure | |7-day

are used as oy

default values 120-day

for the high

and low outlier thresholds in HEC-SSP. The user has the option to enter a
different low outlier threshold for each duration. If a value is entered for
the low outlier threshold, then this value will override the computed value
from the Bulletin 17B methodology. When analyzing maximum flows,
HEC-SSP will identify both high and low outliers. However, only low
outliers will be removed from the data set when performing the analysis.
If a high outlier is identified in the data set, the analyst should try to
incorporate historical period information to extend the time period for
which the high outlier(s) is considered to be the maximum value(s).
Further discussion of outlier thresholds can be found in Bulletin 17B and
the HEC-SSP Statistical Reference Guide. To use the low outlier
threshold, simply check the box and enter a value for one duration or all
durations.

When Analyzing Minimums is selected on the General tab, then the Low
Outlier Threshold criteria becomes the High Outlier Threshold. When
applying the outlier tests, HEC-SSP will identify both high and low
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outliers. However, only high outliers will be removed from the data set
when performing the analysis. If a low outlier is identified in the data set,
the analyst should try to incorporate historical period information to
extend the time period for which the low outlier(s) is considered to be the
minimum value(s).

Historic Period Data

All historic data that provides reliable estimates outside the systematic
record should be used in order to improve the frequency computations.
Information outside of the systematic record can often be used to extend
the record of the largest events to a historic period much longer than that
of the systematic record. HEC-SSP uses historic data as recommended in
Bulletin 17B. This calculation is applied in the same manner in the
Volume Frequency Analysis. To use historic data, check the box labeled
Use Historic Data. The user can enter a starting year for the historic
period, ending year for a historic period and a High Threshold value for
each duration as shown in Figure 7-4. If the user enters a high threshold
value, then any data in the systematic record greater than that value will
also be treated as a historical annual maximum. The user can also enter
historic data that are not contained in the systematic record. This is done
in the table at the bottom labeled Historic Events. If a start year is not
entered, then the assumed start year is the earliest year of the systematic
record and any historical values that have been entered. If an end year is
not entered, then the assumed end year is the latest year in the systematic
record and any entered historic values. Further discussion of the use of
historical data can be found in Bulletin 17B. If Analyze Minimums is
selected on the General tab then the High Threshold becomes the Low
Threshold. The program will treat systematic values that are lower than
the low threshold as historic annual minimums.

Note: The program treats all data in the data set as systematic data. If
historic events are included in the data set, then the user can define the
analysis time window (General tab — Time Window Modification) so that
it only bounds the systematic record. Then define the historic events in
the Historic Events table. Instead of using the Time Window Modification
option, another option is to enter a High Threshold value so that the
historic data point(s) would be treated as historic data (rather than part of
the systematic record).
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Start Year:

End Year:

Ciaration
1-day

Historic Period Data

[] Use Histaric Data

Histaric Period

Cwertide High Qutlier Threshald

T-day

15-day

GO-day

120-day

Year

Histaric Events

1-day T-day 18-day A0-day 120-day

Figure 7-4. Historic Period Data on the Options Tab.

Extracting the Volume-Duration Data

The user can extract the volume-duration data once settings have been
defined on the General and Options tabs. When the Duration Table tab is
selected, the Volume Frequency Analysis editor will appear as shown in
Figure 7-5. The program will compute the annual maximum or minimum
average flows for the durations specified on the Options tab when the user
presses the Extract Volume-Duration Data button at the bottom of the
Duration Table.

The program computes the maximum/minimum flows by evaluating the
flow record as one continuous record. For each duration, the program
computes a time-series of average flow. These time-series are written to
the study DSS file and can be viewed using HEC-DSSVue. Then the
program extracts the annual maximum/minimum flows and populates the
duration table. A similar procedure is followed when a Season has been
defined within the Time Window Modification panel. The program will
only extract the annual maximum from within the season.
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The Allow Editing checkbox in the upper left portion of the Duration
Table tab allows the user to manually edit values in the volume-duration
table. The table becomes editable when the Allow Editing box is
checked. Then the user can overwrite the extracted volume-duration data.
In addition, the program will no longer extract volume-duration data
during a compute and the Extract Volume-Duration Data button
becomes inactive.

When computing the analysis, the program will issue a warning message if
any of the maximum/minimum flows occur a specific number of days
after the beginning of the year. The number of days is determined by the
duration plus five days. For example, for a fifteen-day duration, the
program issues a warning if the maximum/minimum is within twenty days
after the beginning of the year. If water year is chosen, then the program
issues a warning if the maximum/minimum occurs between October 1 —
October 20. This warning is an attempt to let the user know if a maximum
or minimum flow is generated by an event that began in the previous year.
The goal is to prevent a scenario in which the same flow event causes
maximum/minimum flows in consecutive years; this is why it is important
to choose an appropriate annual starting date.

General | Options | Duration Table | Analical | Graphical
[ Allow Editing
Volume-Duration Data
% Highest Mean Yalue for Duration, Average Daily FLOYY in CFS
sar 1 T 15 G0 120
FLOWY Date FLOWY Date FLOWY Date FLOWY Date FLOWY
1942 0452411942 22076.4| 05151942 15345.8| 06051942 13088.6| 06M14511942 12137.3| 0706942 TA30.9 ~
1943| 04/28M1943 4733.9| 05/02/1943 4638.1| 05/08/1943 4440.3| 06/03/1943 2574.3| 0F/0271943 1849.8
1944 | 051711944 13601.6| 05/2211944 12334.9| 057281944 114601.7| 070501944 TO56.9| 072271944 44603
1945 05/081945 12140.6| 05131945 111599.2| 05181945 103581 | 061591945 B137.1| OF/09/1945 37941
1946| 04/23M1946 2998.8| 0472711946 2733.6| 05/03/1946 2273.0] 051711946 1230.4| 0573171946 978.5
1947 | 051211947 TOO3.5| 05/145/1947 a848.5| 05181947 A8118.0| 06/145/1947 2709.0) 06/28/1947 17859.8
1948 047281948 12273.4| 061111948 10224.5| 06091948 9850.8| 06181948 TO14.3| OFM0/M1948 4567 .1
1949| 06231949 10556.0| 0Bf27/1949 9642.2| 06/30/19449 8133.2| 06/30/19449 5828.4| 07/30/19449 4386.0
1950 0452411950 2801.1| 04/27/11950 2711.6| 0473001950 2396.7| 05/04/1950 15459.3| 06121950 13159.9
1951 | 041001351 1881.6| 05141951 1718.3| 05/2371951 1610.7| 061471951 1082.0| 06/05/1951 868.6
1952| 05/08/1952 11669.4| 0501171952 10749.8| 0501971952 9703.8| 0B/22/1952 71472 072211952 A704.7
1953 04731011953 2706.0) 06/04/1953 2497.2| 0B/06/1953 2283.0| 0B8/20/1953 17259.2| 0B/28/1953 1298 .6
1954 | 04181954 21221 0472171954 2050.3| 04/28/1954 182591 06/04/1954 1595.2| 06/07/1954 1131.6
1955| 09251955 5496.6| 0572971955 2694.8| 05/30/19585 2349.9| 06721719585 1559.2| 08729719585 1154.8
1956 05/0711956 1766.1| 051171956 17221 051111956 1626.0) 061171956 1172.4| 0611451956 941.9
1957 | 0B/0SM1957 9403.5| 061111957 8794.2| 081451957 THES.2| OF/06M 957 A357.9| 09/01/1957 4360.3
1958| 051141958 125901 | 051711958 12047.0) 05/2311958 11492.6| 061451958 9129.4| 0B/22/1958 54335
19559 | 0872601959 253594 05/20/19549 1821.9| 05/20/1954 1624.9| 06/05/19559 1045.9| 06/01/19549 G446
1960 041131960 B034.5| 047161960 A335.6| 0472411960 4832.5| 05/2271960 32991 | 08/2711960 24826
1961 | 050451961 56954 05/07/1961 A052.7| 05/0711961 4518.2| 06/06/1961 3084.0| 0Br28/1961 2001.7
1962 | 0452211962 9023.2| 0472711962 8121.7| 05/02/1 962 T289.3| 05/28/14962 48759.4| 061271962 3086
1963 041151963 2477.4| 041161963 2285.6| 04161963 2097.4| 051451963 1814.7| 06/04/1963 1115.2
1964 | 0511501964 2353.4| 05/19/1964 2237.5| 0572511964 1963.8| 06/10/1964 1293.1| 0B/M17/1964 938.8
1965 0615911965 8007.6| 05/26/1 965 T162.8| 05/27/14965 8955 06/30/1965 5202.7| 081171965 3916.0
1966 051151966 3704.0| 051251966 34701 051451966 3276.3| 05145/ 966 26291 061311966 20478
1967 | 08101967 8810.2| 08MB/1967 5186.4| 08/20/1967 3533.9| 091471967 1653.6| 09/08/1967 13415
1968 | 0572411968 5432 6| 05/29/1 968 A095.6| 06/05/1 968 49181 | 070171968 3315.0| 0872501968 2410.0
19659 05/06/1969 A866.6| 05/08/19649 A070.9| 0572711964 4960.4| 06/22/1 9649 4148.6| 072971964 28634 b
| EsractVolume-Duration Data |

Figure 7-5. Volume-Duration Table.
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The user must Compute the analysis before viewing a frequency plot of
the volume-duration data. The plot created by pressing the Plot Duration
Data button, located at the bottom of a Volume Frequency Analysis
editor, shows the annual maximum/minimum volumes plotted using the
user specified plotting position method, as shown in Figure 7-6.

E Volume-Duration Frequency Data Plot for RIO GRANDE AT ALBUQUERQUE UNREGULATED FLOW TEST 10 Q@@

File Edit Wiew Window

Volume-Duration Fregquency Data Plot for RIO GRANDE AT ALBUQUERQUE UNREGULATED FLOW TEST 10
Return Period
1.0 11 2 5 10 50 100 200 500
L L I L ! I L L ! P

100000.0

[}
10|
10000.0 IIIII! |
@ mpuEE g ®
5 o A
=
g
= Iill
1000.0 LS
T oo

100.0 T T T T T T T T
0.5999 0.993 0.99 0.4 0.4 0.2 01 0.02 0.010.005 0.002 0.0001

Probahility

W 1-Day Data Observed Events (Weibul plotting positions) B 7-Day Data Observed Events (Weibul plotting positions) B 15-Day Data Observed Events iisibull plotting positions)
W 60-Day Daa Observad Events (Weibull plotting positions) B 120-Day Daa Observed Events (Weibull plotting positions)

Figure 7-6. Plot of Volume-Duration Data.

Analytical Frequency Analysis

The user can choose between performing an Analytical Frequency
Analysis or a Graphical Frequency Analysis once settings have been
defined on the General and Options tabs. The Duration Data does not
have to be extracted before computing an analysis. The program will
automatically extract the duration data when the Compute button is
pressed. This section of the manual describes how to compute and view
results for an Analytical Frequency Analysis.

When the user selects the Analytical tab on the Volume Frequency
Analysis editor, the window will appear as shown in Figure 7-7. As
shown, four additional tabs will appear on the screen: Settings, Tabular
Results, Plot, and Statistics.
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General | Options | Duration Table | Analtical | Graphical

Settings | Tabular Results | Plot| Statistics

Log Transformation:  On Skew

Distribution: () Use Station Skew

LogPearsanlll b’ (3 Use Weighted Skew

Expected Probahlity Curve
() Use Regional Skew

) Compute Expected Prob.Curve

Duration Req. Skew R.Skew MSE
(& Do Mot Compute Excpected Prob. 1 0.3 0.302
3 0.3 0.302
7 0.3 0.302
15 0.3 0.302
30 0.3 0.302
G0 0.3 0.302
a0 0.3 0.302
120 0.3 0.302
183 0.3 0.302
Flat Flat Flat
Duration Analytical Graphical
Compute Data Cure Curve Wiew Report % [ 0K ] [ Cancel ]

Figure 7-7. Analytical Tab of the Volume Frequency Analysis Editor.

Settings

In addition to settings on the General and Options tabs, there are more
options on the Settings tab the user must define in order to perform an
Analytical Frequency analysis on the volume-duration data. These

settings include:
e Distribution
e Expected Probability Curve
e Skew

Distribution

This option allows the user to select a distribution to perform the
frequency analysis. The current version of HEC-SSP contains five

distribution choices: None, Normal, LogNormal,
Pearson |11, and LogPearson Ill. If the user has
selected the Use Log Transform option, located
on the General tab, then the available choices for
distribution are None, LogNormal, and
LogPearson I11. If the user has selected the Do
not use Log Transform option, located on the

Distritbiution:

LogPearsanll b

MHane
LogMaormal

General tab, then the distribution choices are None, Normal, and Pearson
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Expected Probability Curve

This setting has two options, Compute Expected Prob. Curve and Do
Not Compute Expected Prob. Curve. The default setting is to have the
expected probability curve computed. When computed, the expected
probability curves will be = qaiesie) Beleralli S

shown in the report that is
opened by pressing the View (&) Compute Expected Praob. Curve
Report button at the bottom of
the Volume Frequency
Analysis editor. The expected
probability curves are also saved to the study DSS file, along with the
computed volume frequency curves and 5 and 95 percent confidence
limits. The expected probability adjustment is a correction for bias in the
computed frequency curve. The bias is caused by the skew in the
uncertainty due to the shortness of the data record. The Method of
Moments estimation of the Log Pearson Il parameters produces a median
estimate of each frequency curve quantile, and the adjustment changes to a
mean (unbiased) estimate, which is different from the median because of a
skewed uncertainty distribution. Please review the discussion in Bulletin
17B about the expected probability curve adjustment for an explanation of
how and why it is computed. The use of the expected probability curve is
a policy decision. It is most often used in establishing design flood
criteria. The basic flood frequency curve without the expected probability
adjustment is the curve used in computation of confidence limits, risk, and
in obtaining weighted averages of independent estimates of flood
frequency discharge (Interagency Advisory Committee on Water Data,
1982).

(1 Da Mot Compute Expected Prab. Curve
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Skew

The skew option is only available whenever the analytical distribution is
set to LogPearsonlll. There are three options contained within the skew
setting, Use Station
Skew, Use
We|ghted Skew’ and () Use Station Skew
Use Regional Skew.
The default skew

Skew

(%) Use Weighted Skew

Setting is Use () Use Regiohal Skew
St_ation_SkeW- With Duration Reg. Skew R.Skew MSE
this setting, the skew 1 0.3 0302
of the computed § gi gig;
curve will be based 15 03 0302
solely on computing 30 0.3 0.302
B0 0.3 0.302
a skew from the data o 13 ETE
points. 120 0.3 0202
183 0.2 0.302

The Use Weighted
Skew option requires
the user to enter a
generalized regional
skew and a mean-square error (MSE) of the generalized regional skew.
This option weights the computed station skew with the generalized
regional skew.

The Use Regional Skew option requires the user to enter a generalized
regional skew and a mean-square error (MSE) of the generalized regional
skew. The program will ignore the computed station skew and use only
the generalized regional skew.

Compute

Press the Compute button, located at the bottom of the Volume Frequency
Analysis editor, once options have been set on the
General, Options, and Settings tabs. If the compute is
successful, the user will receive a message that says
Compute Complete. At this point, the user can review results from the
analytical analysis by selecting the Tabular Results and Plot tabs.

Multiple Volume Frequency analyses can be computed using the
Compute Manager. Select the Analysis=>Compute Manager menu
option to open the Compute Manager. Select the analyses to be computed
and then press the Compute button. Close the compute dialogs and
Compute Manager when the program finishes computing the analyses.
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Tabular Results

The Tabular Results tab contains a table of results for the analytical
frequency analysis. An example of the results table is shown in Figure 7-
8. The top portion of this table contains the analytical frequency curves
for each duration. Data in the frequency curves can be re-sorted. Click
the Percent Chance Exceedance column header (two mouse clicks are
required the first time). The percent chance exceedance ordinates, along
with the frequency curves, will sort so that the lowest values are on top or
the highest values are on top. The statistics of the analytical frequency
curves are contained below the frequency curve ordinates. The statistics
include the mean, standard deviation, station skew, regional skew,
weighted skew, adopted skew, number of years of record, and number of
years with zero or missing flow.

User-adjusted statistics can be defined by the user on the Statistics tab. If
the user has not entered statistics on the Statistics tab, then the results table
will look similar to Figure 7-8. If the user does enter statistics on the
Statistics tab, then the results table will include the adjusted mean,
adjusted standard deviation, and adjusted skew. If specified by the user,
the program will use the user-adjusted statistics when computing the
analytical curves.

General | Options | Duration Tahle Anabdical | Graphical

Settings | Tabular Results | Plot | Statistics

| Compute |

Data

Curve

Curve

view Report & Frint

[

Ok

| [ cance

“Wolume-Duration Frequency Curves for South ForkWailua River, Average Daily FLOW in CGFS
Percent
Chance 1 3 7 15 an B0
Exceedance
0.z 14304.0 7093.4 4012.49 23747 14749.0 4742
0.4 119936 6041.0 34284 2049.2 13048 860.9
1.0 103548 5283.0 3008.3 18123 11734 7758
2.0 85048 4565.4 26071 1582.5 1041.9 6911
5.0 5381.8 3635.8 2098.0 1288.0 8668 a78.8
10.0 5510.8 2965.9 17284 1069.9 7318 4823
20.0 41838 2308.1 1363.45 851.8 591.8 4027
50.0 2456.0 14103 860.7 545.3 3851 269.8
g0.0 1414.5 8471 538.8 344.4 243.0 177.0
90.0 1053.0 G44.5 420.4 269.4 188.6 140.8
95.0 8224 5124 341.9 219.4 1520 116.0
948.0 5128 3304 2311 148.2 949.7 79.7
Statistics 1 3 7 14 30 1]
Mean 3.385 3144 2.932 2.733 2.576 2.425
Standard Dev. 0.281 0.259 0.240 0.234 0.230 0.212
Station Skew -0.108 -0.122 -0.064 -0.108 -0.249 -0.185
Regional Skew
Weighted Skew
Adopted Skew -0.109 -0122 -0.064 -0.108 -0.249 -0.185
#Years a7 a7 97 97 97 a7
# ZerofMissing 1] a 1] 1] 1] 1}
Flot Duration Flot Analtical Flot Graphical

Figure 7-8. Tabular Results for a Volume Frequency Analysis.

7-18




HEC-SSP User's Manual Chapter 7 - Performing a Volume Frequency Analysis

Plot

In addition to tabular results, a Plot tab is available for viewing results, as
shown in Figure 7-9. The results graph includes the systematic annual
maximum/minimum volumes, plotted using the specified plotting position
method, and the analytical frequency curves. The analytical frequency
curves are based on the computed statistics or user-adjusted statistics if
they are defined on the Statistics tab.

General| Options | Duration Table | Analtical | Graphical

Settings | Tabular Results | Plot | Statistics

Return Period
1.0 1.1 2 ] 10 50 100 200 500
I L L L

100000.0 ; ; ; ; ; ;

10000.0+

FLOWY in CFS

1000.0+

100.0 T T T T T T T T T T T
0.9999 0.999 0.99 0.4 0.a 0.z 01 0.0z 0.01 0.002 0.0001

Probability
B 1-Day Data Observed Events (Wieibull plotting position=) 1-Oay Curve B 7-Day Data Observed Events (Weibull plotting positions)
7-Day Curve B 15Oay Osta Observed Events (Weibull plotting positions) 15.03y Curve
M 60-Day Data Observed Events (eibull plotting positions) 60-Day Curve B 120-Oay Data Observed Events (ifeibull plotting positions)
120-Day Curve
Plot Duration Plot Anahtical Flot Graphical
Compute Data Curve Curve View Report & [ ok |[ concer |

Figure 7-9. Plot of Analytical Results for a Volume Frequency Analysis.

Statistics

As discussed in EM 1110-2-1415, a necessary step in a volume-frequency
analysis is to make sure the analytical frequency curves are consistent
across all durations (USACE, 1993). In some situations, frequency
curves from different durations might cross one another. The Statistics
tab contains tools allowing the user to modify the mean, standard
deviation, and skew to make sure frequency curves do not cross one
another.

When the user selects the Statistics tab, the window will appear as shown
in Figure 7-10. The upper portion of the Statistics tab contains a plot of
the computed and user-adjusted statistics. The user has the option of
choosing the parameter to be plotted in the comparison graph. Computed
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statistics are plotted as black data points and user-adjusted statistics are
plotted as blue data points. The first table, Sample Statistics, contains the
statistics computed from the systematic data. In addition, the adopted
skew value in this table can be the station skew, weighted skew, or
regional skew. The adopted skew is set by the user on the Settings tab.
The lower table is where the user enters the adjusted statistics. Before
entering adjusted statistics, the user must check the box in Column 1.
User-adjusted statistics entered in this table are used when the program
computes the analytical frequency curve.

Genaral | Options | Duration Tahle| Anahtical | Graphical
Settings | Tabular Results | Plot| Statistics
-0.00
-0.05 - .
0,10 (] : . Log Transformation:  On
015 L] Distribution: LagPearsanlll
=
% 0,20 . . ¥-axis Parameter -axis Parameter
026 L hean | | Skew 4
E -1 *
o.sn Updats Plot
0.35 T T T T T T T T
25 25 7 23 28 3 3.1 32 33
Mea
Sample Statistics 1 3 T 14 a0 60
Mean 3.385 3144 2.932 2733 2578 2,425
Standard Dev. 0.281 0.259 0.240 0.234 0.230 0.212
Station Skew 0.109 0.122 0.064 -0.105 0.249 0.185
Adopted Skew 0.109 0.122 0.064 -0.105 0.249 0.185
Use | Adjusted 1 3 7 14 30 1]
Statistics
[+] [mean 3.385 3144 2.832 2.733 2478 2.425
[] |standar..
l¥| |Adopted ... 0.05 0.1 015 0.2 0.25 0.3
Plot Duration Plat Anakdical Plot Graphical
Compute | Data Curve Curve Wiew Report =] [ OK ] [ Cancel I

Figure 7-10. Statistics Tab in the Volume Frequency Analysis Editor.

Graphical Frequency Analysis

In addition to an analytical frequency analysis, which uses a statistical
distribution to fit the data, the user has the option to graphically fit a
frequency curve to the data. A graphical curve can be very useful when
the available analytical distributions do not provide a good fit. One
example of when a graphical frequency analysis is more appropriate is
when plotting a frequency curve for flow data that is downstream of a
flood control reservoir. Analytical frequency distributions are often not
appropriate for fitting flow data that is significantly regulated by upstream
reservoirs. In general, a portion of the flow frequency data for a highly
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regulated stream will be very flat in the zone in which upstream regulation
can control the flow. This type of data lends itself to a graphical fit.

When the Graphical tab is selected on the Volume Frequency analysis
editor, the window will appear as shown in Figure 7-11. As indicated, two
additional tabs will appear on the screen, Curve Input and Plot.

General | Options | Duration Table | Analtical| Graphical
Curve Input | Plot
Lser-Defined Graphical Curve Log Transformation:  On
Yolume-Duration Frequency Curves for CHATTAHOOCHEE RIVER-CORKELIA, GA-FLOWY, Average Daily FLOWY in GFS
Percent Chance 1 7 a0 &0 an
Exteedance
0.z
0.5
1.0
20
5.0
10.0
200
a0.0
g0.0
40.0
95.0
59.0
Plot Plot Plot
Duration Analytical Graphical
Compute Data Curve Curve Yiew Report % [ [o]24 ] [ Cancel ]

Figure 7-11. Graphical Curve Table for a Volume Frequency Analysis.

Curve Input

The user manually enters the frequency ordinates for all durations in the
table on the Curve Input tab. As previously mentioned, the number of
frequency ordinates and durations are set on the Options tab. The idea is
to enter values in the table that will create a best fit line of the data, based
on the user’s judgment. Data entered in the graphical curve table will be
plotted as a line in the graph on the Plot tab after the Compute button is
pressed.

Plot

The graphical analysis Plot tab is available for viewing results, as shown
in Figure 7-12. The results graph includes the historic annual
maximum/minimum flows, plotted using the specified plotting position
method, and the user-defined graphical curve, which was entered in the
table on the Curve Input tab.
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General | Options | Duration Takle | Analytical | Graphical
Curve Input| Flot

Return Period
1.0 11 2 b} 10 50 100 200 500
1 L 1 L

100000.0

10000.0

FLOWY in CF3

1000.04

100.0

T T T T T
0.9999 0.989 0.9 n0g 05 0z 0.1 0.0z 0.01

L
0.002 0.0001

Probability
1-Day Graphical Curve 7-Day Graphical Curve 15.03y Graphical Curve
60-Day Graphical Curve 120-Day Graphical Curve 4 1-Day Data Observed Events Qiieibull plotting positions)
4  7-Day Data Observed Events (Weibull plotting positions) +  15-Day Dsta Observed Events (Weibull platting positions) 4 60-Damy Data Observed Events (ieibul platting pasitions)
4+ 120-Day Data Observed Events (Weibull plotting positions)
Plat Duration Plot Analytical Plot Graphical
[ Campute Data Curve Curve Vigw Repart = ok ][ cancel

Figure 7-12. Plot Tab for a Graphical Analysis.

Viewing and Printing Results — Volume Frequency
Analysis

The user can view output for the frequency analysis directly from the
Volume Frequency Analysis editor (Tabular and Graphical output) or by
using the plot and view report buttons at the bottom of the editor. The
output consists of tabular results, an analytical frequency curve plot, a
graphical frequency curve plot, and a report documenting the data and
computations performed.

Tabular Output

Once the computations for the analytical frequency analysis are
completed, the user can view tabular output by opening the Tabular
Results tab under the Analytical analysis tab. The details of this table
were discussed above. The tabular results can be printed by using the
Print button at the bottom of the Volume Frequency Analysis editor.
When the print button is pressed, a window will appear, giving the user
options for how the table is to be printed.
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Graphical Output

Graphical output can be opened by selecting one of the plot buttons at the
bottom of the Volume Frequency Analysis editor or by selecting the Plot
tab under the Analytical or Graphical tabs. There are three plot buttons at
the bottom of the VVolume Frequency Analysis editor, Plot Duration Data,
Plot Analytical Curve, and Plot Graphical Curve. Pressing the Plot
Duration Data button will open a new window containing a graph showing
the systematic data plotted using the user-defined plotting position
method. Pressing the Plot Analytical Curve button will open a new
window containing a graph with both the systematic data and the
computed analytical frequency curves, as shown in Figure 7-13. Pressing
the Plot Graphical Curve button will open a new window containing a
graph with both the systematic data and the user-defined frequency curves.

& Yolume-Duration Frequency Analytical Plot for RIO GRANDE AT ALBUQUERQUE UNREGULATED FLOW TEST 10 Q@@

File Edit “iew Window

Wolume-Duration Frequency Analical Plot for RIO GRAMNDE AT ALBUQUERGQUE UNREGULATED FLOW TEST 10
Retumn Period
1.0 11 2 i} 10 A0 100 200 &001000
L L L L L L L . . P

100000.0

10000.04

FLOW in CFS

1000.0

100.0 T T T T T T T T T
0.9333 0.893 099 09 048 02 01 0.02 0.01 0.005 0.002 0.0001

Probahility
W 1-Oay Data Observed Events (isibul plotting positions) 1-Day Curve W 7-Day Data Observed Ewents (Uieibul plotting positions)
7-Day Curve M 15-Day Data Observed Events (Weibull plotting positions) 15-Day Curve
W 60-Day Data Observed Everts (Weibull plotting positions) 60-Day Curve W 120-Day Data Dbserved Events (Weibull plotting positions)
120-Day Curve

Figure 7-13. Plot of Systematic Data and Analytical Frequency Curves.

All plots opened by selecting one of the plot buttons at the bottom of the
Volume Frequency Analysis editor contain menu options for printing,
editing, and saving the plots.

Plots can be sent to the printer by selecting the Print option located on the
File menu. Additional printing options available from the File menu are
Page Setup, Print Preview, and Print Multiple (used for printing multiple
graphs on the same page). The plot can also be sent to the Windows
Clipboard by selecting Copy to Clipboard from the File menu.
Additionally, the plot can be saved to a file by selecting the Save As
option from the File menu. When the Save As option is selected, a
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window will appear allowing the user to select a directory, enter a
filename, and select the format for saving the file. Currently four file
formats are available for saving the plot to disk: windows metafile,
postscript, JPEG, and portable network graphic. The data contained
within the plot can also be tabulated by selecting Tabulate from the File
menu. When this option is selected, a separate window will appear with
the data tabulated. Additional options are available from the File menu for
saving the plot properties as a template (Save Template) and applying
previously saved templates to the current plot (Apply Template).

The Edit menu contains several options for customizing the plot
properties. These options include Plot Properties, Configure Plot Layout,
Default Line Styles, and Default Plot Properties. Also, the user can right-
click on a line or data point in the plot area or in the legend and a shortcut
menu will open with customization options. Both the Y and X-axis
properties can be edited by placing the mouse on top of axis and clicking
the right mouse button. Then select the Edit Properties menu option in
the shortcut menu. For example, the user can turn on minor tic marks for
the y-axis and modify the minimum and maximum scale for the x-axis.
The graphic customizing capabilities within HEC-SSP are very powerful,
but are also somewhat complex to use. The code used in developing the
plots in HEC-SSP is the same code that is used for developing plots in
HEC-DSSVue and several other HEC software programs. Please refer to
the HEC-DSSVue User’s Manual for details on customizing plots.

Viewing the Report File

Computational results for a volume frequency analysis are written to a
report file. The report file lists all of the input data and user settings,
plotting positions of the data points, intermediate results, each of the
various statistical tests performed (i.e. high and low outliers, historical
data, etc...), and the final results. This file is often useful for
understanding how the software arrived at the final frequency curves.
Press the View Report button at the bottom of the Volume Frequency
Analysis editor to open the report, as shown in Figure 7-14.
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Eile Edit Search Format
File: | caHEC-S5F Build 2008-02-1 Sprojectswolume-duration_testingWolumeF requencyAnalysisResultsiS outh_Fork_Wailua_RiverSouth_F ork_Wailua_|
~
Volume-Duration Analysis
18 Jum 2008 02:47 M
—-- Input Data —--
Analysis Name: South Fork Wailua River
Description:
Data et Name: 3F WATLUA RIVER-LIHUE, K&UAI, HI-FLOW
DE3 File Name: C:%HEC-53FP Build Z008-02-13%projectsivolume-duration testingiwvolume-duration testing. das
D55 Pathname: /5F WAILUA RIVER/LIHUE, KAUAI, HI/FLOW//1DAY/USGS/
Project Path: C:VHEC-33F Build 20058-02-13%\projectsivolume-duration testing
Feport File Name: C:WHEC-33F Build =2008-02-13%wprojectsiwolume-duration testing'VolumeFrequencyinalysisResults'South
Result File Name: C:%HEC-33F Build 2005-02-13%projectsiwolume-duration testinghVolumeFrecquencyinalysizResults) Jouth
Analyze Maximums
Analysis Year: Calendar Year
Record Start Date: 01 Jan 1912
Record End Date: 17 Jun 2008
User-Specified Durations
Duration: 1 day
Duration: 3 days
Duration: 7 days
Duration: 15 days
Duration: 30 days
Duration: 60 days
Plotting Position Type: Weibull
Probahility Distribution Type: Pearson Type ITI
Use Log Transform
Upper Confidence Lewel: 0.05
Lower Confidence Level: 0.95
Use Default Fredquencies
Skewy Option: Use Station Skew
Regional Skew: --—-
Regional Skew M3E: -—-
Display ordinate walues using 0 digits in fraction part of walue
—-— End of Input Data ---
<< Low Outlier Test >>
Based on 97 ewents, l0 percent outlier test walue K(HN) = 3.006
0 low outlier(s) identified below test walue of 345.13
<4 Hirth NMutlier Teatr =% N
¥
1:1.11 11

Figure 7-14. Volume Frequency Analysis Report.
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Plots, tables and reports can also be created by selecting menu options
from the Results menu. At least one volume frequency analysis must be
selected in the study explorer before selecting one of the menu options on
the Results menu. Results from multiple analyses are combined in one
graph if they are selected in the study explorer when the Graph menu
option is selected. The Results=>Summary Report menu option will
create a summary table of statistics and frequency curve ordinates for the
selected analyses as shown in Figure 7-15.

'%VolumeFrequen:ySummary.rpt @

Eile Edit Search Faormat
File: | GaTemplssP_ ot

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, 3
Volume Fregquency Summary Report

Table 1 Summary of Statistics

Analysis Data Duration Mean Std aaiaeeees BHEW. v evniinnn s Hist Outlier Zero/ Syst Hist

Hawe Hame Dev. stn Rgnl Tight. Adpt Evnt Hi Lo Meng Ewnt Perd

RI0 GRANDE AT ALBUQUERQUE UNREGULATED FLOW TEST 10 Rio Grande at Alubquercie UNREGULATED 1-Day 3.731 0.319 -0.448 -0.448 o o o o 61

RI0 GRANDE AT ALBUQUERQUE UNREGULATED FLOW TEST 10 Rio Grande at Alubquercue UNREGULATED 7-Day 3.670 0.348 -0.53% -0.53% o o o o 81

RI0 GRANDE AT ALBUQUERQUE UNREGULATED FLOW TEST 10 Rio Grande at Alubquercue UMREGULATED L15-Day 3.621 0.340 -0.532 -0.532 o o o o 81

RI0 GRANDE AT ALEUQUERQUE UNREGULATED FLOW TEST 10 Rio Grande at Alubgquercie UMREGULATED 60-Day F.470 0.341 -0.339 -0.339 o o o o &l

RI0 GRANDE AT ALBUQUERQUE UNREGULATED FLOW TEST 10 Rio Grande at Alubquercque UMREGULATED 1z0-Day 3.334 0.310 -0.231 -0.231 o o o o 81

Table 2 Sumnary of Frequency Curve Ordinates

Analysis Data Iuration cent Change Exceedance--—----------—-----—-

Wame a3 as a0 &0 50 z0 10 5 z 1

RI0 GRANDE AT ALEUQUERQUE UNREGULATED FLOW TEST 10 Rio Grande at Alubgquercae UNREGULATED Ll-Day 773.0 1478.4 2043.2 2963.8 5681.8 10096.2 13248.5 1g34l.2 20384.5 Z3416.¢
RI0 GRANDE AT ALBUQUERQUE UNREGULATED FLOW TEST 10 Rio Grande at Alubquercue UNREGULATED 7-Day 575.1 1178.5 1677.7 2506.2 s007.2 9083.1 11956.0 14734.8 18292.7 20905. 0
RI0 GRANDE AT ALBUQUERQUE UNREGULATED FLOW TEST 10 Rio Grande at Alubquercue UMREGULATED 15-Day 500.1 1035.5 1480.3 2225.9 4485.4 B8195.4 10821.9 13365.5 16628.0 19028, ¢
RI0 GRANDE AT ALBUQUERQUE UNREGULATED FLOW TEST 10 Rio Grande at Alubquercue UNREGULATED 60-Day 38z.4 756.5 1053.6 1548.7 3085.8 5783.2 7845.8 8872.8 12838.3 15203.0
RI0 GRANDE AT ALBUQUERQUE UNREGULATED FLOW TEST 10 Rio Grande at Alubquercue UMREGULATED 120-Day 363.5 637.7 850.4 1185.0 2223.6 3976.8 5307.9 6684.2 8595.3 10116, ¢
Table 3 Summary of User Statistics and Frewquency Curwve Ordinates

Analysis Data Turation Hean Std Adpt cent Change Exce
Hawe Hame 99 95 B 80 50 zn 1o

RI0 GRANDE AT ALBUQUERQUE UNREGULATED FLOW TEST 10 Rio Grande at Alubquercie UNREGULATED 1-Day 3.731 0.330 -0.460 714.4 1408.0 15973.4 2505.3 5704.4 10315.8 13624.3 168
RI0 GRANDE AT ALBUQUERQUE UNFEGULATED FLOW TEST 10 Rio Grande at Alubgquergue UNREGULATED 7-Day 3670 0.320  -0.480  €50.8 12656 1765.2 2577.8 4966.3  &79L.1 1l472.4 14
RI0 GRANDE AT ALBUQUERQUE UNREGULATED FLOW TEST 10 Rio Grande at Alubquercue UMREGULATED L15-Day 3.622 0.315 -0.550 582.1 1147.8 1ls01.9 2338.6 4474.4 7797.6 10080.8 1zz
RI0 GRANDE AT ALBUQUERQUE UNREGULATED FLOW TEST 10 Rio Grande at Alubquercue UMREGULATED 60-Day 3.470 0.310 -0.560 4z1.2 824.6 1145.0 1664.6 3153.4 5441.5 6983.2 82
RI0 GRANDE AT ALBUQUERQUE UNREGULATED FLOW TEST 10 Rio Grande at Alubquercque UMREGULATED 1z0-Day 3.335 0.300 =-0.570 327.1 628.9 B65.8 1243.6 2308.6 3808.2 4372.8 5¢w
< >

1:1.11 111

Figure 7-15. Summary Table for a Volume Frequency Analysis.
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CHAPTER 8

Performing a Duration Analysis

This chapter discusses in detail how to use the Duration Analysis editor in
HEC-SSP. A duration analysis can be performed on flow and stage data
as well as other data types. All regular interval data can be used in a
duration analysis and an option is included to manually define a duration
curve.

Contents
e Starting a New Analysis
e General Settings and Options
e Analytical Duration Analysis
e Manual Analysis
e Viewing and Printing Results
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Starting

a New Analysis

A duration analysis can be started in two ways, either by right clicking on
the Duration Analysis folder in the study explorer and selecting New, or
by going to the Analysis menu and selecting New and then Duration
Analysis. When a new duration analysis is selected, the Duration
Analysis editor will appear as shown in Figure 8-1.

B Duration Analysis Editor, -*

MName: |
Description:
Data Set Mone
D55 File Mame
Report File:
General | Options
Method
() Rank All Data Values
O Bin (STATS)
-l Soale
(&) Linear
) Probablity
Y-Auis Scale
(&) Linear
i Log

W]
A
L
B
Wianual Entry
Tire Window Modification
End Paoints
DSS Range is
[ start Date @)
] End Date Q
Duration Period
Annual ¥
Start of Period End of Perind
[ Potouration curve | [ viewRepon || & ok J[ cancet | ano

Figure 8-1. Duration Analysis Editor.

The user is required to enter a Name for the analysis, while a Description
is optional. A data set (flow, stage, or other) can be selected from the
available data sets stored in the current study DSS file (see Chapter 4 for
importing data into the study). The list of data that can be selected for a
duration analysis will only include those data that have a regular interval,
like IHOUR and 1DAY (E-part pathname). Choose “None” for the Data
Set when defining the duration curve manually on the Manual Entry tab.
Once a Name is entered and a data set is selected, the DSS File Name and
Report File will automatically be filled out. The DSS filename is by
default the study DSS file. The report file is given the same name as the
analysis with the extension ".rpt".
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General Settings and Options

Once the analysis name and data set are selected, the user can begin to
perform the analysis. Contained on the Duration Analysis editor are four
tabs. The tabs are labeled General, Options, Results, and Manual
Entry. This section of the manual explains the use of the General and
Options tabs.

General
The first tab contains general settings for performing the duration analysis
(Figure 8-1). These settings include:

e Method

e X-Axis Scale

e Y-Axis Scale

e Time Window Modification

e Duration Period

Method

This option allows the user to choose the Rank All Data Values or Bin
(STATS) method for computing the duration

Method analysis; the rank all data values method is the
@ Rank Al Data Values preferred choice. This method computes the

duration curve by sorting the data from largest
to smallest, ranking the values from 1 to n, and
using: P =100*[M /(n+1)] where M is the
ranked position and n is the number of events. The Bin method uses a
similar procedure as in the STATS program for computing the duration
curve (U.S. Army Corps of Engineers, 1996). The data is grouped into
bins (classes) and the duration curve is computed using the number of data
in each bin.

(0 Bin (STATS)

X-Axis Scale

This option allows the user to choose the scale of the x-axis. The options
are Linear and Probability. This option will affect the x-axis scale in the
duration curve plot and how the “interpolated”

H-fyis Scale .
frequency curve is computed. The program
) Linear will use a probability scale when interpolating
O Prabablity the final duration curve to the user specified
exceedance ordinates.
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Y-Axis Scale

This option allows the user to choose the scale of the y-axis. The options
are Linear and Log. This option will affect the y-axis scale in the
duration curve plot, how the program computes

T-Auls Seale evenly spaced bins when the Bin (Stats) method

(¥) Linear is selected, and how the “interpolated” frequency

O Log curve is computed. One option for computing
bins is to let the program define the bins at evenly

spaced intervals between the minimum and
maximum values from the selected data set. When Log is set as the y-axis
scale, the program will convert the minimum and maximum values to log
space before computing the evenly spaced bin limits. Also, the program
will use log scale when interpolating the final duration curve to the user
specified exceedance ordinates.

Time Window Modification

This option allows the user to narrow the time window used for the
analysis. The default is to use all of the data contained in the selected data
set. The user can
enter either a start
date and end date or
both a start and end
date. If a start [] start date (]
and/or end date are

used, they must be L] end date L)
dates that are
contained within the data stored in the selected data set. The date range
for the selected data set is shown in the editor just above the Start Date
field.

Tirme Window Modification

0SS Range is 13DEC1940- 185EP2004
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Duration Period

This option allows the user to compute multiple duration curves for
different time windows within the year. If Annual is selected, then the
program uses all the data when computing the duration curve. If
Quarterly is selected, then the program separates the data into quarters
and computes a separate duration curve for each quarter. For example, a
duration curve for the 1% quarter includes all data measured from Jan 1 —
March 31. The program will compute a separate duration curve for each
month of the year when the Monthly option is selected. The User-
Defined option lets the user define one or multiple periods within the year.
Then the program will perform the duration analysis using data only
measured during the user-defined period(s).

Dwiration Period

Annual b

Gluarterly
manthly
lser-Defined

Options

In addition to the general settings, there are also several options available
to the user for modifying the computations of the duration curve. These
options include:

e Output Labeling

e Plotting Position Formula

e User-Specified Exceedance Ordinates

e Bin Limits
When the Options tab is selected, the Duration Analysis editor will appear
as shown in Figure 8-2.
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[ Duration Analysis Editor -*

Marmne: “ |

Description: ‘ C]|

Data Set [Mone ~|

DS File Name: | [m)

Report File: ‘ E]|

General| Options | Marual Entry

Output Labeling User-Specified Exceedance Ordinates Bin Limnits

DEE Data Mame is [[] Change or Add to Default values Evenly Spaced

[ change Label Percent of I:l # Bins

D55 Data Units are Time Exceeded -

[ change Lakel 950

500
80.0
500
&1 Rankfir+1) 250
150
) Rankin 10.0
50
20

Flotling Fosition Formula

0.1

[ Plot Duration Curve ] [ Yiew Report ] =1 I QK H Cancel ” Apply

Figure 8-2. Duration Analysis Editor with Options Tab Selected.

Output Labeling

This option allows the user to change the default labels for data contained
in the output tables and

Qutput Labeling plots. The user can
DEE Bt el Ts change both the name of
the data as well as the units
[] Change Lahel | | of the data. The output
DSS Data Units are labeling does not result in
the conversion of data from
[ change Label | | one unit system to another;
it only affects what is

displayed on table headings and the y-axis of the results plot.
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Plotting Position Formula

This option allows the user to choose how the
duration curve is computed (this option is not Plotting Position Formula
available when the Bin method is selected). @) Rankiii+1)

When Rank/(N+1) is selected the program
will compute the duration curve using:

P =100*[M /(n +1)] where M is the ranked

position and n is the number of events. When Rank/N is selected the
program will compute the duration curve using: P =100*[M /n] where M

is the ranked position and n is the number of events.

) RankiM

User-Specified Exceedance Ordinates

This option allows the user to change the ordinates used in computing the
resulting duration curves. The default values listed in percent of time
exceedance are 99,
Llzer-Specified Exceedance Ordinates 95, 90, 80, 50, 25,
15, 10, 5, 2, 1, and
0.1. Check the box
Fercent of next to Change or
Time Exceedead add to default
9.0 values to change or
95.0 add additional
90.00 | values. Once this
ggg box is checked, the
25 1 user can add/remove
150 rows and edit the
10.0 ordinates. To add or
5.0 remove a row from
4.0 the table, select the
1D1” row(s), place the
: mouse over the
highlighted row(s)
and click the right mouse button. The shortcut menu contains options to
Insert Row(s) and Delete Row(s). The program will use the default
values, even if they are not contained in the table, when the Change or
add to default values option is not checked. Finally, all values in the
table must be between 0 and 100.

[]change or add to default values

Bin Limits

The Bin Limits panel is only active when the Bin (STATS) method is
selected on the General tab. This option helps the user to define the limits,
the minimum and maximum values, for each bin. There are two options;
Evenly Spaced and User-Defined. When Evenly Spaced is selected the
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Compute

user must also enter the number of bins. The Extract Bin Limits button
will automatically populate the bin limits table by first extracting the
minimum and maximum values from the data set and then linearly
interpolating evenly spaced bin limits. If Log is selected as the Y-axis
scale on the General tab, then the program converts the minimum and
maximum values to log space before computing the evenly spaced bin
limits. The User-Defined option lets the user manually enter the bin
limits. The user must ensure the minimum and maximum values from the
data set are contained in the bin limits table. For example, if the minimum
flow from the data set is 100.0 then the first row in the table must be less
than or equal to 100.0. Additional rows can be added to the table. Place
the mouse pointer on top of the table and click the right mouse button.
Then select the Insert Row(s)... menu option to open an editor for
specifying the number of rows to insert into the table.

Bin Limits
Evenly Spaced w

10 # Bins

Extract Bin Limits

54578
33,338.20
6613062
98923.05

131,715.47
164,507.89
197,300.3
230,092.73
262 88516
295 677.58
328,470.00

Once the new analysis has been defined, and the user has all of the
General and Options information selected the way they want, performing
the computations is simply a matter of pressing the
Compute button at the bottom of the Duration Analysis
editor. If the computations are successful, the user will
receive a message that says “Compute Complete”. At this point, the user
can begin to review the results.

Multiple Duration analyses can be computed using the Compute
Manager. Select the Analysis=>Compute Manager menu option to open

8-8



HEC-SSP User's Manual Chapter 8 - Performing a Duration Analysis

the Compute Manager. Select the analyses to be computed and then press
the Compute button. Close the compute dialogs and Compute Manager
when the program finished computing the analyses.

Results

This section of the manual describes results that are available for the
Duration analysis. When the user selects the Results tab on the Duration
Analysis editor, the window will appear as shown in Figure 8-3. As
shown, two additional tabs will appear on the screen: Tabular Results

and Plot.
B2 Duration Analysis Susquehanna Standard Method
Marne: |Susquehanna Standard Method |
Description: | E]|
Data Set: | SUSQUEHANNA RIVER v]
D35 File Mame: |C:ITempIDurati0n_AnaIysisIDuration_AnaIysis.dss E]|
Report File: |:isResuItsISuSquehanna_Standard_Meth0dISuSquehanna_Standard_Method.rpiE]|
General | Options| Results |
Tahular Results | Plot
Fercent of Annual - FLOW
Time Exceeded
95.00 9a7.77
95.00 1486.70
90.00 1838.05
g0.00 3005.92
50.00 8095.90
25.00 18022.25
15.00 26771.70
10.00 34462.00
5.00 48097 .55
2.00 T2T93.26
1.00 91998.09
010 170843.05
Compute ] ’ Flat Duration Curve ] ’ Wiew Report ] @ Print ’ QK ] ’ Cancel

Figure 8-3. Results Tab of the Duration Analysis Editor.

Tabular Results

The Tabular Results tab will bring up a table of results for the duration
analysis. The tabular results are different for the Rank All Data Values
and Bin (STATS) methods. An example of tabular results for a Rank All
Data Values analysis is shown in Figure 8-3. The results table will
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contain multiple duration curves if the Quarterly, Monthly, or the User
Defined options are selected as the Duration Period. Data in the duration
curve table can be re-sorted. Click the Percent of Time Exceeded
column header (two mouse clicks are required the first time). The percent
of time exceeded ordinates, along with the duration curve values, will sort
so that the lowest values are on top or the highest values are on top.

The tabular results tab will look different when the Bin (STATS) method
is used to compute the duration analysis. As shown in Figure 8-4, there
are two tables. The first table contains summary information about the
bins and the second table contains the interpolated duration curve.

General | Options | Results
Tahular Results | pPlat

Class Number

Lower Bin Limit

Upper Bin Limit

Mumbet in Bin

Accurm Number

Percent Egual or Exceeded

1.0

20

avEE

100.0

20

30

are1

99.9

3.0

4.0

ara7

99.9

4.0

5.0

22

av4a

49.8

5.0

6.0

ar

arar

99.8

6.0

4.0

BB

aeg0

98.1

4.0

10.0

45

8624

98.4

10.0

15.0

254

8629

473

15.0

20.0

261

42748

94.4

ofm|o|~m ;| e |wk]—=

20.0

an.an

423

a014

91.4

Percent of
Time Exceeded

Annual - FLOW

99.0

6.4

95.0

14.2

40.0

233

a0.0

45.0

50.0

171.4

25.0

368.2

15.0

518.8

10.0

BEZ.1

5.0

906.4

20

12673

Figure 8-4. Results Tab for a Bin (STATS) analysis.

Plot

In addition to tabular results, a Plot tab is available for viewing a graphical

plot of the duration curves. When the Plot tab is selected the window will
change to what is shown in Figure 8-5. The plot contains the computed
duration curve and the duration curve interpolated to the user-defined

ordinates (defined on the Options tab). Multiple duration curves will be

graphed if the Quarterly, Monthly, or User Defined options are selected as

the duration period.
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B Duration Analysis Susquehanna Standard Method

Marme: Susguehanna Standard Method
Description: E]
Data Set: SUSQUEHANNA RIVER b
DSS File Mame: | caTernpiDuration_Analysis\Duration_Analysis.dss )
Report File: [isResultsiSusguehanna_Standard_MethodiSusguehanna_Stand:()
General | Options | Results
Tahular Results | Flot
Dutkan M@k Pl far Srsquehanm Sandard Mahad

JE0 000

200000 =

2501000 -

200000 —
3
g b
“ 150000

IEIJJIIJ—T

\
4
SO0 <'0._
“¢hh‘w_
—
. T N -
o T T T T T T T # ______ $——t b
n 10 il n an an (=1} Ta 1) a0 100
Farcgn. of Time Exceaded

|+ Interpolated Coppe - ----- Computed Cunve
| Ccorpute | l Plot Duratian Curve ] [ view Report ] & l oK H Cancel

Figure 8-5. Plot Tab of the Duration Analysis.

Manual Duration Analysis

The user has the option to manually define a duration curve. This option
would be used when a duration curve has been computed outside of HEC-
SSP. The “None” data set must be selected in order to define a duration
curve manually. When the Manual Entry tab is selected, the editor will
display a plot and table as shown in Figure 8-6. The table allows the user
to enter data values for the percent of time exceedance ordinates defined
on the Options tab. When the user enters values in this table, those values
will be plotted as a line on the plot after the Compute button is pressed.
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% Duration Analysis Manual Entry Curve g@§|
Narme Manual Entry Curve
Description [m]
Diata Set None -
D53 File Name: | caTempiDuration_aAnalysisiDuration_Analysis.dss [J
Report File SaTempiDuration_Analysis\DurationAnalysisResultsiManual_Entry_CureiManual_Entry_Curve rpi_)
General | Options | Results | Manual Entry
Variable Manual Duration Analysis Plotfor Manual Entry Curve
Nare: [Frow 180,000
Units: | ofg
160,000
Percent of Flovy
Time Exceeded 140,000
99.0 912.78
95.0 2380.78
90.0 4216.77 120,000
80.0 TRA5.7T
50.0 18895.76
25.0 28070.74 100,000
150 74074 £ '
10.0 35969.63 =
50 AR2A7 07| E i
2.0 7E7E3.32 o 80,000
1.0 9504758
0.1 176618.73 a0,000
40,000
20,000+
1} T T T T T T T T T
a 10 20 a0 40 a0 a1} 70 a0 a0 100
Percent of Time Exceeded
‘ Manual-Entry Curve
[ Compute | [ PotDuationcuve | [ viewRepot | | £

Figure 8-6. Manual Entry Tab of the Duration Analysis Editor.

Viewing and Printing Results

The user can view output for the duration analysis directly from the
Duration Analysis editor (Tabular and Graphical output) or by using the
buttons at the bottom of the editor. Results can also be opened by
selecting the duration analysis in the study explorer and then choosing the
Graph, Table, or Report option available from the Results menu.

Tabular Output

Once the computations for the duration analysis are completed, the user
can view tabular output by selecting the Tabular Results tab under the
Results tab. The details of this table were discussed above.

The tabular results can be printed by using the Print button at the bottom
of the Duration Analysis editor. When the print button is pressed, a
window will appear giving the user options for how they would like the
table to be printed.
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Graphical Output

Graphical output of the duration curve can be obtained by selecting either
the Plot tab under the results tab, or by pressing the button labeled Plot

Duration Curve at the bottom of the Duration Analysis editor. When the
Plot Duration Curve button is pressed, a duration curve plot will appear in

a separate window as shown in Figure 8-7.

r

B2 Duration Analysis Plot for Susquehanna Standard Method

File Edit iew ‘Window

Duration Analysis Plot for Susguehanna Standard Method

@ 250,000
300,000
250000

200,000+

150,000

FLOWY in cfs

1EIEI,EIEIEI-|'*

50,0001 %,

Fercent of Time Exceeded

—4— |nterpolated Curve

------ Computed Curve

Figure 8-7. Duration Curve Plot.

The duration curve plot can be sent to the printer by selecting the Print
option from the File menu at the top of the window. Additional printing
options available from the File menu are Page Setup, Print Preview, and
Print Multiple (used for printing multiple graphs on the same page). The
graphic can also be sent to the Windows Clipboard by selecting Copy to
Clipboard from the File menu. Additionally, the plot can be saved to a
file by selecting the Save As option from the File menu. When the Save
As option is selected, a window will appear allowing the user to select a
directory, enter a filename, and select the format for saving the file.
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Currently four file formats are available for saving the graphic to disk:
windows metafile, postscript, JPEG, and portable network graphic.

The data contained within the plot can also be tabulated by selecting
Tabulate from the File menu. When this option is selected, a separate
window will appear with the data tabulated. Additional options are
available from the File menu for saving the plot options as a template
(Save Template) and applying previously saved templates to the current
plot (Apply Template).

The Edit menu contains several options for customizing the graphic.
These options include Plot Properties, Configure Plot Layout, Default
Line Styles, and Default Plot Properties. Also, a shortcut menu will
appear with further customizing options when the user right-clicks on a
line on the graph or the legend. Both the Y and X-axis properties can be
edited by placing the mouse on top of axis and clicking the right mouse
button. Then select the Edit Properties menu option in the shortcut
menu. For example, the user can turn on minor tic marks for the y-axis
and modify the minimum and maximum scale for the x-axis. The graphic
customizing capabilities within HEC-SSP are very powerful, but are also
somewhat complex to use. The code used in developing the plots in HEC-
SSP is the same code that is used for developing plots in HEC-DSSVue
and several other HEC software programs. Please refer to the HEC-
DSSVue User’s Manual for details on customizing plots.

Viewing the Report File

A report file is created when the duration analysis computations are
performed. The report file contains information about the duration
analysis and the final results. To view the report file press the View
Report button at the bottom of the Duration Analysis editor. When this
button is pressed, a window will appear containing the report as shown in
Figure 8-8.
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Eile Edit 3Search Farmat

File: CATemplDuration_AnalysisiDurationAnalysisResultsiSusguehanna_Standard_MethochSusguehanna_Standard_Method rpt

Duration Analysis
17 Mar 2010 10:43 AM

--- Input Data ---

Analysis Name: Susgquehanna Standard Method
Description:

D533 File Name: C:\Temp\Duration Analysis‘\Duration dnalysis.dss
DiG Pathnawe: /SUSQUEIANNA RIVER/BLOOMSEURG, PA/FLOW/01JAN1G9S/1DAY/COMPUTEDZ/

Project Path: C:\Temp\Duration nalysis
Report File Nam \Tenp)Duration_AnalysisiDurationinalysisResults)Susquehanna_Standard MethodSusquehanna_Standard Method.rpt
Result File Name: C:\Temp)Duration_inalysis‘DurationhnalysisResults)Susquehanna_Standard Method\$usquehanna_Standard Method.xml

Duration Analysis Method: Standard

Duration Plot Position Method: Rank/ (N+1)

X-hxis Hcale: Linear

Duration Peried: Annual

Use Standard Percent Exceedance

Display ordinate walues using 2 digits in fraction part of walue

--- End of Input Data ---

Arrmal Duration Analysis
Time Period: 0lJan - 3lDec

Mumber Valid Values: 40480
Mumber Missing Values: 0

Minimum Value: 545.78
Mawimum Value: 328,470.00

FLOW
cf=

Percent of
Time Exceeded

|

I

|

I 997.77
| 1,486.70
I 1,938.05
I 3,005.92
I 8,095.90
| 18,022.25
| 26,771.70
I

.

34,462.00
A0 na7 cc

| [40:1_40:1

40:1

Figure 8-8. Duration Analysis Report File.
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CHAPTER 9

Performing a Coincident Frequency
Analysis

This chapter discusses in detail how to use the Coincident Frequency
Analysis editor in HEC-SSP. A coincident frequency analysis can be
performed on any data type; flow, stage, precipitation, wind, etc. The
coincident frequency analysis requires both duration and frequency
curves. These can be computed by existing analyses in the HEC-SSP
study or they can be entered manually in the coincident frequency analysis
editor.

The Coincident Frequency Analysis is designed following guidelines in
EM 1110-2-1415. This analysis tool can be used to compute the
exceedance frequency relationship for a variable that is a function of two
other variables. An example is illustrated in Figure 9-1. In this example,
the stage at the damage site on the tributary, variable C, is a function of
stream flow from the tributary, variable A, and the stage in the mainstem
river, variable B.

A=
Tributary
Flow

/

C=
Tributary A =Trbutary Flow — probability distribution *known”

Stage at B = Mainstem Stage — probability distribution *known”
damage site

B=
Mainstem

Stage C = Tributary Stage — probability distribution not known,

value computed f(A,B)

Figure 9-1. Example Application of the Coincident Frequency Analysis.

The general procedure for performing a coincident frequency analysis,
using HEC-SSP is described below.

1) Develop a duration curve for variable B. This can be done using the
Duration Analysis editor or it can be defined manually in the
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Coincident Frequency Analysis editor. Then discretize the duration
curve to determine index values for variable B. The index values
should be defined so that the area under the discretized duration curve
approximates the original duration curve. Figure 9-2 shows a flow
duration curve that has been discretized using 9 index points. The
index points are taken at the midpoint of each discrete segment and
there are more index points along the steeper portion of the duration
curve. The Coincident Frequency Analysis editor can be used to
define the index points and to estimate the proportion of time for each
index point. For example, the 9" index point in Figure 9-2 is taken at
the midpoint for the discrete segment from 100 to 60 percent of time
exceeded. The flow value at this point represents the variable B index
occurring 40 percent of the time. The 8" index point is taken at the
midpoint for the discrete segment from 60 to 40 percent of time
exceeded. The flow value at this point represents the variable B index
occurring 20 percent of the time. The proportion of time assigned to
each index point will be used to compute the variable C frequency
curve.

180,000 ‘
160,000
140,000 ’L
120,000

00,000

FLOWIn

80,000 |
4

60,000

40,000

20,000

0 10 0 30 40 50 60 mn 80 a0 100
Percent of Time Exceaded

Figure 9-2. Variable B Duration Curve Divided into Discrete Segments.

2) Different procedures are required depending on whether variables A
and B are independent or not independent of one another. When
variables A and B are assumed independent of one another, develop a
frequency curve of variable A. The frequency curve can come from an
existing Bulletin 17 or General Frequency analysis or it can be defined
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manually in the Coincident Frequency Analysis editor. If variables A
and B are not independent of one another, then develop a frequency
curve of variable A for each variable B index value. In this case, the
variable A frequency curves must be defined manually in the
Coincident Frequency Analysis editor. This involves extracting
annual peak values for variable A that occur for each discrete range
identified on the variable B duration curve and performing a separate
frequency analysis on each set of variable A data.

3) Develop the response of variable C for combinations of variable A

and variable B. This could be done using a hydrologic or hydraulic
model. For the example shown in Figure 9-1, a flow value from the
variable A frequency curve would be applied to the tributary and the
index flow (or stage) from the variable B duration curve would be
applied to the mainstem. The hydrologic or hydraulic model would be
used to compute the variable C stage at some reference point on the
tributary. This model simulation would be computed for many
combinations of variable A and variable B. Figure 9-3 shows example
output from a hydraulic model. The model was used to generate
output from multiple combinations of variable A and B values. In this
example, there were 12 variable A values and 9 index values from
variable B. This resulted in 108 simulation results. The table shown
in Figure 9-3 is referred to as the Response Curves table in HEC-SSP
and these values must be entered by the user.

Variable B Index
/ Values
vatiable & || B1=300582 | B2-809590 | B3=1405368 | B4=21795.00 | B5=30080.62 | B6=38067.52 | B7=51667.13 | BA=72793.26 | BO=112645 41
C=fAB1) | C=fAB2) | C=f(AB3) | C=fAB4) | C=fAB5) | C=fABB) | C=TABT | C=fAEE) | C=fABY)
66,039 461.96 a61.97 461.37 46197 361.97 461.96 361.36 361.96 461.69)|
54,354| 477.24 477.24 477.25 47726 47728 477.32 47737 4775 477.91)|
46,370]| 475.02 475.03 475.05 475.07 47511 47518 47531 475,45 475.97)|
28,053 473.03 473.04 473.07 47311 47318 473.28 47347 473.77 474 45|
30,296)| 470.94 470,95 470.9% 471.02 471.08 4712 471.42 471.89 a72.78)|
24,264)| 468,59 468,61 468.64 469.69 468,77 460.9 47013 470.71 a71.74||
16,631)| 467.78 467.91 467.97 466.07 466,22 466.42 466,78 468,54 470.83)|
11,39)| 465.04 465,06 465.27 465.47 465.71 466.04 466,64 467 86 468.75|
7.095)| 463.82 463,82 463.82 463.89 464.08 464,52 46533 466.87 468.21)|
5,578 463.37 463,37 463.36 463.38 463,52 463.99 464,55 466.57 468.03|
4,589 463.02 463.02 463.02 463.02 463.14 463.65 464,62 46636 466.94||
5210 462.47 46347 462.47 462.47 462 59 4632 464 75 466,12 468,82
Variable A Variable C Results
ariabie =
from Hydraulics Model
Values

Figure 9-3. Response of Variable C for Combinations of Variable A and
Variable B.

4) The program computes the variable C frequency curve by first using the

response curves to compute conditional frequency curves of variable C.
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This is done by assigning the same frequency from the variable A value
to the corresponding variable C value. Then for a selected value of
variable C, the frequency value from each conditional frequency curve

is multiplied by the corresponding proportion of time (probability) from

the variable B index value. The values are summed to obtain the
frequency of the selected value of variable C. This is done for a

number of values of variable C until a complete frequency curve is

created.

Contents

Starting a New Analysis
General Settings

Variable A

Variable B

Response Curves

Viewing and Printing Results

Starting a New Analysis

A coincident frequency analysis can be started in two ways, either by right
clicking on the Coincident Frequency Analysis folder in the study explorer
and selecting New, or by going to the Analysis menu and selecting New
and then Coincident Frequency Analysis. When a new coincident
frequency analysis is selected, the Coincident Frequency Analysis editor
will appear as shown in Figure 9-4.
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-
B Coincident Frequency Analysis Editor, -*

Mame |
Description: [:]
DEE File Mame: [
Repart File =
General | variable & | Vatiable B| Response Curves | Results
Wariahle A User Specified Frequency Crdinates
(%) A and B can be Assumed Independent (Marginal Frequency Curve for &) [ Use Values fram Table Belaw
() Aand B can not be Assumed Independent (Conditional Frequency Curves far &) N
Frequencyin Percent
Yariable B 0.2
Number of Index Values 3|8 ?g
20
Output Laheling 50
Data Name oA
20.0
Data Units 50.0
80.0
- Seale Sl
95.0
(& Linear 99.0
O Log
View Report =] [ Ok ] [ Cancel ] [ Apply

Figure 9-4. Coincident Frequency Analysis Editor.

The user is required to enter a Name for the analysis, while a Description
is optional. Once a Name is entered, the DSS File Name and Report File
will automatically be filled out. The DSS filename is by default the study

DSS file. The report file is given the same name as the analysis with the
extension ".rpt".

General Settings

Once the analysis name has been entered, the user can begin to perform
the computations. Contained on the Coincident Frequency Analysis editor
are five tabs. The tabs are labeled General, Variable A, Variable B,
Response Curves, and Results. The first tab contains general settings for

performing the coincident frequency analysis (Figure 9-4). These settings
include:

e Variable A

Variable B

Output Labeling

Y-AXxis Scale

User Specified Frequency Ordinates
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Variable A

This option allows the user to choose whether the coincident frequency
analysis assumes variables A and B are independent or dependent. When
variables A and B can be assumed independent, there will be only one
frequency curve for variable A. A conditional variable A frequency curve
assumes variables A and B are not independent, so there will be a separate
variable A frequency curve for each variable B index value.

Wariable A

(& & and B can be Assumed Independent (Marginal Frequency Cure far &)

() & and B can not be Assumed Independent (Canditional Freguency Curves far A

Variable B

This option allows the user to define the number of index values for
variable B. The index points are used to discretize the duration curve. A
probability, or a proportion of time, will be assigned to each index point.

Yariable B

Fumber of Index Walues

Output Labeling

This option allows the user to enter labels for data contained in the output

tables and plots. The

Cutput Labeling
Data Mame |stage

Data Units | faat

user must enter the
name of the data as
well as the data units.
The output labeling
does not result in the

conversion of data

from one unit system to another; it only affects what is displayed on table
headings and the y-axis of the results plot.

Y-AXxis Scale

This option allows the user to choose the scale of the y-axis. The options

-Axis Scale
(%) Linear
O Log

are Linear and Log. This option will affect the
y-axis scale in the coincident frequency curve
plot.
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User Specified Frequency Ordinates

User Specified Frequency Ordinates This option allows the user to change the
frequency ordinates used for creating result tables
Ll el o Taile el and graphs. The default values listed in percent

chance exceedance are 0.2, 0.5, 1, 2, 5, 10, 20, 50,
0.2 80, 90, 95, and 99. Check the box next to Use
G Values from Table below to change or add
1.0 additional values. Once this box is checked, the
2.0 user can add/remove rows and edit the frequency
5.0 values. To add or remove a row from the table,
10.00 | select the row(s), place the mouse over the
;gg highlighted row(s) and click the right mouse
200 button. The shortcut menu contains options to
900 Insert Row(s) and Delete Row(s). The program
95.0 will use the default values, even if they are not
99.0 contained in the table, when the Use Values from
Table below option is not checked. Finally, all
values in the table must be between 0 and 100.

Freguency in Percent

Variable A

The Variable A tab is used to define the frequency curve for variable A.
This tab will look different based on the user’s selection on the General
Tab. The Variable A tab will look like Figure 9-5 when “A and B can be
Assumed Independent” is selected on the General tab. Since variables A
and B are independent, there will only be one frequency curve for variable
A

As shown in Figure 9-5, the user can choose to define the curve manually
or select an existing study analysis. When the Manual Entry option is
selected, the user must define the Data Name and Data Units. Then the
user must enter the frequency curve for variable A. A frequency curve
value must be defined for each percent chance exceedance ordinate in the
table. When the Existing Study Analysis option is selected, the
dropdown list will be active and the user can choose any Bulletin 17B or
General Frequency analysis in the HEC-SSP study. The variable A
frequency curve table will be populated with the frequency curve when an
analysis is selected. The program uses the statistics from the selected
analysis and computes the frequency curve that populates the table.
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) Manual Entry
Diata Mame

Data Units

(%) Existing Study Analysis

General | Variable A | variable B | Response Curves | Results

Specify Frequency Curve Yariahle A Fregquency Curve
Percent Chance F LW

Exceedance

0.2 GEO3Y

0.4 A4354

1.0 46370

2.0 38053

5.0 30296

10.0 24265

20.0 18631

A0.0 11395

80.0 7095

a0.0 a578

95.0 45849

4950 3210

Figure 9-5. Variable A Tab when Variable A and B are Independent.

The Variable A tab will look like Figure 9-6 when “A and B can not be
Assumed Independent” is selected on the General tab. A conditional
variable A frequency curve assumes variables A and B are not
independent, so there will be a separate variable A frequency curve for
each variable B index value.

As shown in Figure 9-6, the user must define the Data Name and Data
Units. Then the user must manually enter the variable A frequency curve
for each index value of variable B. This involves extracting the annual
peak values for variable A that occur for each discrete range identified on
the variable B duration curve and performing a separate frequency
analysis on each set of variable A data. Also, a frequency curve value
must be defined for each Percent Chance Exceedance ordinate in the table.
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General| Yariable A | variable BE| Response Curves || Results
Wariahle A
Data Mame | Floyw

Data Units |15

Wariable A Conditional Freguency Curves

Fercent Chance Flaw P{A[ET) Flowye P{AIEZ) Flow PiA[E3) Flawe P{AE4) Flawe PiAIES)
Exceedance
0.2 4537 1 194496 236722 303103 587051
0.5 38773 14805.0 18661.1 254426 438473
1.0 33958 11950.8 154872 220828 41974 6
2.0 29289 95639 127605 1849720 355677
5.0 23320 G996.3 497259.8 151936 27746.8
10.0 18929 54135 77938 125434 222560
20.0 1458.8 4073.3 GO09E.4 100145.3 170429
50.0 865.0 25516 4083.9 BES0.2 102331
80.0 496 5 1756.0 297349 45371 E147.49
50.0 366.6 14952 2598.0 37546 4711.48
850 2834 13311 23574 32285 37824
499.0 171.9 1111.0 2031.2 24637 250649

Figure 9-6. Variable A Tab when Variable A and B are not Independent.

Press the Plot button located at the lower left corner of the Variable A tab
to open a plot of the variable A frequency curve(s).

Variable B

The Variable B tab is used to define the duration curve for variable B and
the index points with an associated probability. The index points will be
used by the user when developing the response curves (response of
variable C to each combination of variables A and B). The associated
probability represents the proportion of time that each index point can be
expected to occur.

As shown in Figure 9-7, the left side of the variable B tab is used to select
the duration curve from an existing Duration Curve analysis. Once
selected, the program populates the duration curve table. Press the Plot
button located at the lower left corner of the Variable B tab to open a plot
of the variable B duration curve.
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General | Wariable A| Variahle B | Response Curves | Results
Curation Curve Cevelop Probabilities fram Duration Curve
Import Duration Curie MNumber of Index Paints 9
Duration Curve Test13 hd () Define Automatically
Percant of Annual - FLOVY () Define fram Index Points
Time Exceeded O Define from Probabilities
99.0 4978
95.0 1486.7
an.0 14381 Generate Tabla
80.0 3005.9
50.0 80585.9 Prohatility Index Break Paint
2ol Te0z2 40.00 3005.92 100.00
16.0 26771.7 G000
10.0 344F3 0 20.00 §095.90
40.00
15.00 16044.34
50 48097.6 2500
10.00 22396.97 :
20 72793.3 1500
10 51658 1 5.00 3061685
10.00
4.00 40316.22
0.1 1700426 6.00
3.00 53046.83 :
2.00 7279326 2D
1.00 13585613 1.00
0.00

Figure 9-7. Variable B Tab.

After the duration curve has been selected, the right side of the variable B
tab is used to define the index points and associated probabilities used to
discretize the duration curve. The number of index points is defined on
the General tab and is included on the Variable B tab to let the user know
how many index points must be defined in the table. There are 4 methods
for defining the index values and the associated probabilities. The user
selects one of the methods, edits the table, and then clicks the Generate
Table button in order for the program to finish populating the table. The
following text describes each method.

Define Automatically. The program will use a predefined pattern of
probability ranges when this option is selected, as contained in Table 9-1,
to populate the Probability column. The pattern is dependent on the
number of index points and the default probability patterns do not extend
beyond nine index points. If more than nine index points have been
selected for the analysis, then use one of the other methods for defining
the index points and associated probabilities. The program will compute
the Index and Break Point columns when the Generate Table button is
pressed. The Break Point column is computed using the probability
pattern. The first row in this column is always 100. The second break
point is computed by subtracting the first probability value from the first
break point value. The third break point is computed by subtracting the
second probability value from the second break point value. This
procedure is followed until the last break point is computed; it should
always have a value of 0. The Index values are taken from the duration
curve at the midpoint between each break point range. For example, if the
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first break point was 100 and the second was 60 then the first Index value
would be the value from the duration curve at 80 percent time exceeded.

Table 9-1. Default Probability Patterns.
Number of Index Points

Index 3 4 5 6 7 8 9
20 15 45 35 35 35 40
60 35 40 30 25 20 20
10 35 10 20 20 15 15
15 4 10 10 10 10

4 6 10 5
3 4
1 3 3
3
1

[y

© 00 N O OB~ WD

Define from Index Points. The number of rows is set by the number of
index points. In this case, the Index column is edited by the user; the user
must enter an index value in each row. When the Generate Table button
is pressed, the program will compute the Break Point and the Probability
values. First, the program will use the selected duration curve and
interpolate a percent of time exceeded for each user-defined index value.
Then break points are computed so that they are half way between the
percent of time exceeded values (the first and last break points will be 100
and 0). The probability values are computed based on the break points.
For example, the first probability value is computed by subtracting the
second break point value from the first. The second probability value is
computed by subtracting the third break point value from the second. This
procedure is followed until the last probability value is computed.

Define from Probabilities. The number of rows is set by the number of
index points. In this case, the Probability column is edited by the user;
the user must enter a probability value in each row (the probability values
should add up to 100). When the Generate Table button is pressed, the
Break Point column is computed using the user-entered probability
pattern. For example, the first row in the break point column is 100;
therefore, the second break point is computed by subtracting the first
probability value from the first break point value. The third break point is
computed by subtracting the second probability value from the second
break point value. This procedure is followed until the last break point is
computed,; it should always have a value of 0. The Index values are taken
from the duration curve at the midpoint between each break point range.
For example, if the first break point was 100 and the second was 60 then
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the first Index value would be the value from the duration curve at 80
percent time exceeded.

User-Specified Index Points and Probability Ranges. This option can
only be selected when the user does not select an existing Duration Curve
to import. This would be applicable for the case where the user developed
the duration curve outside of HEC-SSP and developed the index points
and associated probabilities. As shown in Figure 9-8, the user must
specify both the Probability and Index values; the user must enter values
in each row. When the Generate Table button is pressed, the Break
Point column is computed using the user-entered probability pattern. For
example, the first row in the break point column is 100; therefore, the
second break point is computed by subtracting the first probability value
from the first break point value. The third break point is computed by
subtracting the second probability value from the second break point
value. This procedure is followed until the last break point is computed; it
should always have a value of 0.

Dwration Curve

Import Curation Curve

Mone

Percent of

General | Wariable A| Variahle B | Response Curves | Results

Cevelop Probabilities fram Duration Curve

Mumber of Index Paoints 7

Time Exceeded

(& User-Specified Index Points and Probability Ranges

[ Generate Tahle

Prabahility Incles Break Paint
2094 260547 100.00
25.94 736361 £9.06
16.81 1520250 4313
12.00 2524055 24.31
f.31 4068211 12.31
156 6380737 5.50

1.94 11382711 1.94
0.00

Figure 9-8. User-Specified Option to Define Index Points and Probability
Ranges.

Response Curves

The Response Curves tab is used to define the response of variable C to
each combination of variable A and variable B. This analysis is
performed outside of HEC-SSP. For example, a hydraulics model could
be used to apply flow values from the variable A frequency curve to the
tributary and the index flow (or stage) from the variable B duration curve
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would be applied to the mainstem. The hydraulics model would be used
to compute the variable C stage at some reference point on the tributary
for multiple combinations of variable A and variable B. The peak variable
C stage is the value to input into the Response Curves table.

As shown in Figure 9-9, there are two options for the Response Curves
table; Same Variable A for each index or Different Variable A for each
index. When the Same Variable A for each index option is selected,
there is only one Variable A column in the response curves table. The
user can manually fill in the values for Variable A or press the Import
Variable A button. When the button is pressed, the program will import
the values on the Variable A tab. The user can edit the Variable A values
after they are imported. When the Different Variable A for each index
option is selected, there is a separate Variable A column for each variable
B index value, as shown in Figure 9-10. The user can manually fill in the
values for Variable A or press the Import Variable A button. When the
button is pressed, the program will import the values from the Variable A
tab. The user can edit the Variable A values after they are imported. In
most cases, the Different Variable A for each index options will be used
when performing a conditional analysis (variables A and B can not be
assumed independent). In this case, a separated variable A frequency
curve was defined for each variable B index value; therefore, when the
Import Variable A button is pressed the program will import the
corresponding frequency curve into the response curves table.

The user must compute the variable C value given the combinations of
variables A and B. Figure 9-9 contains 12 values of variable A and 9
index values for variable B. Therefore, the user would have 108
combinations of variables A and B to compute values of variable C. Once
computed, the user would manually enter the variable C values into the
response curves table. For example, the first value in the first variable C
column in Figure 9-9 is 481.38. This was computed using a variable A
value of 66039 and a variable B value of 3005.92.

The Plot Response Surface button will open a plot similar to the one
shown in Figure 9-11. Each line in the response surface plot shows the
variable C versus variable A relationship for a given variable B index
value.
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General | Variable &) Variahle El| Response Curves | Results

Wariahle A
(%) Same Yariahle Afor each index

() Different Variable Afor each index

’ Import Variable A

Yariahle A B1=3005.92 | B2=8095.90 | B3=14053.68 | B4=21795.00 | B5=30089.62 | B6=38967 52 | BF=51657.13 | B8=V2793.26 |B9=112646.41
C=1fAB1) C=1ABZ) C=1(AB3) C=1AB4) C=1(AB5) C = 1A BE) C=fABT) C = f(ABE) C =1{A,B9)

GE039 481.38 481.37 481.37 481.37 481.37 481.36 481.36 481.36 481.69
54354 47724 47724 47725 47726 477.28 47732 47737 477.8 4779
46370 475.02 475.03 475.05 475.07 47511 47518 47531 47548 47597
39053 473.03 473.04 473.07 473.11 47318 47328 47347 47377 474.45
30296 470.94 470.95 470.98 471.02 471.09 471.2 471.42 471.89 472.78
243265 469.59 469.61 469.64 469.69 469.77 469.9 47013 470.71 471.74
18631 467.78 467.91 467.97 468.07 468.22 468.42 468.78 469.54 470.82
11395 465.04 465.06 46527 465.47 465.71 466.04 466 64 467 86 469.75
7095 463.82 463.82 463.82 463.89 464.09 464.52 465.33 466.87 469.21
5578 463.37 463.37 463.36 463.38 463.52 463.99 464.88 466.57 469.03
4539 463.02 463.02 463.02 463.02 46314 463,65 464 62 466,36 463.94
3210 46247 46247 462.47 462.47 462.59 463.2 464.28 46612 468.82

Flot Response Surface ]

Figure 9-9. Response Curves Tab for Same Variable A for Each Variable B
Index.

General | Variahle & | Variable B| Respanse Curves | Results

Wariahle &

) Same Variabla A for each index

@ Different variahle A for sach index

[ Import Yariable A
‘ariable & BE1=3334.00 Wariahle & B2=12975.25 Wariahle & B3=34462.00 Yariable & B4=F2059.41 Wariahle & B5=112646.41
C=f(aB1) C=1ABZ C=1AB3 = f(A,B4) C = f(4,B5)

46371 463.01 19449.6 468.2 236722 469.54 30310.3 471.22 587051 478.81
38773 46276 14805.0 466.5 186611 468.06 254426 47017 48847.3 476.08
33945.8 462.85 11950.8 465.3 15487.2 46696 220828 469.39 419746 474.44
2928.9 462.35 9563.9 464.459 127609 465.97 18872.0 468.53 355677 472.99
23320 462.08 f996.3 4638 §729.8 464.8 151936 467.35 27746.8 471.39
18929 461.8 54135 463.31 77938 464.08 125434 466.47 22256.0 470.31
1458.8 461.54 4073.3 462.83 G098.4 463.54 10015.3 465.61 17042.9 469.19
865.0 461.12 2551.6 46216 4083.9 462.84 BES0.2 464.42 102331 467.59

496.5 460.81 1786.0 461.73 29739 462.37 45371 463.71 6147.9 466.68

366.6 460.649 1485.2 461.56 2598.0 462.18 37546 463.45 4711.5 466.4

283.4 460.59 13311 461.46 23579 462.06 32285 463.29 37824 466.22

17189 460.46 1111.0 461.31 2031.2 461.89 24637 463.07 2505.9 466.02

Plot Response Surface ]

Figure 9-10. Response Curves Tab for Different Variable A for Each Variable B
Index.
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Flle Edit View
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Figure 9-11. Plot of Response Curves.
Compute

Once the new analysis has been defined, and the user has all of the
information defined on the General, Variable A, Variable B, Response
Curves tabs, performing the computations is simply a matter of pressing
the Compute button at the bottom of the Coincident Frequency Analysis
editor. If the computations are successful, the user will receive a
message that says “Compute Complete”. At this point, the user can begin
to review the results.

The following describes how the variable C coincident frequency curve is
computed.

1) The program uses the variable A frequency curve(s) and the variable A
values in the response curves table to assign a frequency of
exceedance to each variable C value in the response curves table.

2) The program finds the minimum and maximum values of variable C in
the response curves table.

3) The program defines 100 evenly spaced values of variable C in-
between the minimum and maximum values (100 values include the
minimum and maximum values).
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4) For each variable C from step 3, the program will look-up the
exceedance frequency value from each response curve in step 1 and
multiply by the corresponding proportion of time (using the
probability defined on the Variable B tab) obtained from the variable
B index value. These “weighted” values from each response curve are
summed to compute the variable C frequency curve.

5) The curve is interpolated to the selected exceedance ordinates defined
on the General tab.

Multiple coincident frequency analyses can be computed using the
Compute Manager. Select the Analysis=>Compute Manager menu
option to open the Compute Manager. Select the analyses to be computed
and then press the Compute button. Close the compute dialogs and
Compute Manager when the program finishes computing the analyses.

Results

This section of the manual describes results that are available for the
Coincident Frequency analysis. When the user selects the Results tab on
the Coincident Frequency Analysis editor, the window will appear as
shown in Figure 9-12. Both tabular and graphical results are included.
The percent chance exceedance ordinates are the same as those defined on
the General tab. In addition, the Data Name and Data Units defined on the
General tab are used in the column header in the results table and the y-
axis label in the plot.

General | Variable A | Variable B | Response Curves | Results

Coincident Frequency Plot for Coincident Freq Test 15
Return Period

Percent Chance

Exceedance £200

0.2 479.16 1.0 11 2 5 10 50100 500 10000
05 47626 480 L L L L f | Lo L1

1.0 474.44
20 47279 ;
5.0 471.05 4787 /
10.0 459,83 /
200 468.19 1764

50.0 45551

80.0 463.96
90.0 45342 4744 /
95.0 463.05

99.0 462.44 y

472

458 /
455 1

154 .

Stage In feet

462 T T T T L
0.6938 0.999 0.8%9 04 0.4 0z 041 002 0005 0001 0.0001

Frohahility

Computed Curve

i Plot Conditional Frequency Curves |

Figure 9-12. Results Tab of the Coincident Frequency Analysis Editor.
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By pressing the Plot Condition Frequency Curves, the user can plot the
response curves entered on the Response Curves tab along with the
computed curve and the upper and lower accurate limits.

[£] conditional Frequency Plot 0 S

File Edit View

E 482

480 -

Upper Accurate Limit

478 -

476

5
3
L

5
3
L

Stage in fest
\

a7n 4 Lower Accurate Limit

44—

462 T T T T T T T
0.9999 0.999 099 09 0.8 o1 o.01 0.001 0.oo01

Probability

A, 3008 92)
C=fA,40316.22)

C=iA,B005.9)
=8, 53046 54)

C=fA,15094.39)
C=f(A72Z7O3.26)

A, 2230607
C=fn, 13555638

C=f(,30616.85)
Computed

Figure 9-13. Plot of Conditional Frequency Curves.

Data in the frequency curve table can be re-sorted. Click the Percent
Chance Exceedance column header (two mouse clicks are required the
first time). The percent chance exceedance ordinates, along with
frequency values, will sort so that the lowest values are on top or the
highest values are on top.

Viewing and Printing Results

The user can view output for the coincident frequency analysis directly
from the Coincident Frequency Analysis editor (tabular and graphical
output) or by using the buttons at the bottom of the editor.
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Tabular Output

Once the computations for the coincident frequency analysis are
completed, the user can view tabular output by selecting the Results tab.
The tabular results can be printed by using the Print button at the bottom
of the coincident frequency analysis editor. When the print button is
pressed, a window will appear giving the user options for how they would
like the table to be printed. Result tables can also be created from the
Results menu. At least one coincident frequency analysis must be
selected in the study explorer before selecting the Results—> Table option.

Graphical Output

Graphical output of the coincident frequency analysis can be obtained by
selecting either the Results tab, or by pressing the Plot button at the
bottom of the coincident frequency analysis editor. When the Plot button
is pressed, a frequency curve plot will appear in a separate window as
shown in Figure 9-14. Result graphs can also be created from the Results
menu. At least one coincident frequency analysis must be selected in the
study explorer before selecting the Results>Graph option. Results will
be graphed in the same plot if multiple coincident frequency analyses are
selected in the study explorer when opening a graph from the Results
menu.

The coincident frequency curve plot can be sent to the printer by selecting
the Print option from the File menu at the top of the window. Additional
printing options available from the File menu are Page Setup, Print
Preview, and Print Multiple (used for printing multiple graphs on the same
page). The graphic can also be sent to the Windows Clipboard by
selecting Copy to Clipboard from the File menu. Additionally, the plot
can be saved to a file by selecting the Save As option from the File menu.
When the Save As option is selected, a window will appear allowing the
user to select a directory, enter a filename, and select the format for saving
the file. Currently four file formats are available for saving the graphic to
disk: windows metafile, postscript, JPEG, and portable network graphic.
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-

@ Coincident Frequency Plot for Coincident Freq Test 15 =ARCIR X
File Edit View Window
Coincident Freguency Plot for Coincident Freg Test 15
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Frobabhility

| Computed Curve

Figure 9-14. Coincident Frequency Analysis Plot.

The data contained within the plot can also be tabulated by selecting
Tabulate from the File menu. When this option is selected, a separate
window will appear with the data tabulated. Additional options are
available from the File menu for saving the plot options as a template
(Save Template) and applying previously saved templates to the current
plot (Apply Template).

The Edit menu contains several options for customizing the graphic.
These options include Plot Properties, Configure Plot Layout, Default
Line Styles, and Default Plot Properties. Also, a shortcut menu will
appear with further customizing options when the user right-clicks on a
line on the graph or the legend. Both the Y and X-axis properties can be
edited by placing the mouse on top of axis and clicking the right mouse
button. Then select the Edit Properties menu option in the shortcut
menu. For example, the user can turn on minor tic marks for the y-axis
and modify the minimum and maximum scale for the x-axis. The graphic
customizing capabilities within HEC-SSP are very powerful, but are also
somewhat complex to use. The code used in developing the plots in HEC-
SSP is the same code that is used for developing plots in HEC-DSSVue
and several other HEC software programs. Please refer to the HEC-
DSSVue User’s Manual for details on customizing plots.
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Viewing the Report File

A report file is created when the coincident frequency analysis
computations are performed. The report file lists the input data, user
settings, and the final results. This file is often useful for understanding
how the software arrived at the final frequency curve.

To view the report file press the View Report button at the bottom of the
Coincident Frequency Analysis editor. When this button is pressed, a
window will appear containing the report as shown in Figure 9-15.

-
& Independent_Coincident_Freq_Cu.rpt

File Edt Search Format
File: |caTempiCoincident_Fraguency_ExarmplesCoincidentFreqResultsindependent_Coincident_Freq_Cullndependent_Coincident_Freg_Cu.rpt
-
Coincident Fredquency Analysis
14 Apr 2010 02:11 P

--— Input Data --—-

Analysis Name: Independent Coincident Freg Cu

Description:

Project Path: C:\Temp)Coincident Fredquency Exauple

Report File Name: C:\TempCoincident Fregquency Example)CoincidentFregResults)Independent Coincident Freg_CuYIndependent Coincident Freg Cu.rpt
Result File Name: C:\TempiCoincident Frequency Example)CoincidentFredqResults)Independent Coincident Freg CulIndependent Coincident Freo Cu.xml
D55 File Name: C:\Temp’\Coincident Frequency Example’Coincident Frequency Exauple.dss

Display ordinate wvalues using 2 digits in fraction part of walue

Marginal Frequency for Variable 4

| Exceedance | |

| Percent | |

| | |

| 0.2 | 66,039.16 |

| 0.5 | 54,353.90 |

| 1.0 | 46,369,859 |

| 2.0 | 39,053.42 |

| 5.0 | 30,295.76 |

| 10.0 | 24,265.15 |

| 20.0 | 18,631.00 |

| 50.0 | 11,395.30 |

| 80.0 | 7,095.20 |

| 90.0 | 5,577.85 |

| 85.0 | 4,589.19 |

| 89.0 | 3,210.47 |

| | |

Index-¥alue Table for Variable B

| Occurrance | Index | Exceesdance | Assigned |

| Frequency | Walue | Break Point | Exceedance |

| Percent | | Fercent | Percent |

| | | | |

| | | 100.0 | |

| 40.0 | 3,005.92 | | 80.0 |

1 1 | £0.0 | |

| z0.0 | §,085.90 | 50.0 |

1 1 I an n | I S/

11101 1:1

Figure 9-15. Coincident Frequency Analysis Report File.
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CHAPTER 10

Performing a Balanced Hydrograph
Analysis

The current version of HEC-SSP allows the user to compute balanced
hydrographs. In this type of analysis, observed data, flow, and volume-
frequency curves are used to create a hypothetical hydrograph that
“balances” flow rates, volumes, and frequency. Within a balanced
hydrograph, the flow and/or volume across multiple durations satisfies the
relation between flow/volume and duration for a given frequency. For
example, a 5-day 0.2 percent annual chance exceedance (ACE) balanced
hydrograph would have individual hydrograph ordinates arranged in such
a way that the flow volumes for the 1-hr, 1-day, ..., 5-day durations would
each equal the 0.2 percent ACE flow rates and/or volumes. Although such
hydrographs do not necessarily preserve the random character of natural
hydrographs, use of balanced hydrographs ensures an appropriate flow
rate and/or volume (in terms of frequency), regardless of the
characteristics of a particular watershed or location. This chapter
discusses in detail how to use the Balanced Hydrograph Analysis editor
within HEC-SSP.

Contents

Starting a New Analysis
General Settings

Frequency Curves

Viewing and Printing Results
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Starting a New Analysis

A balanced hydrograph analysis can be started in two ways, either by right
clicking on the Balanced Hydrograph Analysis folder in the study explorer
and selecting New, or by going to the Analysis menu and selecting New
and then Balanced Hydrograph Analysis. When a new balanced
hydrograph analysis is selected, the Balanced Hydrograph Analysis Editor
will appear as shown in Figure 10-1.

[] Balanced Hydrograph - E@
Name: |
Description: =
Flow Data Set: -
DSS File Name: ]
Report File: 3]
General | Frequency Cur\«'esl Resu\ts|
Qutput Labeling Time Window Medification User Specified Frequency Ordinates
DSS Data Mame is DSS Range is Use Values from Table Below
Change Label Start Date & Frequency in Percent
DE5 Data Units are End Date = gg
Change Label 1:0
Number of Probabilities 0= 20
. 5.0
Number of Durations: 0= User-Specified Probabilities for 100
User-Specified Durations 36 AR T BRI 200
(1 Hour = 0.0417 Days) Frequency In Percent ggg
Duration in Days a0.0
95.0
99.0
Compute | ‘ Plaot | | View Report | ‘ QK | | Cancel

Figure 10-1. Balanced Hydrograph Analysis Editor.

The user is required to enter a Name for the analysis, while a Description
is optional. A Flow Data Set must be selected from the available datasets
stored within the current study DSS file. This flow data set could be
comprised of daily measurements or those of a shorter duration. Generally
speaking, shorter duration datasets (such as IHOUR or 15MIN) should be
used in lieu of daily durations (see Chapter 4 for importing flow data into
the study). The list of data that can be selected for a balanced hydrograph
analysis will only include those data that have a regular interval, like
15MIN, 1HOUR, or 1DAY (E-Part pathname). Once a Name is entered,
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the DSS File Name and Report File will automatically be filled out. The
DSS filename is by default the study DSS file. The report file is given the
same name as the analysis with the extension ".rpt".

General Settings

Once the analysis name has been entered, the user can begin to perform
the analysis. Contained on the Balanced Hydrograph Analysis editor are
three tabs. The tabs are labeled General, Frequency Curves, and
Results. The first tab contains general settings for performing the
balanced hydrograph analysis (Figure 10-1). These settings include:

e Output Labeling

e Number of Durations

e User-Specified Durations

e Time Window Modification

e Number of Probabilities

e User-Specified Probabilities for Balanced Hydrographs
e User Specified Frequency Ordinates

Output Labeling

This option allows the user to change the default labels for data contained
in the output tables and
plots. The user can
change both the name of
Change Label the data as well as the
units of the data. The
output labeling does not
result in the conversion
of data from one unit
system to another; it
only affects what is displayed on table headings and the y-axis of the
results plot.

Cutput Labeling
0SS Data Mame is

0S5 Data Units are

Change Label

Number of Durations

This option allows the user to set the number of frequency curve durations
that will be used to
construct the balanced
hydrographs. The
number entered will
modify the number of rows contained within the User-Specified

Y

Mumber of Durations: 4=
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Durations. Typically, balanced hydrographs are constructed using more
than one duration. However, as the number of durations is increased, the
resulting hydrographs will preserve less of the random character of natural
hydrographs. At a minimum, the number of durations must be set equal to
one.

The User-Specified Durations table automatically adjusts the number of

User-Specified Durations rows based on the defined

(1 Hour = 0.0417 Days) number of durations. After
the user sets the number of
IS QUrations, the user must _

— 0/ | input the durations for which
30/ | the balanced hydrographs

501 I will be created. The

Duration in Days

program will arrange

hydrograph ordinates to
“balance” the flow-durations (i.e. volumes) using the durations defined
within this table. Note that the units for each duration is days. For
example, a one hour duration is equivalent to 0.0417 days.

There are no default durations. A typical listing of durations includes both
shorter and longer durations. Durations should be listed in descending
order with shorter durations listed first followed by longer durations. The
smallest duration should be equal to or greater than the time step of the
input flow data set. For example, a 1IDAY flow data set cannot be used in
conjunction with a specified duration of 0.0417 days.

Time Window Modification

This option allows the user to define a time window used for the analysis.
The time window should correspond to the period within the Flow Data
Set that the user wishes to use as a “template” hydrograph shape. The

Time Window Modification default is to use all
of the data
DSS Rangeis 03MNOV1984 - 070CT2013 contained within
7] Start Date 17sep2004[)| | the selected data
— set. If the default
| End Date 215ep2004 . time window is

used, HEC-SSP
will identify the event with the greatest peak flow rate within the selected
flow data set and use that as the “template” hydrograph shape. If a start
and/or end date are used, they must be dates that are contained within the
data stored in the selected data set. The date range for the selected data set
is shown in the editor just above the Start Date field.
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Number of Probabilities

This option lets the user choose the number of probabilities that will be
used to construct the
balanced hydrographs.
The default setting is “1” probability. Using the default will result in the
creation of a single balanced hydrograph.

Y

Mumber of Probabilities: 6l

The User-Specified
Probabilities table
automatically adjusts
Frequency In Percent the number of rows
0.2} | based on the defined
0511 number of
1.0 probabilities. After the
2.0

5pl| user sets the number of
100l probabilities, the user
must input the
probabilities for the balanced hydrograph analysis. This listing should be
entered in ascending order (i.e. 0.2, 0.5, 1.0, etc). The input listing cannot
use frequencies outside of the User Specified Frequency Ordinates. The
input frequencies should have units of percent.

Uszer-Specified Probabilities for
Balanced Hydrographs

User Specified Frequency Ordinates

This option allows the user to change the frequency ordinates used for
creating result tables and
graphs. The default values
listed in percent chance
e exceedance are 0.2, 0.5, 1,
02| | 2,5, 10, 20, 50, 80, 90, 95,
0.5/ and 99. Check the box next
21| to Use Values from Table
50/ | below to change or add
;gg additional values. Once this
=00l | box is checked, the user can
g0.0f | add/remove rows and edit
001 the frequency values. To
95.0
990/ | add or remove a row from
the table, select the row(s),
place the mouse over the highlighted row(s) and click the right mouse
button. The shortcut menu contains options to Insert Row(s) and Delete
Row(s). The program will use the default values, even if they are not
contained in the table, when the Use Values from Table below option is

not checked. Finally, all values in the table must be between 0 and 100.

User Specified Frequency Ordinates

Use Values from Table Below
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Frequency Curves

The Frequency Curves tab is used to define the flow- frequency curves for
the User-Specified Durations. As shown in Figure 10-2, the Frequency
Curves tab contains a panel for each frequency curve; the number of
frequency curves is defined in the General tab. Two options are available
to define these flow-frequency curves. First, the user can input the flow-
frequency information for all of the frequency ordinates. Second, the user
can input the Log-Pearson 111 statistics (mean, standard deviation, and
skew). Both forms of input can be determined using pre-determined flow-
and/or volume-frequency analyses (i.e. Bulletin 17B, Bulletin 17C,
Volume-Frequency, etc).

| Plot Flow-

The Plot Flow-Frequency Frequenss | ton will open a
graph showing all flow-frequency curves defined on the frequency curves
tab as well as the Flow Data Set, as show in Figure 10-3.

Compute

[] Balanced Hydrograph - Sinnemahaning_Balanced = =
Name: Sinnemahoning_Balanced
Description Balanced Hydrograph Creation for Sinnemahoning Creek at Sinnemahoning, PA ]
FlowData Set: | SINNEMAHONING-hourly o)
D35 File Name: |C:APROJECTS\SSP_Testing\Projects\Balanced_Hydrographs\Balanced_Hydrographs.dss o
Report File cts\Balanced_Hydrographs\BalancedHydrographiSinnemahoning_BalancediSinnemahoning_Balanced.r(.)
General| Frequency Curves | Results|
Frequency Curve Duration 1 (0.0417) Frequency Curve Duration 2 (1.0) Frequency Curve Duration 3 (3) Frequency Curve Duration 4 (5)
@ Manual Entry ) Manual Entry () Manual Entry ) Manual Entry
() Enter LPIIl Statistics @ Enter LPIIl Statistics @ Enter LPIIl Statistics @ Enter LPIIl Statistics
Statistics Statistics Statistics Statistics
Wean; 4.2 Mean: 4.087 Mean 3.987 Mean: 3.893
Standard Deviation: 0. Standard Deviation 0.187 Standard Deviation: 0.16 Standard Deviation 0.147
Skew: 0.382 Skew: 0.247 Skew: 0.169 Skew: 0.101

Frequency In Percent Frequency Curve Frequency In Percent  Frequency Curve Frequency In Percent Frequency Curve Frequency In Percent Frequency Curve

0.2 101874.3 02 48026 4 0.2 302288 02 215847

05 §2205.8 05 40918.3 05 26575.3 05 19300.9

1.0 69234.1 1.0 359462 1.0 239314 1.0 17613.7

20 57687.2 20 312855 20 213753 20 15851.5

5.0 443181 5.0 25535.7 5.0 18098.2 5.0 13770.2

10.0 35415.0 10.0 214214 10.0 15657.6 100 12102.4

200 273291 200 17447 1 20.0 13188.0 200 10373.9

[ sooETFIE) 50.0 120035 50.0 9605.0 50.0 77719
80.0 11439.7 80.0 84682 80.0 7099.0 80.0 5869.7

90.0 9381.3 0.0 71259 90.0 6096.3 900 50848

95.0 80517 95.0 62100 95.0 53918 95.0 45238

99.0 6163.4 99.0 48549 99.0 43129 99.0 36474/

Compute I [ Plot Flow-Frequency ] \ Plot Balanced Hydrograph \ [ View Report I Apply

Figure 10-2. Balanced Hydrograph Analysis Frequency Curves Tab.
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@ Frequency Curves for Sinnemahoning_Balanced =RRC

File Edit View
1000000.0

100000.0

FLOAY

10000.0

1000.0 T T T T T T T
0.9999 0.99 09 0.a 0.1 0.01 000

Frequency

— 0.042-Day Duration
— 5-Day Duration

1-Day Duration 3-Day Duration

Figure 10-3. Plot of Frequency Curves Defined in the Frequency Curves Tab.

Compute

Results

Press the Compute button, located at the bottom of the
Balanced Hydrograph Analysis editor, once options have

been set on the General and Frequency Curves tabs. If the
compute is successful, the user will receive a message that says Compute
Complete. At this point, the user can begin to review the results.

Multiple Balanced Hydrograph analyses can be computed using the
Compute Manager. Select the Analysis=>Compute Manager menu
option to open the Compute Manager. Select the analyses to be computed
and then press the Compute button. Close the compute dialogs and
Compute Manager when the program finishes computing the analyses.

This section describes results that are available for the Balanced
Hydrograph analysis. When the user selects the Results tab on the
Balanced Hydrograph Analysis editor, the window will appear as shown
in Figure 10-4. Both tabular and graphical results are included. The
durations and probabilities for the balanced hydrographs are the same as
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those defined on the General tab. In addition, when the Data Name and
Data Units are defined on the General tab they are used in the y-axis label
in the plot.

[ Balanced Hydrograph - Sinnemahoning_Balanced [E- ==
Name: Sinnemahoning_Balanced
Description: Balanced Hydrograph Creation for Sinnemahaoning Creek at Sinnemahaoning, PA )]
Flow Data Set. | SINNEMAHONING-hourly =
DSS File Name: | C:\PROJECTS\SSP_Testing\Projects\Balanced_Hydrographs\Balanced_Hydrographs.dss ()]
Report File: C:\PROJECTS\SSP_Testing\Projects\Balanced_Hydrographs\BalancedHydrograph\Sinnemahoning_Balance[.)
‘ General | Frequency Curves‘ Resu\ts|
Date | Hydrogra | Hydrogra .| Hydrogra.| Hydrogra...| Hydrogra.. | Hydrogra Sinnemahoning_Balanced Results
(0.2 Perc...| (0.5Perc...| (1Perce... | (2Perce.. | (5Perce... | (10 Perc... 120,000
16 Sepie 270238 27497 27700 2776.7 27465 26537| ~ !
17 Septe.. 27028 27497 27700 27767 27465 26537
17 Septe.. 26478 26937 27136 27201 26905 25997
17 Sepie 26405 2686 4 27062 27127 26831 25925
17 Seple 26405  2686.4) 27062 27127| 26831 25025 100,000
17 Septe.. 26405 2686.4) 27062 27127 26821 25925 =
17 Septe.. 26405 2686.4) 27062 27127 26821 25925
17 Sepie 26405 2686 4 27062 27127 26831 25925
17 Sepie 26955 2742 4 276268 27692 27391 2646.6 80,0004
17 Septe.. 27303 27777 27982 2304.9 27744 2680.7
17 Septe. 2789.0 28374 28584 28652 28341 27383
17 Sepie 30503 31032 31261 31336 30995 29949 el
17 Sepie. 32529 3309.4 33338 33418 33054 3193.8 b 50000
17 Septe.. 34781 35386 35646 35732 35343 3415.0 c '
17 Septe. 6944 6 70653 71173 71344 7056.8 68185 g
17 Sepie 99135 93372 88796 8396.0 77028 7161.8 (@]
17 Sepie. 99135 9337.2 88796 8396.0 77028 7161.8 d
17 Septe.. 330747 284008 252445 221505 18272.4| 15459.6 40,0004
17 Septe 330747 2840938 252445 2215056 182724 15459.6
17 Sepie 330747 2849938 252445 221505 182724 154596
17 Sepie. 41116.9 35429.6 313828 27536.5 22715.4 19218.6
17 Septe.. 43592.8 37563.0 332726 291946 240832| 203759 20.000
17 Septe 450149 38788.4 343580 30147.0 248689 21040.6 '
17 Sepie 48780.7 420333 372322 32669.0 269493 228008
17 Sepie. 49747.0 42865.9 37969.8 3331641 27483.2 23252.4
18 Septe..| 102060.9 82356.4| 69360.9) 577929 443993 354799 -
18 Seple 1016877 820552 69107.3 575815 442369 353501 0
18 Septe 494386 426002 377344 2331095 273128 231083 17 18 19 20 21
18 Septe. 491911 42386.9 37545.5 329438 271761 22992.6 Sep2004
18 Septe.. 47080.1 40567.9 359342 31530.0 26009.8| 220059
18 Seple 463182 399114 353527 310198 255889 21649.8 —— 0.2 PercentEvent —— 0.5 PercentEvent ——— 1 Percent Event —— 2 Percent Event
18 Seple 45719.0 393951 348954| 306185 252579 213697
18 Septe. 45334.9 39064.1 34602.2 30361.3 25045.7 21190.2| ~ B IPEHBETE S I (PR e
Compute ] [ Plot Flow-Frequency ] ‘ Plot Balanced Hydrograph | [ View Report ] Apply

Figure 10-4. Results Tab of the Balanced Hydrograph Analysis Editor.

Viewing and Printing Results

The user can view the output for the balanced hydrograph analysis directly
from the Balanced Hydrograph Analysis editor (tabular and graphical
output) or by using the buttons at the bottom of the editor.

Tabular Output

Once the computations for the balanced hydrograph analysis are

completed, the user can view the tabular
output by selecting the Results tab. Tabular
results can be opened after clicking the Plot
Balanced Hydrograph button and selecting File->Tabulate or by double
clicking on the balanced hydrograph plot in the Results tab and in the
opened plot selecting File-> Tabulate. The balanced hydrograph table can

’ Plot Balanced Hydrograph
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also be printed once opened in a new window using the File=>Print
option. An additional printing option available from the File menu is Print
Preview. The table can also be exported by selecting Export... from the
File menu. When the Export option is selected, a window will appear
allowing the user to select the Field Delimiter and additional Table Export
Options. Currently five field delimiter formats are available for exporting
the table: TAB, SPACE, COMMA, COLON and SEMI-COLON.

Graphical Output

Graphical output of the balanced hydrograph analysis can be obtained by
selecting either the Results tab, or by pressing the Plot Balanced
Hydrograph button at the bottom of the balanced hydrograph analysis
editor. When the Plot Balanced Hydrograph button is pressed, a balanced
hydrograph plot will appear in a separate window as shown in Figure
10-5. The example balanced hydrograph plot in Figure 10-5 was created
after modifying the Time-Window (in the General tab). The user can
modify the Time-Window to obtain balanced hydrographs for a specific
maximum peak in the dataset.

The balanced hydrograph plot can be sent to the printer by selecting the
Print option from the File menu at the top of the window. Additional
printing options available from the File menu are Page Setup, Print
Preview, and Print Multiple (used for printing multiple graphs on the same
page). The graphic can also be sent to the Windows Clipboard by
selecting Copy to Clipboard from the File menu. Additionally, the plot
can be saved to a file by selecting the Save As option from the File menu.
When the Save As option is selected, a window will appear allowing the
user to select a directory, enter a filename, and select the format for saving
the file. Currently four file formats are available for saving the graphic to
disk: windows metafile, postscript, JPEG, and portable network
graphic.

10-9



Chapter 10 - Performing a Balanced Hydrograph Analysis HEC-SSP User's Manual

@ Sinnemahoning_Balanced Results =aReN X |

—

File Edit View
Sinnemahoning_Balanced Results

100,000

50,0004

60,0004

m

Flow in CFS

40,000

20,0004

Sep2004

|< I ,l

—— 0.2 Percent Event —— 0.5 Percent Event
—— 1 Percent Event —— 2 Percent Event
—— 5 Percent Event 10 Percent Event
—— SINMEMAHONING DCP-REY FLOW

Figure 10-5. Balanced Hydrograph Analysis Plot.

As explained previously, the data contained within the plot can also be
tabulated by selecting Tabulate from the File menu. When this option is
selected, a separate window will appear with the data tabulated.
Additional options are available from the File menu for saving the plot
options as a template (Save Template) and applying previously saved
templates to the current plot (Apply Template).

The Edit menu contains several options for customizing the graphic.
These options include Plot Properties, Configure Plot Layout, Default
Line Styles, and Default Plot Properties. Also, a shortcut menu will
appear with further customizing options when the user right-clicks on a
line on the graph or the legend. Both the Y and X-axis properties can be
edited by placing the mouse on top of axis and clicking the right mouse
button. Then select the Edit Properties menu option in the shortcut
menu. For example, the user can turn on minor tic marks for the y-axis
and modify the minimum and maximum scale for the x-axis. The graphic
customizing capabilities within HEC-SSP are very powerful, but are also
somewhat complex to use. The code used in developing the plots in HEC-
SSP is the same code that is used for developing plots in HEC-DSSVue
and several other HEC software programs. Please refer to the HEC-
DSSVue User’s Manual for details on customizing plots.
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Viewing the Report File

A report file is created when the balanced hydrograph analysis
computations are performed. The report file lists the input data, user
settings, and the final results. This file is often useful for understanding
how the software arrived at the balanced hydrograph.

| viewReport || 15 view the report file press the View Report button at

the bottom of the Balanced Hydrograph Analysis editor.
When this button is pressed, a window will appear containing the report as
shown in Figure 10-6.

@ Sinnemahoning_Balanced.rpt [&J
File Edit Search Format

File: | C:\PROJECTS\SSP_Testing\Projects\Balanced_Hydrographs\BalancedHydrograph\Sinnemahoning_Balanced\Sinnemahoning_Balanced.rpt

Balanced Hydrograph Analysis
09 Nov 2015 03:54 EM

m

——— Input Data ———

Inalysis Name: Sinnemahoning Balanced
Description: Balanced Hydrograph Creation for Sinnemahoning Creek at Sinnemahoning, PR

Data Set Name: SINNEMAHONING-hourly
D55 File Name: C:\PROJECTS\SSP Testing\Projects\Balanced Hvdrographs\Balanced Hydrographs.dss
D55 Pathname: //SINNEMAHONING/FLOW/0LNOV1984 - 010CT2013/1HOUR/DCE-REV/

Start Time: 17 Sep 2004, 00:00
End Time: 21 Sep 2004, 24:00

Project Path: C:\PROJECTS\SSP_Testing\Projects\Balanced Hydrographs

Report File Name: C:\PROJECIS\SSF Testing\Projects\Balanced Hydrographs\BalancedHydrograph\Sinnemahoning Balanced\S5inne
Result File Name: C:\PROJECIS\SSF Testing\Projects\Balanced Hydrographs\BalancedHydrograph\Sinnemahoning Balanced\S5inne

0.0417-day Flow-Freguency Curwve

| Exceedance | FLOW

| Percent | |

| | |

| 0.2 | 101,874.3 |

| 0.5 | g82,205.8 |

| 1.0 | 69,234.1 |

| 2.0 | 57,687.2 |

| 5.0 | 44,318.1 |

| 10.0 | 35,415.0 |

| 20.0 | 27,329.1 |

| 50.0 | 17,271.3 |

| g80.0 | 11,439.7 |

| 90.0 | o, 30030

| 95.0 | 8,051.7 |

| 99.0 | 6.163.4 | S
4 m 3

11/09/2015 15:54 PM 1111 11

Figure 10-6. Balanced Hydrograph Analysis Report File.

The computations that were used to create the balanced hydrographs are
contained within the Report output. Specifically, the base, required, and
final flow-duration values are detailed along with the percent error for
each duration and frequency. Additionally, the balanced hydrograph
report can be opened using the Results—>Report option in the Results
dropdown menu at the top of the SSP window.
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APPENDIX B

Example Data Sets

The input and output for eleven example data sets are provided to illustrate
the use of selected options and to assist in verifying the correct execution
of the program.

The first six example data sets are the same examples that were found in
the HEC-FFA program documentation. The first six examples were
duplicated with a Bulletin 17B and General Frequency analysis. This
manual only shows these examples using the Bulletin 17B analysis;
however, the example data sets show that results are the same whether a
Bulletin 17B or General Frequency analysis was performed. As shown in
the example data sets, the HEC-SSP software produces the same results as
HEC-FFA for these six data sets. All of these examples are provided with
the software as a single HEC-SSP study labeled "SSP Examples”. You
can install this study on your computer by selecting the Help-> Install
Example Data menu option. After opening this study for the first time on
your computer, you must compute each example before viewing tabular
and graphical results.

A brief description of each example is provided. In most cases the
weighted skew option was selected, and a regional skew value was entered
from the generalized skew map of the United States provided within
Bulletin 17B (Plate 1).

The example problems shown in this section are entitled:
1. Fitting the Log-Pearson Type Il Distribution.
. Analysis with High Outliers.
. Testing and Adjusting for a Low Quitlier.

. Zero Flood Years.

. Use of Historic Data and Median Plotting Positions.

2
3
4
5. Confidence Limits and Low Threshold Discharge.
6
7. Analyzing Stage Data.

8

. Using User-Adjusted Statistics.
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9. General Frequency - Graphical Analysis.

10.
11.
12.
13.
14.
15.

16.

17.

18.

Volume Frequency Analysis, Maximum Flows.
Volume Frequency Analysis, Minimum Flows.
Duration Analysis, Bin (STATS) Method.
Duration Analysis, Rank All Data Method.
Duration Analysis, Manual Entry.

Coincident Frequency Analysis, A and B can be Assumed
Independent.

Coincident Frequency Analysis, A and B cannot be Assumed
Independent.

Balanced Hydrograph Analysis, Using an Historical Event
Hydrograph.

Balanced Hydrograph Analysis, Using a Triangular-shaped
Hydrograph.

When the "SSP Examples” study file is open, the screen will appear as
shown in Figure B-1. There are six Bulletin 17B analyses, nine General
Frequency analyses, two Volume Frequency analyses, three Duration
analyses, two Coincidence Frequency analyses, and two Balanced
Hydrograph analyses in this study. The following sections document each
of the example data sets. Appendix C details six additional examples
which make use of the Expected Moments Algorithm and Bulletin 17C
procedures.
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MPLES

File Edit View Maps Data Analysis Results Tools Window Help
2o B s B 4B B 2

200 Analysis | pl| [ Base Map

=), Bulletin 17
AT Sinnemahening_B17C
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ATB FFA Test 3
ATB FFATest4
ATB FFA Test 5
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GF General Frequency FFA Test 1
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=1L Volume Frequency Analysis
*“VF Sinnemahaning_VolumeFrequency
~WF Unreg Flow Rio Grande Test 10
*VF Low Flow Analysis Test 11
=}, Duration Analysis
D Duration Curve Test 13 Oipetimba-g
$D Fishkill Cresk Test 12
“D Manual Duration Curve Test 14
= | Coincident Frequency Analysis
1-CF Coincident Freq Test 15
*--CF Coincident Freq Test 16
= Balanced Hydrograph Analysis
{BH Balanced Hydrograph Test 17
*BH Balanced Hydrograph Test 12
= )| Data
; Back Creek-Jones Springs
Chatianoochee River
Fishkill Creek-Beacan, NY
Fishkill Creek-Daily Flow
Floyd River-James 14
Kaskaskia River-Vandalia, IL
Orestimba Cregk-Newman, CA
Ridley Creek-Moylan, PA 2

Floyd Fiwe

-
dnds st alb Unreg 0f

[ ] (%] (%
Loading Bulletin 17 Reservoir Inflows i
Resenvoir Inflows deleted E
[® Mo Agaitional Content || | |study ssP EXAMPLES saved

Messages

Coordinates: -68 east, 59 north

Figure B-1. SSP Examples Study.
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Example 1: Fitting the Log-Pearson Type I1I
Distribution

The input data for FFA Test 1 is the same as that for Example 1 in
Appendix 12, Guidelines for Determining Flood Flow Frequency, Water
Resources Council Bulletin 17B. Example 1 illustrates the routine
computation of a frequency curve by the Bulletin 17B methodology.

The data for this example is from Fishkill Creek in Beacon, New York.
The period of record used for this example is from 1945 to 1968. To view
the data from HEC-SSP, right-click on the data record labeled “Fishkill
Creek-Beacon, NY” in the study explorer and then select Tabulate. The
data will appear as shown in Figure B-2.

A\ /FISHKILL CREEK/BEACON/FLO... (celo (=) b

File Edit View
BEACON
Ordinate Date Time FLOW
oBs

Units cfs

Type INST-VAL
1 05 Mar 1945 12:00 22800
2 27 Dec 1945 12:00 1.470.0
3 14 Mar 1947 24:00 22200
4 18 Mar 1943 24:00 2870.0
5 01 Jan 19449 24:00 30200
G| 09 Mar1950 12:00 1,210.0
7| 01Apr1951 12:00 24900
g 12 Mar 1952 12:00 31700
4 25 Jan 1953 12:00 32200
10| 13 Sep 1954 12:00 1,760.0
11| 20 Aug 1955 12:00 2.2800.0
12| 16 Oct 1955 12:00 28,2800
13| 10 Apr 1957 12:00 1,210.0
14| 21 Dec 1957 12:00 2500008
15| 11 Feb 1954 12:00 1,860.0
16 06 Apr 1960 12:00 21400
17| 26 Feb 1961 12:00 4 3400
18| 13 Mar 1962 12:00 3,060.0
19| 23 Mar 1963 12:00 1,780.0
20| 26 Jan 1964 12:00 1,3280.0
21| 09 Feb 1965 12:00 930.0
22| 15 Feb 1964 12:00 1,040.0
23| 30 Mar 1967 12:00 1,580.0
24| 19 Mar 1968 12:00 36300

Figure B-2. Tabulation of the Peak Flow Data for Fishkill Creek.

To plot the data for this example, right-click on the data record again and
then select Plot. A plot of the data will appear as shown in Figure B-3.
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=

[i Fishkill Creek-Beacon, NY 3 = | B -
File Edit View

6,000+

5,000+

4,000+

Flomy {cfs)
%]

3,000+ @
2,000+ o

1,000+ p—f

T T T T T T T T T T T T
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< BEACON OBS FLCWS

Figure B-3. Plot of the Fishkill Creek Data.

A Bulletin 17B and a General Frequency analysis have been developed for
this example. To open the Bulletin 17B analysis editor for Example 1,
either double-click on the analysis labeled FFA Test 1 from the Study
Explorer, or from the Analysis menu select open, then select FFA Test 1
from the list of available analyses. When FFA Test 1 is selected, the
Bulletin 17B analysis editor will appear as shown in Figure B-4.
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[ Bulletin 17 Editor - FFA Test1 El- (3w
Name FFATest1
Description: WRC Appendix 12, Example 1 - Fitting the Log-Pearson Type Il Distribution =
Flow Data Set | Fignkill Creek-Beacon, NY -
D55 File Name: | C:\PROJECTSISSPIProjects\SSP_Examples\SSP_EXAMPLES. dss (]
Repaort File: CAPROJECTS\SSP\Projects\SSP_Examples\Bulletin17Results\FFA_Test_1\FFA_Test 1.rpt =
General | Options Tabular Results
Method for Computing Statistics and Confidence Limits Low Outlier Test Confidence Limits
17C EMA Multiple Grubbs-Beck @ Defaults (0.05, 0.95)
@ 78 Methods @ Single Grubbs-Beck User Entered Values
Upper Limit:
Generalized Skaw Plotting Position YripErLmrE
Use Station Skew Weibull (A and B =0) Lower Limit:
@ Median (Aand B = 0.3)
@ Use Weighted Skew
Hazen (4 and B = 0.5) Time Window Modification
Use Regional Skew HirschiStedinge
Regional Sk R ile B D DSS Rangeis  05MAR1945 - 19MAR1968
egional Skew: . =
0.8 Other (Specify A, B) Start Date =
Reg. Skew MSE 0.302 [ —
Plotting position computed using formula End Date [®)]
{m-A){n+1-A-B)
Expected Probablity Curve Where
@ Compute Expected Prob. Curve m=Rank, 1=Largest
M=Number ears
Do Mot Compute Expected Prob. Curve AB=Constants
B
compute | | Plotcunve | [ viewRepot | [ Prnt | oK Cancel

Figure B-4. Bulletin 17B Analysis Editor with FFA Test 1 Data Set.

Shown in Figure B-4 are the general settings that were used to perform
this frequency analysis. As shown, the Skew option was set to use the

Weighted Skew. To use the weighted skew option, the user must enter a
value for the Regional Skew and the Regional Skew Mean Square Error
(MSE). This selection requires the user to either look up a value from the
generalized skew map of the United States, which is provided with
Bulletin 17B, or develop a value from a regional analysis of nearby gages.
In this example a value of 0.6 was taken from the generalized skew map of
the U.S. from Bulletin 17B. Bulletin 17B suggests using a Regional Skew
MSE of 0.302 whenever regional skew values are taken from the map.

Also for this example, the Expected Probability Curve option was
selected to be computed in addition to the Log Pearson 11l computed
curve. The Weibull plotting position method was selected, as well as the
default Confidence Limits of 0.05 (5 percent chance exceedance) and
0.95 (95% chance exceedance). Shown in Figure B-5 is the Bulletin 17B
editor with the Options Tab selected.
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[ Bulletin 17 Editor - FFA Test1* [ ==
Name: FFATest 1
Description: WRC Appendix 12, Example 1 - Fitting the Log-Pearson Type Ill Distribution 8
Flow Data Set: :Fishkill Creek-Beacon, NY =
D85 File Name: | C\PROJECTSISSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES dss 8]
Report File: CAPROJECTSISSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\Bulletin17Results\FFA_Test_1\FFA_Test_1.rpt o]
General Omi0ﬂ8| TabularResuIts|
Low Qutlier Threshold Histaric Period Data User Specified Frequency Ordinates
[] override Low Qutlier Threshold [] Use Historic Data [7] Use Values from Table Below
Value i] istori i
L Historic Period Frequency in Percent
Start Year: 0.2
. 0.5
EndYear: 10
Override High Outlier Threshold: 2.0
5.0
— 10.0
Historic Events 20.0
Water Year Peak 50.0
80.0
90.0
95.0
99.0
Compute ] ’ Plat Curve ] ’ View Report ] ’ Print ] ’ OK ] ’ Cancel ] ’ Apply ]

Figure B-5. Bulletin 17B Editor with Options Tab Selected for FFA Test 1.

As shown in Figure B-5, none of the available options for modifying the

frequency analysis were selected for this example. These options include
changing the Low Outlier Threshold and using Historic Data.
Additionally, the option to override the default Frequency Ordinates was

not selected.

Once all of the General and Optional settings are set or selected, the user
can press the Compute button to perform the analysis. Once the
computations have been completed, a message window will open stating
Compute Complete. Close this window and then select the Tabular

Results tab. The analysis window should look like Figure B-6.
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[] Bulletin 17 Editor - FFA Test1 E- [
Name: FFATest 1
Description: WRC Appendix 12, Example 1 - Fitting the Log-Pearson Type |ll Distribution =
Flow Data Set | Fishkill Cresk-Beacon, NY -
DSS File Name: | c:\PROJECTSISSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES. dss )
Report File: C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\Bulletin17Results\FFA_Test_1\FFA_Test 1.rpt E]
| Generall Dptionsl Tabular Results
Frequency Curve for: Fishkill Creek-Beacon, NY
Confidence Limits
Percent Chance Computed Curve Expected Prob. IO IS
Exceedance Flow in cfs Flow in cfs
0.05 0.95
0.2 18828.3 274943 38020.6 12103.2
0.5 142151 18603.3 26365.4 9605.0
1.0 11387.8 13909.9 197728 79949
2.0 9030.6 10419.0 14655.7 §589.2
5.0 G506.1 7058.0 9635.2 49934
10.0 4958.9 5206.3 G847.3 39457
20.0 36571 37432 4721.0 2096.4
50.0 21938 21938 2659.5 1795.6
80.0 14383 1417.8 1760.0 1106.2
90.0 11922 1162.9 14845 8802
95.0 1037.6 999.5 13133 7407
99.0 829.6 7783 10825 558.6
System Statistics Mumber of Events
Log Transform: Flow Event MNumber
Statistic Value H?storic E.\fents 0
Mean 3.368 E'ghg“t}!'ers g
Standard Dev 0.246 Z""" 0“ r'ﬁrs. o
Station Skew 0.730 Se“t’ r ‘;_'SE'”gt 4
Regional Skew 0.600 Hg.fsternapm - V:n 5
Weighted Skew 0.66g| [oorcreno
Adopted Skew 0.668
. Compute | ’ Plot Curve ] ’ View Report ] ’ Print ] ’ oK ] ’ Cancel ] Apply

Figure B-6. Bulletin 17B Analysis Window with Results Tab Shown for FFA

Test 1.

As shown in Figure B-6, the Frequency Curve table contains the following

results:

Percent Chance Exceedance

Computed Curve (Log-Pearson 11 results)

Expected Probability Curve

Confidence Limits (5% and 95% chance exceedance curves)

On the bottom, left side of the results tab is a table of Statistics for the
observed station data (mean, standard deviation, station skew) and
regional adjustment (regional skew, weighted skew, and adopted skew).
Also on the bottom, right side of the results tab is a Number of Events
table showing the number of historic events used in the analysis, number
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of high outliers found, number of low outliers, number of zero or missing
data years, number of systematic events in the gage record, and the
historic record length (if historic data was entered).

In addition to the tabular results, a graphical plot of the computed
frequency curves can be obtained by pressing the Plot Curve button at the
bottom of the analysis window. A plot of the results for this example is
shown in Figure B-7.

[] Bulletin 17 Plat for FFA Test 1 = | B jd S
File Edit View Window
Bulletin 17 Plot for FFA Test 1
e Return Period
Q 1.1 2 a 10 an 200100010000
1':”:”:”:”:”:' 1 1 1 1 1 1 1 1 1 1 1 1
10000.04
i
£
[}
[
1000.04
100.0 T T T | — T T T1 T T
0.949 0.4 0.4 0.z 0.1 0.0z 0002 00001
Frobahility
Computed Curve ===m-- Expected Probakility Curve
— == 5 Percent Confidence Limit = == 85 Percent Confidence Limit
] Obzerved Events (Weibull plotting positions)

Figure B-7. Plotted Frequency Curves for FFA Test 1.

The tabular and graphical results can be sent to the printer or the Windows
clipboard for transfer into another piece of software. To print the tabular
results, select Print from the bottom of the analysis window. To send the
tabular results to the Windows clipboard, highlight the data you want to
send to the clipboard and then press the Control-C key sequence. To print
the graphical results, first bring up the graphical plot and then select Print
from the File menu. To send the graphic to the windows clipboard, select
Copy to Clipboard from the File menu.
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In addition to the tabular and graphical results, there is a report file that
shows the order in which the calculations were performed. To review the
report file, press the View Report button at the bottom of the analysis
window. When this button is selected a text viewer will open the report
file and display it on the screen. Shown in Figure B-8 is the report file for
FFA Test 1.

The report file contains a listing of the input data, preliminary results,
outlier and historical data tests, additional calculations needed, and the
final frequency curve results. Different types and amounts of information
will show up in the report file depending on the data and the options that
have been selected for the analysis. The user should review the report file
to understand how HEC-SSP performed the Bulletin 17B frequency curve
calculations.

[ [ Fra_test_Lopt -

File Edit Search Format

File: \cap ROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\Bulletin17Results\FFA_Test 1\FFA_Test_1.rpt

Bulletin 17B Fregquency Analysis
12 Jan 2016 10:05 EM

——— Input Data ——

m

IAnalysis Name: FFR Test 1
Description: WRC Appendix 12, Example 1 - Fitting the Log-Pearson Type III Distribution
Fishkill Creek at Beacon, NY

Data Set Name: Fishkill Creek-Beacon, NY
D55 File Name: C:\PROJECTS\SSF Testing\Projects\Appendix B Examples\S5F Examples\55F EXAMPLES.dss
D35 Pathname: /FISHKILL CREEK/BERCON/FLOW/01janl300/IR-CENTURY/O0BS/

Report File Name: C:\PROJECTS5\S55F Testing\Projects\Appendix B Examples‘\5S5PF Examples\Bulletinl7Results\FFA Test I1\FFA Te
¥ML File Name: C:\PROJECTS\SSP_Testing\Projects\Appendix B Examples\55F_ Examples\Bulletinl7Results\FFA Test 1\FFA Test_

Start Date:
End Date:

Skew Option: Use Weighted Skew
Regional Skew: 0.6

Regional Skew MSE: 0.302
Plotting Position Type: Weibull

Upper Confidence Lewvel: 0.05
Lower Confidence Level: 0.95

Display ordinate walues using 1 digits in fraction part of wvalue

——— End of Input Data ———

<< High QOutlier Test >>

Based on 24 events, 10 percent outlier test deviate K(N) = 2.487
Computed high outlier test walue = 9,424.96

4 T b

011212016 10:05 AM 1111 11

Figure B-8. FFA Test 1 Report File.
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Example 2: Analysis with High Outliers

The input data for FFA Test 2 is the same as that for Example 2 in

Appendix 12, Guidelines for Determining Flood Flow Frequency, Water
Resources Council Bulletin 17B. Example 2 illustrates the application to
data with a high outlier.

The data for this example is from Floyd River in James, lowa. The period
of record used is from 1935 to 1973. To view the data from HEC-SSP,
right-click on the data record labeled "Floyd River-James IA" in the
study explorer and then select Tabulate. The data will appear as shown in

Figure B-9.
‘ SFLOYD RIVER/JAMES IMFLDW.-‘...[ =NRCY ﬂ
File Edit WView
JAMES |A
Ordina... Date Time FLOW
0OBS
10) 13 May 1944 12:00 7.440| =
11| 12 Mar 1945 12:00 5,320
12| 01 Mar 1946 12:00 1,400
13| 25 Jun 1947 12:00 3,240
| 14| 17 Mar 1948 12:00 2710
il 15| 05 Mar 1949 12:00 4520
16| 19 Jun 1950 12:00 4,840
17| 28 Mar 1951 12:00 8,320
18| 31 Mar 1952 12:00 13,900| —
19| 08 Jun 1953 12:00 71,500
20| 22 Jun 1954 12:00 6,250
21| 10 Jul 1955 12:00 2,260
22| 13 Jul 1956 12:00 318
23| 05 Jul 1957 12:00 1,330
24| 01 Jul 1958 12:00 970
25| 01 Jun 1959 12:00 1,920
26| 29 Mar 1960 12:00 15,100
27| 02 Mar 1961 12:00 2,870
28| 29 Mar 1962 12:00 20,600] =
29| 02 Jun 1963 12:00 3,810
30| 09 Sep 1964 12:00 726
31| 02 Apr1965 12:00 7,500
32| 10 Feb 1966 12:00 7170
33| 19 Jun 1967 12:00 2,000
34| 21 Jul 1968 12:00 829
35| 05 Apr1969 12:00 17,300
36| 04 Mar 1970 12:00 4740
37| 01 Jan 1971 12:00 13,400
38| 01Jan 1972 12:00 2,940|
39| 01Jan 1973 12:00 5,660 -

Figure B-9. Tabulation of the Peak Flow Data for the Floyd River.
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To plot the data for this example, right-click on the data record and then
select Plot. A plot of the data will appear as shown in Figure B-10.

@ Floyd River-lames IA

= [ B -

File Edit View

50,000+

40,000+

Flomy {cfs)

30,000+

20,000+

10,000+

oo
I % po

o o

T
1940

T
1945

T
1950

T
1955

T
1960

T
1965

T
1970

< JAMES 1A OBS FLCWY

Figure B-10. Plot of Floyd River Data

A Bulletin 17B and General Frequency analysis have been developed for
this example. To open the Bulletin 17B analysis editor for FFA Test 2,
either double-click on the analysis labeled FFA Test 2 from the study
pane, or from the Analysis menu select open and then select FFA Test 2
from the list of available analyses. When FFA Test 2 is selected, the
Bulletin 17B analysis editor will appear as shown in Figure B-11.
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[ Bulletin 17 Editor - FFA Test 2% = [
Name: FFATest2
Description: WRC Appendix 12, Example 2 - Adjusting for a high outlier =
Flow Data Set. Floyd River-James 14 h
DSS File Name: | C:\PROJECTSISSP\Projects\SSP_Examples\SSP_EXAMPLES.dss =
Report File CAPROJECTS\SSPProjects\3SP_Examples\Bulletin17Results\FFA_Test_2\FFA_Test_2.rpt =]
General | Options Tabular Results
Method for Computing Statistics and Confidence Limits Low Qutlier Test Confidence Limits
17C EMA Multiple Grubbs-Beck @ Defaults (0.05, 0.95)
@ 78] @ Single Grubbs-Beck User Entered Values
Upper Limi
Generalized Skew Plotting Position SLLEATLCE
Use Station Skew Weibull (A and B = 0) Lower Limit
@ Median (AandB=03)
@ Use Weighted Skew N N N
Hazen (& and B = 0.5) Time Window Modification
Use Regional Skew HirschiStedinge
LEELEELE RS DSSRangeis 28JUN1935- 01JAN1973
Regional Skew: _ —
0.3 Other (Specify A, B) Start Date LJ
Reg. Skew MSE 0.302 N - P —
Plotting position computed using farmula End Date (=]
(m-A){n+1-A-B)
Expected Probablity Curve Where:
@ Compute Expected Prob. Curve -1_:Ra[1-2_1:Lari;est
N=MNumbe Years
Do Mot Compute Expected Prob. Curve R ESEITEETE
B
compute | | Plotcuve | | viewRepon | [ Prnt | [ ok [ oy |[ canca

Figure B-11. Bulletin 17B Analysis Editor with FFA Test 2 Data Set.

Shown in Figure B-11 are the general settings that were used to perform
this frequency analysis. As shown, the Skew option was set to use the
Weighted Skew. To use the weighted skew option, the user must enter a
value for the Regional Skew and the Regional Skew Mean Square Error
(MSE). This selection requires the user to either look up a value from the
generalized skew map of the United States, which is provided with
Bulletin 17B, or develop a value from a regional analysis of nearby gages.
In this example a value of -0.3 was taken from the generalized skew map
of the U.S. from Bulletin 17B. Bulletin 17B suggests using a Regional
Skew MSE of 0.302 whenever regional skew values are taken from the
map.

Also for this example, the Expected Probability Curve option was
selected to be computed in addition to the Log Pearson 111 computed
curve. The Weibull plotting position method was selected, as well as the
default Confidence Limits of 0.05 (5 percent chance exceedance) and
0.95 (95% chance exceedance). Shown in Figure B-12 is the Bulletin 17B
editor with the Options Tab selected.
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[ Bulletin 17 Editor - FFA Test 2 IE@I
MName: FFATest2
Description: WRC Appendix 12, Example 2 - Adjusting for a high outlier 8
Flow Data Set: :Floyd River-James 14 i
D85 File Name: | C:\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES dss 8]
Report File: CIAPROJECTSVSSP_Testing\Projects\Appendix_B_Examples\SSP_ExamplesiBulletin17Results\FFA_Test_2\FFA_Test_2.rpt o]
| General| Options | Tabular Results|
Low Qutlier Threshold Historic Period Data User Specified Frequency Ordinates
[] override Low Outlier Threshald Use Historic Data [7] Use Values from Table Below
Value istori i
Historic Period Frequency in Percent
Start Year: 1892 0.2
. 0.5
End Year: 10
Override High Outiier Threshald: 70000 20
5.0
— 10.0
Historic Events 20.0
Water Year Peak 50.0
80.0
90.0
95.0
99.0
. Compute ’ Plot Curve ] ’ View Report ] ’ Print ] ’ OK ] ’ Cancel ] Apply

Figure B-12. Bulletin 17B Editor with Options Tab Selected for FFA Test 2.

As shown in Figure B-12, the Historic Period Data option has been
selected to reflect the fact that the 1953 flood peak of 71,500 cfs is known
to be the largest flood since 1892. When the analysis was originally
performed on this data set, the 1953 event was found to be a high outlier.
(The reader may replicate this result by un-checking the "Use Historic
Data" box, hitting the Compute button, and reviewing the Tabular Results
tab.) High outliers should not be eliminated from an analysis, as they are
valuable pieces of the flow record. However, when a high outlier is found
in a data set, it suggests that the event might actually be the largest in a
much longer period of record. The analyst should always try to locate and
incorporate historic information to define a longer record and improve the
quality of the frequency analysis. Since it was known that the 1953 event
was the largest value since 1892, the year 1892 is entered as the Start
Year for the historic period. Additionally, a High Threshold Value of
70,000 cfs was entered. By entering the High Threshold Value of 70,000
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cfs, the 1953 flood of 71,500 cfs was removed from the systematic record
and treated as a historic data value during the historic data adjustment
calculations performed by HEC-SSP and outlined in Bulletin 17B,
Appendix 6. Since no End Year was entered for the historic period, the
last year of the systematic data set will be used as the End Year.

Other features on this tab include the Low Outlier Threshold and the
option to override the default Frequency Ordinates, neither of which are
selected in this example.

Once all of the General and Optional settings are set or selected, the user
can press the Compute button to perform the analysis. Once the
computations have been completed, a message window will open stating
Compute Complete. Close this window and then select the Tabular
Results tab. The analysis window should look like Figure B-13.

[ Bulletin 17 Editor - FFA Test 2 = [
Name: FFATest2
Description: WRC Appendix 12, Example 2 - Adjusting for a high outlier o]
Flow Data Set: :Floyd River-James IA -
DSS File Name: |C:\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.dss =
Report File: C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\Bulletin17Results\FFA_Test_2\FFA_Test_2.rpt E]
| General | opngnsl Tabular Results
Frequency Curve for: Floyd River-James |14
Confidence Limits
Percent Chance Computed Curve Expected Prob. EION IS
Exceedance Flow in cfs Flow in cfs
0.05 0.95
0.2 G8690.4 87683.6 146181.2 40256.7
0.5 49599.7 59583.3 98491.6 304128
1.0 379806 43795.7 713343 241415
20 284248 31613.9 50326.8 187604
5.0 18469.9 197248 300679 128425
10.0 12637.5 13167.0 192146 9148.5
200 83017.9 81889 113543 6025.9
50.0 34039 34039 44583 2596.5
80.0 1470.9 14417 19581 1037.6
90.0 955.3 919.6 13176 §30.1
95.0 G671.4 G32.0 9509 4157
99.0 3494 308.0 5418 190.3
System Statistics Mumber of Events
Log Transform: Flow Event Mumber
Statistic Value H?storic E.\.'ents 0
Mean 3537 E'ghgﬂ}!'ers S
Standard Dev 0438 ZOW Our'f.”s. o
Station Skew 0.165 Se“t’ r ‘;_'SE'”gt 2
Regional Skew -0.300 Hy.fsternapm - \.';n 5 o
Weighted Skew 0.075| [eencreno
Adopted Skew 0.075
. Compute | ’ Plot Curve ] [ View Report ] ’ Print ] ’ oK ] ’ Cancel ] Apply

Figure B-13. Bulletin 17B Editor with Results Tab Selected for FFA Test 2.
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As shown in Figure B-13, the Frequency Curve table contains the
following results:

Percent Chance Exceedance

Computed Curve (Log-Pearson 11 results)

Expected Probability Curve

Confidence Limits (5% and 95% chance exceedance curves)

On the bottom left-hand side of the results tab is the Statistics table for the
observed station data (mean, standard deviation, station skew) and
regional adjustment (regional skew, weighted skew, and adopted skew).
Also on the bottom right-hand side of the results tab is the Number of
Events table showing the number of historic events used in the analysis,
number of high outliers found, number of low outliers, number of zero or
missing data years, number of systematic events in the gage record, and
the historic record length (if historic data was entered).

In addition to the tabular results, a graphical plot of the computed
frequency curves can be obtained by pressing the Plot Curve button at the
bottom of the analysis window. A plot of the results for this example is
shown in Figure B-14.
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[] Bulletin 17 Plat for FFA Test 2 = | B jwé S
File Edit View Window
Bulletin 17 Plot for FFA Test 2
Return Period
1.1 2 a 10 an 200 10000
1':”:”:”:”:”:":' 1 1 1 1 1 1 1 1 1 1 1 1
~
100000.04 =
i
= 10000.07
[}
[
1000.04
100.0 T T T T T T T T1 T T
.99 nga 0.5 nz2 o1 N0z 0002 0.0001
Frobahility
Computed Curve ===m-- Expected Probakility Curve
= == 5 Percent Confidence Limit === 85 Percent Confidence Limit
2 Observed Events 0A%eibul plotting positions) O High Outlier

Figure B-14. Plotted Frequency Curves for FFA Test 2.

The tabular and graphical results can be sent to the printer or the windows
clipboard for transfer into another piece of software. To print the tabular
results, select Print from the bottom of the analysis window. To send the
tabular results to the windows clipboard, highlight the data you want to
send to the clipboard and then press the Control-C key sequence. To print
the graphical results, first bring up the graphical plot and then select Print
from the File menu. To send the graphic to the windows clipboard, select
Copy to Clipboard from the File menu.

In addition to the tabular and graphical results, there is a report file that
shows the order in which the calculations were performed. To review the
report file, press the View Report button at the bottom of the analysis
window. When this button is selected a text viewer will open the report
file and display it on the screen. Shown in Figure B-15 is the report file
for FFA Test 2.
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The report file contains a listing of the input data, preliminary results,
outlier and historical data tests, additional calculations needed, and the
final frequency curve results. Different types and amounts of information
will show up in the report file depending on the data and the options that
have been selected for the analysis. The user should review the report file
to understand how HEC-SSP performed the frequency curve calculations.

[ [ Fratest 2.pt -

R

File Edit Search Format

File: \cap ROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\Bulletin17Results\FFA_Test 2\FFA_Test_2.rpt

Bulletin 17B Fregquency Analysis
12 Jan 2016 10:07 BEM

m

——— Input Data ——

IAnalysis Name: FFR Test 2
Description: WRC Rppendix 12, Example 2 - Rdjusting for a high outlier
Floyd Riwer at James, IA

Data Set Name: Floyd Riwver—James IR
D55 File Name: C:\PROJECTS%55F Testing\Projects\Appendix B Examples\35F Examples\55F EXAMPLES.das
D35 Pathname: /FLOYD RIVER/JAMES IR/FLOW/01janl900/IR-CENTURY/0BS/

Report File Name: C:\PROJECTS5\S55F Testing\Projects\Appendix B Examples‘\55P Examples\Bulletinl7Results\FFA Test 2\FFA Te
¥ML File Name: C:\PROJECTS\SSP_Testing\Projects\Appendix B Examples\55F_ Examples\Bulletinl7Results\FFA Test 2\FFA Test_

Start Date:
End Date:

Skew Option: Use Weighted Skew
Regional Skew: -0.3

Regional Skew MSE: 0.302
Plotting Position Type: Weibull
Upper Confidence Lewvel: 0.05
Lower Confidence Level: 0.85
Use High Outlier Threshold
High OQutlier Threshold: 70000.0
Use Historic Data

Historic Period Start Year: 1892
Historic Period End Year: ———

Display ordinate walues using 1 digits in fraction part of wvalue

——— End of Input Data ———

——— Preliminary Results ——— -

q [ [T F

011212016 10:07 AM 1111 11

Figure B-15. FFA Test 2 Report File.
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Example 3: Testing and Adjusting for a Low Outlier

The input data for FFA Test 3 are the same as that for Example 3 in
Appendix 12 of the WRC Guidelines. FFA Test 3 illustrates the
application to data with a low outlier. Note that the program automatically
screens for low outliers and, if low outliers are found, outputs the
preliminary results in the report file in order to allow for comparison with
the final results.

The data for this example is from Back Creek in Jones Springs, West
Virginia. The period of record used for this example is from 1929 to
1973. To view the data, right-click on the data record labeled "Back
Creek-Jones Springs™ in the study pane and then select Tabulate. The
data will appear as shown in Figure B-16.

M /BACK CREEK/JONES SPRINGS, .. EEI
File Edit View
JONES SP...
Ordina... Drate Time FLOWY
0BS
Units CFS| -
Type INST-VAL |~
1| 17 Apr 1929 12:00 8,750
2| 230ct1929 12:00 15,500
3| 08 May 1931 12:00 4,060
4| 04 Feb 1939 12:00 6,300
5| 20 Apr 1940 12:00 3,130
6| 06 Apr1941 12:00 4,160
7| 22 May 1942 12:00 6,700
8| 150ct 1942 12:00 22,400
9 24 Mar 1944 12:00 3,880
10| 18 Sep 1945 12:00 8,050( =
11| 03 Jun 1946 12:00 4,020 (I
12| 15 Mar 1947 12:00 1,600
13[ 14 Apr 1948 12:00 4,460
14| 31Dec 1948 12:00 4,230
15| 02Feb 1950 12:00 3,010) |
16| 05 Dec 1950 12:00 9,150
17| 28 Apr 1952 12:00 5,100
18] 22 Nov 1952 12:00 9,820/ (I
19 02 Mar 1954 12:00 6,200
20| 19 Aug 1955 12:00 10,700]_
21| 15 Mar 1956 12:00 3,880
22| 10 Feb 1957 12:00 3,420
23| 27 Mar 1958 12:00 3,240
24 03Jun 1959 12:00 6,800
25| 09 May 1960 12:00 3,740
26| 19 Feb 1961 12:00 4,700
27| 22 Mar 1962 12:00 4,380
28 20 Mar 1963 12:00 5,190 ~

Figure B-16. Tabulation of the Peak Flow Data for Back Creek.
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To plot the data for this example, right-click on the data record and select

Plot. A plot of the data will appear as shown in Figure B-17.

@ Back Creek-Jones Springs

—

=l |-

Flomy {cfs)

File Edit View

20,000+
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10,000+ =]
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T T T T T T T T
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T
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< JONES SPRINGS, Wi OBS FLCWY
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Figure B-17. Plot of Back Creek Data.

A Bulletin 17B and General Frequency analysis have been developed for
this example. To open the Bulletin 17B analysis editor for FFA Test 3,
either double-click on the analysis labeled FFA Test 3 from the study
explorer, or from the Analysis menu select open and then select FFA Test
3 from the list of available analyses. When FFA Test 3 is selected, the
Bulletin 17B analysis editor will appear as shown in Figure B-18.
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[ Bulletin 17 Editor - FFA Test 3* G S
Name: FFATest3
Description: WRC Appendix 12, Example 3 - Testing and adjusting for a low outlier [
Flow Data Set.  Back Creek-Jones Springs =
DSS File Name:  CAPROJECTSISSPIProjects\SSP_Examples\SSP_EXAMPLES dss ]
Report File CAPROJECTS\SSPProjects\SSP_Examples\Bulletin17Results\FFA_Test_3\FFA_Test_3 pt =]
General | Options Tabular Results
Method for Computing Statistics and Confidence Limits Low Outlier Test Confidence Limits
() 17C EMA Multiple Grubbs-Beck @ Defaults (0.05, 0.95)
@ {178 Metnods @ Single Grubbs-Beck User Entered Values
Upper Limi
Generalized Skew Platting Posiian AL
Use Station Skew Weibull (A and B=0) Lower Limit
@ Median (AandB=10.3)
@ Use Weighted Skew . . .
Hazen (& and B =0.5) Time Window Modification
Use Regional Skew HirschiStedinge
Irschistedinger D33 Rangeis 17APR1929-01JAN1973
Regional Skew: =
0.3 Other (Specify &, B) Start Date 3]
Req. Skew MSE 0.302 NN ST =
Plotting position computed using faorl jula End Date o
{m-A){n+1-A-B)
Expected Probablity Curve Where:
@ Compute Expected Prob. Curve ~1_=Pa[1 ;_1=Lar'_;%t
N=Number of Years
Do Mot Compute Expected Prob. Curve RASUITEETE
B
Compute | | Plot Curve | ‘ View Report | | Print | | OK | ‘ Apply | | Cancel

Figure B-18. Bulletin 17B Analysis Editor with FFA Test 3 Data Set.

Shown in Figure B-18 are the general settings that were used to perform
this frequency analysis. As shown, the Skew option was set to use the

Weighted Skew. To use the weighted skew option, the user must enter a
value for the Regional Skew and the Regional Skew Mean Square Error
(MSE). This selection requires the user to either look up a value from the
generalized skew map of the United States, which is provided with

Bulletin 17B, or develop a value from a regional analysis of nearby gages.

In this example, a value of 0.5 was taken from the generalized skew map
of the U.S. from Bulletin 17B. Bulletin 17B suggests using a Regional
Skew MSE of 0.302 whenever regional skew values are taken from the

map.

Also for this example, the Expected Probability Curve option was
selected to be computed in addition to the Log Pearson Il computed
curve. The Weibull plotting position method was selected, as well as the
default Confidence Limits of 0.05 (5 percent chance exceedance) and

0.95 (95% chance exceedance). Shown in Figure B-19 is the Bulletin 17B

editor with the Options Tab selected.
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[2] Bulletin 17 Editor - FFA Test 3 (= ==
Name: FFATest3
Description: WRC Appendix 12, Example 3 - Testing and adjusting for a low outlier 8]
Flow Data Set: :Elack Creek-Jones Springs ':
D85 File Name: | C\PROJECTSISSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES dss ]
Report File: CIAPROJECTSVSSP_Testing\Projects\Appendix_B_Examples\3SP_Examples\Bulletin17Results\FFA_Test_3\FFA_Test_3.rpt )
| General‘ Options | Tabular Results|
Low Qutlier Threshold Historic Period Data User Specified Frequency Ordinates
[] override Low Qutlier Threshold [] Use Historic Data [7] Use Values from Table Below
Value ] istori i
0 Historic Period Frequency in Percent
Start Year. 0.2
. 0.5
End Year: 10
Override High Outlier Threshold: 0 28
5.0
— 10.0
Historic Events 20.0
Water Year Peak 50.0
80.0
90.0
95.0
99.0
“Compute | | Plotcuve | [ viewRepot | [ Print | [ ok ][ cancet ][ Apoy

Figure B-19. Bulletin 17B Editor with the Options Tab Selected for FFA Test 3.

As shown in Figure B-19, none of the available options for modifying the
frequency curve were selected for this test example. These options
include the Low Outlier Threshold and Historic Period Data.
Additionally, the option to override the default Frequency Ordinates was
not selected.

Once all of the General and Optional settings are set or selected, the user
can press the Compute button to perform the analysis. Once the
computations have been completed a message window will open stating
Compute Complete. Close this window and select the Tabular Results
tab. The analysis window should look like Figure B-20.
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[ Bulletin 17 Editor - FFA Test 3 = 3
Name: FFATest3
Description: WRC Appendix 12, Example 3 - Testing and adjusting for a low outlier =
Flow Data Set: :Elack Creek-Jones Springs -
DSS File Name: | c:\PROJECTSISSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.dss o]
Report File: C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\S5P_Examples\Bulletin17Results\FFA_Test 3\FFA_Test 3.rpt E]
| General | opngnsl Tabular Results
Frequency Curve for: Back Creek-Jones Springs
z G z — S Tal: Confidence Limits
ercent Chance omputed Curve pected Prob. )
Fl cfs
Exceedance Flow in cfs Flow in cfs owin cs
0.05 0.95
0.2 371586 45353.3 599277 266316
0.5 289338 3344486 441457 215065
1.0 237289 26456.6 346758 181404
2.0 19265.6 208404 269335 15153.9
5.0 14322.3 149891 18852.3 11698.7
10.0 11181.4 11493.2 14053.3 93871
20.0 84490 8562.5 10156.9 72600
50.0 52375 52375 G044.6 45207
80.0 34904 34598 4069.5 28914
90.0 2901.0 2856.5 34337 23345
95.0 258237 24655 30291 19816
99.0 20044 1923.8 24707 15059
System Statistics Mumber of Events
Log Transform: Flow Event MNumber
Statistic Value H?storic E.\fents 0
Mean 3741 [“gh[?“t}!'ers 3
Standard Dev 0.231) SEOUTES. ;
Station Skew 0624 Se“t’ r ‘;_'SE'”gt 5
Regional Skew 0.500 Hg.fsternapm - V:n 5
Weighted Skew 0577 (eorcreno
Adopted Skew 0.577
Compute | [ Plot Curve ] [ iew Report ] [ Print ] [ OK ] [ Cancel ] Apply

Figure B-20. Bulletin 17B Editor with the Results Tab Selected for FFA Test 3.

As shown in Figure B-20, the Frequency Curve table contains the
following results:

Percent Chance Exceedance

Computed Curve (Log-Pearson 11 results)

Expected Probability Curve

Confidence Limits (5% and 95% chance exceedance curves)

On the bottom left-hand side of the results tab is a table of Statistics for
the observed station data (mean, standard deviation, station skew) and
regional adjustment (regional skew, weighted skew, and adopted skew).
Also on the bottom right-hand side of the results tab is a table of Number
of Events showing the number of historic events used in the analysis,
number of high outliers found, number of low outliers, number of zero or
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missing data years, number of systematic events in the gage record, and
the historic record length (if historic data was entered).

In this analysis, the software detected one low outlier in the systematic
record. As recommended in Bulletin 17B, if a low outlier is detected, then
that data point will be removed and the Conditional Probability
Adjustment will be used to recalculate the frequency curve and then the
statistics without that point. Review the report file to see the original
statistics, computed curves, the low outlier test, and recomputed curves.

In addition to the tabular results, a graphical plot of the computed
frequency curves can be obtained by pressing the Plot Curve button at the
bottom of the analysis window. A plot of the results for this example is
shown in Figure B-21.

[] Bulletin 17 Plot for FFA Test 3 = | B jwé S
File Edit View Window
Bulletin 17 Plot for FFATest 3
] Return Period
Q 1.1 2 a 10 an 200100010000
1':”:”:”:”:”:' 1 1 1 1 1 1 1 1 1 1 1 1
Fal
F
=
e
P
100000+ e
i
=
[}
[
100004
O
100.0 T T T | — T T 11 T T
.99 nga 0.5 nz2 o1 0oz 0002 0.0001
Frobahility
Computed Curye ===--- Expected Probahbility Curve
— == 5 Percent Confidence Limit === 85 Percent Confidence Limit
Obzetved Events (Weibull plotting positions) O Loy Owtlier

Figure B-21. Pot for FFA Test 3.

In addition to the tabular and graphical results, there is a report file that
shows the order in which the calculations were performed. To review the
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report file, press the View Report button at the bottom of the analysis
window. When this button is selected a text viewer will open the report
file and display it on the screen. Shown in Figure B-22 is the report file
for FFA Test 3.

The report file contains a listing of the input data, preliminary results,
outlier and historical data tests, additional calculations needed, and the
final frequency curve results. Different types and amounts of information
will show up in the report file depending on the data and the options that
have been selected for the analysis.

r@ FFA_Test_3.rpt -

File Edit Search Format

File: \cap ROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\Bulletin17Results\FFA_Test 3\FFA_Test_3.rpt

Bulletin 17B Fregquency Analysis
12 Jan 2016 10:12 EM

m

——— Input Data ——

IAnalysis Name: FFR Test 3

Description: WRC Appendix 12, Example 3 - Testing and adjusting for a low outlier

Back Creek near Jones Spring, WV

Data Set Name: Back Creek-Jones Springs

D55 File Name: C:\PROJECTS\SS5F Testing\Projects\Appendix B Examples‘\S5SF_Examples‘\S5P EXAMPLES.dss
D35 Pathname: /BACK CREEK/JONES SPRINGS, WV/FLOW/01janl900/IR-CENTURY/0BS/

Report File Name: C:\PROJECTS5\S55F Testing\Projects\Appendix B Examples‘\55F Examples\Bulletinl7Results\FFA Test 3\FFA Te
¥ML File Name: C:\PROJECTS\SSP_Testing\Projects\Appendix B Examples\55F_ Examples\Bulletinl7Results\FFA Test 3\FFA Test_

Start Date:
End Date:

Skew Option: Use Weighted Skew
Regional Skew: 0.5

Regional Skew MSE: 0.302
Plotting Position Type: Weibull

Upper Confidence Lewvel: 0.05
Lower Confidence Level: 0.85

Display ordinate walues using 1 digits in fraction part of wvalue

——— End of Input Data ———

——— Preliminary Results ———

<< Skew Weighting >>

Based on 38 events, mean-sguare error of station skew = 0.197

Mean-square error of regional skew = 0.302 -

'l 1 +
0112/2016 10:12 AM 1111 1:1

Figure B-22. Report File for FFA Test 3.

B-25



Appendix B — Example Data Sets

HEC-SSP User's Manual

Example 4: Zero-Flood Years

The input data for FFA Test 4 are the same as that for Example 4 in
Appendix 12 of the WRC Guidelines. FFA Test 4 illustrates the
application to data that includes several zero flow years.

The data for this example is from Orestimba Creek in Newman,
California. The period of record used for this example is from 1932 to
1973. To view the data from HEC-SSP, right-click on the data record
labeled "Orestimba Creek-Newman, CA” in the study explorer and then
select Tabulate. The data will appear as shown in Figure B-23.

. SORESTIMBA CREEE/NEWMAN, l =R &J
File Edit WView
MEWRMARM,
Ordina... Date Time FLOW
0OBS
Units CFS| =
Type INST-VAL |
1| 08 Feb 1932 12:00 4,260
2| 29 Jan 1933 12:00 345
3| 01.Jan 1934 12:00 516
4| 08 Apr1935 12:00 1,320
5] 13 Feb 1936 12:00 1,200
6| 13 Feb 1937 12:00 2180
7| 11 Feb 1938 12:00 3,230
& 09 Mar 19349 12:00 115
9| 27 Feb 1940 12:00 3.440| =
10| 04 Apr1941 12:00 3,070
11| 24 Jan 1942 12:00 1,880
12| 21 Jan 1943 12:00 6,450
13| 29 Feb 1944 12:00 1,290
14| 02 Feb 1945 12:00 5,970
15| 25 Dec 1945 12:00 782
16| 30 Sep 1947 12:00 0
17| 30 Sep 1948 12:00 0
18| 12 Mar 19489 12:00 335(
19| 05 Feb 1950 12:00 175
20| 03 Dec 1950 12:00 2,920
21| 12 Jan 1952 12:00 3,660
22| 07 Dec 1952 12:00 147
23| 30 Sep 1954 12:00 0
24| 19 Jan 1955 12:00 16
25| 23 Dec 1955 12:00 5,620
26| 24 Feb 1957 12:00 1,440
27| 02 Apr1958 12:00 10,200
28| 16 Feb 1959 12:00 5,380 -

Figure B-23. Tabulation of the Peak Flow Data for Orestimba Creek.
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To plot the data for this example, right-click on the data record and then
select Plot. A plot of the data will appear as shown in Figure B-24. The
years with peak flows measuring zero are visible.

=

@ Orestimba Creek-Mewman, CA =NREN X

File Edit View

10,000+

8,000+

6,000+ o

Flomy {cfs)

4,000+

2,000+ o o

o
=] o o [}
[v] o C PR o o

o

T T T T T T T T
1935 1940 1945 1950 1955 1960 1965 1970

= MBEAMAR, CA OBS FLCWS

Figure B-24. Plot of Orestimba Creek Data.

A Bulletin 17B and General Frequency analysis have been developed for
this example. To open the Bulletin 17B analysis editor for FFA Test 4,
either double-click on the analysis labeled FFA Test 4 from the study
explorer, or from the Analysis menu select open, then select FFA Test 4
from the list of available analyses. When FFA Test 4 is selected, the
Bulletin 17B analysis editor will appear as shown in Figure B-25.
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[ Bulletin 17 Editor - FFA Test4* =l |mtdm
Name FFATest4
Description: WRC Appendix 12, Example 4 - Zero flood years )
Flow Data 5et | grestimba Creek-Newman, CA -
DSSFile Name. | C\PROJECTS\SSP\Projects\SSP_Examples\SSP_EXAMPLES.dss 8]
Report File: C:PROJECTSISSPI\Projects\SSP_Examples\Bulletin17Results\FFA_Test_4\FFA_Test_4.rpt &
General | Options Tabular Results
Method for Computing Statistics and Confidence Limits Low Qutlier Test Confidence Limits
) 17C EMA Multiple Grubbs-Beck @ Defaults (0.05, 0.95)
@ Single Grubbs-Beck User Entered Values
Upper Limit;
Generalized Skew Plotting Position Upper Limit:
Use Station Skew REITGETESY) LowerLimt
@ Median (Aand B=10.3)
@ Use Weighted Skew X .
Hazen (A and B =0.5) Time Window Modification
Use Regional Skew HirschiStedinge
Resional 5k Irschistedinger DSS Rangeis 08FEB1932-11FEB1973
egional Skew: 0. =
0.3 Other (Specify A, B) Start Date =
Req. Skew MSE: 0.302 e o S —
Ploting position computed using formula End Date m]
(m-A)(n+1-A-B)
Expected Probablity Curve Where:
@ Compute Expected Prob. Curve I;:,T'?rffa;_::;
Do Mot Compute Expected Prob. Curve ABSEITEETE
B:
Compute | ‘ Plot Curve | | View Report | | Print | | OK | | Apply ‘ | Cancel

Figure B-25. Bulletin 17B Analysis Editor with FFA Test 4 Data Set.

Shown in Figure B-25 are the general settings that were used to perform
this frequency analysis. As shown, the Skew option was set to use the
Weighted Skew. To use the weighted skew option, the user must enter a
value for the Regional Skew and the Regional Skew Mean Square Error
(MSE). This selection requires the user to either look up a value from the
generalized skew map of the United States, which is provided with
Bulletin 17B, or develop a value from a regional analysis of nearby gages.
In this example a value of -0.3 was taken from the generalized skew map
of the U.S. from Bulletin 17B. Bulletin 17B suggests using a Regional
Skew MSE of 0.302 whenever regional skew values are taken from the

map.

Also for this example, the Expected Probability Curve option was
selected to be computed in addition to the Log Pearson Il computed
curve. The Weibull plotting position method was selected, as well as the
default Confidence Limits of 0.05 (5 percent chance exceedance) and
0.95 (95% chance exceedance). Shown in Figure B-26 is the Bulletin 17B
editor with the Options Tab selected.
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[] Bulletin 17 Editor - FFA Test4 = e
Name: FFATest4
Description: WRC Appendix 12, Example 4 - Zero flood years )
Flow Data Set: :Drestimba Creek-Mewman, CA -
D85 File Name: | C:\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES dss 8]
Report File: CIAPROJECTSVSSP_Testing\Projects\Appendix_B_Examples\SSP_ExamplesiBulletin17Results\FFA_Test_4\FFA_Test_4.rpt o]
General Omi0ﬂ8| TabularResuIts|
Low Qutlier Threshold Historic Period Data User Specified Frequency Ordinates
[] override Low Outlier Threshald [] Use Historic Data [7] Use Values from Table Below
Value i] istori i
- Historic Period Frequency in Percent
Start Year: 0.2
. 0.5
End Year: 10
Override High Outlier Threshold: 0 28
5.0
— 10.0
Historic Events 20.0
Water Year Peak 50.0
80.0
90.0
95.0
99.0
“Compute | | Plotcuve | | ViewReport | [ Print | [ ok [ cancel |[ opy

Figure B-26. Bulletin 17B Editor with the Options Tab Selected for FFA Test 4.

As shown in Figure B-26, none of the available options for modifying the
frequency curve were selected for this test example. These options
include the Low Outlier Threshold and Historic Period Data.
Additionally, the option to override the default Frequency Ordinates was
not selected.

Once all of the General and Optional settings are set or selected, the user
can press the Compute button to perform the analysis. Once the
computations have been completed a message window will open stating
Compute Complete. Close this window and then select the Tabular
Results tab. The analysis window should look Figure B-27.
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[ Bulletin 17 Editor - FFA Test 4

2 s

Name: FFATest4
Description: WRC Appendix 12, Example 4 - Zero flood years =
Flow Data Set: :Drestimba Creek-Mewman, CA -
DSS File Name: | C:\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.dss o]
Report File: C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\Bulletin17Results\FFA_Test_4\FFA_Test_4.rpt E]
| General | Dptionsl Tabular Results
Frequency Curve for: Orestimba Creek-Mewman, CA
z G z S S Tal: Confidence Limits
ercent Chance omputed Curve pected Prob. )
Fl cf:
Exceedance Flow in cfs Flow in cfs owinee
0.05 0.95
0.2 32544 6 38023.0 30008.5 16880.0
0.5 246232 28469.3 573474 13227.0
1.0 19296.3 21762.8 429047 10678.4
2.0 145724 16029.5 307538 83349
5.0 9289.3 9919.8 18092.9 55828
10.0 G041.4 G307.6 10955.5 3787.0
200 34501 35342 5761.9 22601
50.0 10428 10428 15587 7035
30.0 265.5 286.7 403.5 160.5
90.0 121.0 112.9 195.8 G5.1
95.0 G0.9 54.4 106.0 29.0
99.0 15.3 117 3.6 5.6
System Statistics Mumber of Events
Log Transform: Flow Event Mumber
Statistic Value H?storic E.\fents 0
Mean 2.966 [“gh[?“t}!'ers [1’
Standard Dev 0.668| (o ETIEE. 5
Station Skew 0,568 Se“t’ r ‘;_'SE'”gt 5
Regional Skew -0.300 Hg.fsternapm - V:n 5
Weighted Skew _p473| [Historic Ferio
Adopted Skew -0.473
. Compute ’ Plot Curve ] ’ View Report ] ’ Print ] ’ oK ] ’ Cancel ] Apply

As shown in Figure B-27, the Frequency Curve table contains the
following results:

Percent Chance Exceedance

Computed Curve (Log-Pearson 11 results)

Expected Probability Curve

Confidence Limits (5% and 95% chance exceedance curves)

Figure B-27. Bulletin 17B Editor with the Results Tab Selected for FFA Test 4.

On the bottom left-hand side of the results tab is a table of Statistics for

the observed station data (mean, standard deviation, station skew) and

regional adjustment (regional skew, weighted skew, and adopted skew).

Also on the bottom right-hand side of the results tab is a table of Number

of Events showing the number of historic events used in the analysis,
number of high outliers found, number of low outliers, number of zero or
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missing data years, number of systematic events in the gage record, and
the historic record length (if historic data was entered).

As noted earlier, there were six zero values in this record, and also a low
outlier. A zero value causes difficulty because the first step in fitting a
Log Pearson 11 distribution is computing the base-10 log of each flow
value, which is undefined for zero. Bulletin 17B recommends removing
the zero values (and the low outlier) from the systematic record to
compute a preliminary frequency curve, and then adjusting that curve with
the Conditional Probability Adjustment. The final frequency curve and
statistics are shown in the table, and the preliminary calculations can be
reviewed in the report file.

In addition to the tabular results, a graphical plot of the computed
frequency curves can be obtained by pressing the Plot Curve button at the
bottom of the analysis window. A plot of the results for this example is
shown in Figure B-28.

Bl |-t

@ Bulletin 17 Plot for FFA Test 4 1

File Edit View Window

Bulletin 17 Plot for FFA Test 4
Return Period

1.1 2 a 10 an 200100010000
100000.0 : :
100000+
@ 100004
£
5
- 100.0
10.0
1.0 T T T | — T T 11 T T
.99 nga 0.5 nz2 o1 0oz 0002 0.0001
Frobahility
Computed Curye ===--- Expected Probahbility Curve
= == 5 Percent Confidence Limit === 85 Percent Confidence Limit
2 Observed Events (eibull plotting postions) O Low Qutlier

Figure B-28. Plot of FFA Test 4 Results.
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The tabular and graphical results can be sent to the printer or the windows
clipboard for transfer into another piece of software. To print the tabular
results, select Print from the bottom of the analysis window. To send the
tabular results to the windows clipboard, highlight the data you want to
send to the clipboard and then press the Control-C key sequence. To print
the graphical results, first bring up the graphical plot and then select Print
from the File menu. To send the graphic to the windows clipboard, select
Copy to Clipboard from the File menu.

In addition to the tabular and graphical results, there is a report file that
shows the order in which the calculations were performed. To review the
report file, press the View Report button at the bottom of the analysis
window. When this button is selected a text viewer will open the report
file and display it on the screen. Shown in Figure B-29 is the report file
for FFA Test 4.

The report file contains a listing of the input data, preliminary results,
outlier and historical data tests, additional calculations needed, and the
final frequency curve results. Different types and amounts of information
will show up in the report file depending on the data and the options that
have been selected for the analysis.
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==

R T S ———
File Edit Search Format

File: C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\Bulletin17Results\FFA_Test_4\FFA_Test 4.rpt

Bulletin 17B Fregquency Analysis
12 Jan 2016 10:15 EM

m

——— Input Data ——

IAnalysis Name: FFR Test 4
Description: WRC Appendix 12, Example 4 - Zero flood years
Orestimba Creek near Newman, CA

Data Set Name: Orestimba Creek-Newman, CA |
D55 File Name: C:\PROJECTS\SS5F Testing\Projects\Appendix B Examples‘\S5SF_Examples‘\S5P EXAMPLES.dss
D35 Pathname: /ORESTIMBA CREEK/NEWMAN, CA/FLOW/01janl900/IR-CENTURY/0BS/

Report File Name: C:\FROJECTS\55F Testing\Projecta\Appendix B Examples‘\35F Examples‘\Bulletinl7Results\FFA Test 4\FFR Te
¥ML File Name: C:\PROJECTS\SSP_Testing\Projects\Appendix B Examples\S55P Examples\Bulletinl7Results\FFA Test 4\FFA Test

Start Date:
End Date:

Skew Option: Use Weighted Skew
Regional Skew: -0.3

Regional Skew MSE: 0.302
Plotting Position Type: Weibull

Upper Confidence Lewvel: 0.05
Lower Confidence Level: 0.85

Display ordinate walues using 1 digits in fraction part of wvalue

——— End of Input Data ———

——— Preliminary Results ———

Note: RAdopted skew egquals station skew and preliminary
frequency statistics are for the conditional frequency curve
because of zero or missing events.

4 T | 3

011212016 10:15 AM 1111 11

Figure B-29. HEC-SSP Report File for FFA Test 4.
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Example 5: Confidence Limits and Low Threshold
Discharge

This example illustrates the use of user-entered confidence limits.
Probabilities of .01 and .99 were entered for the computed confidence
limit curves. This data set also includes two very low values, the higher of
which is just above the default low outlier threshold. This example
therefore also demonstrates the use of a user-entered low outlier threshold
set to be higher than both values.

The data for this example is from Kaskaskia River in Vandalia, Illinois.

The period of record used for this example is from 1908 to 1970. To view
the data from HEC-SSP, right-click on the data record labeled "Kaskaskia
River-Vandalia, IL" in the study explorer and then select Tabulate. The
data will appear as shown in Figure B-30.

A /KASKASKIA RIVER/VANDALIA, L. e[ ) e
File Edit View
VANDALIA, IL
Ordina.|  Date Time FLOW
0BS
31| 12 Jun 1941 12.00 4,560 «
32| 12 Jul 1942 12.00 13,600
33| 18 May 1943 12.00 52,200
34| 24 Apr 1944 12.00 31,000
35 10 Jun 1945 12.00 21,500
36| 04 May 1946 12:00 13,000
37| 10 Jun 1947 12:00 12,300
38| 28 Mar 1948 12.:00 19,000
39| 16 Feb 1949 1200 25,000
40 04 Jan 1950 12.00 51,300
41 29 Jun 1951 12.00 31,000
42| 15 Apr 1952 12:00 10,500
43 05 Mar 1953 12:00 5,680
44| 19 Apr1954 12.:00 505
45| 25 Apr 1955 12.00 5,000
46| 27 Feb 1956 12.00 7,840|—
47| 29 Jun 1957 12.00 62,700
48 04 Aug 1958 12.00 12,400
49| 12 Feb 1959 12:00 17,200
50| 30 Jun 1960 12.:00 11,800
51) 10 Apr 1961 12.:00 34,400
52| 25 Mar 1962 12.00 17,100| _
53| 22 May 1963 12.00 9,000 =
54| 04 May 1964 12.00 8,500
55 04 May 1965 12:00 5,350
56 19 May 1966 12:00 11,900
57| 10 Dec 1966 12.:00 27,000
58 23Dec 1967 12.00 20,800
H 59| 31 Jan 1969 12.00 20,700
60/ 16 Jun 1970 12.00 30,000

g

Figure B-30. Tabulation of the Peak Flow Data for Kaskaskia River.
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To plot the data for this example, right-click on the data record and then
select Plot. A plot of the data will appear as shown in Figure B-31.

@ Kaskaszkia River-Vandalia, IL

= [ B -

File Edit View

¥0,000

60,000+

50,000+

40,000+

Flomy {cfs)
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Figure B-31. HEC-SSP Plot of the Kaskaskia River Data.

A Bulletin 17B and General Frequency analysis have been developed for
this example. To open the Bulletin 17B analysis editor for FFA Test 5,
either double-click on the analysis labeled FFA Test 5 from the study
explorer, or from the Analysis menu select Open and then select FFA
Test 5 from the list of available analyses. When FFA Test 5 is selected,
the Bulletin 17B analysis editor will appear as shown in Figure B-32.
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[=] Bulletin 17 Editor - FFA Test 5% & [
Mame FFATestS
Description: Example using other confidence limits and a base peak discharge =]
Flow Data Set. | Kaskaskia River-Vandalia, IL -
D35 File Name' | C:pROJECTS\SSPIProjects\SSP_Examples\SSP_EXAMPLES dss =
ReportFile: C:\PROJECTS\SSPIProjects\SSP_Examples\Bulletin17Results\FFA_Test_5\FFA_Test_5.rpt LJ
General | Options Tabular Results
Method for Computing Statistics and Confidence Limits Low Qutlier Test Confidence Limits
) 1TCEMA Multiple Grubbs-Beck Defaults (0.05, 0.95)
@ Single Grubbs-Beck @ User Entered Values
Generalized Skew Plotting Position Upper Limit: 0.01
Use Station Skew Weibull (Aand B =0) Lower Limit 0.99
@ Median (A andB=0.3)
@ Use Weighted Skew . N N .
Hazen (& and B = 0.5) Time Window Modification
Use Regional Skew HirschiStedinge
SEEIEEL R DSSRangeis 06MAY1908 - 16JUN1870
Regional Skew: = . =
0.4 Other (Specify A, B) Start Date =
Reg. Skew MSE: 0.302 Ay e P S, — —
Plotting position computed us:m_-,. for .1lI|C~I End Date ]
{m-A){n+1-A-B)
Expected Probablity Curve Where
© Compute Expected Prob. Cuve r;ff;fﬂj:'ﬁt;i
Do Not Compute Expected Prob. Curve HESETIRATS
B
compute | | Plotcuve | | viewRepot | [ Prnt | [ ok ][ aeey [ cancel

Figure B-32. Bulletin 17B Analysis Editor for FFA Test 5.

Shown in Figure B-32 are the general settings that were used to perform
this frequency analysis. As shown, the Skew option was set to use the

Weighted Skew. To use the weighted skew option, the user must enter a
value for the Regional Skew and the Regional Skew Mean Square Error
(MSE). This selection requires the user to either look up a value from the
generalized skew map of the United States, which is provided with

Bulletin 17B, or develop a value from a regional analysis of nearby gages.

In this example a value of -0.4 was taken from the generalized skew map
of the U.S. from Bulletin 17B. Bulletin 17B suggests using a Regional
Skew MSE of 0.302 whenever regional skew values are taken from the

map.

Also for this example, the Expected Probability Curve option was
selected to be computed in addition to the Log Pearson 11l computed

curve. The default method of Weibull plotting positions was selected.
The default values for confidence limits (.05 and .95) were changed to
0.01 (1 percent chance exceedance) and 0.99 (99% chance exceedance).
Shown in Figure B-33 is the Bulletin 17B editor with the Options Tab

selected.
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(=] Bulletin 17 Editor - FFA Test 5 [ ==l
Name: FFATest5
Description: Example using other confidence limits and a base peak discharge )]
Flow Data Set: :Kaskaskia River-Vandalia, IL =
D85 File Name: | Cc\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES dss 8]
Report File: CIAPROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_ExamplesiBulletin17Results\FFA_Test_5\FFA_Test_S.rpt o]
General | Options | Tabular Results|
Low Qutlier Threshold Historic Period Data User Specified Frequency Ordinates
Override Low Qutlier Threshold [] Use Historic Data [7] Use Values from Table Below
Value 2000 i i i
Historic Period Frequency in Percent
Start Year: 0.2
. 0.5
End Year: 10
Override High Outiier Threshald: 0 L
5.0
— 10.0
Historic Events 20.0
Water Year Peak 50.0
80.0
90.0
95.0
99.0
. Compute | ’ Plot Curve ] ’ View Report ] ’ Print ] ’ OK ] ’ Cancel ] Apply

Figure B-33. Bulletin 17B Editor with the Options Tab Shown for FFA Test 5.

As shown in Figure B-33, a Low Outlier Threshold of 2000 cfs was
entered. In the initial computation with this data (which the reader can
reproduce by Computing without the "Use Low Outlier Threshold™ box
checked), the default low outlier threshold was 1,253 cfs, just below the
second lowest value of 1,270 cfs. A look at the statistics and computed
frequency curve from that run shows that the 1,270 cfs value is well below
the computed curve and with a station skew of -0.21 the frequency curve
does not fit the upper data well. By choosing to also censor the 1,270 cfs
value with a threshold of 2000 cfs, the fit is improved. None of the other
available options, such as Historic Period Data and the option to override
the default Frequency Ordinates were selected for this test example.

Once all of the General and Optional settings are set or selected, the user
can press the Compute button to perform the analysis. Once the
computations have been completed a message window will open stating
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Compute Complete. Close this window and then select the Tabular
Results tab from the analysis window. The analysis window should look

Figure B-34.
[ Bulletin 17 Editor - FFA Test 5 = [
Name: FFATest5
Description: Example using other confidence limits and a base peak discharge (]
Flow Data Set: :Kaskaskia River-vandalia, IL -
DSS File Name: | C:\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES. dss )
Report File: CIPROJECTSVSSP_Testing\Projects\Appendix_B_Examplesi3SP_Examples\Bulletin17Results\FFA_Test 5\FFA_Test S.rpt [
| General | Dptionsl Tabular Results
Frequency Curve for: Kaskaskia River-Vandalia, IL
z E z S e~ Confidence Limits
ercent Chance omputed Curve pected Prob. )
Fl cfs
Exceedance Flow in cfs Flow in cfs owin &
0.01 0.99
0.2 92314.3 102679.1 163829.9 62770.9
0.5 73871.2 799942 123959.4 519971
1.0 G1633.1 G5543.3 989047 445818
2.0 50711.9 53081.6 776434 77326
5.0 38060.7 301377 54542 4 204334
10.0 20659.4 30178.4 40301.0 23616.6
20.0 220815 222774 28409.6 18050.2
50.0 12824.3 128243 15554.3 105541
80.0 7652.3 75831 9368.6 5936.8
90.0 5904.5 58195 7396.3 43671
95.0 47925 4685.0 51471 339238
99.0 328256 3136.2 44281 21307
System Statistics Mumber of Events
Log Transform: Flow Event Mumber
Statistic value H?storic E.vents 0
Mean 4116 [“gh[?“t}!'ers g
Standard Dev 0.274| ERETEE. 0
Station Skew 0.399 Se“t’ r "t_'sz'”gt 0
Regional Skew -0.400 (RS SIS
Weighted Skew 0.1g2| [Histoncreno
Adopted Skew 0.182
. Compute | ’ Plot Curve ] ’ View Report ] ’ Print ] ’ oK ] ’ Cancel ] Apply

Figure B-34. Bulletin 17B Editor with the Results Tab Selected for FFA Test 5.

As shown in Figure B-34, the Frequency Curve table contains the
following results:

Percent Chance Exceedance
Computed Curve (Log-Pearson Il results)
Expected Probability Curve

Confidence Limits (1% and 99% chance exceedance curves)

On the bottom left-hand side of the results tab is a table of Statistics for
the observed station data (mean, standard deviation, station skew) and
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regional adjustment (regional skew, weighted skew, and adopted skew).
Also on the bottom right-hand side of the results tab is a table of Number
of Events showing the number of historic events used in the analysis,
number of high outliers found, number of low outliers, number of zero or
missing data years, number of systematic events in the gage record, and
the historic record length (only if historic data was entered).

With the user-defined low-outlier threshold of 2000 cfs, there are two low-
outliers detected. The analysis report shows the program omitted these
values and used the Conditional Probability Adjustment to recompute the
resulting frequency curve and statistics. The report file (described below)
includes the preliminary computation before removal of outliers and the
default and user-defined outlier thresholds, as well as the final frequency
curve and statistics.

In addition to the tabular results, a graphical plot of the computed
frequency curves can be obtained by pressing the Plot Curve button at the
bottom of the analysis window. A plot of the results for this example is
shown in Figure B-35.

[] Bulletin 17 Plot for FFA Test 5 = | B jwé S
File Edit View Window
Bulletin 17 Plotfor FFA Test &
Return Period
1.1 2 a 10 an 200 10000
1':”:”:”:”:”:":' 1 1 1 1 1 1 1 1 1 1 1 1
1000000+
i
= 10000.0
[}
o
10000+ s
O
100.0 T T T T T T T 11 T T
.99 nga 0.5 nz2 o1 0.0z 0002 0.0001
Frobahility
Computed Curye ===--- Expected Probahbility Curve
= == 1 Percent Confidence Limit === 88 Percent Confidence Limit
2 Observed Events (eibull plotting postions) O Low Qutlier

Figure B-35. Plot of the Frequency Curve Results for FFA Test 5.
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The tabular and graphical results can be sent to the printer or the windows
clipboard for transfer into another piece of software. To print the tabular
results, select Print from the bottom of the analysis window. To send the
tabular results to the windows clipboard, highlight the data you want to
send to the clipboard and then press the Control-C key sequence. To print
the graphical results, first bring up the graphical plot and then select Print
from the File menu. To send the graphic to the windows clipboard, select
Copy to Clipboard from the File menu.

In addition to the tabular and graphical results, there is a report file that
shows the order in which the calculations were performed. To review the
report file, press the View Report button at the bottom of the analysis
window. When this button is selected a text viewer will open the report
file and display it on the screen. Shown in Figure B-36 is the report file
for FFA Test 5.

The report file contains a listing of the input data, preliminary results,
outlier and historical data tests, additional calculations needed, and the
final frequency curve results. Different types and amounts of information
will show up in the report file depending on the data and the options that
have been selected for the analysis.
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==

N E B ———
File Edit Search Format

File: C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\Bulletin17Results\FFA_Test_5\FFA_Test 5.rpt

Bulletin 17B Fregquency Analysis
12 Jan 2016 10:18 EM

m

——— Input Data ——

Analysis Name: FFR Test 5
Description: Example using other confidence limits and a base peak discharge
Kaskaskia Riwver at Vandalia, IL

Data Set Name: Kaskaskia Riwver-Vandalia, IL
D55 File Name: C:\PROJECTS\SS5F Testing\Projects\Appendix B Examples‘\S5SF_Examples‘\S5P EXAMPLES.dss [
D35 Pathname: /EASKASKIZ RIVER/VANDALIAZA, IL/FLOW/01janl300/IR-CENTURY/OBS/

Report File Name: C:\FROJECTS\55F Testing\Projecta\Appendix B Examples‘\35F Examples‘\Bulletinl7Results\FFA Tesat 5\FFA Te
¥ML File Name: C:\PROJECTS\SSP_Testing\Projects\Appendix B Examples\S55P Examples\Bulletinl7Results\FFA Test S\FFA Test

Start Date:
End Date:

Skew Option: Use Weighted Skew
Regional Skew: -0.4

Regional Skew MSE: 0.302
Plotting Position Type: Weibull
Upper Confidence Lewvel: 0.01
Lower Confidence Level: 0.9%
Use Low Outlier Threshold

Low OQutlier Threshold: 2000.0

Display ordinate walues using 1 digits in fraction part of wvalue

——— End of Input Data ———
——— Preliminary Results ———

<< Skew Weighting >>

< [ | p

011212016 10:18 AM 1111 11

Figure B-36. Report File for FFA Test 5.
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Example 6: Use of Historic Data and Median Plotting

Position

This example demonstrates how to use historic information to improve a
flow frequency analysis. A historic flood peak of 15,000 cfs which
occurred in 1843 is included in the analysis. This value is the highest
known value up to the present time (1974 for this example), even though
the systematic record stopped in 1955.

The data for this example is from Ridley Creek in Moylan, Pennsylvania.
The period of record used for this example is from 1932 to 1955. To view
the data from HEC-SSP, right-click on the data record labeled "Ridley
Creek-Moylan, PA" in the study explorer and then select Tabulate. The
data will appear as shown in Figure B-37.

Jl /RIDLEY CREEK/MOYLAN, PAJFL... s o[

File Edit WView
MOYLAM, PA
Ordinate Date Time FLOW
0OBS
Units CFS
Type INST-WVAL
1| 28 Mar 1932 12:00 891.0
2| 23 Aug 1933 12:00 26800
3| 05 Mar1934 12:00 1,080.0
4/ 09 .Jul 1935 12:00 3,000.0
5 03 Jan 1936 12:00 1,590.0
6| 22Feb1937 12:00 770.0
7| 23 .Jul1938 12:00 33200
8| 03 Feb1939 12:00 a978.0
9 15 Mar 1940 12:00 1,770.0
10| 07 Feb 1941 12:00 T46.0)
11| 13 Aug 1942 12:00 1,000.0
12| 30 Dec 1942 12:00 9580.0
13| 06 Jan 1944 12:00 865.0
14| 18 Sep 1945 12:00 1,040.0 0
15| 26 Dec 1945 12:00 1,000.0
16| 22 May 1947 12:00 433.0010
17| 05 May 1948 12:00 740.0
18| 30Dec 1948 12:00 1,040.048
19| 03 Aug 1950 12:00 1,590.0
200 25 MNov 1950 12:00 57200
21 11 Mar 1952 12:00 1,490.0
22| 22 MNov 1952 12:00 918.0
23| 14 Dec 1953 12:00 670.0
24| 18 Aug 1955 12:00 4.390.0

Figure B-37. Tabulation of the Peak Flow Data for Ridley Creek.
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To plot the data for this example, right-click on the data record and then
select Plot. A plot of the data will appear as shown in Figure B-38.

[ Ridley Creek-Moylan, PA

= [ B -

File Edit View

5,000+

4,000+

3,000+ e

Flomy {cfs)

2,000+

1,000+ o

0-—— T T T T T T T T T T

T T T T T T T T T T T
1934 1836 1933 1940 1942 15944 1946 1943 1950 1952 1954

o

MO LAMN, PA OBS FLCWY

Figure B-38. Plot of the Ridley Creek Data.

A Bulletin 17B and General Frequency analysis have been developed for
this example. To open the Bulletin 17B analysis editor for FFA Test 6,

either double-click on the analysis labeled FFA Test 6 from the study

explorer, or from the Analysis menu select open, then select FFA Test 6

from the list of available analyses. When FFA Test 6 is selected, t
Bulletin 17B analysis editor will appear as shown in Figure B-39.

he
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[=] Bulletin 17 Editor - FFA Test 6* E- S
Name FFATest6
Description: Example using Median plot positions, historic data, and period of knowledge beyond last year of data =]
Flow Data Set  Ridley Creek-Maylan, PA hs
D35 File Name' | C:pROJECTS\SSPIProjects\SSP_Examples\SSP_EXAMPLES dss =
ReportFile: C:\PROJECTS\SSPIProjects\SSP_Examples\Bulletin17Results\FFA_Test_B\FFA_Test_6.rpt LJ
General | Options Tabular Results
Method for Computing Statistics and Confidence Limits Low Qutlier Test Confidence Limits
) 1TCEMA Multiple Grubbs-Beck @ Defaults (0.05, 0.95)
@ Single Grubbs-Beck User Entered Values
Upper Limi
Generalized Skew Plotting Position SLICTILTITE
Use Station Skew Weibull (4 and B =0) Lower Limit:
@ Median (AandB=03)
@ Use Weighted Skew N . "
Hazen (4 and B = 0.5) Time Window Modification
Use Regional Skew Hirsch/Stedinge
Rl SR DSSRangeis 28MAR1932 - 18AUG1955
Regional Skew: . —
0.4 Other (Specify A, B) Start Date =
Reg. Skew MSE: 0.302 ey e e e - P =
Plotting position computed us:m_; for ju\a End Date ]
{m-A)/{n+1-A-B)
Expected Probablity Curve Where:
© Compute Expected Prob. Cuve ITf:i?'j]j;:}f.:E:f:
Do Not Compute Expected Prob. Curve HESETIEATNE
B:
compute | | Plotcuve | | viewRepot | [ Prnt | [ ok ][ aeey [ cancel

Figure B-39. Bulletin 17B Analysis Editor for FFA Test 6.

Shown in Figure B-39 are the general settings that were used to perform
this frequency analysis. As shown, the Skew option was set to use the
Weighted Skew. To use the weighted skew option, the user must enter a
value for the Regional Skew and the Regional Skew Mean Square Error
(MSE). This selection requires the user to either look up a value from the
generalized skew map of the United States, which is provided with
Bulletin 17B, or develop a value from a regional analysis of nearby gages.
In this example a value of 0.4 was taken from the generalized skew map of
the U.S. from Bulletin 17B. Bulletin 17B suggests using a Regional Skew
MSE of 0.302 whenever regional skew values are taken from the map.

Also for this example, the Expected Probability Curve option was
selected to be computed in addition to the Log Pearson Il computed
curve. The Median plotting position method was selected, as well as the
default Confidence Limits of 0.05 (5 percent chance exceedance) and
0.95 (95% chance exceedance). Shown in Figure B-40 is the Bulletin 17B
editor with the Options Tab selected.
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[=] Bulletin 17 Editor - FFA Test 6 = @I
Name: FFATest6
Description: Example using Median plot positions, historic data, and period of knowledge beyond last year of data ]
Flow Data Set | Ridley Creek-Moylan, PA -
D55 File Name: | C:\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES dss 8]
Report File: CAPROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\Bulletin17Results\FFA_Test G\FFA_Test_G.rpt o]
| General| Options | Tabular Results|
Low Qutlier Threshold Historic Period Data User Specified Frequency Ordinates
[] override Low Qutlier Threshold Use Historic Data [7] Use Values from Table Below
Value istori i
Historic Period Frequency in Percent
Start Year: 0.2
. 0.5
End Year: 1974 1.0
Override High Outlier Threshold: 2.0
5.0
— 10.0
Historic Events 20.0
\Water Year Peak 50.0
1843 15000.0 80.0
90.0
95.0
99.0
“Compute | | PlotCuve | [ ViewReport | [ Print | [ ok [ cancel || ppp
Figure B-40. Bulletin 17B Analysis Editor with Options Tab Shown for FFA

Test 6.

As shown in Figure B-40, the Historic Period Data option has been
selected to reflect a historical flood event of 15,000 cfs in 1843 and an
analysis period from 1843 to 1974. Historic data is used to account for
historic flood events large enough to be relevant to the analysis and not
contained in the systematic data record. The additional information
provided by historic data can improve the flood frequency analysis,
especially when the data collection period for a given area is relatively
short. Information for a Historic Flood Peak has been entered to account
for a peak flow of 15,000 cfs in the 1843 water year. The Historic Period
Start Year has been left blank. By default this value will be the earliest
year found in the historic flood peak data or the systematic record.
Therefore for this example, 1843 will automatically be used for the Start
Year of the Historic Period. An End Year of 1974 has been entered. The
systematic record for the gage ended in 1955, however when this analysis
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was performed in 1974, no other flood peaks of consequence had been
observed between 1955 and 1974. Therefore, 1974 is set as the End Year
for the historic period analysis.

Other features on this tab include the Low Outlier Threshold and the
option to override the default Frequency Ordinates. Neither option is
selected in this example.

Once all of the General and Optional settings are set or selected, the user
can press the Compute button to perform the analysis. Once the
computations have been completed a message window will open stating
Compute Complete. Close this window and then select the Tabular
Results tab from the analysis window. The analysis window should look
Figure B-41.

[ Bulletin 17 Editor - FFA Test 6 & =
Name: FFATest6
Description: Example using Median plot positions, historic data, and period of knowledge beyond last year of data E]
Flow Data Set: | Ridley Creek-Moylan, PA .
DSS File Name: | C:\PROJECTSISSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.dss o]
Report File: C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\Bulletin17Results\FFA_Test_G\FFA_Test 6.rpt E]
| General | Dptionsl Tabular Results
Frequency Curve for: Ridley Creek-Moylan, PA
z G z S S Tal: Confidence Limits
ercent Chance omputed Curve pected Prob. )
Fl cfs
Exceedance Flow in cfs Flow in cfs owin cs
0.05 0.95
0.2 17499.9 289445 41571.2 10177.3
0.5 12096.4 172255 25679.7 7516.8
1.0 9065.0 11758.7 17650.2 59243
20 67243 30842 11994.0 4621.3
5.0 4435.0 49144 70367 32528
10.0 316158 33503 4595.1 2426.5
200 21805 22433 29203 17339
50.0 1198.0 1198.0 14951 948.6
80.0 7544 7434 9524 557.2
90.0 622.3 G07.4 799.6 441.0
95.0 5434 5245 709.0 728
99.0 4435 4205 5942 289.0
System Statistics Mumber of Events
Log Transform: Flow Event Mumber
Statistic Value H?storic E.\.'ents 1
Mean 3.120 E'ghgﬂ}!'ers g
Standard Dev 0.284| SERETIEE. o
Station Skew 1078 Se“t’ r ‘;_'SE'”gt 5
Regional Skew 0.400 Hy.fsternapm - \.';n s 12
Weighted Skew 0.890| (storicFerno
Adopted Skew 0.890
- Compute ’ Plot Curve ] ’ View Report ] ’ Print ] ’ oK ] ’ Cancel ] Apply

Figure B-41. Bulletin 17B Editor with the Results Tab Selected for FFA Test 6.
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As shown in Figure B-41, the Frequency Curve table contains the
following results:

Percent Chance Exceedance

Computed Curve (Log-Pearson 11 results)

Expected Probability Curve

Confidence Limits (5% and 95% chance exceedance curves)

On the bottom left-hand side of the results tab is a table of Statistics for
the observed station data (mean, standard deviation, station skew) and
regional adjustment (regional skew, weighted skew, and adopted skew).
Also on the bottom right-hand side of the results tab is a table of Number
of Events showing the number of historic events used in the analysis,
number of high outliers found, number of low outliers, number of zero or
missing data years, number of systematic events in the gage record, and
the historic record length (if historic data was entered).

This example reports one historical flood event, and a historical period of
132 years, between 1843 and 1974. The reported statistics reflect the use
of the historical data adjustment outlined in Bulletin 17B Appendix 6.
The report file (described below) shows the initial computation of the
statistics and frequency curve before the historical data was used, and the
resulting statistics and frequency curve after the historical data is taken
into account.

In addition to the tabular results, a graphical plot of the computed
frequency curves can be obtained by pressing the Plot Curve button at the
bottom of the analysis window. A plot of the results for this example is
shown in Figure B-42.
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[] Bulletin 17 Plot for FFA Test 6 = | B jwé S
File Edit View Window
Bulletin 17 Plot for FFATest 6
] Return Period
Q 1.1 2 a 10 an 200100010000
1':”:”:”:”:":' 1 1 1 1 1 1 1 1 1 1 1 1
il
i
£
/ 3
/;»"
100000+ ;f-’“? f/
— e i
E /‘:@;;:f"
s 0%
= - g
L - -
..--"" -
100004 —
— =g~
100.0 T T T | — T T 11 T T
.99 nga 0.5 nz2 o1 0oz 0002 0.0001
Frobahility
Computed Curye ===--- Expected Probahbility Curve
— == 5 Percent Confidence Limit === 85 Percent Confidence Limit
] Obzetved Events (Median plotting positions) Historic Data

Figure B-42. Plot of the Frequency Curve Results for FFA Test 6.

The tabular and graphical results can be sent to the printer or the windows
clipboard for transfer into another piece of software. To print the tabular
results, select Print from the bottom of the analysis window. To send the
tabular results to the windows clipboard, highlight the data you want to
send to the clipboard and then press the Control-C key sequence. To print
the graphical results, first bring up the graphical plot and then select Print
from the File menu. To send the graphic to the windows clipboard, select
Copy to Clipboard from the File menu.

In addition to the tabular and graphical results, there is a report file that
shows the order in which the calculations were performed. To review the
report file, press the View Report button at the bottom of the analysis
window. When this button is selected a text viewer will open the report
file and display it on the screen. Shown in Figure B-43 is the report file

for FFA Test 6.
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The report file contains a listing of the input data, preliminary results,
outlier and historical data tests, additional calculations needed, and the
final frequency curve results. Different types and amounts of information
will show up in the report file depending on the data and the options that
have been selected for the analysis.

[ [ Fra_test .pt =5

R

File Edit Search Format

File: C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\Bulletin17Results\FFA_Test_6\FFA_Test G.rpt

Bulletin 17B Fregquency Analysis
12 Jan 2016 10:20 BEM

m

——— Input Data ——

Analysis Name: FFR Test &
Description: Example using Median plot positions, historic data, and pericd of knowledge beyond last year of data
Ridley Creek at Moylan, PR

Data Set Name: Ridley Creek-Moylan, PR N
D55 File Name: C:\PROJECTS\SS5F Testing\Projects\Appendix B Examples‘\S5SF_Examples‘\S5P EXAMPLES.dss [
D35 Pathname: /RIDLEY CREEK/MOYLAN, PA/FLOW/01janl1900/IR-CENTURY/OBS/

Report File Name: C:\PFROJECTS\55F Testing\Projects\Rppendix B Examples)\55F Examples‘\Bulletinl7Results\FFA Test &\FFR Te
¥ML File Name: C:\PROJECTS\SSP_Testing\Projects\Appendix B Examples\55F_ Examples\Bulletinl7Results\FFA Test 6\FFA Test_

Start Date:
End Date:

Skew Option: Use Weighted Skew
Regional Skew: 0.4

Regional Skew MSE: 0.302
Plotting Position Type: Median

Upper Confidence Lewvel: 0.05
Lower Confidence Level: 0.85

Use Historic Data

Historic Period Start Year: -—-
Historic Period End Year: 1574
Year: 1843 Value: 15,000

Display ordinate walues using 1 digits in fraction part of wvalue

——— End of Input Data ———

——— Preliminary Results ———

<| .. - | -

011212016 10:20 AM 1111 11

Figure B-43. HEC-SSP Report File for FFA Test 6.
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Example 7: Analyzing Stage Data

This example demonstrates how to use the General Frequency analysis to
analyze stage data. The data for this example is annual maximum stage
data for a reservoir. The period of record used for this example is from
1948 to 2004. To view the data, right-click on the data record labeled
"Reservoir Stage" in the study explorer and then select Tabulate. The
data will appear as shown in Figure B-44.

A /BE CREEK/RESERVOIR/STAGE/D... i =)
File Edit View
RESERVOIR
Ordina..|  Date Time STAGE
OBSERVED
Units feet| »
Type INST-VAL |
1| 01Jan 1948 12:00 631.88
2| 01Jan 1949 12:00 630.17
3| 01 Jan 1950 12:00 647 47
4| 01.Jan 1951 12:00 63182
5[ 01Jan 1952 12:00 £32.88
6| 01.Jan 1953 12:00 655.37| _
7| 01Jan 1954 12:00 647.63|
8| 01.Jan 1955 12:00 £38.00
9| 01 Jan 1956 12:00 640 65
10| 01Jan 1957 12:00 634 51
11| 01Jan 1958 12:00 £34.49
12| 01 Jan 1959 12:00 637.49
13[ 01 Jan 1960 12:00 £32.36
14| 01.Jan 1961 12:00 638.02
15[ 01Jan 1962 12:00 £30.59
16| 07 Jan 1963 12:00 626.77
17| 01Jan 1964 12:00 £30.28
18] 01 Jan 1965 12:00 630.12
19] 01 Jan 1966 12:00 630.79
20[ 01Jan 1967 12:00 637.63
21| 01Jan 1958 12:00 £32.21
22| 01 Jan 1958 12:00 63210
23| 01Jan 1970 12:00 623.00
24| 01.Jan 1971 12:00 £30.40
25| 01Jan 1972 12:00 658.40
26| 01Jan 1973 12:00 630.80
27| 01Jan 1974 12:00 631.60
28| 01Jan 1975 12:00 63840 -

Figure B-44. Tabulation of the Peak Stage Data for Example 7.

To plot the data for this example, right-click on the data record and then
select Plot. A plot of the data will appear as shown in Figure B-45.
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@ Reservoir Stage

=RRE X

File Edit View

GE0

650

645

G40

Stane (M)

B35 (T

B30-°

G254

620

T T
1950 1960

T T T T
1970 1980 1990 2000

< RESERWOIR OBSERWED STAGE

Figure B-45. Plot of the Reservoir Stage Data.

A General Frequency analysis has been developed for this example. To
open the General Frequency analysis editor for this example, either
double-click on the analysis labeled Stage Analysis Test 7 from the study
explorer, or from the Analysis menu select open, then select Stage
Analysis Test 7 from the list of available analyses. When test 7 is opened,
the General Frequency analysis editor will appear as shown in Figure B-
46. For this analysis, the Do Not Use Log Transform option was
selected, the Weibull plotting position method was selected, the default
Confidence Limits were selected, and no modification was made to the

time window.
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Mame:
Description:
Data Set:

D34S File Name:

Report File:

[¥] General Frequency Analysis Editor - Stage Analysis Test 7

Stage Analysis Test 7|

Example 7, Analysis of Reservoir Stage Data

:Reservoirstage

CAPROJECTS\SSP\Projects\SSP_Examples\SSP_EXAMPLES. dss

L

-

=)

\Projects\3SP_Examples\GeneralFrequencyResults\Stage_Analysis_Te st_'ﬁ.StageE]

(& [

General | Options | Analytical | Graphical

Log Transform

Upper Limit:

Lower Limit:

DSS Range is
[] start Date

[] End Date

Data Set

) Use Log Transform

@ Do Motuse Log Transform

Confidence Limits
@ Defaults (0.05, 0.95)

() User Entered Values

Time Window Modification

01JAN1948 - 01JANZ2004

(7) Partial Duration

Period of Record Years:

@ Annual Maximum:

Plotting Position
@ Weibull (A and B =0)
) Median (AandB=10.3)
(7) Hazen (Aand B=05)
() Other (Specify A, B)

Plotting position computed using formula
(m-A)(n+1-A-B)

Where:
m=Rank, 1=Largest
M=Mumber of Years
AB=Constants

Compute

Plot Analytical Plot Graphical
Curve

Curve ‘ View Report @ Print

Cancel

Figure B-46. General Frequency Analysis Editor for Stage Analysis Test 7.

Shown in Figure B-47 is the General Frequency analysis editor with the
Options Tab selected. Features on this tab include the Low Outlier
Threshold, adding Historic Date to the analysis, an option to override the
default Frequency Ordinates, and Output Labeling. The 0.1 percent

frequency ordinate was added to the User Specified Frequency

Ordinates table.
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[ General Frequency Analysis Editor - Stage Analysis Test 7 =) |etEm
Name: Stage Analysis Test 7]
Description: Example 7, Analysis of Reservoir Stage Data
Data Set: Resenvoir Stage
D33 File Name: |3 JECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES ds:()
Report File: P_Examples\GeneralFrequencyResults\Stage_Analysis_Test_7\Stage_Analysis_Test 7.rpi[]
| General| Options | Analytical | Graphical i
Low Outlier Threshold Histaoric Period Data User Specified Frequency Ordinates
[T override Low Outlier Threshold [ Use Historic Data Use Values from Table Below
Value = - =
Historic Period Freguency in Percent
Cutput Labeling SEiGEE 01
. X 1.0
DSS DataMNameis STAGE EndYear 20
[E] Change Label |STAGE Override High Outlier Threshald: 13-3
DSS Data Units are — 12.0
Historic Events 150
[7] Change Label Water Year Peak 20.0
300 =
50.0
70.0
80.0
90.0
95.0
99.0

Compute

Plot Analytical
Curve

Plot Graphical
Curve

View Report @ Print

[ OK H Cancel l

Figure B-47. General Frequency Analysis Editor with Options Tab Shown for

Stage Analysis Test 7.

Once all of the General and Optional settings are set or selected, the user

can choose to perform an Analytical or Graphical analysis. In this
example, a graphical analysis was performed on the peak stage data.

Shown in Figure B-48 is the Graphical tab. The frequency curve was
entered manually into the User-Defined Graphical Curve table. When
the Compute button is pressed, the program plots the graphical frequency
curve along with the annual maximum peak stage values.
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[ General Frequency Analysis Editor - Stage Analysis Test 77 IE@
Name: Stage Analysis Test7
Description: Example 7, Analysis of Reservoir Stage Data =]
Data Set :Reser\«'mr Stage -

DSS File Name: ) JECTSISSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.ds:()

Report File: P_Examples\GeneralFrequencyResults\Stage_Analysis_Test_7\Stage_Analysis_Test_7.rpi)
| Generall Options | Analytical| Graphical it
R General Frequency Graphical Plot for Stage Analysis Test 7 AT TE
Retum Period @ Mormal (Top N Events) Log (All Events)
] 1.1 2 5 10 50 2001000 10000 Data Type
| | f P PR |
Y T R I I R R — | T = | @ Flow @ Stage
1 11 A I O e | A i ) .
| | 111 . L | ',’I
630 1 | I | I S D I P | Equivalent Years 5
| 11 -y 1 ofRecord 57
1 I | I | I/I’ 1
670 : : : : : : : : H: : + : ! User-Defined Graphical Curve
7
I { I A 1 i e e | 1 i
_ Gl | TR T T | Frequency Ordinates
T 1 I | 1 {1 | 1 A Percent Chance
£ TR . ] 1 e — Blakalalas 3
= i 1 I  — - (| 1 L —
1) 6 i e B B B I B e e ] = 0.1 671.5
= 1 I | A T e | 1 1.0 661.0
B i e B e | 1{,/( Il i 2.0 6580
640 I I [ - 11 I 5.0 §52.0
I F1 1 oy e e 1 1 S e | 1 Thoh G152
| Bl s 1 R | = s
6304 I s o A i — | I 12.0 €47.8
ZERRE R R
20.0 638.9
620+ | R . 1. | | 30.0 537.5
I I | A I ] | 1 . :
1 | A . 1 B A | 1 50.0 633.5
| L1 11 | | I N R N | | L~ 70.0 63l.2
610 T T T T T T T T -
0888 089 09 05 0204 002 0002 0.0001 ;gg :3;;
Exceedance Probahility 95:,_-, 630:0
[« mj ¢ 95.0 £20.0
o] Ohserved Events QWveibull plotting positions)
User Curve -
Plot Analytical Plot Graphical
Compute Curve Cunve View Report & Print [ ok || cancel |[ appy |

Figure B-48. General Frequency Graphical Tab Shown for Stage Analysis Test
1.

In addition to the table and plot available on the Graphical tab, a plot of
the graphical frequency curves can be obtained by pressing the Plot
Graphical Curve button at the bottom of the analysis window. A plot of
the results for this example is shown in Figure B-49.
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@ General Frequency Graphical Plot for Stage Analysis Test 7 I. =NN ﬁ]
File Edit View Window
General Fregquency Graphical Plot for Stage Analvsis Test 7
Return Period
1.1 2 a 10 anl 200 1000 10000
R S s e ey s i B B A e e R
| 111 | I I N Y I B /’I
4 | 111 | I S -
680 T [ o et Ry (o 1 I [t I |
| 111 | i I)/ |
670 | R B | HH | /I
| i | 1 I//I | |
- | I . . | 1l {, | l/ |
3 B0 | 111 | I N E |
= | I - | I Il.f | I
T St it R [ Rl St S || B S
) | 111 | I 4 |
= | 11 | -l Ii__,.l-"' -1 |
0 G40 I L2 11 I
| I . . 1 o 1 J N R N I |
I ..1.-,-_-1_‘.!1'."_-"."-"":'1':"'. I I III I I I I
B30 | | I N Y S A | |
A 111 | N A | |
| 111 | 0 S W |
620 e I I I B o I B [ B [
i | i | o 1 N o e B | |
G110 I| 1 I| L1 I| 1 I| I“I I I| I| 1 I| T T
.99 nga 0.5 02 01 n.oz n.ooz2 00001
Exceedance Probability
] Obzetved Events (Weibull plotting positions) U=zer Curve
— —= 5 Percent Confidence Limit — —= 83 Percent Confidence Limit

Figure B-49. Plot of the Frequency Curve Results for Stage Analysis Test 7.

Graphical results can be sent to the printer or the windows clipboard for
transfer into another piece of software. To print the graphical results, first
bring up the graphical plot and then select Print from the File menu. To
send the graphic to the windows clipboard, select Copy to Clipboard
from the File menu.

In addition to the tabular and graphical results, there is a report file that
shows the order in which the calculations were performed. To review the
report file, press the View Report button at the bottom of the analysis
window. When this button is selected a text viewer will open the report
file and display it on the screen. Shown in Figure B-50 is the report file
for Stage Analysis Test 7.

The report file contains a listing of the input data, preliminary results,
outlier and historical data tests, additional calculations needed, the final
computed frequency curve results, and the user-defined graphical
frequency curve. Different types and amounts of information will show
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up in the report file depending on the data and the options that have been

selected for the analysis.

@ Stage_Analysis_Test_T.rpt

=

File Edit Search Format

File: | C\PROJECTS\SSP_Testing\Projects\ippendix_B_Examples\SSP_Examples\GeneralFrequencyResults\Stage_Analysis_Test_7\Stage

Reservoir Stage

——— End of Analytical Frequency Curve ———

<< User-Defined Graphical Freguency Curve >>
Reservoir Stage

——— End of Graphical Freguency Curve ——

| |

| |
| Mean 635.612 | Historic Events a |
| Standard Dev §.905 | High Outliers 2 |
| Station Skew 1.511 | Low Qutliers ] |
| | Zero Ewvents a |
| | Missing Ewvents 0 |
| | Systematic Ewents 57 |

|

| User-Defined | Percent | Confidence Limits |
| Curve | Chance | . 05 0.95 |
| SIAGE, feet | Exceedance | STAGE, feet |
e [ o |
| 671.50 | 0.1 | 686.59 656.41 |
| 661.00 | 1.0 | 672.70 649.30 |
| 658.00 | 2.0 | 668.73 647.27 |
| €52.00 | 5.0 | 660.80 643.20 |
| 648.20 | 10.0 | 655.77 640.63 |
| 647.60 | 12.0 | 653.86 639.65 |
| 641.00 | 15.0 | 647.62 635.75 |
| 638.90 | 20.0 | 443.30 635.75 |
| 637.50 | 30.0 | 639.42 635.58 |
| 633.50 | 50.0 | 635.17 631.83 |
| 631.19 | 70.0 | 633.52 630.76 |
| 631.10 | 0.0 | 633.52 630.75 |
| 630.50 | 90.0 | 633.52 629.04 |
| £30.00 | 95.0 | 633.52 626.48 |
| 6§20.00 | 99.0 | 623.12 616.88 |
| |

I UL Jamm ZUuU 83l. 1% I 33 1583 83U 28 gL.3T I -~
| 01 Jan 2001 631.12 | 54 1945 630.17 93.10 |
| 01 Jan 2002 636.54 | 55 1965 630.12 94.83 |
| 01 Jan 2003 636.96 | 56 1963 626.77 96.55 |
| 01 Jan 2004 648.34 | 57 1970 623.00 98.28 |
|

< | 1M

m

01122016 10:25 AM

28:15.28:15 28:15 |J

Figure B-50. Report File for Stage Analysis Test 7.
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Example 8: Using User-Adjusted Statistics

This example demonstrates how to use the General Frequency analysis
and enter user-adjusted statistics. The data for this example is from an
analysis that computed local runoff for the Rio Grande at Albuquerque.
The data includes unregulated daily average flows generated by rainfall-
runoff from areas downstream of upstream reservoirs. The period of
record used for this example is from 1944 to 2000. To view the data,
right-click on the data record labeled "Rio Grande at Alb Local Runoff"
in the study explorer and then select Tabulate. The data will appear as

shown in Figure B-51.

Ay R0 GFLANDE..’LDCAL_INFLOWS...[ = | B S
File Edit View
LOGAL_IN...
Crdina... Date Time FLOW
CALC
Units CF3| =
Type PER-AVER
1] 19 Aug 1944 24:00 1,175.0
2[ 21 May 1945 24:00 1,297.0
3| 21 Aug 1946 24:00 978.0
4] 16 Aug 1947 24:00 741.0
5| 20 Jun 1943 24:00 23130
G| 04 Aug 1949 24:00 1,891.0]
7| 02 Aug 1950 24:00 1,790.0| =
& 014ug 1951 24:00 1,489.0
o[ 12 Aug 1952 24:00 2,061.0
10| 18 Jul 1953 24:00 1,430.0
11| 23 May 1954 24:00 930.0
12| 25 Sep 1955 24:00 4790.0
13| 20 Jul 1956 24:00 1,040.0
14| 20 Oct 1957 24:00 3,613.0]
15| 30 May 1958 24:00 4,358.0
16| 24 May 1959 24:00 5420
17| 11 Jun 1960 24:00 812.0
18| 23 Aug 1961 24:00 861.0
19| 09 Jul 1962 24:00 927.0
20| 30 Aug 1963 24:00 505.0
21| 06 Jun 1964 24:00 361.0
22| 19 Jun 1965 24:00 1,677.0
23| 02 Aug 1966 24:00 1487.0
24| 10 Aug 1967 24:00 4186.0
25| 01 Aug 1968 24:00 911.0
26| 12 Sep 1969 24:00 1,519.0
27| 15 May 1970 24:00 847.0
25| 27 Jul 1871 24:00 22290 -

Figure B-51. Tabulation of the Peak Flow Data for Example 8.

To plot the data for this example, right-click on the data record and then
select Plot. A plot of the data will appear as shown in Figure B-52.
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@ Rio Grande at Alb Local Runoff

= | B (et

File Edit View

5,000

B| 4,500+ o

4,000+

3,500

3,000+

2,500+

Flomy {cfs)

2,000
1,500 o5 oo
11,0004 © %055 =

500 e e

T T T
1950 1960 1970

T
1980

T T
1990 2000

@ LOCAL_IMNFLOWYS_ALBUGUERGUE CALC FLOWY

Figure B-52. Plot of Data for Example 8.

A General Frequency analysis has been developed for this example. To
open the General Frequency analysis editor for this example, either
double-click on the analysis labeled Local Runoff at Alb Test 8 from the
study explorer, or from the Analysis menu select open, then select Local
Runoff at Alb Test 8 from the list of available analyses. When test 8 is
opened, the General Frequency analysis editor will appear as shown in

Figure B-53.
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[¥] General Frequency Analysis Editor - Local Runoff at Alb Test 8 E@
Name: Local Runoff at Alb Test 8|
Description: This examples shows how to enter user adjusted statistics )
Data Set: 'Rio Grande at Alb Local Runaff X
DSSFile Name: | CAPROJECTSISSP\Projects\SSP_Examples\SSP_EXAMPLES dss G
Report File: SP_Examples\GeneralFrequencyResults\Local_Runoff_at Alb_Test 8\Local_Rurl.)

General | Options | Analytical | Graphical

Log Transform Plotting Position
@ Weibull (A andB=10)

~) Median (AandB=0.3)
~) Hazen (A and B =0.5)

@ Use Log Transform

() Do Motuse Log Transform

Confidence Limits ") Other (Specify A, B)

@ Defaults (0.05, 0.95) . . i
Plotting position computed using formula
~1 User Entered Values (m-A){n+1-A-B)
Where:
0.05 m=Rank, 1=Largest
I R M=Murr fYears
Loty Limie 0.9 A B=Constants

Upper Limit:

Time Window Modification B

D33 Rangeis 19AUG1944 - 240CT2000

[7] Start Date ()]
[7] End Date ()]
Data Set

) Partial Duration

Period of Record Years:

@ Annual Maximum:

Plot Analytical
Compute Curve

| Plot Graphical

Curve ‘ I Wiew Report ‘ l %F’rint ‘ I 0K ‘ Apply Cancel
Figure B-53. General Frequency Analysis Editor for Local Runoff at Alb Test 8.

Shown in Figure B-53 are the general settings that were used to perform
this frequency analysis. For this analysis, the Use Log Transform option
was selected, the Weibull plotting position method was selected, the
default Confidence Limits were selected, and no modification was made
to the Time Window.

Shown in Figure B-54 is the General Frequency analysis editor with the
Options Tab selected. Features on this tab include the Low Outlier
Threshold, an option to use Historic Data, an option to override the
default Frequency Ordinates, and Output Labeling. All defaults
settings were selected for this example.
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@ General Frequency Analysis Editor - Local Runoff at Alb Test 8 IE@I
Name: Local Runoff at Alb Test §
Description: This examples shows how to enter user adjusted statistics 3]
Data Set: Rio Grande at Alb Local Runoff h

DSE File Name: | 3JECTS\SSP_Testing\Projects\sppendic_B_Examples\SSP_Examples\SSP_EXAMPLES.ds:.]

Report File: C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\GeneralFrequl.]
General| Options | Analytical | Graphical =
Low Qutlier Threshold Historic Period Data User Specified Frequency Ordinates

["] Override Low Outlier Threshold || Use Historic Data |71 Use Values from Table Below

Value istori i
Historic Period Frequency in Percent

Qutput Labeling Start Year. T oo

0SS Data Mameis FLOW End Year: 0

[7] Change Label Override High Outlier Threshold: 2.0

. 10.0
DSS Data Units are  CFS Historic Events

[7] change Label ‘Water Year Feak 500

m

Plot Analytical

Compute l Curve View Report & print [ oK H Cancel l Apply

Figure B-54. General Frequency Analysis Editor with Options Tab Shown for
Local Runoff at Alb Test 8.

Plot Graphical
Curve

Once all of the General and Optional settings are set or selected, the user
can choose to perform an Analytical or Graphical analysis. In this
example, an analytical analysis was performed. Shown in Figure B-55 is
the Settings tab for the analytical analysis. As shown, the distribution
selected for this example is LogPearsonlll. The Skew option was set to
Use Station Skew and the Do Not Compute Excepted Probability
option was selected.
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@ General Frequency Analysis Editor - Local Runoff at Alb Test 8 IE@
Mame: Local Runoff at Alb Test 8
Description: This examples shows how to enter user adjusted statistics ]
Data Set: Rio Grande at Alb Local Runoff -

DS5 File Name: | )JECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES ds:[]

Report File C:\PROJECTSISSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\GeneralFrequ(.)
| Generall Dptinns| Analytical ‘ Graphical| -
Settings | Tabular Resu\tsl Plot
Log Transformation: On Generalized Skew
@ Use Station Skew
Distribution:
LogPearsonlll - ) Use Weighted Skew

“I Use Regional Skew
Regional Skew:

Reg. Skew MSE:

Expected Probablity Curve

m

) Compute Expected Prob. Cunve

@ Do Mot Compute Expected Prob. Curve

Plot Analytical
Curve

Plot Graphical
Curve

Compute View Report & Print I OK I I Cancel J Apply

Figure B-55. General Frequency Analysis Editor with Settings Tab Shown for
Local Runoff at Alb Test 8.

Press the Compute button to perform the analysis. Once the computations
have been completed, a message window will open stating Compute
Complete. Close this window and then select the Plot tab within the
analytical analysis. The analytical plot window should look Figure B-56.
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[ General Frequency Analysis Editor - Local Runoff at Alb Test 8 Gl x|
Name: Local Runoff at Alb Test 8
Description: This examples shows how to enter user adjusted statistics [
Data Set: Rio Grande at Alb Local Runoff -
D38 File Name: 3 JECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\S5P_EXAMPLES dsi]
Report File: C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_ExamplesiGeneralFrequl.)
General | Options | Analytical | Graphical i
Settings | Tabular Results | Plot
Exceedance Probability for Rio Grande at Alb Local Runoff Ly amaE @1
Return Period }
Distribution: LogPearsonlll
1.1 2 5 10 50 200 1000 10000 -
10000.0 1 1 L P L 1 L Computed Statistics
Mean 3.130/| oflogs
Std Dev n.217| oflogs
Skew 0.25g | oflogs
Adopted Skew n.258| oflogs
g User Statistics I
of logs
£ 100004 Mean 0 g
9 Std Dev. o oflogs
s
Adpt Skew o oflogs
Equivalent
¥rs of Rec
100.0 T T T T T T T 11 T T
0.99 0.9 0.5 02 01 0.02 0.005 0.0001
Frobability
Computed Curve ——= 5 Percent Confidence Limit 5
——— Plot Analytical Plot Graphical I
i Compute Curve Curve View Report | & Print | 0K | | Cancel

Figure B-56. The Plot Tab for Local Runoff at Alb Test 8.

As shown in Figure B-56, the Plot tab contains a graph of the systematic
data, the computed frequency curve, and the confidence limits. The right
side of the plot tab contains a table of Computed Statistics and User
Statistics. The user has the option to enter a mean, standard deviation,
adopted skew, and equivalent years of record in the User Statistics table.
The Compute button must be pressed after User Statistics have been
entered in order for the program to compute a frequency curve using the

user statistics.

As mentioned at the beginning of this example, the annual peak flows
were based on daily averaged flows. In order to compute an instantaneous
peak flow frequency curve, a relationship between daily averaged flows
and the corresponding instantaneous peak flows was developed. This was
done by plotting daily averaged flow and the corresponding instantaneous
peak flow for selected flood events. Using this relationship, a Mean of
3.371 was computed and entered in the User Statistics table and the

analytical analysis was recomputed.
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Figure B-57 shows that the frequency curve computed from the user-
adjusted statistics is added to the graph. This figure also shows that the
user does not have to enter values for all statistics in order for the program
to compute a user-adjusted frequency curve. The program will use
statistics computed from the systematic and historic data if the statistics
are not defined in the User Statistics table. In this example, the program
used the computed statistics for standard deviation, adopted skew,
equivalent years of record and the user-defined mean of 3.371 when
computing the user-adjusted frequency curve.

Name:
Description:

Data Set:

Report File:

[£] General Frequency Analysis Editor - Local Runcff at Alb Test8 = 2=
Local Runoff at Alb Test 8

This examples shows how to enter user adjusted statistics

Rio Grande at Alb Local Runoff

DSS5 File Name: | C\PROJECTSISSPIProjects\SSP_Examples\SSP_EXAMPLES dss

C\PROJECTS\SSP\Projects\SSP_Examples\GeneralFrequencyResults\Local_Runoff_at_Alb_Test 8\Lo caLRuD

B« |8

General | Options | Analytical | Graphical

Settings | Tabular Results | Plot

Exceedance Probability for Rio Grande at Al Local Runoft

Log Transformation: On
Return Period

Distribution LogPearsonlll

11 2 5 10 S0 100 200 500 10000 100000 )
100000.0 L L L L L L L L Computed Statistics
Mean 3.130 oOflogs
Std Dew, 0.217| oflogs
Skew 0.258 Oflogs
10000,0 Adopted Skew 0.258 Oflogs
g User Statistics
£
z V] Mean 3.371 Oflogs
o
= Std Dev. o oflogs
1000.0-
Adpt Skew g oflogs
Equivalent
¥rs ofRec
1000 T T T T T T T T T T
09 05 0z a1 00200 0.002 0.0001  0.00004
Probability
Computed Cunve —=—= & Percent Confidence Limit ——= 05 Percent Confidence Limit
——— User §tats Computed Cupe ~ ==eees User Stats § Percent Confidence Limit  ==-=-~ User Stats 95 Percent Confidence Limit
O Observed Ewents(Weibull platting positions) ol
Plot Analytical Plot Graphical
i Compute ! Curve Curve | View Report | & Print 0K Cancel

Figure B-57. Plot Tab with User Adjusted Statistics and Frequency Curves for
Local Runoff at Alb Test 8.

Select the Tabular Results tab to see information for both the computed
and user-adjusted frequency curves. As shown in Figure B-58, the
Frequency Curve table contains the percent chance exceedance, computed
curves (Log-Pearson Il results), and the Confidence Limits (5% and 95%
chance exceedance curves) for both the computed and user-adjusted
statistics.

On the bottom left-hand side of the results tab is a table of Statistics for
the observed station data (mean, standard deviation, station skew) and
regional adjustment (regional skew, weighted skew, and adopted skew).
Also on the bottom right-hand side of the results tab is a table of Number
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of Events showing the number of historic events used in the analysis,
number of high outliers found, number of low outliers, number of zero or
missing data years, number of systematic events in the gage record, and
the historic record length (if historic data was entered).

[4] General Frequency Analysis Editor - Local Runoff at Alb Test & =] @
Name: Local Runoff at Alb Test 8
Description This examples shows how to enter user adjusted statistics ||
Data Set: :Rio Grande at Alb Local Runoff v:
DSS File Name: ) JECTSISSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.ds!..)
Report File: C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\GeneralFrequl..]
| Generall Dpllons| Analytical | Grapmca\|
Tabular Results | Plat
Curve based on Data Curve based on User-Adjusted Statistics
Percent Chance Computed Confidence Limits Computed Confidence Limits
Exceedance Curve FLOW in CFS Curve FLOW in CFS
FLOW in CF3 0.05 0.95 FLOW in CFS 0.05 0.05
0.2 66734 9163.0 5260.5 46249.2 63502.6 364571
0.5 55307 7386.2 4459.0 383205 509807 a0a02.0
1.0 4751.8 G162.8 3899.3 32931.3 427104 270237
2.0 40387 5101.9 33754 27989.7 353582 233923
5.0 31849 38784 2728.9 220723 268787 18912.4
10.0 25054 307041 2266.3 17986.8 21276.6 15705.9
200 20417 23458 1813.8 14149.5 162571 125701
50.0 13211 14746 1182.3 9155.4 10219.5 51935
80.0 881.2 992.6 765.9 6106.9 6879.2 53081
90.0 72186 8245 §12.2 5000.8 57138 42431
95.0 615.5 7132 510.9 4265.5 4943.0 35406
99.0 463.3 552.8 368.3 3211.0 38309 25627
System Statistics Mumber of Events
Statistic Value Event Mumber
Mean 3.130| |Historic Events 0
Standard Dev 0.217| |High Qutliers 0 LA e TR &
Station Skew 0.258| |Low Qutliers 0 g
Regional Skew Zero Or Missing 0 Distribution: LogPearsonlll
Weighted Skew Systematic Events 57
Adopted Skew 0.258| |Historic Period

Compute

Plot Graphical
Curve

Plot Analytical
Curve

View Report & Print [ OK ] [ Cancel ] Apply

Figure B-58. General Frequency Editor with Results Tab Selected for Local
Runoff at Alb Test 8.

In addition to the tabular results, a graphical plot of the computed
frequency curves can be obtained by pressing the Plot Analytical Curve
button at the bottom of the analysis window. A plot of the results for this
example is shown in Figure B-59.
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@ General Frequency Analytical Plot for Local Runoff at Alb Test 8 - NN X

File Edit View Window
General Fregquency Analytical Plot for Local Runoff at Alb Test 8

Return Period

Q 1.1 2 5 10 50 200100010000

1 DDDDD |:| 1 1 1 1 1 1 1 1 1 1 1 1
e
e L
. 100000+
Lo
L]
=
=
[}
=
100004
100.0 T T T | — T T 11 T T
.99 nga 0.5 nz2 o1 0oz 0002 0.0001
Frobahility
Computed Curve === 5 Percent Confidence Limit
= == 85 Percent Confidence Limit — — — Us=er Stats Computed Curve
""" User Stats 5 Percent Confidence Limit ====== lzer Stats 95 Percent Confidence Limit
] Obzetved Events (Weibull plotting positions)

Figure B-59. Plot of the Frequency Curve Results for Local Runoff at Alb Test
8.

The tabular and graphical results can be sent to the printer or the windows
clipboard for transfer into another piece of software. To print the tabular
results, select Print from the bottom of the analysis window. To send the
tabular results to the windows clipboard, highlight the data you want to
send to the clipboard and then press the Control-C key sequence. To print
the graphical results, first bring up the graphical plot and then select Print
from the File menu. To send the graphic to the windows clipboard, select
Copy to Clipboard from the File menu.

In addition to the tabular and graphical results, there is a report file that
shows the order in which the calculations were performed. To review the
report file, press the View Report button at the bottom of the analysis
window. When this button is selected a text viewer will open the report
file and display it on the screen. Shown in Figure B-60 is the report file
for Local Runoff at Alb Test 8.

B-65




Appendix B — Example Data Sets HEC-SSP User's Manual

The report file contains a listing of the input data, preliminary results,
outlier and historical data tests, additional calculations needed, and the
final frequency curve results. Different types and amounts of information
will show up in the report file depending on the data and the options that
have been selected for the analysis.

[ Local Runoff at Alb Test &rpt [

File Edit Search Format

File: |jects\Appendix_B_Examples\SSP_Examples\GeneralFreguencyResults\Local_Runoff_at_Alb_Test S\Local_Runoff_at_Alb_Test 8.rpt

T Z,395.% ——l I0.O T T IIO= Z,286.3 1 N

| 2,041.7 — | 20.0 | 2,345.8 1,813.8 |

| 1,321.1 — | 50.0 | 1,474.6 1,182.3 |

| &881.2 -— &80.0 | 992.6 765.9 |

| 721.6 — | g90.0 | 824.5 612.2 |

| 615.5 — | 95.0 | 713.2 510.9 |

| 463.3 — | 99.0 | 552.8 368.3 |

[ [ [ |

<< Systematic Statistics >>

Ric Grande at Alb Local Runoff

| Log Transform: | |

| FLOW, CF3S | Number of Events |

|——————— |—————— |

| Mean 3.130 | Historic Ewvents a |

| Standard Devw 0.217 | High Qutliers 0 |

| Station Skew 0.258 | Low Outliers a |

| BRegional Skew -——— | Zero Ewvents 0 |

| Weighted Skew -——- | Missing Events 1} |

| Rdopted Skew 0.258 | Systematic Events 57 |

[ [ |

——-— End of Analytical Frequency Curve ——

<< User Frequency Curwve >>

Rio Grande at Alb Local Runoff

| Computed Expected | Fercent | Confidence Limits |

| Curve Probability | Chance | 0.05 0.95 |

| FLOW, CFS | Exceedance | FLOW, CFS |

[ [ [ |

| 46,249.2 —— 0.2 | 63,502.6 36,457.1 |

| 368, 329.5 — | .5 | 50,980.7 30,902.0 |

| 32,931.3 — | 1.0 | 42,710.4 27,023.7 |

| 27,989.7 — | 2.0 | 35,358.2 23,382.3 |

| 22,072.3 —— 5.0 | 26,878.7 18,912.4 |

| 17,986.8 — | 10.0 | 21,276.6 15,705.9 |

| 14,149.5 — | 20.0 | 16,257.1 12,570.1 |

| 9,155.4 -— 50.0 | 10,219.5 8,193.5 | E

| 6,106.9 — | 80.0 | 6,879.2 5,308.1 |

| 5,000.8 — | 90.0 | 5, 713.H 4,243.1 |

| 4,265.5 — | 95.0 | 4,943.0 3,540.6 |

| 3,211.0 -— 99.0 | 3,830.9 2, 5529 |

|- | |- |

<< User Statistics >>

Ric Grande at Alb Local Runoff -

4| 1 2
01122016 10:30 AM 31:30..31:30 3130 IJ

Figure B-60. Report File for Local Runoff at Alb Test 8.
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Example 9: General Frequency - Graphical Analysis

This example demonstrates how to create a Graphical Analysis within a
General Frequency analysis. The data for this example is from an analysis
that computed regulated flow for the Rio Grande at Albuquerque. The
data includes regulated daily average flows from upstream reservoirs
routed downstream to Albuquerque. The period of record used for this
example is from 1974 to 2002. To view the data, right-click on the data
record labeled "Rio Grande at Alb Reg Flow" in the study explorer and
then select Tabulate. The data will appear as shown in Figure B-61.

A\ /RIO GRANDE/RIO GRANDE AT ... | =) [ S
File Edit View
RIO GRAN. .
Ordina... Drate Time FLOWY
REGULAT
Units ofs|
Type INST-VAL |
1| 01Jan 1974 24:00 1,950.0
2| 24 May 1975 24:00 5,800.0
3[ 21May 1976 24:00 3,170.0
4| 18 Aug 1977 24:00 1,640.0
5 24 May 1978 24:00 4,320.0
6| 01Jun 1979 24:00 7,870.0
7| 28 May 1980 24:00 7,130.0
8| 05 May 1981 24:00 2,170.0
9| 09.Jun 1982 24:00 4,630.0
10| 12Jun 1983 24:00 7,330.0
11| 27 May 1984 24:00 8,500.0
12| 24 Apr 1985 24:00 8,650.0
13| 07 Aug 1986 24:00 4,670.0] =
14| 22 Jul1987 24:00 6,120.0
15| 01Apr1988 24:00 3,880.0
16| 27 Apr 1989 24:00 3,710.0
17| 12 May 1990 24:00 2,420.0
18| 07 Aug 1991 24:00 4,800.0
19] 12 May 1992 24:00 5,900.0
20| 05Jun 1993 24:00 7,000.0
21| 12 May 1994 24:00 6,250.0
22| 25 May 1995 24:00 6,370.0
23| 22 Feb 1996 24:00 1,770.0
24| 11Jun 1997 24:00 5,980.0
25| 09 May 1998 24:00 3,940.0
26| 01Jun 1999 24:00 45500
27| 03 Jun 2000 24:00 1,500.0
28| 23 May 2001 24:00 4,760.0| ~

Figure B-61. Tabulation of the Peak Flow Data for Example 9.
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To plot the data for this example, right-click on the data record and then
select Plot. A plot of the data will appear as shown in Figure B-62.

@ Ric Grande at Alb Reg Flow

= [ B -

File Edit View

6,000+ =

5,000+

Flomy {cfs)

4,000+ o

3,000+

2,000

o

1,000

T T T T
1975 1980 1985 1990

T T
1995 2000

<RI GRAMDE AT ALBUQUERGQUE, MM REGULATED FLCAWY FLCAY

Figure B-62. Plot of Data for Example 9.

A General Frequency analysis has been developed for this example. To
open the General Frequency analysis editor for this example, either
double-click on the analysis labeled Reg Flow Rio Grande Test 9 from
the study explorer, or from the Analysis menu select open, then select Reg
Flow Rio Grande Test 9 from the list of available analyses. When Test 9
is opened, the General Frequency analysis editor will appear as shown in

Figure B-63.
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[4] General Frequency Analysis Editor - Reg Flow Rio Grande Test 3 E@

MName: Reg Flow Rio Grande Test 9|

Description: Example using a graphical general frequency analysis &

Data Set: Rio Grande at Alb Reg Flow T

D335 File Name: | CA\PROJECTS\SSP\Projects\SSP_Examples\SSP_EXAMPLES.dss )]

Report File: juencyResults\Reg_Flow_Rio_Grande_Test_9\Reg_Flow_Rio_Grande_Test_9.rpil.]

General | Options | Analyticall Graphical

Log Transform Plotting Position

@ Use Log Transform @ Weibull (Aand B=0)

_ Median (A and B=10.3)
) Hazen (A and B = 0.5)

) Do Notuse Log Transform

Confidence Limits *) Other (Specify A, B)

@ Defaults (0.05, 0.95
: ( ) Plotting position computed using formula

) User Entered Values (m-A){n+1-A-B)
Where:

0.05 m=Rank, 1=Largest

N=MNumbe

A B=Constants

Upper Limit:

Lower Limit:

Time Window Modification B:

DSS Range is 01JAN1974 - 15MAY2002

[7] Start Date ()]
[] End Date ()]
Data Set

) Partial Duration

Period of Record Years:

@ Annual Maximum:

Plot Analytical
Curve

Plot Graphical

Curve ‘ I View Report ‘ l éF’rint ‘ I Ok ‘ Apply Cancel

Compute ‘

Figure B-63. General Frequency Analysis Editor for Reg Flow Rio Grande Test
9.

Shown in Figure B-63 are the general settings that were used to perform
this frequency analysis. For this analysis, the Use Log Transform option
was selected, the Weibull plotting position method was selected, the
default Confidence Limits were selected, and no modification was made
to the Time Window.

Shown in Figure B-64 is the General Frequency analysis editor with the
Options Tab selected. Features on this tab include the Low Outlier
Threshold, an option to use Historic Data, an option to override the
default Frequency Ordinates, and Output Labeling. All defaults
settings were selected for this example.
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[ General Frequency Analysis Editor - Req Flow Rio Grande Test 9 =) |
Name Reg Flow Rio Grande Test9
Description: Example using a graphical general frequency analysis =
Data Set Ria Grande at Alb Reg Flow |
DSSFile Name: | JECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.dss[..]
Report File neraIFrequencyResu\ts\Reg_FIow_Rio_Grande_Tesl_Q\Reg_FIow_Rm_Grande_Test_Q.rml:]
| General| Options | Analytical | Graphical i
Low Qutlier Threshaold Historic Period Data User Specified Frequency Ordinates
[ override Low Outlier Threshold [ Use Historic Data Use Values from Table Below
Value i : :
FHETE HEme Frequency in Percent
Output Labeling EEUNCEE 0.2
_ 0.5
DS5 Data Name is  FLOW End Year 10
[C] Change Label  FLOW Override High Qullier Threshold gg
i 10.0
D35 Data Units are  cfs Historic Events 300
[F] Change Label |cfs Water Year Peak 50.0

w
o
=
m

Plot Analytical

Plot Graphical
Compute I Curve

Curve

IWI & Print I oK I I

cancel | Appl

Figure B-64. General Frequency Analysis Editor with Options Tab Shown for
Reg Flow Rio Grande Test 9.

Once all of the General and Optional settings are set or selected, the user
can choose to perform an Analytical or Graphical analysis. In this
example, a graphical analysis was performed. Shown in Figure B-65 is
the Graphical analysis tab. As shown, a graph containing the systematic
data and graphical curve is on the left side and a table containing the user-
entered frequency curve is on the right side of the window. The frequency
curve was entered manually into the User-Defined Graphical Curve
table. When the Compute button is pressed, the program plots the
graphical frequency curve along with the annual maximum flow values.
For this example, a reservoir model was used to route synthetic
hydrographs through the reservoir network upstream of Albuquerque
using current operating criteria. This was done for the 0.2, 0.5, 1.0, 2.0,
10, 20, and 50 percent events. Output from the model was input into the
Frequency Ordinates table. For the more frequent events (10 year and
below), the graphical curve was fit to the data visually. This example
shows how a reservoir network can influence the frequency curve. Notice
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how the frequency curve is flat for the 20 through the 1 percent chance
events. The reservoir network is able to control flooding in this range.
This example also shows that as flood events become larger, the reservoir
network has less influence on controlling downstream flooding.

[ General Frequency Analysis Editor - Reg Flow Rio Grande Test 9 =l (3w
Name: Reg Flow Rio Grande Test9
Description: Example using a graphical general frequency analysis =
Data Set: Rio Grande at Alb Reg Flow -
D35 File Name: | JECTSISSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.dss [
Report File neralFrequencyResults\Reg_Flow_Rio_Grande_Test_9\Reg_Flow_Rio_Grande_Test_9.rpil]
| General | optiens | analytical Graphical
4 General Frequency Graphical Plot for Reg Flow Rio Grande Test 9 AT T
P (@ Mormal (Top N Events) Log (All Events)
Q
1.1 2 5 10 50 2001000 100000 DERITE
100000.0 T——T—FT—— T ® Flow - stage
e e ey e o e o
1 11 1 | I 1T 1 11711 Equivalent Years 29
1 111 | I 11 1101 of Record
1 11 | 1 1rrri
| | - | | I TR I I | User-Defined Graphical Curve
1 || | | I I I I I |
| 11 | | I R I I I V) Frequency Ordinates
10000.0 ! (. ! LI O I Percent Chance
’ | e [ e o el 7 Data Value
1 1 1 A 2EA=%411 Exceedance
E IR A 0.2 L14.300.0
=
= LA I RN Hot 10,500.9
z [ | e rnn icll 7,751.0
| 1 4+ | | b o B B B 2.0 7,750.0
w 1 1 X | L rrn 5.0 7,600.0
r /}/ 1 | L rnni 0.6 7.510.0
1000.04 I 1 I | | I R e o | = Led-—e
g | I T e W 20T 7,380.0
/4 -1 | =1 rrrd 50.0 5,400.0
[ el | | 14+ 80.0 2,500.0
[ el i | | (Il e Bl N O M | 90.0 1, 650.0
¥ | | | b o B B B o 1'..00 a
1 [ | | I T T I I | : e
1 [ | 1 rrnri 99.0 §30.0
1 [ | | I T T I I |
1 [ | | I T T I I |
100.0 1 t t L I T T
099 09 05 0201 002 0002 0.0001
Exceedance Probahility
=) Ohzerved Events (Weibull plotting postions) User Curve
— == 5 Percent Confidence Limit === 95 Percent Confidence Limi
Plot Analytical Plot Graphical
Compute | Curve Curve Wiew Report & Print [ OK H Cancel H Apply

Figure B-65. Graphical Tab Shown for Reg Flow Rio Grande Test 9.

A graphical plot of the graphical frequency curve can be obtained by
pressing the Plot Graphical Curve button at the bottom of the analysis
window. A plot of the results for this example is shown in Figure B-66.
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=Y

@ General Frequency Graphical Plot for Reg Flow Ric Grande Test 9 NN X
File Edit View Window
General Fregquency Graphical Plot for Reg Flow Rio Grande Test 4
Return Period
1.1 2 a 10 an 200100010000
100000.0 |' I |' |' i : :
| | | |
| | | |
| | | |
| | | |
I I I §
| | | V
100000+ | | | |
@ I I t I
= I I I I
= | | | |
: - e
| - u"
: 1000.0 Irf,?"{pvf : :
' e i [ [
s | |
L1 [ [
| 1 | |
| I | |
| 1 | |
100.0 —1 } H———
.99 nga 0.5 nz2 o1 0oz 0002 0.0001
Exceedance Probahility
] Obzetved Events (Weibull plotting positions) U=zer Curve
— == 5 Percent Confidence Limit === 85 Percent Confidence Limit

Figure B-66. Plot of the Frequency Curve Results for Reg Flow Rio Grande Test
9.

The graphical results can be sent to the printer or the windows clipboard
for transfer into another piece of software. To print the graphical results,
first bring up the graphical plot and then select Print from the File menu.
To send the graphic to the windows clipboard, select Copy to Clipboard
from the File menu.

In addition to the tabular and graphical results, there is a report file that
shows the order in which the calculations were performed. To review the
report file, press the View Report button at the bottom of the analysis
window. When this button is selected a text viewer will open the report
file and display it on the screen. Shown in Figure B-67 is the report file
for Reg Flow Rio Grande Test 9.

The report file contains a listing of the input data, preliminary results,
outlier and historical data tests, and additional calculations needed.
Different types and amounts of information will show up in the report file
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depending on the data and the options that have been selected for the
analysis.

@ Reg_Flow_Rio_Grande_Test_9.rpt &J

File Edit Search Format

File: \\ppendix_B_Examples\SSP_Examples\GeneralFrequencyResults\Reg_Flow_Rio_Grande_Test_9\Reg_Flow_Rio_Grande_Test_9.rpt

General Frequency Analysis
12 Jan 2016 10:34 M

»

——— Input Data ——

Analysis Name: Reg Flow Rio Grande Test 9
Description: Example using a graphical general frequency analy3is

m

Data Set Name: Rio Grande at Alb Reg Flow
D55 File Name: C:\PROJECTS\S5F Testing\Project3\Appendix B Examples\S5P Examples‘\5SF EXZMPLES.dss
D55 Pathname: fRI0 GRRANDE/RIQ GRANDE AT ALBUQUERQUE, NM/FLOW/0lJAN1900/IR-CENTURY/REGULLIED FLOW/

Start Date: i
End Date:

Project Path: C:\PROJECT5%55F_ Testing\Projects\Appendix B Examples‘35F Examples
Report File Name: C:\PROJECTS\SSP_Testing\Projects\Appendix B Examples\S5P_ ExampleS\GeneralFreq'uencyResul
Result File Name: C:\PROJECTS5\SS5F_Testing\Projects\Appendix B Examples)\55F Examples\GeneralFrequencyResul

Plotting Position Type: Weibull

Probability Distribution Type: Hone
Use Log Transform

User-Specified Frequencies
Frequency: 0.2
Frequency: 0.5
Frequency: 1.0
Frequency: 2.0
Frequency: 5.0
Frequency: 10.
Frequency: 20.
Frequency: 50.
Frequency: &80.
Frequency: 90.
Frequency: 95.
Frequency: 99.

[ e e e e e e }

Display ordinate walues using 1 digits in fraction part of walue

——— End of Input Data ——

Based on 29 events. 10 mercent outlier test dewiate KN} = 2.549
< | 1 | +

01122076 10:34 AM 1111 11 IJ

Figure B-67. Report File for Reg Flow Rio Grande Test 9.
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Example 10: Volume Frequency Analysis, Maximum
Flows
This example demonstrates how to perform a Volume Frequency analysis
for maximum flows. The data for this example was derived from an
analysis where a time-series of daily average unregulated flows were
computed for the Rio Grande at Albuquerque. The period of record for
this example is from 1941 to 2002. To view the data, right-click on the
data record labeled "Rio Grande at Alb Unreg Daily" in the study
explorer and then select Plot. The data will appear as shown in Figure B-
68.
r@ Rio Grande at Alb Unreg Daily o] 5 S |
File Edit View
20,000
15,000
z
& 10,000
5,000
i

0- T T T
1940 1960 1970 1980 19490 2000

UMNREG _ALBURUERGUE CALC FLCWS

Figure B-68. Plot of Daily Average Flow for Example 10.

A Volume Frequency analysis has been developed for this example. To
open the Volume Frequency Analysis editor for this example, either
double-click on the analysis labeled Unreg Flow Rio Grande Test 10
from the study explorer, or from the Analysis menu select open, then
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select Unreg Flow Rio Grande Test 10 from the list of available
analyses. When test 10 is opened, the Volume Frequency Analysis editor
will appear as shown in Figure B-69.

[ Volume Frequency Analysis Editor - Unreg Flow Ric Grande Test 10 5l (mEdm
Name: Unreg Flow Rio Grande Test10|
Description: Unregulated Volume-Duration Analysis Rio Grande at Albuguerque [
Data Set: Rio Grande at Alb Unreg Daily e

DSS File Name: | c:\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP[_]

Report File: zndix_El_ExampIes\SSF'_Examples\VqumeFrequenc:yAnaIysisResuIts\Unreg_FIouD
General | Options | Duration Table | Analytical | Graphical i
Log Transform Plotting Position Time Window Modification
@ Use Log Transform @ Weibull (A and B=10) End Points
Do Notuse Log Transform TETENRETY 5=03)) DSSRangeis 26APR1941 - 30SEP2002
o - N Hazen (A and B =0.5) Start Date D
aximum or Minimum Analysis
' ' z Other (Specify A, B) =
. End Date [
@ Analyze Maximums . . .
Plotting position computed using
Analyze Minimums formula Season
(m-A)i{n+1-A-B)
Year Specification Where: . _ To Define a Subset of the Year
n=Rank, 1=Largest Season Start: Season End:
Water Year (starts Oct 1) MN=Mumber of Years — — L
AB=Constants L) [J i
) EEET T EEE.ET ) A MOTE: season must be within a year,
as defined in the Year Specification
Other B:
Starting 01Jan()
Flot Yearly Data
Plot Plot Plot
Duration Analytical Graphical
Compute | Data Curve Curve | View Report | % Print | OK | | Cancel | Apply

Figure B-69. Volume Frequency Analysis Editor for Unreg Flow Rio Grande
Test 10.

Shown in Figure B-69 are the general settings that were used to perform
this frequency analysis. For this analysis, the Use Log Transform option
was selected, the Weibull plotting position method was selected, Analyze
Maximums was selected, the Calendar Year option was selected, and no
modification was made to the Time Window.

Shown in Figure B-70 is the Volume Frequency Analysis editor with the
Options Tab selected. Features on this tab include an option to override
the default Flow Duration values, an option to override the default
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Frequency Ordinates, and Output Labeling. Both the flow-duration
and frequency ordinate tables were modified.

[ valume Frequency Analysis Editor - Unreg Flow Rio Grande Test 10 =l S
Name: Unreg Flow Rio Grande Test'10|
Diescription: Unregulated Volume-Duration Analysis Rio Grande at Albuguerque =
Data Set: :Rio Grande at Alb Unreg Daily v:
DSS File Name: | c:\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP[.]
Report File: zndix_El_ExampIes‘nSSF’_ExamplesWolumeFrequencyAnaIysisResults‘.Unreg_FIO\E]
| General| Options | Duration Table | Analytical | Graphical i
Flow Durations User Specified Frequency Ordinates Historic Period Data
Change or add to default values Use Values from Table Below [] Use Historic Data
Historic Period
Duration in days Frequency in Percent
Start Year: i]
1 0.1 -
7 0.2 End Year: 0
15 0.5
60 1.0 Duration Override High O...
120 20
50 1-day
10.0 IGEL
20.0 15-day
50.0 60-day |
200 120-day =
90.0
95.0
99.0
Historic Events
Year 1-day T-day
Qutput Labeling Low Qutlier Threshald
D583 DataNameis FLOW [ Override Low OQutlier Threshold
[l Change Lael  [FLOW Duration Override Low Qutli... m
D355 Data Units are CFS 1-day
T-day
[[]Change Label |CFS 15-day
AN-riay S
Plot Plot Plot
Duration Analytical Graphical
Compute Data Curve Curve View Report @ Print ’ OK ] ’ Cancel ] Apply

Figure B-70. Options Tab Shown for Unreg Flow Rio Grande Test 10.

Once all of the General and Optional settings are set or selected, the user
can extract the volume-duration data from the time-series of daily flows.
Select the Duration Data tab and press the Extract Volume-Duration
Data button at the bottom of the table. The table should then fill with the
flow-duration values, as shown in Figure B-71.
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Mame:
Description:

Data Set:

[4] Volume Frequency Analysis Editor - Unreg Flow Rio Grande Test 10

Unreg Flow Rio Grande Test 10|
Unregulated Volume-Duration Analysis Rio Grande at Albuguerque E]

:Rio Grande at Alb Unreg Daily =

D33 File Name: | C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP[)

e =

Report File: :ndix_B_Examples\SSP_ExamplesWolumeFrequencyAnalysisResults\Unreg_Flov_)
General | Options | Duration Table | Analytical | Graphical ol
[] Allow Editing
Volume-Duration Data
Y Highest Mean Value for Duration, Average Daily FLOW in CFS
ear 1 7 15 60 120
Date FLOW Date FLOW Date FLOW Date FLOW Date FLOW
1942 04/24/1942 22076.4) 051511942 15345.8| 06/05/1942 13098.6| 06/14/1942 12137.3| 07/06/1942 797
1943 04/28/1943 4733.9| 05/021943 4638.1| 05/08/1943 4440.3| 06/03/1943 2574.3| 071021943 184 |
1944| 05171944 13601.6| 05/2211944 12334.9| 05/28/1944 11501.7| 07/05/1944 7056.9| 07/221944 44€
1945| 05/08/1945 12140.6| 05/13/1945 11199.2| 05/18/1945 10358.1| 06/19/1945 6137.1| 07/09/1945 37¢
1946 04/23/1946 2098.8| 04/27M1945 2733.6| 05/03/1946 2273.0) 05M7/1946 1230.4| 05/31/1946 97
1947| 051211947 7003.5| 05151947 5848.5| 05/18/1947 5118.0| 06/15M1947 2709.0| 06/28M1947 17§
1943 05/28/1948 122735 06/11/1948 10224.5| 06/09/1948 9950.8| 06/18/1948 7014.3| 07101948 45€ =
1949 06/23/1949 10556.0| 06/27/1949 9642.2| 06/30/1949 8133.2| 06/30/1949 5828.4| 07/30/1949 436 =
1950| 04/24/1950 2901.1| 04/27M1950 2711.6| 04/30/1950 2396.7| 05/04/1950 1549.3| 06M12/1950 13
1951 05M10/1951 1881.6) 05M14/1951 1718.3| 08/23/1951 1610.7| 06/14/M1951 1082.0| 06/05/1951 8€
1952| 05/08/1952 11669.4| 05/11/1952 10749.8| 05/19/1952 9703.8| 06221952 7147.2| 071221952 470
1953| 05/31/1953 2706.0| 06/04M1953 2497.2| 06/06/1953 2283.0) 06/20/11953 1729.2| 06/28/1953 124
1954| 05M18/1954 2122.1| 04/211954 2050.3| 04/28M1954 1929.1| 06/04/1954 1595.2| 06/07/1954 113
1955| 09/25/1955 5496.6| 05/29/1955 2694.8| 05/30/1955 2349.9| 06/21/1955 1559.2| 08/29/1955 T1EES
1956 05/07/1956 1766.1| 05/11/1956 1722.1| 05/11/1956 1626.0) 06/11/1956 1172.4| 06M14/1956 94
1957| 06/09/1957 9403.5| 06111957 8794.2| 06/15/1957 7865.2| 07/06/1957 5357.9| 09/01/1957 43€
1958| 05M14/1958 12590.1| 05171958 12047.0| 05/231958 11492.6| 06/14/1958 9129.4| 06/22/1958 542
1959 08/26/1959 2539.4| 05/2011959 1821.9| 05/20/1959 1624.9| 06/05/1959 1049.9| 06/01/1959 84
1960 041371960 6034.5| 04M16/1960 5335.6| 04/24/1960 48325 05/22/1960 3299.1| 06/27/1960 248
1961 05/04/1961 5695.4| 05/07/1961 5052.7| 05/07/1961 4518.2| 06/06/1961 3084.0) 06/28/1961 20
1962 04/2211962 9023.2| 04/271962 8121.7| 05/021962 7289.3| 05/28M1962 4879.4| 06121962 310
1963| 04M15/1963 2477.4| 04161963 2288.6| 04161963 2097.4| 05151963 1514.7| 06/04/1963 111 g
1964 05M15/1964 2353.4| 05191964 2237.5| 05/25/1964 1963.8| 06/10/1964 1293.1| 061711964 o
1965| 06M19/1965 8007.6| 05/26/1965 7162.8| 05/27M1965 5995.5| 06/30/1965 5202.7| 08111965 3N
1966 05M11/1966 3704.0) 051211966 3470.1| 05/14/1966 3276.3| 05/15/1966 2629.1| 06131966 204
1967 08M0/1967 8810.2| 08161967 5186.4| 08/20/1967 3533.9| 09/14/1967 1653.6| 09/08/1967 134 i
1088 NEMDAMQRS RADY R NEMDQMMARS RNQOR A NEMNARMARS AQ12 1 N7ZMNAHM0RS 23450 NemE10Ra 241
Plot Plot Plot
Duration Analytical Graphical
Compute Data Curve Curve View Report @ Print ’ OK ] ’ Cancel ] Apply

Figure B-71. Volume-Duration Data Table for Unreg Flow Rio Grande Test 10.

Once the data has been extracted, the user must choose to perform an
Analytical or Graphical analysis. In this example, an analytical analysis

was performed. Shown in Figure B-72 is the Settings tab for the

analytical analysis. As shown, the distribution selected for this example is
LogPearsonlll. The Skew option was set to Use Station Skew and the Do

Not Compute Excepted Probability option was selected.
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[4] Volume Frequency Analysis Editor - Unreg Flow Rio Grande Test 10 =] \EI
MName: Unreg Flow Rio Grande Test 10
Description: Unregulated Volume-Duration Analysis Rie Grande at Albuquerque )]
Data Set: :Rio Grande at Alb Unreg Daily -

D55 File Name: | C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP(]

Report File: zndix_B_ExampIes\SSF'_Examples\VqumeFrequenc:yAnaIysisResuIts\Unreg_FIouE]
| Generall Dptionsl Duration Table| Analytical | Graphical i
Settings | Tabular Results | Plot| statistics|
Log Transformation: On Skew
@ Use Station Skew
Distribution:
:LogF'earsonIII v: _) Use Weighted Skew
Expected Probablity Curve _1 Use Regional Skew
+! CRETE SEEEEiFl e Duration Reg. Skew R Skew MSE
@ Do Mot Compute Expected Prob. Curve 1
7
15
60 E
120
Plot Plot Plat
r——— . Duration Analytical Graphical
. Compute | Data Curve Curve View Report é Print [ OK ] ’ Cancel ] Apply

Figure B-72. Settings Tab Shown for Unreg Flow Rio Grande Test 10.

Press the Compute button to perform the analysis. A message window
will open stating that a few of the annual maximums occurred during the
beginning of the year. The message suggests that the user change the
year/season specification to capture independent events. You want to
minimize the possibility that the same flood event is used for consecutive
years. Press the OK button to finish the compute. Once the computations
have been completed, a message window will open stating Compute
Complete. Close this window and then select the Tabular Results tab
within the analytical analysis. The results table should look Figure B-73.
The top portion of the results table contains the percent chance exceedance
for all durations (the report contains confidence limits). The bottom
portion of the results table contains the statistics for all duration.
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[ Volume Frequency Analysis Editor - Unreg Flow Rio Grande Test 10 =l S
MName: Unreg Flow Rio Grande Test 10
Description: Unregulated Volume-Duration Analysis Rio Grande at Albuguerque (|
Data Set: iRio Grande at Alb Unreg Daily 'j
D35S File Name: |sp_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES. ds/..]
Report File: Results\Unreg_Flow_Rio_Grande_Test_10\Unreg_Flow_Rio_Grande_Test_10.rpi[.]
| General | Options | Duration Table| Analytical | Graphical -
Tabular Results | Piot | Statistics
Vaolume Frequency Curves for Unreg Flow Rio Grande Test 10, Average Daily FLOW in CFS
Percent
Chance 1 T 15 G0 120
Exceedance
0.1 335037 292457 266903 235021 15795.5| »
0.2 30580.0 26878.3 24513.0 20992.6 14034.9(
0.5 266804 23652.5 215474 17776.0 118236
1.0 237055 211388 19237.9 154225 10236.6
2.0 20708.6 18560.9 16871.1 13139.6 8720.9| 2
5.0 167071 150481 13649.4 102301 §820.2
10.0 136357 122991 11132.2 8107.0 54517 £
200 104925 9442.8 8521.9 6037.0 41274
50.0 6042.2 53442 4790.5 3296.3 23711|—
80.0 32467 27702 24625 1702.5 1323.0
90.0 2280.6 1894.6 1675.6 1178.3 963.7| ~
Statistics
Percent
Chance 1 i 15 60 120
Exceedance
Mean 3.760 37m 3.653 3501 3.366
Standard Dev. 0.305 0.320 0.324 0.328 0.294
Station Skew -0.418 -0.506 -0.509 -0.312 -0.183
Regional Skew
Weighted Skew B
Adopted Skew -0.418 -0.506 -0.509 -0.312 -0.183
#Years 57 57 57 57 57
# Zero/Missing 4 4 4 4 4
# Years with Missing ... 3] 3] 3] 3] G i
L obiodi P ac zn FET
Plot Plot Plat
Duration Analytical Graphical
Data Curve Curve View Report @ Print [ OK ] ’ Cancel ] Apply

Figure B-73. Tabular Results Tab for Unreg Flow Rio Grande Test 10.

Note: These tabular results use the default computed statistics.

As shown in Figure B-74, the Plot tab contains a graph of the systematic
data and the computed frequency curves. Notice how some of the
frequency curves look like they might cross if the lines were extended.

The Statistics tab can be used to modify the computed statistics to ensure

that the frequency curves are consistent.
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[4] Volume Frequency Analysis Editor - Unreg Flow Rio Grande Test 10 = (mEdm
MName: Unreg Flow Rio Grande Test 10
Description: Unregulated Volume-Duration Analysis Rio Grande at Albuguerque =
Data Set: Rio Grande at Alb Unreg Daily =)
D35 File Name: | sp_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES dsi.]
Repaort File: tesults\Unreg_Flow_Rio_Grande_Test_10Wnreg_Flow_Rio_Grande_Test_10.rpi.]
| General | Options | Duration Table | Analytical | Graphical -
| Settings I Tabular Results| Plot | Statistics|
Return Period
11 2 a 10 50100 a00 10000100000
1 DDDDDD 1 1 1 1 1 1 1 1 1 1 1 1 1 1
10000.04
o
[Fi
=]
=
z
(=] =
= E
[T
1000.0
100.0 T T T T T T T T T 1T T T T
0.959 0.949 04 0.5 0.z o1 0.0z 0.0058 0.001 0.0001 0.000001
Frobahility
| 1-Day Data Observed Events (vWeibull plotting positions) — 1-Day Curve
| 7-Day Data Observed Events (vWeibull plotting positions) — 7-Day Curve
| 15-Day Data Obzerved Events (Weibull plotting positions) — 15-Day Curve
| E0-Day Data Obzerved Events (Weibull plotting positions) — G0-Day Curve
| 120-Day Data Obzerved Events (Weibull plotting positions) — 120-Day Curve i
Plot Plot Plot
— : Duration Analytical Graphical
| Compute | Data Curve Curve I View Report ‘ & Print I 0K ‘ I Cancel

Figure B-74. Plot Tab for Unreg Flow Rio Grande Test 10.

For this example, the standard deviation and the adopted skew values were
modified to make sure the volume frequency curves were consistent. As
shown in Figure B-75, the check boxes next to mean, standard deviation,
and adopted skew were checked and then user-adjusted statistics were
entered into the table for all durations. The Compute button must be
pressed after adjusted statistics have been entered in order for the program
to recompute the frequency curves using the user-adjusted statistics.
Figure B-76 shows the Plot tab after the user-adjusted statistics were
entered on the Statistics tab. Results on the Tabular Results tab will also
update when user-adjusted statistics are entered on the Statistics tab.

B-80



HEC-SSP User's Manual

Appendix B — Example Data Sets

[ Velume Frequency Analysis Editor - Unreg Flow Rio Grande Test 10 =] -
MName: Unreg Flow Rio Grande Test 10
Description: Unregulated Volume-Duration Analysis Rio Grande at Albuguerque =
Data Set: :Rio Grande at Alb Unreg Daily
DSS File Name: | :gP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.ds!]
Report File: Results\Unreg_Flow_Rio_Grande_Test_10\Unreg_Flow_Rio_Grande_Test_10.rpi_]
| General | options | Duration Table| Analytical | Graphical -
[ Setings | Tabular Results | Piot| Statistics |
-0.145
L]
-0.204
-0.25+
-0.304 . Log Transformation: On
g -0.351 Distribution: LogPearsonlil
o -n.40 . X-axis Parameter Y-axis Parameter
-0.454 ® . Mean ~| skew -
=045 L Update Plot
-0.85 T T T T T T T T
335 34 345 35 3485 36 365 3T 3TH 38
Mean
Sample Statistics 1 T 15 G0 120 3
Mean 3.760 37N 3.653 3.501 3.366
Standard Dev. 0.305 0.320 0.324 0.328 0.294
Station Skew -0.418 -0.506 -0.509 -0.312 -0.183
Adopted Skew -0.418 -0.506 -0.509 -0.312 -0.183
Use | Adjusted 1 T 15 60 120
Statistics
V] |Mean 378 KN 3.653 3501 3.366
[V] |Standar... 0.305 0.3 0.315 032 0.32
[V] |Adopted ... -0.4182 -0.5 -0.5 -0.45 -0.45
Plat Plot Plaot
Duration Analytical Graphical
Data Curve Curve iew Report @ Print ’ 0K ] ’ Cancel ] Apply

Figure B-75. Statistics Tab for Unreg Flow Rio Grande Test 10.
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[4] Volume Frequency Analysis Editor - Unreg Flow Rio Grande Test 10

= =

MName: Unreg Flow Rio Grande Test 10
Description: Unregulated Volume-Duration Analysis Rio Grande at Albuguerque =
Data Set: :Rio Grande at Alb Unreg Daily -
D35 File Name: | sp_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.ds{.]
Report File: Results\Unreg_Flow_Rio_Grande_Test_10\Wnreg_Flow_Rio_Grande_Test_10.rpi_]
| General | Options | Duration Table| Analvtical | Graphical -
| setiings | Tabular Results| Plot | statistics |
Return Period
11 2 a 10 0100 a00 10000100000
1DDDDDD 1 1 1 1 1 1 1 1 1 1 1 1 1 1
10000.04
m
[T
O
1=
z
(] =
b E
[T
1000.04
100.0 T T T T T T T T T T T T T
0.999 0.99 04 0a 02 01 0.02 0.005 0.001 0.0001 0.000001
Frobahility
| 1-Day Data Observed Events (Weibull plotting positions) — 1-Day Curve
| 7-Day Data Obzerved Events (Weibull plotting positions) — 7-Day Curve
| 15-Day Data Ohserved Events (Wieibull plotting positions) — 15-Day Curve
| B0-Day Data Ohserved Events (Wieibull plotting positions) — 60-Day Curve
| 120-Day Data Ohzerved Events (Weibull plotting positions) — 120-Day Curve o
Plot Plot Plot
E— : Duration Analytical Graphical
. Compute | Data Curve Curve View Report & Print [ OK ] [ Cancel ] Apply

Figure B-76. Plot Tab for Unreg Flow Rio Grande Test 10 After the Statistics

were Adjusted on the Statistics Tab.

In addition to the Tabular Results and Plot tabs, graphical plots can be
opened by selecting the Plot Duration Data or Plot Analytical Curve
buttons at the bottom of the analysis window. A plot of the results for this

example is shown in Figure B-77.
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@ Volume Frequency Analytical Plot for Unreg Flow Ric Grande Test 10 - =RACN X

oli7]

FLOW in CFS

File Edit View Window

Wolume Frequency Anahytical Plot for Unreg Flow Rio &rande Test 10
Return Period

1.1 2 a 0 50 100 Z0o0 500 10000
1 1 1 1 1 1 1 1 1 1

A00000.0

40000.0 4

A000.0

A00.0

T
0.999 093 04 05 0.z 0.1 0.0z 0.0 0.002 0.0001

Frobability
1-Day Data Observed Events (Weibull plotting positions) 1-Day Cunee
T-Day Data Observed Events (Wfeibull plotting positions) 7-Day Cunee

G0-Day Data Obserwed Events (Weibull plotting positions)

15-Day Data Observed Events feibull plotting positions) —— 15-Day Cunve
120-C ay D ata Obsenred Ewvents Afeibull plotting positions) —

G0-Day Cunve
120-Lay Cunwe

Figure B-77. Plot of the Frequency Curve Results for Unreg Flow Rio Grande
Test 10.

The tabular and graphical results can be sent to the printer or the windows
clipboard for transfer into another piece of software. To print the tabular
results, select Print from the bottom of the analysis window. To send the
tabular results to the windows clipboard, highlight the data you want to
send to the clipboard and then press the Control-C key sequence. To print
the graphical results, first bring up the graphical plot and then select Print
from the File menu. To send the graphic to the windows clipboard, select
Copy to Clipboard from the File menu.

In addition to the tabular and graphical results, there is a report file that
shows the order in which the calculations were performed. To review the
report file, press the View Report button at the bottom of the analysis
window. When this button is selected a text viewer will open the report
file and display it on the screen. Shown in Figure B-78 is the report file
for Unreg Flow Rio Grande Test 10.

The report file contains a listing of the input data, preliminary results,
outlier and historical data tests, additional calculations needed, and the
final frequency curve results. Different types and amounts of information
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will show up in the report file depending on the data and the options that
have been selected for the analysis.

] Unreg_Flow Rio Grande Test 10— )
File Edit Search Format
| File: C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_ExamplesiWolumeFrequencyAnalysisResults\Unreg_Flow_Rio_Grande_Test_10Wnre¢
-
<< Skew Weighting >>
Based on 57 events, mean-sguare error of station skew = 0.119
Mean-square error of regional skew is undefined.
<< Frequency Curve >>
Rioc Grande at Alb Unreg Daily (l-day Max) H
| Computed Expected | Percent | Confidence Limits | =
| Curve Probability | Chance | 0.05 0.95 | f
| FLOW, CFS | Exceedance | FLOW, CFS |
| | | |
| 33,513.9 == [ 0.1 | 48,233.5 25,408.4 |
| 30,589.9 == [ 0.2 | 43,373.8 23,433.8 |
| 26,689.7 == [ 0.5 | 37,022.3 20,75%9.0 |
| 23,714.2 == [ 1.0 | 32,287.4 18,682.0 |
| 20,716.6 == [ 2.0 | 27,625.6 16,552.4 |
| 16,714.0 == [ 5.0 | 21,5594.4 13,637.5 |
| 13,641.4 == [ 10.0 | 17,141.9 11, 378.5 |
| 10,4587.1 == [ 20.0 | 12,781.9 &,880.9 |
| 6,044.8 == [ 50.0 | 7,067.4 5,182.6 |
| 3,248.0 -— 80.0 | 3,832.8 2,675.6 |
| 2, 2B .5 == [ 590.0 | 2,761.4 1,800.5 |
| 1,678.6 == [ 95.0 | 2,090.7 1,267.9 |
| 909.0 == [ 99.0 | 1,210.7 622.9 |
| | | |
<< Systematic Statistics >>
Rio Grande at Alb Unreg Daily (l-day Max)
| Log Transform: | |
| FLOW, CFS | Number of Events |
| | |
| Mean 3.760 | Historic Events o |
| Standard Dew 0.305 | High Outliers a |
| Station Skew -0.418 | Low Outliers 1} |
| Regional Skew -—— | Zero Ewvents a |
| Weighted Skew -—— | Missing Events 4 |
| Adopted Skew -0.418 | Systematic Events 57 |
| | |
——— End of Analytical Freguency Curve ———
<< User Frequency Curve >>
Rio Grande at Alb Unreg Daily (l-day Max)
| Computed Expected | Percent | Confidence Limits |
| Curve Probability | Chance | 0.05 0.95 |
| FLOW, CFS | Exceedance | FLOW, CFS | e
4 | i b
0112/2016 10:44 AM 1111 1:1
b y

Figure B-78. Report File for Unreg Flow Rio Grande Test 10.
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Example 11: Volume Frequency Analysis, Minimum
Flows

This example demonstrates how to create a low flow VVolume Frequency
analysis. The data for this example was downloaded from the USGS. It is
comprised of daily average flow for the Chattahoochee River at Cornelia,
Georgia. Drought conditions were occurring in the region at the time of
this analysis. Among other things, a low flow analysis can be used to
determine the severity of a drought. The period of record for this example
is from 1957 to 2007. To view the data, right-click on the data record
labeled "Chattahoochee River" in the study explorer and then select Plot.
The data will appear as shown in Figure B-79.

@ Chattahoochee River = | B i

File Edit View

10,000+

8,000+

Flomy {cfs)

6,000+

4,000+

2,000

1] T T T T T
1960 1970 1980 19490 2000

CORMELIA, GA& USGS FLOWY

Figure B-79. Plot of Daily Average Flow for Example 11.

A Volume Frequency analysis has been developed for this example. To
open the Volume Frequency Analysis editor for this example, either
double-click on the analysis labeled Low Flow Analysis Test 11 from the
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study explorer, or from the Analysis menu select open, then select Low

Flow Analysis Test 11 from the list of available analyses. When test 11 is

opened, the Volume Frequency Analysis editor will appear as shown in

Figure B-80.
[Z] Volume Frequency Analysis Editor - Low Flow Analysis Test 11 [=] @
Name: Low Flow Analysis Test 11|
Description: This example shows how to perform a low flow analysis using HEC-S5P =
Data Set: Chattahoochee River -
DSSFile Name: | sp_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES ds:_]
Report File: 1cyAnalysisResults\Low_Flow_Analysis_Test_11\Low_Flow_Analysis_Test_11.rpi_]
General | Options | Duration Table | Analytical | Graphical| i
Log Transform Flotting Position Time Window Modification
@ Use Log Transform @ Weibull (Aand B =0) End Points
PoNotuse Log Transfomm IEEEAEE 520 DSSRangeis 31JUL1957 - 22JUN2008
i in - Hazen (A and B =0.5) Start Date D
Maximum or Minimum Analysis )
Other (Specify A, B —
. (Spedily A, B) 7] End Date 31Dec2007()
Analyze Maximums i . i
Plotting position computed using
@ Analyze Minimums formula Season
(m-A)/(n+1-A-B)
Year Specification Where: ) i To Define a Subset of the Year
i e Season Start: Season End:
Water Year (starts Oct 1) M=Mumber of Years — —
AB=Constants [ [

@ Calendar Year (starts Jan 1)

Other

MOTE: season must be within a year,
as defined in the Year Specification

m

B:
Starting 01Janla)
Flot Yearly Data
Plot Plot Plot
Duration Analytical Graphical
Compute | Data Curve Curve | View Report | %Frint | OK || Cancel | Apply

Figure B-80. Volume Frequency Analysis Editor for Low Flow Analysis Test

11.

Shown in Figure B-80 are the general settings that were used to perform

this frequency analysis. For this analysis, the Use Log Transform option
was selected, the Weibull plotting position method was selected, Analyze
Minimums was selected, and the Calendar Year option was selected.
The Calendar Year option was selected because low flows are possible in
late September, early November. Starting the year on January 1
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minimizes the possibility of using the same low flow event in multiple
years. An end date of 31 December 2007 was entered in the Time
Window Modification. This end date was specified because not all the
data for the summer of 2008 was available at the time of the analysis.

Shown in Figure B-81 is the Volume Frequency Analysis editor with the
Options Tab selected. Features on this tab include an option to override
the default Flow Duration values, an option to override the default
Frequency Ordinates, and Output Labeling.

[E volume Frequency Analysis Editor - Low Flow Analysis Test 11 5l (mEdm
Name: Low Flow Analysis Test 11|
Description: This example shows how to perform a low flow analysis using HEC-S5P =
Data Set: :Chaﬂahoochee River v:
DSS File Name: | gp_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.ds!]
Report File: icyAnalysisResults\Low_Flow_Analysis_Test_11\Low_Flow_Analysis_Test_11.rpi.]
General| Options | Duration Table | Analytical | Graphical| i
Flow Durations User Specified Frequency Ordinates Historic Period Data
Change or add to default values [7] Use Values from Table Below [ Use Historic Data
Historic Period
Duration in days Frequency in Percent
Start Year: i]
1 0.2 -
7 0.5 End Year: 0
30 1.0
60 =0 Duration Override Low O...
90 5.0
10.0 ity
200 IEday
500 30-day
300 60-day
a0.0 90-day
95.0 |
99.0 i
Historic Events
Year 1-day 7-day
Output Labeling High Qutlier Threshold
D55 DataNameis FLOW [7] override High Qutlier Threshald
[C] Change Label [FLOW Duration Override High OUti...
D58 Data Units are CFS 1-day
7-day
[F] change Label |CFS 30-day
60-day
90-day
Plot Plot Plot
Duration Analytical Graphical
Compute Data Curve Curve View Report % Print ’ OK ] ’ Cancel ] Apply

Figure B-81. Options Tab Shown for Low Flow Analysis Test 11.

Once all of the General and Optional settings are set or selected, the user
can extract the volume-duration data. Select the Duration Data tab and
press the Extract Volume-Duration Data button at the bottom of the
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table. The table should then fill with the flow-duration values, as shown
in Figure B-82.

[&] Volume Frequency Analysis Editor - Low Flow Analysis Test 11 = |
MName: Low Flow Analysis Test 14
Description: This example shows how to perform a low flow analysis using HEC-S5P =
Data Set: :Chaﬂahoochee River v:
DSS File Name: |C:\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP[_]
Report File: \Appendix_B_Examples\SSP_ExamplesWolumeFrequencyAnalysisResults\Low_F[]
General | Options| Duration Table | Analytical | Graphical =
[T] Allow Editing
Yolume-Duration Data
v Lowest Mean Value for Duration, Average Daily FLOW in CFS
ear
1 7 30 G0 90
Date FLOW Date FLOW Date FLOW Date FLOW Date FLOW
1958| 1211311958 202.0| 12/26M1958 266.4| 121211958 209.4| 12/26M1958 307.1| 1212611958 3326
1959| 08/30/1959 222.0| 08/30M1959 306.3| 01/01/1959 370.7| 01/011959 342.9| 01/01/1959 3445
1960( 07171960 325.0{ 07191960 427.9| 12101960 467.0( 12/311960 507.8| 121311960 5725
1961 11121961 270.0( 10/29M1961 367.9| 11121961 378.6| 12/091961 413.8| 12/09/1961 4442
1962| 10/28/1962 198.0( 11/08M1962 258.6| 11/081962 2820 11171962 328.4| 111171962 3525
1963| 10/20/1963 2440 10/211963 288.4| 11/041963 304.9) 11/28M1963 338.0 11/221963 3723
1964 | 09/27/1964 300.0| 09/28M1964 337.9| 09/29/1964 414.9| 09/28M1964 483.4| 01/01/1964 459.9
1965| 09/26/1965 175.0 12/24M1965 277.1| 09/29/1965 303.6| 12291965 349.2| 12311965 357.8
1966 09/M11/1966 200.0| 09121966 267.3| 01/02/1966 303.2| 01/021966 348.2| 01/04/1966 348.9| =
1967 | 08191967 380.0| 08M8MH967 476.9| 041231967 576.0) 01/02H967 625.7| 01/01M1967 577.2
1968| 09/15/1968 245.0| 08/30M1968 297.0( 09151968 352.4| 10151968 363.7| 11/07M1968 3724
1969| 10/19/1969 206.0( 10/3011969 366.4| 10/311969 425.0| 08151969 510.5| 01/01/1969 516.4
1970( 10/04/1970 229.0( 10/08M1970 261.6| 10181970 306.8| 10191970 344.5| 10/28M1970 404.9
1971| 10/311971 363.0] 10131971 436.6| 01/011971 451.0{ 01/03M1571 473.0{ 01/011971 495.0
1972 101151972 290.0| 09161972 3451| 09/29M1972 398.8| 10/22N1972 421.2| 11/021972 4727
1973| 10/271973 3720 104271973 444 1| 11181973 453.2| 11/20M1973 501.4| 11/201973 556.4
1974| 11/08/1974 278.0) 11111974 a72.0( 11161974 408.3| 11181974 442 1| 120711974 487.2
1975| 08/24/1975 307.0( 08/27M1975 390.7| 09/06/1975 454.6| 09/16M1975 542.4| 01/011975 518.8
1976| 09/231976 288.0| 09/231976 372.9| 10/06M1976 433.2| 10/06M1976 491.5| 11/26/1976 5101
1977| 09/031977 153.0 09/05M1977 249.4| 09/041977 332.9| 09/06M1977 351.0( 09131977 4135
1978| 07/3011978 162.0( 11/08M1978 279.6| 11131978 286.5| 11/26M1978 310.6| 11/29M1978 3541
1979| 08181979 205.0| 08/22M979 393.0| 08/25M979 518.1| 01/01M1979 4720 01/011979 4155
1980( 09/14/1980 155.0{ 09161980 282.3| 09191980 331.5| 09/28M1980 384.4| 121311980 403.3
1981| 10/04/1981 120.0{ 10/09/1981 161.9| 10/251981 187.3] 11171981 2254| 10/25/1981 2444
1982| 10/03/1982 190.0{ 10/07M1982 252.7| 10/071982 3049 10121982 380.8| 01/01/1982 361.2
1983| 08/28/1983 194.0| 08/24M1983 302.6| 09/031983 363.7| 10121983 382.0] 11131983 397.3|
1984 11/18/1984 282.0| 11/271984 3641 10/211984 409.4| 11271984 4329 11/27/1984 456.2
1088 AN 088 401 0N AN 2088 2000 An2Na85 17 8 AN Q88 AR2 21 411M9/100858 A12 2] -
4 T | +
Plot Plot Plot
Duration Analytical Graphical
Compute Data Curve Curve View Report @ Print [ OK ] ’ Cancel ] Apply

Figure B-82. Volume-Duration Data Table for Low Flow Analysis Test 11.

Once the data has been extracted, the user must choose to perform an
Analytical or Graphical analysis. In this example, an analytical analysis
was performed. Shown in Figure B-83 is the Settings tab for the
analytical analysis. As shown, the distribution selected for this example is
LogPearsonlll. The Skew option was set to Use Station Skew and the Do
Not Compute Excepted Probability option was selected.
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[&] Volume Frequency Analysis Editor - Low Flow Analysis Test 11

(O [l

Name: Low Flow Analysis Test 11
Description: This example shows how to perform a low flow analysis using HEC-SSP ]
Data Set: Chattahoochee River |
DSS File Name: | C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP(_
Report File: \Appendix_B_ExampIes\SSF’_ExampIes\VoIumeFrequenc:yAnalysisResults\Low_FEJ
| General | Options | Duration Tablel Analytical | Graphical i
Settings | Tabular Results | Plot| Statistics|
Log Transformation: On Skew
@ Use Station Skew
Distribution:
_LogF'earsonIII - _ Use Weighted Skew
Expected Probablity Curve 1 Use Regional Skew
) Compute Expected Prob. Curve Duration Reg. Skew
@ Do Mot Compute Expected Prob. Curve 1
7
30
G0
90 e
Fl 10 2
Plat Plot Plot
Duration Analytical Graphical
Compute ‘ Data Curve Curve I View Report J é Print I OK ‘ I Cancel ‘

Figure B-83. Settings Tab Shown for Low Flow Analysis Test 11.

Press the Compute button to perform the analysis. A message window
will open stating that a few of the annual maximums occurred during the
beginning of the year. The message suggests that the user change the
year/season specification to capture independent events. You want to
minimize the possibility that the same flood event is used for consecutive
years. Press the OK button to finish the computation. Once the
computations have been completed, a message window will open stating
Compute Complete. Close this window and then select the Tabular
Results tab within the analytical analysis. The results table should look

Figure B-84. The top portion of the results table contains the percent
chance exceedance for all durations (the report contains confidence
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limits). The bottom portion of the results table contains the statistics for

all durations.

[ volume Frequency Analysis Editor - Low Flow Analysis Test 11 =l S
Name: Low Flow Analysis Test 11
Description: This example shows how to perform a low flow analysis using HEC-SSP (]
Data Set: :Chaﬂahoochee River v:
DSSFile Name: | sp_Testing\Projects\Appendix_B_Examples\SSP_Examples\S5P_EXAMPLES. ds!..]
Report File: icyAnalysisResults\Low_Flow_Analysis_Test_11\Low_Flow_Analysis_Test_11.rpil_]
| Generall Dptionsl Duration Table| Analytical | Graphical o
- Tabular Results | plot | Statistics
Volume Frequency Curves for Low Flow Analysis Test 11, Average Daily FLOW in CFS
Percent
Chance 1 7 30 60 90
Exceedance
99.0 469.9 4917 5725 5297 G571 »
95.0 404.0 4534 517.6 570.3 593.0(
90.0 366.9 426.3 4827 5325 5538
800 321.3 3875 436.0 4822 502.6
50.0 236.5 300.2 3387 3773 398.0)
200 161.5 208.3 2417 2722 204.3(% L
10.0 128.2 164.0 1954 2216 2441 1
5.0 104.2 131.0 160.7 183.5 205.9
2.0 809 98.8 126.1 145.2 166.9
1.0 G7.6 80.4 105.8 1227 1436
0.5 56.9 65.7 89.2 104.2 124.2| -
Statistics
Percent
Chance 1 i 30 60 90
Exceedance
Mean 2.351 2444 2504 2552 2579
Standard Dewv. 0.182 0171 0.159 0.154 0.143
Station Skew -0.758 -1.201 -0.989 -0.977 -0.858
Regional Skew | 3
Weighted Skew
Adopted Skew 0.758 1.201 0.989 0.977 0.888
#Years 50 50 50 50 50
# Zero/Missing 0 0 0 0 0
# Years with Missing ... 0 0 0 0 0 =
Plot Plot Flot
. . Duration Analytical Graphical
. Compute | Data Curve Curve View Report @ Print [ OK ] ’ Cancel ] Apply

Figure B-84. Tabular Results Tab for Low Flow Analysis Test 11.

Note: These tabular results use the default computed statistics.

As shown in Figure B-85, the Plot contains a graph of the systematic data
and the computed frequency curves. Notice how some of the frequency
curves look like they might cross if the lines were extended. The
Statistics tab can be used to modify the computed statistics to ensure that
the frequency curves are consistent.
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[ Volume Frequency Analysis Editor - Low Flow Analysis Test 11 E@
Mame: Low Flow Analysis Test 11
Description: This example shows how to perform a low flow analysis using HEC-SSP [J
Data Set Chattahoochee River i

D55 File Name: | gP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES. ds{.

Report File: icyAnalysisResults\Low_Flow_Analysis_Test_11\Low_Flow_Analysis_Test_11.rpil.]
| General | Options | Duration Table | Analytical | Graphical L=l
| Settings | Tabular Results | Plat | Statistics|
Return Period
1.1 2 5} 10 a0 100 500 10000100000
1 DDDD 1 1 1 1 1 1 1 1 1 1 1 1 1
[}
[
=
=
= 100.04
=
=
o
L -
100 T T T T T T T T T 1 T T T
0.999 0.99 048 0.4 02 01 0.02 0.005 0001 0.0001 0.000001
Probability
u 1-Day Data Chserved Events (Weibull plotting positions) m] 1-Dary Data Lowe Outlier
1-Day Curve u 7-Day Data Oheerved Events (Weibull plotting positions)
T-Day Data Low Cutlier 7-Day Curve
| | 30-Day Data Observed Events (Weibull plotting positions) [m] 30-Day Data Lowy Cutlier
30-Day Curve n B0-Day Data Ohserved Events (Weibull plotting positions)
G0-Dray Data Lowe Outlier GO-Diavy Curve
| 90-Day Data Ohserved Events (Weibull plotting positions) [m] 90-Davy Data Lowe Cutlier |
90-Day Curve b
Plot Plot Flot
. Duration Analytical Graphical
. Compute | Data Curve Curve View Report é Print [ OK ‘ I Cancel Apply

Figure B-85. Plot for Low Flow Analysis Test 11.

For this example, the standard deviation and the adopted skew were
modified to make sure the volume frequency curves were consistent. As
shown in Figure B-86, the check boxes next to mean, standard deviation,
and adopted skew were checked and then user-adjusted statistics were
entered into the table for all durations. The Compute button must be
pressed after adjusted statistics have been entered in order for the program
to recompute the frequency curves using the user-adjusted statistics.
Figure B-87 shows the Plot tab after the user-adjusted statistics were
entered on the Statistics tab. Results in the Tabular Results table will
also update when user-adjusted statistics are entered on the Statistics tab.
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[ volume Frequency Analysis Editor - Low Flow Analysis Test 11 =l |dm
Name: Low Flow Analysis Test 11
Description: This example shows how to perform a low flow analysis using HEC-SSP =
Data Set: :Chatlahoochee River -
DSS File Name: | gP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES. ds:]
Report File: icyAnalysisResults\Low_Flow_Analysis_Test_11\Low_Flow_Analysis_Test_11.rpi]
| Generall Options I Duration Table| Analytical | Graphical i
| Settings | Tabular Results | F'Iot| Statistics |
-0.8 - o
.
. L ]
03 *
Log Transformation: On
5 1.0 8 » Distribution: LogPearsonlll
[ X-axis Parameter Y-axis Parameter
A4 :Mean v: :Skew v:
1.2 . Update Plot
T T T T T
235 24 245 25 255
hean
Sample Statistics 1 ri 30 60 a0
Mean 2.351 2444 2.504 2.552 2579
Standard Dev. 0.182 0171 0.159 0.154 0.143
Station Skew -0.758 -1.201 -0.959 -0.977 -0.888
Adopted Skew -0.758 -1.201 -0.959 -0.977 -0.888
Use | Adjusted 1 i 30 60 90
Statistics
V] |Mean 2351 2444 2.504 2552 2579
V] |Standar... 0.182 0.175 0.17 0.165 0.16
V] |Adopted .. -0.8 -0.88 -0.86 -0.84 -0.82
Flot Flot Plot
Duration Analytical Graphical
Data Curve Curve View Report & Print ’ OK ] ’ Cancel Apply

Figure B-86. Statistics Tab for Low Flow Analysis Test 11.
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[ Volume Frequency Analysis Editor - Low Flow Analysis Test 11

MName: Low Flow Analysis Test 11

Description: This example shows how to perform a low flow analysis using HEC-SSP ]
Data Set: :Chattahoochee River J
DSSFile Name: | sp_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES dsi.]
Report File: icyAnalysisResults\Low_Flow_Analysis_Test_11\Low_Flow_Analysis_Test_14.rpi]

(O (e

-

| Generall Options I Duration Table| Analytical | Graphical

| Settings | Tabular Results | Plot | Statistics|
Return Period
1.1 2 5] 10 50100 400 10000100000
1 DDDD 1 1 1 1 1 1 1 1 1 1 1 1 1
[}
L
[
=
= 100.04
z
[}
|
[F =
100 T T T T T T T T T 1T T T T
0.9949 0.949 0.4 0.5 0.2 01 0.02 0005 0001 0.0001 0.000001
Frobahility

| 1-Day Data Obhserved Events (vWeibull plotting positions) m] 1-Day Data Lowe Outlier

——— 1-Day Curve | T-Day Data Obzerved Events (Weibull plotting positions)
T-Day Data Low Outlier —— 7-Day Curve

| 30-Day Data Ohzerved Events (Weibull platting positions) m] 30-Day Data Low Outlier

—— 30-Day Curve n G0-Day Data Observed Events (Wieibull plotting positions)
B0-Day Data Low Cutlier G0-Day Curve

| 90-Day Data Observed Events (Weibull plotting positions) m} 90-Dray Data Lowe Outlier

— 90-Day Curve -

Plat Plot Plot
Duration Analytical Graphical
i Compute Data Curve Curve

View Report

Cancel Apply

& print [ ok ]|

Figure B-87. Plot Tab for Low Flow Analysis Test 11.

In addition to the Tabular Results and Plot tabs, graphical plots can be
opened by selecting the Plot Duration Data or Plot Analytical Curve
buttons at the bottom of the analysis window. A plot of the results for this
example is shown in Figure B-88.
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@ ‘Volume Frequency Analytical Plot for Low Flow Analysis Test 11 L=

FLOW in CFS

10000

100.0+

10,0

File Edit View Window

Yolume Frequency Analvtical Plot for Low Flow Analysis Test 11
Return Period

11 2 5 10 50 100 200 500 10000
I ! L PR

T T T T T T T T LI
0.99 09 05 0z 0.1 0.02 0.01 0.005 0.002 0.0001

0.999
Prabability
B 1-Day Dats Observed Events (Weibull plotting positions) O 1-Day Data Low Outlier ——— 1-Day Curve
B 7-Day Data Observed Everts (Weibull plotting positions) 7-Day Data Low Outlier ——— 7-Day Curve
| 30-Diary Data Observed Events (Weibull plotting positions) [m} 30-Day Data Lowe Outlier — 30-Day Curve
B 60Day Data Ohserved Events (Weibul plotting positions) 60-Day Data Low Outlier ——— BO0-Day Curve
n 90-Day Data Ohserved Events (Weibull plotting positions) o 90-Day Data Low Outlier — 80-Day Curve

Figure B-88. Plot of the Frequency Curve Results for Low Flow Analysis Test
11.

The tabular and graphical results can be sent to the printer or the windows
clipboard for transfer into another piece of software. To print the tabular
results, select Print from the bottom of the analysis window. To send the
tabular results to the windows clipboard, highlight the data you want to
send to the clipboard and then press the Control-C key sequence. To print
the graphical results, first bring up the graphical plot and then select Print
from the File menu. To send the graphic to the windows clipboard, select
Copy to Clipboard from the File menu.

In addition to the tabular and graphical results, there is a report file that
shows the order in which the calculations were performed. To review the
report file, press the View Report button at the bottom of the analysis
window. When this button is selected a text viewer will open the report
file and display it on the screen. Shown in Figure B-89 is the report file
for Low Flow Analysis Test 11.

The report file contains a listing of the input data, preliminary results,
outlier and historical data tests, additional calculations needed, and the
final frequency curve results. Different types and amounts of information
will show up in the report file depending on the data and the options that
have been selected for the analysis.
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@ Lm_FIow_AnaIysis_Test_lErfi— ﬁ

File Edit Search Format

File: "asting\Projects\Appendix_B_Examples\SSP_Examples\VolumeFreguencyAnalysisResults\Low_Flow_Analysis_Test_11\Low_Flow_Analysis_Test_11.rpt

<< Skew Weighting >>

Based on 50 events, mean-sguare error of station skew = 0.163
Mean-square error of regional skew is undefined.

<< Frequency Curve >>
Chattahoochee River (l-day Min)

(|

| Computed Expected | Percent | Confidence Limits |
| Curve Probability | Chance Non- | 0.05 0.95 |
| FLOW, CFS | Exceedance | FLOW, CFS |
| | | |
| 470.4 == [ 99.0 | 564.1 4058.1 |
| 404.3 | 95.0 | 473.5 357.0 |
| 367.1 | 590.0 | 424.0 326.9 |
| 321.4 == [ g0.0 | 364.9 285.0 |
| 236.4 | 50.0 | 261.5 214.4 |
| 161.4 | 20.0 | 179.2 142.7 |
| 128.1 == [ 10.0 | 144.7 1058.8 |
| 104.0 | 5.0 | 120.0 86.3 |
| 80.7 | 2.0 | 95.9 64.2 |
| 67.4 == [ 1.0 | gl.8 alel B
| 56.7 == [ 0.5 | 70.4 42.3 |
| 45.5 == [ 0.2 | 58.1 32.5 |
| | | |

<< Systematic Statistics >>
Chattahoochee River (l-day Min)

Log Transform:

RAdopted Skew — 158 Systematic Events 50

| | |
| FLOW, CFS | Number of Events |
| | |
| Mean 2.351 | Historic Events o |
| Standard Dew 0.182 | High Outliers a |
| Station Skew -0.758 | Low Outliers 1 |
| Regional Skew -—— | Zero Ewvents a |
| Weighted Skew -—— | Missing Events a |
| | |
| | |

——— End of Analytical Freguency Curve ———

<< User Frequency Curve >>
Chattahoochee River (l-day Min)

| Computed Expected | Percent | Confidence Limits |
| Curve Probability | Chance Non- | 0.05 0.95 |
| FLOW, CFS | Exceedance | FLOW, CFS | -
4 | i b
! 01122016 10:54 AM 30:22.30:22 30:22

-

Figure B-89. Report File for Low Flow Analysis Test 11.
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Example 12: Duration Analysis, BIN (STATS) Method

This example demonstrates how to use the Duration analysis. The data for
this example is daily average flow from the Fishkill Creek (Beacon NY)
USGS stream gage. The period of record used for this example is from 01
Oct, 1944 to 30 Sep, 1968. To view the data, right-click on the data
record labeled "Fishkill Creek-Daily Flow" in the study explorer and then
select Plot. The data will appear as shown in Figure B-90.

[:] Fishkill Creek-Daily Flow =RN=N X

=

File Edit View

Flomy {cfs)

5,000+

4,000+

3,000+

2,000+

1,000+

VR ARIUR A ;L.L_J b Ak

1946 1948 1950 1852 1954 1956 1953 1960 1962 1964 1966 1968

BEACON MY USGES FLCWS

Figure B-90. Plot of the Daily Average Flow for Example 12.

A Duration analysis has been developed for this example. To open the
analysis editor for this example, either double-click on the analysis labeled
Fishkill Creek Test 12 from the study explorer, or from the Analysis
menu select open, then select Fishkill Creek Test 12 from the list of
available analyses. When Test 12 is opened, the duration analysis editor
will appear as shown in Figure B-91.
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[&] buration Analysis Editor - Fishkill Creek Test 12

[-E- [

MName: Fishkill Creek Test 12
Description: =
Data Set: :Fishkill Creek-Daily Flow -
DSS File Name: | ng\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.dss[.]
Report File: stienAnalysisResults\Fishkill_Creek_Test_12\Fishkill_Creek_Test_12.rpt[.]

General | Options | Results |

Method Time Window Modification

(71 Rank All Data Values End Points

@ Bin (STATS)

DSSRangeis 010CT1944 - 30SEP1968

¥-Axis Scale

) [7] Start Date )
@ Linear

) Propabiity [ End Date L
Y-Axis Scale Duration Period

@ Linear Annual A
© Log Start of Period End of Periad

Compute ] [ Plot Duration Curve ] [ View Report ] % Print [ Ok ] ’ Cancel ] Apply

Figure B-91. Duration Analysis Editor for Fishkill Creek Test 12.

Shown in Figure B-91 are the general settings that were used to perform
this duration analysis. For this analysis, the Bin (STATS) method was
selected, the x-axis scale was set to Linear, the y-axis scale was set to
Linear, and the Annual duration period was selected.

The Options Tab is shown in Figure B-92. Features on this tab include
Output Labeling, the Percent of Time Exceeded ordinates, and Bin
Limits. The Bin Limits panel is active in this example because the Bin
(STATS) method was selected on the General tab. The User-Defined bin
limits method was selected and the bin limits were entered manually.
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[£] Duration Analysis Editor - Fishkill Creek Test 12 (= ==
Name: Fishkill Creek Test 12
Description: ]
Data Set: iFishkiII Creek-Daily Flow -

D3S File Name: asting\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.d[.]

Report File: DurationAnalysisResults\Fishkill_Creek_Test_12\Fishkill_Creek_Test_12.[.]
| General| Options | Resultsl |
Output Labeling User-Specified Exceedance Ordinates Bin Limits
DSS Data Mame is  FLOW Change or Add to Default Values _User—Deﬁned ]
[ change Label |FLOW Percent of
. Time Exceeded
DSg Data Units are  CFS 990 1.0f ~
: 207
= 95.0
[[] Cchange Label |CFS 300 30
: 4.0
. - 30.0
Plotting Position Formula 500 5.0
@ Ranki(N+1) 250 ol
RankN 15.0 10.0
10.0 150
5.0 200 .
20 30.0
1.0 400
01 500
0.05 F0.0
0.01 80.0
100.0
150.0
200.0
300.0]—
400.0
500.0
500.0
2800.0
1000.0| -
Compute ] ’ Plot Duration Curve ] ’ View Report ] &% Print ’ OK ] ’ Cancel ] Apply

Figure B-92. Duration Analysis Editor with Options Tab Shown for Fishkill
Creek Test 12.

Once all of the General and Optional settings are set or selected, the user
can choose to compute the analysis by pressing the Compute button.
Once the computations have been completed, a message window will open
stating Compute Complete. Close this window and then select the
Results tab, shown in Figure B-93.
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E Duration Analysis Editor - Fishkill Creek Test12 =2
Name Fishkill Creek Test 12|
Description D
Data Set Fishkill Creek-Daily Flow T

DSS File Name: | c\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES dss [

Report File »pendix_B_Examples\SSP_Examples\DurationAnalysisResults\Fishkill_Creek_Test_12\Fishkill_Cre(.]

| General | Options | Results |

Tabular Results | Pjot,

Class Number Lower Bin Limit Upper Bin Limit Number in Bin Accum Number Percent Equal or Exceeded

1 1.0 2.0 5 8766 1000/ »
2 20 3.0 4 8761 99.9|

3 30 4.0 2 8757 99.9
4 40 5.0 22 8749 99.8|
5 5.0 6.0 37 8727 996/~

6 6.0 8.0 66 8690 99.1

7 8.0 10.0 95 8624 98.4]
8 10.0 15.0 254 8529 97.3|

9 15.0 20.0 261 8275 94.4]

10 200 30.0 423 8014 914

11 300 40.0 408 7591 86.6

12 400 50.0 359 7188 82.0

13 50.0 60.0 332 6827 779
14! 60.0 80.0 480 6495 T41| _

aE o o o o Eo &

Percent of
Time Exceeded Annual - FLOW
99.0 6.4
95.0 14.0
90.0 229
80.0 448
50.0 1714
25.0 360.5
15.0 520.0
10.0 671.6
5.0 916.9
2.0 1326.1
1.0 1503.6
0.1 3039.0
0.05 3769.5
0.01 6707.8
Compute ] [ Plot Duration Curve ] [ View Report ] [ & Print I Apply

Figure B-93. The Results Tab for Fishkill Creek Test 12.

As shown in Figure B-93, the Result tab contains both tabular and
graphical results. The Tabular Results tab contains a table with
information about the bins, like the lower bin limit, the number of values
in the bin, the accumulated number of values greater than or equal to the
lower bin limit, and the percent of time equaled or exceeded for each bin.
Tabular results also include a table of the duration curve interpolated to
the percent of time exceeded ordinates defined on the Options tab. The
Plot tab contains a graph of the duration curve, shown in Figure B-94.
The plot includes the computed duration curve and the duration curve
interpolated to the user-defined percent of time exceeded ordinates. The
duration curve plot can also be opened by pressing the Plot Duration
Curve button at the bottom of the analysis window.
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@ Duration Analysis Editor - Fishkill Creek Test 12

Name Fishkill Creek Test 12
Description

Data Set Fishkill Creek-Daily Flow

DSS File Name: | C:\pROJECTS\SSPIProjects\SSP_Examples\SSP_EXAMPLES.dss
Report File:

(==

D« | |8

C\PROJECTS\SSP\Projects\SSP_Examples\DurationAnalysisResults\Fishkill_Creek_Test_12iFi_]

‘ Generall Options‘ Results |

Tabular Results | Plot

Durstkan Al is Plafar Flensll C raee T 12

7000~

00—

5000~

FLOAY e FS

amo

2000

4 Interpolated Cune

| Compute | | Plot Duration Curve | | View Report |

& Print OK | |

Cancel Apply

Figure B-94. Plot Tab for Fishkill Creek Test 12.

The tabular and graphical results can be sent to the printer or the windows
clipboard for transfer into another piece of software. To print the tabular
results, select Print from the bottom of the analysis window. To send the
tabular results to the windows clipboard, highlight the data you want to
send to the clipboard and then press the Control-C key sequence. To print
the graphical results, first bring up the graphical plot and then select Print
from the File menu. To send the graphic to the windows clipboard, select
Copy to Clipboard from the File menu.

In addition to the tabular and graphical results, there is a report file that
shows the input data and results for the analysis. To review the report file,
press the View Report button at the bottom of the analysis window.
When this button is selected a text viewer will open the report file and
display it on the screen. Shown in Figure B-95 is the report file for
Fishkill Creek Test 12.
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F ™
[ Fishkill_Creek _Test_12.rpt [
File Edit Search Format
File: CAPROJECTS\SSP_Testing\Projects\Appendix_B_Examples\S5P_Examples\DurationAnalysisResults\Fishkill_Creek_Test_12\Fish
-
Annual Duration Analysis
Time Period: 0l1Jan - 31Dec
Humber Valid Values: 8766
Hurber Missing Values: [i]
Minimum Value: al5al
Maximum Value: 6,970.0
| | Lower | HNumber | | Percent |
| Bin | Bin | in | Accum | Egual or |
| Number | Limit | Bin | HNumber | Exceeded |
| ——————- |- |———————— e | |
| 11 1.0 | o | 2766 | 100.000 |
| 2 | 2.0 | 1] 8761 | 99.943 |
| 3 | 3.0 | g1 8757 | 99,897 |
| 4 | 4.0 | 22 | 8749 | 99.806 |
| 3 5.0 | 37 1 8727 | 29 555 |
| € | 6.0 | &6 | 2690 | 09133 |
| 71 2.0 | 95 | g624 | 98.380 |
| g | 10.0 | 254 | 8529 | 97.296 | L
| 9 | 15.0 | 261 | 8275 | 94.399 |
| 10 | 20.0 | 423 | 2014 | 91.421 |
| 11 | 30.0 | 405 | 7591 | 86.596 |
| 12 | 40.0 | 359 | 7186 | 81.976 |
| 13 | 50.0 | 332 | 6827 | 77.880 |
| 14 | 0.0 | 480 | 6495 | 74.0893 |
| 15 | 80.0 | 409 | 6015 | 68.617 |
| 18 | 100.0 | gae | S5606 | 63.952 | s
| 17 | 150.0 | 783 | 4718 | 53.822 |
| 18 | 200.0 | 12468 | 3935 | 44,889 |
| 19 | 300.0 | 822 | 2689 | 30.675 |
| 20 | 400.0 | 484 | 1867 | 21.298 |
| 21 | 500.0 | 340 | 1383 | 15.777 |
| 22 | 800.0 | 465 | 1043 | 11.898 |
| 23 | g00.0 | 239 | 578 | 6.594 |
| 24 | 1,000.0 | 251 | 339 | 3.867 | B
| 25 | 1,500.0 | 47 | gg | 1.004 |
| 26 | 2,000.0 | 32 1 41 | 0.468 |
| 27 | 3,000.0 | 6 | 9 | 0.103 |
| 28 | 4,000.0 | 1| 3| 0.034 |
| 29 | &,000.0 | 31 3 0.034 |
I | 30 | T7.,000.0 | 01 ol 0.000 | I
| === |——— | == |-——— | = | =
NN M | 3
01M12/2016 11:05 AM 1111 11

Figure B-95. Report File for Fishkill Creek Test 12.
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Example 13: Duration Analysis, Rank All Data Method

This example demonstrates how to use the Duration analysis. The data for
this example is daily average flow and the period of record is from 01 Apr,
1899 to 28 Jan, 2010. To view the data, right-click on the data record
labeled "Wondering River-Franklin" in the study explorer and then
select Plot. The data will appear as shown in Figure B-96.

@ Wondering River-Franklin =[S -

=Y

File Edit View
350,000

Flomy {cfs)

300,000+

250,000+

200,000+

150,000+

100,000

50,000+

i Lo

T
1960

B

T T T T
1900 1920 1940 1980 2000

FRAMELIMN OBSERWED FLCWS

Figure B-96. Plot of the Daily Average Flow for Example 13.

A Duration analysis has been developed for this example. To open the
analysis editor for this example, either double-click on the analysis labeled
Duration Curve Test 13 from the study explorer, or from the Analysis
menu select open, then select Duration Curve Test 13 from the list of
available analyses. When Duration Curve Test 13 is opened, the
duration analysis editor will appear as shown in Figure B-97.
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[ puration Analysis Editor - Duration Curve Test13

(= s

Name: Duration Curve Test 13

Description: E]
Data Set: :Wandering River-Franklin =
D85 File Name: 35p_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES dss ]
Report File: les\DurationAnalysisResults\Duration_Curve_Test_13\Duration_Curve_Test_1 3.rptE]

General | Options | Resultsl

Method Time Window Modification

@ Rank All Data Values End Points

_) Bin (STATS)

DSSRangeis 01APR1899- 28JAN2010
X-Axis Scal
Is Scale [] Start Date 5

@ Linear

) Probablity CJEndDate a
Y-Axis Scale Duration Period

_) Linear Annual -
@ Log Start of Period End of Period
Compute ] ’ Flot Duration Curve ] ’ iew Report ] é Print ’ OK ] ’ Cancel ] Apply

Figure B-97. Duration Analysis Editor for Duration Curve Test 13.

Shown in Figure B-97 are the general settings that were used to perform
this duration analysis. For this analysis, the Rank All DataValues
method was selected, x-axis scale was set to Linear, the y-axis scale was
set to Log, and the Annual duration period was selected.

The Options Tab is shown in Figure B-98. Features on this tab include
Output Labeling, the Percent of Time Exceeded ordinates, and Bin
Limits. The Bin Limits panel is not active in this example because the
Bin (STATS) method was not selected on the General tab.
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[ Duration Analysis Editor - Duration Curve Test 13 =) [mEdm
Name: Duration Curve Test 13|
Description: ]
Data Set: :Wondering River-Franklin z)

D85 File Mame: 35P_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES dss ()

Report File: les\DurationAnalysisResults\Duration_Curve_Test_13\Duration_Curve_Test_1 3.rptE]
| General| Options | Resultsl
Output Labeling User-Specified Exceedance Ordinates Bin Limits
D355 Data Mame is  FLOW [7] Change or Add to Default Values User-Defined
[[] Change Label |FLOW Percent of
Time Exceeded
D355 Data Units are  cfs 990
[[] change Label |cfs ggg
Flotting Position Formula ggg
@ Ranki{hN+1) 25:0
©) RankiN D
10.0
5.0
2.0
1.0
0.1
Compute ] ’ Flot Duration Curve ] ’ iew Report ] é Print ’ OK ] ’ Cancel ] Apply

Figure B-98. Duration Analysis Editor with Options Tab Shown for Duration
Curve Test 13.

Once all of the General and Optional settings are set or selected, the user
can choose to compute the analysis by pressing the Compute button.
Once the computations have been completed, a message window will open
stating Compute Complete. Close this window and then select the
Results tab, shown in Figure B-99.
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& Duration A lysis Editor - Duration Curve Test13 ==
Name: Duration Curve Test 13
Description: E]
Data Set: :Wandering River-Franklin z)

D85 File Mame: 35P_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES dss[.)

Report File: les\DurationAnalysisResults\Duration_Curve_Test_13\Duration_Curve_Test_13.rpt[]
Generall Options | Results |
Tabular Results | plot
Percent of
Time Exceeded Annual - FLOW
99.0 997.8
95.0 1486.7
90.0 19381
80.0 3005.9
50.0 8095.9
25.0 18022.2
15.0 26771.7
10.0 34462.0
5.0 49097.6
20 727933
1.0 919981
0.1 170943.0
. Compute | ’ Plot Duration Curve ] [ View Report ] [ & Print ] ’ OK ” Cancel Apply

Figure B-99. The Results Tab for Duration Curve Test 13.

As shown in Figure B-99, the Result tab contains both tabular and
graphical results. The Tabular Results tab contains a table of the
duration curve interpolated to the percent of time exceeded ordinates
defined on the Options tab. The Plot tab contains a graph of the duration
curve. The plot includes the computed duration curve and the duration
curve interpolated to the user-defined percent of time exceeded ordinates.
The duration curve plot can also be opened by pressing the Plot Duration
Curve button at the bottom of the analysis window, shown in Figure B-
100.
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@ Duration Analysis Plot for Duration Curve Test 13 NN X
File Edit View Window
Duration Analysis Plot for Duration Curve Test 13
1000000.0
¥
1EIEIEIEIEI.EI-&
L‘ﬁ.
..
E H*"‘-—-_._
= 10000.07 T
z -
D dy
= o4
L "
~a
-‘-u
1000.0 »
100.0 T T T T T T T T T
1] 10 20 30 40 al G0 il an 40 100
Fercent of Time Exceeded

—#— |nterpolsted Curve  m----- Computed Curve

Figure B-100. Plot Tab for Duration Curve Test 13.

The tabular and graphical results can be sent to the printer or the windows
clipboard for transfer into another piece of software. To print the tabular
results, select Print from the bottom of the analysis window. To send the
tabular results to the windows clipboard, highlight the data you want to
send to the clipboard and then press the Control-C key sequence. To print
the graphical results, first bring up the graphical plot and then select Print
from the File menu. To send the graphic to the windows clipboard, select
Copy to Clipboard from the File menu.

In addition to the tabular and graphical results, there is a report file that
shows the input data and results for the analysis. To review the report file,
press the View Report button at the bottom of the analysis window.
When this button is selected a text viewer will open the report file and
display it on the screen. Shown in Figure B-101 is the report file for
Duration Curve Test 13.
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@ Duration_Curve_Test 13.rpt @

File Edit Search Format

File: | ng\Projects\Appendix_B_Examples\SSP_Examples\DurationAnalysisResults\Duration_Curve_Test_13\Duration_Curve_Test_13.rpt

Result File Name: C:\FROJECTS“S5F Testing\Projects\Appendix B Examples\55F Examples‘\[urationfnalysisRes ,
Duration Analysis Method: Standard

Duration Plot Position Method: Rank/ (H+1)

X-Rxis Scale: Linear

¥-Axis Scale: Logarithmic

Duration Period: Annual
Use Standard Percent Exceedance
Display ordinate values using 1 digits in fraction part of walue

——— End of Input Data —-

Annual Duration Analysis

Time Period: 0l1Jan - 3lDec

Humber Valid Values: 40480
Number Missing WValues: [i]
Minimum Value: 545.8
Maximum Value: 328,470.0

m

| Percent of | FLOW |
| Time Exceeded | cfs |
[ [ |
| 95.0 | 997.8 |
| 95.0 | 1,486.7 |
| 90.0 | 1,8358.0 |
| 0.0 | 3,005.9 |
| 50.0 | 8,095.9 |
| 25.0 | 1&,022.2 |
| 15.0 | 26,771.7 |
| 10.0 | 34,462.0 | |
| S0 | 49,097.5 |
| 2.0 | 72,793.3 |
| 1.0 | 91,998.1 |
| 0.1 | 170,943.0 |
|

€ [ | 3

1

01/12/2016 11:11 AM 1111 11

Figure B-101. Report File for Duration Curve Test 13.
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Example 14: Duration Analysis, Manual Entry

This example demonstrates how to use the Duration analysis and enter the
duration curve manually. To open the analysis editor for this example,
either double-click on the analysis labeled Manual Duration Curve Test
14 from the study explorer, or from the Analysis menu select open, then
select Manual Duration Curve Test 14 from the list of available
analyses. As shown in Figure B-102, the “None” data set was selected for
this analysis. The Manual Entry tab becomes active when the “None”
data set is selected (the Result tab will become inactive).

@ Duratien Analysis Editor - Manual Duration Curve Test 14 of X"
MName: Manual Duration Curve Test 14|
Description: (]
Data Set None =
DSSFile Name: | C:\PROJECTS\SSP_Testing\Projects\&ppendix_B_Examples\SSP_Examples\SSP_EXAMPLES.dss [
Report File: es\DurationAnalysisResults\Manual_Duration_Curve_Test_14\Wanual_Duration_Curve_Test_1 4.rpi|;|
General | Options Manual Entry,
Wethod Time Window Modification
@ Rank All Data Values End Points
Bin (STATS)
DSS Range is
X-Axis Scal —
15 seale Start Date @
@ Linear -
Prabablity Ena Date v
Y-Axis Scale Duration Period
Linear Annual hd
® Log Start of Period End of Period
Compute | ‘ Plot Duration Curve ‘ ‘ View Report | & Print OK Cancel

Figure B-102. Duration Analysis Editor for Manual Duration Curve Test 14.

The y-axis scale was set to Log while all other default options were
selected on the General and Options tabs. Figure B-103 shows the
Manual Entry tab for Manual Duration Curve Test 14. A variable
name of “FLOW?” and units of “cfs” were entered as well as the duration

curve. The program will plot the duration curve when the Compute
button is pressed.

B-108



HEC-SSP User's Manual Appendix B — Example Data Sets

[ Duration Analysis Editor - Manual Duration Curve Test 14 El |ESm)
MName: WManual Duration Curve Test 14
Description: =
Data Set: [None =
DSSFile Name: | C:PROJECTSISSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.dss (]
Report File es\DuraliunAnalys\sResuIis\ManuaI_Duration_Curve_Testj4\ManuaI_DuraUun_Cur\de_Tesl_M—.rpiC]
| Generall Options | | Manual Entry
Variable Manual Duration Analysis Plot for Manual Duration Curve Test 14
Name: [FLow 1000000.0
Units: | ¢fg
Percent of FLOW
Time Exceeded
99.0 998.0
95.0 1488.0 o 05
90.0 1938.0
80.0 3008.0
50.0 8096.0
250 18022.0
15.0 267720
10.0 344620 £
5.0 49098.0 = 10000.04
2.0 727930| £
1.0 91998.0 =
0.1 170943.0
1000.04
1000 T T T T T T T T T
0 10 20 30 40 50 60 70 a0 90 100
Percent of Time Exceeded
Manual-Entry Curve
| Compute \ [ Plot Duration Curve I [ View Report ] & Print Apply

Figure B-103. Duration Analysis Editor with Options Tab Shown for Manual
Duration Curve Test 14.

The duration curve plot can also be opened by pressing the Plot Duration
Curve button at the bottom of the analysis window, shown in Figure B-
104.
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@ Manual Duration Analysis Plot for Manual Duration Curve Test 14

=RRE X

100

File Edit View Window
mManual Duration Analysis Plot for Manual Duration Cumve Test 14
@ 1000000.0
100000.04
-
£ 10000.0+
=
o
—
Lo
1000.0+
100.0 T T T T T T T T T
1] 10 20 a0 40 a0 1] il an S0
Percent of Time Exceeded
Manual-Ertry Curve

Figure B-104. Plot Tab for Manual Duration Curve Test 14.
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Example 15: Coincident Frequency Analysis, A and B
can be Assumed Independent

This example demonstrates how to create a coincident frequency analysis.
Figure B-105 illustrates the scenario for Coincident Freq Test 15. The
goal of this example is to develop a stage-frequency curve at a point along
the tributary (variable C) given flows on the tributary (variable A) and
flows in the mainstem (variable B). Large flows on the mainstem do
cause backwater along the tributary and thus affect the stage at the point of
interest. The data for this example comes from an existing flow frequency
curve for Variable A and an existing flow duration curve for Variable B.
An HEC-RAS model was used to simulate the response of Variable C
(stage at the point of interest) for multiple combinations of flow on the
tributary and flow in the mainstem.

A=
Tributary
Flow

Y

o=
Tributary
Stage at
damage site

E =
Mainstem
Stage

Figure B-105. Scenario for Coincident Freq Test 15.

A Coincident Frequency analysis has been developed for this example. To
open the Coincident Frequency Analysis editor for this example, either
double-click on the analysis labeled Coincident Freq Test 15 from the
study explorer, or from the Analysis menu select open, then select
Coincident Freq Test 15 from the list of available analyses. When
Coincident Freq Test 15 is opened, the Coincident Frequency Analysis
editor will appear as shown in Figure B-106.
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[ Coincident Frequency Analysis Editor - Coincident Freq Test 15 =) |dm
Name: Coincident Freq Test 15|
Description: E]
DSSFile Name: |\55P_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.dss ()
Repaort File: ples\CoincidentFreqResults\Coincident_Freq_Test_15\Coincident_Freq_Test_15.rpt[..]
General | variable A| Variable B | Response Curves | Resuits|
Variable A User Specified Frequency Ordinates
@ AandB can be Assumed Independent (Marginal Frequency Curve for A) [ Use Values from Table Below
~) Aand B can not be Assumed Independent (Conditional Frequency Curves for A)
Frequency in Percent
Variable B 02
Number of Index Values 95 05
1.0
Output Labeling 20
Data Name | Stage a0
100
Data Units  |foet 20.0
50.0
Y-Axis Scale 80.0
@ Linear 0.0
95.0
) Log 99.0
Compute I I Plot I I View Report I & Print I OK J I Cancel Apply

Figure B-106. General Tab Shown for Coincident Freq Test 15.

Shown in Figure B-106 are the general settings for this coincident
frequency analysis. For this analysis, the A and B can be Assumed
Independent (Marginal Frequency Curve for A) option was selected.
This would be determined by performing a correlation analysis between
variables A and B; little correlation would indicate that variables A and B
could be assumed independent. The number of variable B index values
was set to 9, the Data Name was set to “Stage” and the Data Units to
“feet”, and the y-axis scale was set to Linear.

Shown in Figure B-107 is the Coincident Frequency Analysis editor with
the Variable A Tab selected. The Manual Entry option was selected
and a Data Name of “Flow” and Data Units of “cfs” were entered. The
frequency curve values were manually entered into the VVariable A
Frequency Curve table.
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[ Coincident Frequency Analysis Editer - Coincident Freq Test 15 E [
Mame: Coincident Freq Test 15|
Description: [:]
DSS File Name: |\3SP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.dss [
Report File: ples\CoincidentFreqResults\Coincident_Freq_Test_15\Coincident_Freq_Test_15.rpt[)
General Variable A | variable B | Response Cunves | Resu\ts|
Specify Frequency Curve Variable A Frequency Curve
< IEEIEY Percent Chance —
Data Name |Flow Exceedance
0.2 60219.2
Data Units |cfs 05 50625.0
*) Existing Study Analysis ;g ;32:2;
5.0 29667 .4
10.0 24083.0
20.0 18708.5
50.0 11540.6
80.0 7119.0
90.0 5530.3
95.0 4489.3
99.0 3035.9
[ compute | [ Piot | [ viewrepont | | & Piint [ ok || canca ApDly

Figure B-107. Variable A Tab for Coincident Freq Test 15.

Shown in Figure B-108 is the Coincident Frequency Analysis editor with
the Variable B tab selected. The Duration Curve from Test 13 was
selected in the drop-down list. Once selected, the duration curve table
automatically fills with the computed ordinates from the duration curve.
In the Develop Probabilities from Duration Curve panel, the Define
Automatically option was selected. This option uses a predefined
probability pattern to discretize the duration curve into index points. The
Generate Table button was pressed in order activate the predefined
probability pattern. In this example, the first index value is 3005.92 (cfs).
This value is taken at the midpoint between percent of time exceeded
values at 100 and 60 percent (from Duration Curve Test 13). This index
value is assigned a probability of 40 percent; this flow value could be
expected 40 percent of the time. The second index value is 8095.9. This
value is taken at the midpoint between percent of time exceeded values at
60 and 40 percent and is assigned a probability of 20 percent.
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[ Coincident Frequency Analysis Editor - Coincident Freq Test15 E@I
Name: Coincident Freq Test 15
Description: [:]
DSS File Name: |\55P_Testing\Projects\4ppendix_B_Examples\SSP_Examples\SSP_EXAMPLES.dss[..]
Report File ples\CoincidentFreqResults\Coincident_Freq_Test_15\Coincident_Freq_Test_15.rpt[.)
‘ General | Variable A| Variable B | Response Curves | Results|
Duration Curve Develop Probabiliies from Duration Curve
Import Duration Curve Mumber of Index Points 9
Duration Curve Test 13 i @ Define Automatically
Percent of Duration Curve Test13 (7 Define from Index Points
) Annual - FLOW _
Time Exceeded () Define from Probabilities
99.0 997.8 ) ; .
950 1436.7 User-Specified Index Points and Probability Ranges
90.0 19381
500 30059 Generate Table
50.0 §095.9
250 18022.2 Prabability Index SR
15.0 267717 40000 3005920 MO0
10.0 34452.0 20 000 8095 900 B0
50 49097 5 15000 15044 345 LLGE
20 727933 10.000 22396.975 000
10 919981 5.000 30616.850 O
0.1 1709430 4000 40316.220 00
3.000 53046.835 6.000
2.000 72793.258 3.000
1.000 135856.384 00
0.000
[ Compute ] [ Plot ] [ View Report ] 5 Print [ Ok ] [ Cancel Apply

Figure B-108. Variable B Tab for Coincident Freq Test 15.

Once the Variable A and Variable B tabs have been completed, the user
can populate the response curves table. Figure B-109 shows the Response
Curves tab for Coincident Freq Test 15. The Same Variable A for
Each Index option was selected and the Import Variable A button was
pressed to automatically copy values from the Variable A tab and fill in
the Variable A column. The remaining columns in the table were
populated with results from a hydraulics model. For example, the first
value in the second column is 479.16. This value is the stage at the point
of interest given a flow of 60219.18 (cfs) on the tributary (variable A) and
a flow of 3005.92 (cfs) on the mainstem (variable B). A total of 108
simulations were required from the hydraulics model to fill in the response
curves table. Figure B-110 shows a plot of the response surface. The plot
shows variable A (x-axis) and variable C (y-axis). For this example, the
response surface shows that flows greater than 53000 (7™" index point) on
the mainstem affect the stage at the point of interest on the tributary.
When the flow in the mainstem is below 53000 (cfs), only the flow on the
tributary affects the stage at the point of interest.
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[ Coincident Frequency Analysis Editor - Coincident Freg Test 15 El (3
Name: Coincident Freq Test 15
Description [:]
DSSFile Name: |1ssP Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.dss[..]
Report File: ples\CoincidentFregResults\Coincident_Freq_Test_15\Coincident_Freq_Test_15.rpt[.)
General | Variable A | Variable B | Response Curves | Results|
Variable A
@ Same Variable Afor Each Index
() Different Variable A for Each Index
Import Variable A
Variable A B1=3005.920 | B2=8095.900 | B3=15044.345 | B4=22396.975 | B5=30616.850 | B6=40316.220 | BY=53046.835 | B§=72793.258 | B9=135856.3...
C=f(AB1) C =f(AB2) C=1(AB3) C =f(A,B4) C =1(AB5) C =f(ABB) C =f(ABT) C =f(AB8) C =f(A,B9)
60219.2 479.16 479.16 47917 47917 479.18 479.2 479.22 479.28 479.87
50625.0 475.2 476.21 475.22 476.23 476.26 476.32 476.4 475.52 47743
43870.4 474.34 474.35 47437 474.4 474.45 474.53 474.68 474.88 47592
375158 472.62 47264 472 66 47272 47279 4729 4731 473.42 47471
29667 .4 470.81 47083 470.84 470.89 470.98 471.08 471.3 47177 473.35
24083.0 469.54 469.57 469.6 469.65 469.74 469.87 4701 470.68 472.44
187085 467.81 467.94 468.0 468.11 468.26 468.45 468.82 469.56 471.65
115406 465.1 46511 465.38 465.55 465.78 466.11 466.73 467.89 470.73
7119.0 463.83 463.83 463.83 463.9 464.12 464.58 465.39 466.88 470.23
5530.3 463.35 463.35 463.34 463.37 463.52 464.03 454.93 466.55 470.08
44893 462.99 462.99 462.99 462.99 463.12 463.67 464.66 466.34 470.0
30359 462.39 462.39 462.39 462.39 46255 463.21 4643 466.1 469.89
Plot Response Surface ]
Compute ] [ Plat ] [ View Repaort ] & Print [ OK ] [ Cancel ] Apply

Figure B-109. Response Curves Tab for Coincident Freq Test 15.

@ResponseSurfacePlﬂt I — - e -

File Edit View
482

@ 450
478
476
474

472

Stage in feet

470

468

4BE

464

462

T T T T T T
1} 10,000 20,000 30,000 40,000 60,000 60,000
Wariable A

¥0,000

—— C=fAB1)—— C=1f(AB2) —— C=fAB3) —— C=f(AB) —— C=1fAB3 C=1ABE) —— C=fABT) —— C=f(ABB) —— C=flABD

- =

Figure B-110. Response Curves Plot for Coincident Freq Test 15.
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Press the Compute button to perform the analysis. Once the computations
have been completed, a message window will open stating Compute
Complete. Close this window and then select the Results tab. The results
tab should look Figure B-111. The left portion of the results tab contains
the computed variable C frequency curve and the right portion of the
results tab contains a plot of the computed variable C frequency curve.

Name:

Description:

Report File:

[] Coincident Frequency Analysis Editer - Coincident Freq Test 15

Coincident Freq Test 15

DSS File Name: \ssSP_Testing\Projects\Appendix_B_Examples\3SP_Examples\SSP_EXAMPLES.dss [

ples\CoincidentFreqResults\Coincident_Freq_Test_15\Coincident_Freq_Test_15.rpt[.)

BN

[

General | Variable A | Variable B | Response Curves| RESUHS|

Percent Chance
Exceedance

Caincident Freguency Plot for Coincident Freq Test 158

Return Period
479.16

476.26 11 2 5 10 50 200 WDIDD 10000

47444 430 I I I I —

47279 £

471.058

469.83 /

468.19

465.51

463.96 4

463.42

463.05

462.44

Stage in feet

462 T
0.9999 0.8589

T T T L L
04s 02 01 0.02 0.005

Prabability

T
0.88 0.0001

| Plot Conditional Frequency Curves \

|— Computed Curve

Compute | [ Plot | [ ViewReporn | [ & Print |

Cancel

Lok |

Figure B-111. Results Tab for Coincident Freq Test 15.

The tabular and graphical results can be sent to the printer or the windows
clipboard for transfer into another piece of software. To print the tabular
results, select Print from the bottom of the analysis window. To send the
tabular results to the windows clipboard, highlight the data you want to
send to the clipboard and then press the Control-C key sequence. To print
the graphical results, first bring up the graphical plot by pressing the Plot
button from the bottom of the analysis. Then select Print from the File
menu. To send the graphic to the windows clipboard, select Copy to
Clipboard from the File menu.
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In addition to the tabular and graphical results, there is a report file that
shows input data and results. To review the report file, press the View
Report button at the bottom of the analysis window. When this button is
selected a text viewer will open the report file and display it on the screen.
Shown in Figure B-112 is the report file for Coincident Freq Test 15.

@ Coincident_Freq_Test_15.rpt

- S

File Edit Search Format

File: C\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\CoincidentFreqResults\Coincident_Freq_Test_15\Coincident_Freq_Test_15.rpt

| Exceedance | Flow

| Percent | cfs

| |

| 0.2 | 60,219.200
| 0.5 | 50, 625.000
| 1.0 | 43,870.400
| 2.0 | 37,515.800
| 5.0 | 29, 667.400
| 10.0 | 24,083.000
| 20.0 | 18,708.500
| 50.0 | 11,540.600
| 80.0 | 7,1158.000
| 90.0 | 5,530.300
| 95.0 | 4,489.300
| 93.0 | 3,035.3900
| |

Index-Value Table for Variable B

| Occurrance | Index | Exceedance | RAssigned
| Frequency | Value | Break Point | Exceedance
| Percent | | Percent | Percent
| | | |

| | | 100.0 |

| 40.0 | 3,005.920 | | 80.
| | | 60.0 |

| 20.0 | 8,0985.900 | | 50.
| | | 40.0 |

| 15.0 | 15,044.345 | | 32
| | | 25.0 |

| 10.0 | 22,396.975 | | 20.
| | | 15.0 |

| 5.0 1 30,616.850 | | 12
| | | 10.0 |

| 4.0 | 40,316.220 | | .
| | | 6.0 |

| 3.0 | 53,046.835 | | 4.
| | | 3.0 |

| 2.0 | 72,793.258 | | 2l
| | | 1.0 |

| 1.0 | 135,856.384 | | 0.
| | | 0.0 |

| | | |

| Variable A |
| cfs |
1 I

C = £(a,Bl)

fee

T

“

Response Curve for Variable Bl = 3,005.92

1

-

011212016 11:19 AM 1111 11

Figure B-112.

Report File for Coincident Freq Test 15.
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Example 16: Coincident Frequency Analysis, A and B
can not be Assumed Independent

This example demonstrates how to create a coincident frequency analysis
when variables A and B are not independent. Figure B-113 illustrates the
scenario for Coincident Freq Test 16. The goal of this example is to
develop a stage-frequency curve at a point along the tributary (variable C)
given flows on the tributary (variable A) and flows in the mainstem
(variable B). Large flows on the mainstem do cause backwater along the
tributary and thus affect the stage at the point of interest. The data for this
example comes from existing conditional flow frequency curves for
Variable A and an existing flow duration curve for variable B. An HEC-
RAS model was used to simulate the response of variable C (stage at the
point of interest) for multiple combinations of flow on the tributary and
flow in the mainstem.

A=
Tributary
Flow

Y

=

Tributary
B= Stage at
Mainstem damage site
Stage

Figure B-113. Scenario for Coincident Freq Test 16.

A Coincident Frequency analysis has been developed for this example. To
open the Coincident Frequency analysis editor for Coincident Freq Test
16, either double-click on the analysis labeled Coincident Freq Test 16
from the study explorer, or from the Analysis menu select open, then
select Coincident Freq Test 16 from the list of available analyses. When
Coincident Freq Test 16 is opened, the Coincident Frequency analysis
editor will appear as shown in Figure B-114.
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[ Coincident Frequency Analysis Editor - Coincident Freq Test 16 = |

Name: Coincident Freq Test 1§

Description:

D33 File Name: |9\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.ds/
Report File:

1Ny}

\ples\CoincidentFreqResulis\Coincident_Freq_Test_18\Coincident_Freq_Test_16.rpil...

General | Variable A | Variable Bl Response Cuwesl Results|
Wariable A

User Specified Frequency Ordinates

A and B can be Assumed Independent (Marginal Frequency Curve for A) Use Values from Table Below

@ A and B can not be Assumed Independent (Conditional Frequency Curves for A)

Frequency in Percent
Variable B 0.2

Number of Index Values ke

Qutput Labeling

Data Mame | Stage 5.0

Data Units | fapt

Y-Axis Scale
@ Linear S

Log

Compute | | Plot | ‘ Wiew Report | & Print | OK || Cancel

Figure B-114. General Tab Shown for Coincident Freq Test 16.

Shown in Figure B-114 are the general settings for this coincident
frequency analysis. For this analysis, the A and B can not be Assumed
Independent (Conditional Frequency Curve for A) option was selected.
This would be determined by performing a correlation analysis between
variables A and B; a correlation coefficient in the range of 0.3 — 0.7 would
indicate that variables A and B could not be assumed independent. The
number of variable B index values was set to 9, the Data Name was set to

“Stage” and the Data Units to “feet”, and the Y-Axis scale was set to
Linear.

Shown in Figure B-115 is the Coincident Frequency Analysis editor with
the Variable A Tab selected. A Data Name of “Flow” and Data Units
of “cfs” were entered. A separate frequency curve for variable A was
developed for each index value defined on the Variable B tab. For
example, the frequency curve in the “Flow P(A|B1)” column is the
variable A frequency curve for the 1% variable B index value. The
variable B tab shows the 1% index value, 3005.92, is assigned a proportion
of time of 40 percent. Therefore, the 1% variable A frequency curve was
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developed using annual peak flows on the tributary when flows in the
mainstem were in the range of the 1% variable B index value. For this
example, a multivariate lognormal random number generator was used to
develop a large enough data set so that variable A frequency curves could
be computed for each variable B index value. The random numbers were
generated using statistics from the annual peak flows occurring on the
tributary, statistics from the coincident (same day) flows occurring on the
main stem, and the covariance between the two datasets.

[ Coincident Frequency Analysis Editer - Coincident Freq Test 16 E (S
Mame: Coincident Freq Test 16
Description: Q

DE5File Name: | 5155P_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES ds:]
Report File: iples\CoincidentFregResults\Coincident_Freq_Test_1 B\Coincidem_Freq_Test_1B.rpl[:]

‘ General‘ Variable A | Variable B | Response Curves | Resu\ts|
Variable A
Data Name |Flow

Data Units | ¢

‘Variable A Conditional Frequency Curves

Percent Flow P(AIB1) | Flow P{AIB2) | Flow P(AIB3) | Flow P(AlB4) | Flow P(AIBS) | Flow P{AIBE) Flow P(AIB7) | Flow P{AIBS) Flow P{A|B9)
Chance
0.2 42464.0 49934.0 60221.0 63239.0 72700.0 73813.0 86602.0 85327.0 89497.0
0.5 35167.0 42772.0 51234.0 53079.0 61695.0 52595.0 72786.0 72502.0 7E333.0
1.0 36810 are42.0 44837.0 47368.0 53880.0 54634.0 53062.0 53384.0 6E6942.0
2.0 27412.0 32738.0 38757.0 41066.0 46467.0 47088.0 53916.0 54727.0 57997.0
5.0 22063.0 26553.0 31147.0 331500 37217.0 376770 42623.0 43807.0 46769.0
10.0 18193.0 22045.0 25649.0 27407.0 30554.0 30906.0 34589.0 361020 38631.0
20.0 14404.0 17598.0 20274.0 21767.0 24063.0 243140 26861.0 28484.0 30648.0
50.0 9214.0 11437.0 12928.0 14008.0 15237.0 15366.0 165558.0 18101.0 19682.0
80.0 5894.0 74320 82440 9015.0 9648.0 9711.0 10207.0 11802.0 12639.0
90.0 4666.0 5933.0 6516.0 7160.0 7598.0 TE40.0 T7927.0 9075.0 10027.0
95.0 3848.0 4926.0 5366.0 5920.0 6238.0 6267.0 6433.0 T7462.0 8283.0
99.0 2680.0 3475.0 3728.0 4143.0 4309.0 4322.0 4345.0 5169.0 5787.0

[ Compute ] [ Plot ] [ View Repaort ] & Print [ OK H Cancel Apply

Figure B-115. Variable A Tab for Coincident Freq Test 16.

Shown in Figure B-116 is the Coincident Frequency analysis editor with
the Variable B Tab selected. No duration curve was selected for this
example. In the Develop Probabilities from Duration Curve panel, the
User-Specified Index Points and Probability Ranges option was
selected. The probabilities and index values were defined manually and
the Generate Table button was pressed in order to compute the Break
Points.
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[ Coincident Frequency Analysis Editor - Coincident Freq Test 16 = |
Name: Coincident Freq Test 16
Description: .

D35 File Name: |9\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_EXAMPLES.dsi()

Report File: \ples\CoincidentFreqResulis\Coincident_Freq_Test_1 E\CuincidenLFreqjestjB.rm[:]

Duration Curve
Import Duration Curve

General | variable A| Variable B | Response Cunves | Resuits|

Develop Probabilities from Duration Curve

Number of Index Points g
Mone x| Define Automatically
Percent of Define from Index Points
Time Exceeded Define from Probabilities
@ User-Specified Index Points and Probability Ranges
Generate Table
Probability Index Break Point
40.000 3005.920 BRI
20.000 8035.900 G000
15.000 15044.345 SEEE
10.000 22395.975 R0
5.000 30616.850 p=R000
4000 40316.220 JRIFE
2.000 53045.835 B0y
2.000 72793.258 0
1.000 135856.401 REC0T
0.000
Piot
| Compute | l Plot ] [ View Report ] & Print [ oK ] [ Cancel Apply

Figure B-116. Variable B Tab for Coincident Freq Test 16.

Once the Variable A and Variable B tabs have been completed, the user
can populate the response curves table. Figure B-117 shows the Response
Curves tab for Coincident Freq Test 16. The Different Variable A for
Each Index option was selected. When selected, a separate Variable A
column is added for each variable B index value. For example, the first
Variable A column is linked to the C = f(A,B1) column. The second
variable A column is lined to the C = f(A,B2), and so on. The Import
Variable A button was pressed to automatically copy values from the
Variable A tab to fill in appropriate Variable A column. The remaining
columns in the table were populated with results from the hydraulics
model. For example, the first value in the second column is 473.95. This
value is the stage at the point of interest given a flow of 42464 (cfs) on the
tributary (variable A) and a flow of 3005.92 (cfs) on the mainstem
(variable B). A total of 108 simulations were required from the hydraulics
model to fill in the response curves table.
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[E] Coincident Frequency Analysis Editor - Coincident Freq Test 16 [=- =]
Name: Coincident Freq Test 16
Description =]
DSS File Name: |CPROJECTSISSP_ Testing . B I | > EXAMPLES ds& @]
Report File: _B_t _ExamplesiCoincidentFreqResults\Coinci dent_Freq_Test_16\Coincident_Freq_Test_16.rpt[]

General | Variable A | Variable B| Response Curves | Results
Variable A

() Same Variable A for Each Index

(@) Different Variable A for Each Index

import Variable A

Variable A [B1=30059. [ Variable A [B2=80959.. variable A [B3=15044...| Variable A [B4=22396...| Variable A [B5=30616...| Variable A [B6=40316...| Variable A [B7=53046...| Variatle A [B8=72793..[ variable A [ B9=13585
C=1AB1) c=maB2) | C=1(AB3) C=fAB4) C=fABS) C=fABB) C=fABT) C=1(AB8) C = 1(AB9)

2464, 7. 993, 76.02] 0221 79.17 323 80. 7271 85.0 738 48548 866! 85327.0 9.67 8! 7. 77
5167 7 277, 74.05 234, 7 307, 77 707 625 48002 727 72502.0 487 76333 4
1 7 76: 72.67] 837 7. 7. 7! 771 4 477 6301 aq‘m 0. 2 8
7 7 27. 7 757 7 1 7 751 7 753 530 2T 47T 7 5]
22 65 7 147, 7 3 71, 7 72.7 7 72.9: 42623 74, 07, 7 76.56|
1 220. 649 7. 7 0554 71.1 713 458! 724 02 7. 7492 |
1 23] 17593 20274, 1767 4062 7 92 626 707 84, 7 7251
3 1143 12928, 401 5237. 1 74 6558, 23 01 42| 7 79"

4 7432 90 96: 0 49 0207 32 11502 7036

0 5933. i 75 2 6 76 7927. 62 75 7 7055

7. 4926, 3. 592 3 B2 3. 621 27 6433 19 62 6. 283 70.35

22] 3478 4626 4143 462.8 43 463.0 4322 62| 4343 46 5160 6 5787 70.11

" Compute | [ viewReport | | & Print Appl
Figure B-117. Response Curves Tab for Coincident Freq Test 16.

Press the Compute button to perform the analysis. Once the computations
have been completed, a message window will open stating Compute
Complete. Close this window and then select the Results tab. The
Results tab should look Figure B-118. The left portion of the results tab
contains the computed variable C frequency curve and the right portion of
the results tab contains a plot of the computed variable C frequency curve.
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[ Coincident Frequency Analysis Editer - Coincident Freq Test 16 =l |mEm
Name Coincident Freq Test 16
Description: =
DSSFile Name: | C:PROJECTSISSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\SSP_[)
Report File ects\Appendix_B_Examples\SSP_Examples\CoincidentFreqgResults\Coincident_Fi[.]
|GeneraI|VariabIeA Variable B | Response Curves| Results|
Percent Chance ot Coincident Frequency Plot far Caoincident Freg Test 16
Exceedance B Return Period
0.2 479.15 1.0 1.1 5 10 a0 200 1000 10000
0.5 476.25 450 1 1 1 1 1 ———
1.0 47453 J
2.0 473.03 /
50 471.18 e /
10.0 469.81 /
20.0 46816 476
50.0 465.44
80.0 463.87
i /
90.0 45338 i 7
95.0 463.02 =
99.0 46247 = 4724
=
o
o
= 470+
o
468
466 /
/./ -
464 e
462 T T T T T T T 11T
0.9999 0.999 0.949 0.8 0.2 01 0.02 0.005 0.001 0.0001
Frobability
I Plot Conditional Frequency Curves J | Computed Curve
. Compute | I Plot I I View Report I I & Print ‘ I oK H Cancel

Figure B-118. Results Tab for Coincident Freq Test 16.

The tabular and graphical results can be sent to the printer or the windows
clipboard for transfer into another piece of software. To print the tabular
results, select Print from the bottom of the analysis window. To send the
tabular results to the windows clipboard, highlight the data you want to
send to the clipboard and then press the Control-C key sequence. To print
the graphical results, first bring up the graphical plot by pressing the Plot
button from the bottom of the analysis. Then select Print from the File
menu. To send the graphic to the windows clipboard, select Copy to

Clipboard from the File menu.

In addition to the tabular and graphical results, there is a report file that
shows input data and results. To review the report file, press the View
Report button at the bottom of the analysis window. When this button is
selected a text viewer will open the report file and display it on the screen.
Shown in Figure B-119 is the report file for Coincident Freq Test 16.
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@ Coincident_Freq_Test_16.rpt

=

File Edit Search Format

File: | c\PROJECTS\SSP_Testing\Projects\Appendix_B_Examples\SSP_Examples\CoincidentFreqResults\Coincident_Freq_Test_16\Coincident_Freq_Test_16.rpt

Conditional Frequency P(L|B3)

| Exceedance | Flow |
| Percent | cfa |
| | |
| 0.2 | £9,497.000 |
| 0.5 | 76,333.000 |
| 1.0 | 66,942.000 |
| 2.0 | 57,997.000 |
| 5.0 1 46,769.000 |
| 10.0 | 38,631.000 |
| 20.0 | 30,648.000 |
| 50.0 | 19,682.000 |
| g80.0 | 12,639.000 |
| 90.0 | 10,027.000 |
| 95.0 | 8,283.000 |
| 99.0 | 5,787.000 |
| | |

Index-Value Table for Variable B

m

| Occurrance | Index | Exceedance | RAssigned |
| Frequency | Value | Break Point | Exceedance |
| Percent | | Percent | Percent |
| | | | |
| | | 100.0 | |
| 40.0 | 3,005.920 | | £80.0 |
| | | 60.0 | |
| 20.0 | 8,095.900 | | 50.0 |
| | | 40.0 | |
| 15.0 | 15,044,345 | | 32.5 |
| | | 25.0 | |
| 10.0 | 22,396.975 | | 20.0 |
| | | 15.0 | |
| 5.0 | 30,616.850 | | 12.5 |
| | | 10.0 | |
| 4.0 | 40,316.220 | | 8.0 |
| | | 6.0 | |
| 3.0 | 53,046.835 | | 4.5 |
| | | 3.0 | |
| 2.0 | 72,793.258 | | 2.0 |
| | | 1.0 | |
| 1.0 | 135,856.401 | | 0.5 |
| | | 0.0 | |
| | | | |

Response Curve for Variable Bl = 3,005.92

4|

[

01/12/2016 11:23 AM 25342534 2534

Figure B-119. Report File for Coincident Freq Test 16.
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Example 17: Balanced Hydrograph Analysis, Using an
Historical Event Hydrograph

This example demonstrates how to create a Balanced Hydrograph
analysis using an historical event hydrograph shape. In this example,
information from previously-computed Bulletin 17 and VVolume
Frequency analyses will be used along with an historical event to create
numerous balanced hydrographs which are “balanced” across multiple
durations.

A Balanced Hydrograph analysis has been developed for this example. To
open the Balanced Hydrograph analysis editor for this example, either
double-click on the analysis labeled Balanced Hydrograph Test 17 from
the study explorer, or from the Analysis menu select open, then select
Balanced Hydrograph Test 17 from the list of available analyses. When
test 17 is opened, the Balanced Hydrograph Analysis editor will appear as
shown in Figure B-120.

[&] Balanced Hydrograph - Balanced Hydrograph Test 17 =l (w3
Name: Balanced Hydrograph Test 17
Description Sinnemahoning Creek - Using an Historical Event Hydrograph @
Flow Data Set | ginnemahoning Greek-Hourly il
DSSFile Name: | C:PROJECTSISSPIProjects\TeshSSP_Examples\SSP_EXAMPLES.dss )
Report File: sNSSP_Examples\BalancedHydrograph\Balanced_Hydrograph_Test_17\Balanced_Hydrogre )
i General}| Frequency Curvesl Results|
Output Labeling Time Window Modification User Specified Frequency Ordinates
D&S Data Mame is  FLOW
DSSRangeis 06SEP2004 - 110CT2004 [7] Use Values from Table Below
Bilchangebane LE Start Date 163ep2004[.) Frequency in Percent
D385 Data Units are End Date 295ep2004 ] gg
[C] Change Label 1.0
Number of Probabilities: 615 20
" . - 5.0
P IEr T BT EL Cre Sl User-Specified Probabilities for 10.0
User-Specified Durations Balanced Hydrographs 20.0
(1 Hour = 0.0417 Days) Frequency In Percent ggg
Duration in Days gg 90.0
0.0417 10 gg g
1.0 20 =
3.0 50
10.0
Compute I I Plot Flow-Frequency I I Plot Balanced Hydrograph J { View Report I I OK J I Cancel I

Figure B-120. General Tab Shown for Balanced Hydrograph Test 17.

Shown in Figure B-120 are the general settings for this curve combination
analysis. The Number of Durations was set to three: 0.0417-days (1-
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hour), 1-day, and 3-days. These three durations are those which will be
used to “balance” throughout the analysis. The DSS Range was set to
16Sep2004 through 29Sep2004, which corresponded to the passage of the
remnants of Tropical Storm Ivan, as shown in Figure B-121.

F |
@ Sinnemahoning Creek-Hourly o | El ||

File Edit View Time Window
7= 45,000

@ 40,000 [

35,0004

30,0007 |
25,000

20,0004

Flowy {cfg)

15,000+

10,000+

-

a T T T T T
12 19 26 3 10

Sep2004 Oct2004
SINMEMAHOMING DCP-REY FLCAWY

Figure B-121. DSS Time Window Used within Balanced Hydrograph
Test 17.

The number of probabilities was set to six: 0.2, 0.5, 1, 2, 5, and 10 percent
frequencies. Using six probabilities will result in the creation of six
balanced hydrographs. The frequency ordinates were left as the default
values.

Shown in Figure B-122 is the Balanced Hydrograph analysis editor with
the Frequency Curves tab selected. Frequency Curve Duration 1 was
manually defined using results from the Bulletin 17 analysis named
“Sinnemahoning_B17C”. Frequency Curve Duration 1 corresponds to a
duration of 0.0417-days or 1-hour. It is assumed that the Log Pearson
Type III distribution that was fit within the “Sinnemahoning B17C”
Bulletin 17 analysis is indicative of a 0.0417-day duration. Log Pearson
Type 111 parameters were entered for both Frequency Curve Duration 2
and Frequency Curve Duration 3 using results from the VVolume
Frequency analysis named “Sinnemahoning VolumeFrequency”.
Frequency Curve Duration 2 uses the 1-day results while Frequency Curve
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Duration 3 uses the 3-day statistics from the VVolume Frequency analysis.

Figure B-123 shows the plotted frequency curves for this analysis.

[ Balanced Hydrograph - Balanced Hydrograph Test 17 =) |medm
Name: Balanced Hydrograph Test 17|
Description: Sinnemahoning Creek - Using an Historical Event Hydrograph =
Flow Data Set :Smnemahomng Cresk-Hourly -
DSS File Name: | C\PROJECTS\SSP\Projects\SSP_Examples\SSP_EXAMPLES. dss @
Report File: Projects\SSP_Examples\BalancedHydrograph\Balanced_Hydrograph_Test_17\Balanced_[.)
General| Frequency Curves | Results|
Frequency Curve Duration 1 (0.0417) Frequency Curve Duration 2 (1.0) Frequency Curve Duration 3 (3.0)
@ Wanual Entry (7 Manual Entry (Z) Manual Entry
(71 Enter LPIIl Statistics @ Enter LPIIl Statistics @ Enter LPIIl Statistics
Statistics Statistics Statistics
Mean: 1.253 Mean: 1.131 Mean: 3.993
Standard Deviation: 0.227 Standard Deviation 0.192 Standard Deviation: 0.162
Skew: 0.376 Skew: 0.304 Skew: 0.176
Frequency In Percent Frequency Curve Frequency In Percent Frequency Curve Frequency In Percent Frequency Curve
0.2 102267.5 02 56849.8 02 31186.8
0.5 82575.8 0.5 47877.9 0.5 273563.2
1.0 69561.6 1.0 41690.6 1.0 24586.2
2.0 57969.9 20 35964.0 20 21917.5
5.0 44539.8 5.0 29007.7 5.0 18506.4
10.0 35589.8 100 241245 100 15974.4
20.0 27456.8 200 19458.5 200 13420.6
50.0 173339 50.0 13221.6 50.0 9733.1
80.0 11461.6 800 92733 800 7169.0
90.0 9398.6 90.0 7798.9 90.0 6147.2
95.0 80495 95.0 6801.9 95.0 5431.0
99.0 G147.9 99.0 5340.9 99.0 4337.2
compute | [ PiotFlowFrequency | | PiotBalznced Hyarograph | | viewRepor | [ ok |[ canca | Apply

Figure B-122. Frequency Curves Tab for Balanced Hydrograph Test 17.
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-
@ Frequency Curves for Balanced Hydrograph Test 17 =HATN X

File Edit View
1000000.0

100000.0+

FLOwY

10000.0

1000.0 T T T T T T T
0.9959 0.99 08 0s 01 001 0.0

Frequency

3-Day Duration

Figure B-123. Plotted Frequency Curves for Balanced Hydrograph Test 17.

0.042-Day Durstion 1-Day Duration

Press the Compute button to perform the analysis. Once the computations
have been completed, a message window will open stating Compute
Complete. Close this window and then select the Results tab. The results
tab should look Figure B-124. The left portion of the Results tab window
displays the computed balanced hydrographs in a table using the six
frequencies that were previously defined on the General tab. The right
portion of the Results tab displays all six balanced hydrographs in a plot.
To view the balanced hydrographs in a separate window, either click Plot
Balanced Hydrograph or double click on the plot within the Results tab.
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[Z] Balanced Hydregraph - Balanced Hydrograph Test17 =l [me3m|
Name: Balanced Hydrograph Test 17
Description: Sinnemahoning Creek - Using an Historical Event Hydrograph =
Flow Data Set: :Sirmernahcming Creek-Hourly v:
DSS File Name: | C:\PROJECTS\SSP\ProjectsiTest\SSP_Examples\SSP_EXAMPLES.dss ]
Report File stiSSP_Examples\BalancedHydrograph\Balanced_Hydrograph_Test_17\Balanced Hydrogrzl.]
| Generall Frequency Curves| R95Ll|t5|
Date Hydrograph | Hydregraph | Hydrograph | Hydrograph | Hydregraph | Hydrograph Balanced Hydrograph Test 17 Results
(0.2 Percen... | (0.5 Percen...| (1 Percent... | (2 Percent ... | (5 Percent ... | (10 Percent.. 120 000
15 Septemb... 939.8 939.8 939.8 939.8 939.8 9298 -
16 Septemb... 9385 9385 9385 9385 9385 9385 |
16 Septemb 9385 9385 9385 938 5 9385 938.5|= 100,000
16 Septemb... 9385 9385 9385 9385 9385 938.5
16 Septemb... 9287 9287 9287 9287 9287 9287 80,000
16 Septemb 8380 8980 8980 896.0 8980 898.0 .
16 Septemb... 8941 8941 8941 894.1 8941 894.1 L
16 Septemb... 394.1 394.1 894.1 394.1 394.1 3941 — 60,0007
16 Septemb... 884.3 8843 8843 884.3 8843 884.3 =
16 Septemb... 383.0 883.0 883.0 383.0 883.0 283.0 & 400004
16 Septemb 8750 8750 8750 8750 8750 875.0 z '
16 Septemb... 866.0 866.0 866.0 866.0 866.0 866.0
16 Septemnb... 264.0 264.9 864.9 284.0 264.9 264.9 20,000
16 Septemb B57.0 B57.0 8570 B857.0 8570 B57.0
16 Septemb... 855.9 855.9 855.9 855.9 855.0 855.9 0 R B ROV O B B
16 Septemb... 855.0 855.0 8559 855.0 8550 855.0
1718719'20°21'22'23'24'25'26°'27°28'29
16 Septemb... 855.9 855.9 855.9 855.9 855.9 855.9
16 Septemb... 3320 832.0 832.0 3320 832.0 3320 3ep2004
16 Septemb... 8288 82838 8288 828.8 8288 828.8 [« I 0 v]
16 Septemb... 8208 8208 8208 8208 8208 8208 0.2 Percant Evant
16 Septemb... 8118 8118 8118 8118 8118 8118
16 Septemb 8028 8028 8028 8028 8028 8028 —— 0.5 Percent Event
16 Septemb... 8017 8017 8017 8017 8017 801.7 1 Parcant Evert
16 Septemb... 7857 785.7 785.7 785.7 785.7 785.7
16 Septemb 7836 7836 7836 7836 7836 7836 2 Parcent Event
17 Septemb... 7836 783.6 783.6 783.6 783.6 783.6 —— 5 Percent Event
17 Septemb... 7677 767.7 767.7 7677 767.7 767.7 10 Parcant Event
17 Septemb... 7656 765.6 766.6 765.6 765.6 766.6
17 Septemb... 765.6 765.6 765.6 765.6 765.6 766.6] -| [ SINNEMAHONING DCP-REY FLOW
Compute | [ PlotFlow-Frequency | | PlotBalanced Hydrograph | | ViewReport | [ ok J[ cancl Apply

Figure B-124. Results Tab for Balanced Hydrograph Test 17.

In addition to the tabular and graphical results, there is a report file that
shows input data and results. To review the report file, press the View
Report button at the bottom of the analysis window. When this button is
selected a text viewer will open the report file and display it on the screen.
Shown in Figure B-125 is the report file for Balanced Hydrograph Test
17.
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@Ealanced_Hydragraph_Test_].?.rpt P —

==

File Edit Search Format

File: C\PROJECTS\SSP\Projects\TestiSSP_Examples\BalancedHydrograph\Balanced_Hydrograph_Test_17\Balanced_Hydrograph_Test_17.rpt

0.2% Balanced Hydrograph Summary
0.0417-day Duration
Start Index: 49; 18 Sep 2004, 01:00
End Index: 49; 18 Sep 2004, 01:00
Lverage FLOW (CFS)
Base 42 BEE
Bequired 102,268
Final 102,268 0.00% error
Final/Base Ratio: 2.38452
1-day Duration
Start Index: 43; 17 Sep 2004, 1%:00
End Index: 67; 18 Sep 2004, 1%:00
Average FLOW (CFS)
Base 37,498
Bequired 56,850
Final 56,850 0.00% error
Final/Base Ratio: 1.5160%
3-day Duration
Start Index: 40; 17 Sep 2004, 16:00
End Index: 112; 20 Sep 2004, 1&6:00
Average FLOW (CFS)
Base 20,551
Required 31,187
Final 31,187 -0.00% error
Final/Base Ratio: 1.51753
Balanced Hydrograph was computed using 13 iterations.
N et e o -

m

05/16/2016 14:00 PM 12:42 12:42

12:42

Figure B-125. Report File for Balanced Hydrograph Test 17.
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Example 18: Balanced Hydrograph Analysis, Using a
Triangular-shaped Hydrograph

This example demonstrates how to create a Balanced Hydrograph
analysis using a hypothetical triangular hydrograph shape. In this
example, information from previously-computed Bulletin 17 and VVolume
Frequency analyses will be used along with an historical event to create
numerous balanced hydrographs which are “balanced” across multiple
durations.

A Balanced Hydrograph analysis has been developed for this example. To
open the Balanced Hydrograph analysis editor for Balanced Hydrograph
Test 18, either double-click on the analysis labeled Balanced
Hydrograph Test 18 from the study explorer, or from the Analysis menu
select open, then select Balanced Hydrograph Test 18 from the list of
available analyses. When test 18 is opened, the Balanced Hydrograph
Analysis editor will appear as shown in Figure B-126.

[Z] Balanced Hydrograph - Balanced Hydrograph Test 18 = [
Name: Balanced Hydragraph Test 18
Description: Sinnemahoning Creek - Using a Triangular-shaped Hydrograph [™]
FlowData Set  Sinnemahoning Creek-Triangular -
DSS File Name: | c:APROJECTSISSP\Projects\SSP_Examples\SSP_EXAMPLES. dss =
Report File: 3PP | 1cedHydragrapr |_Hydrograph_Test_18\Balanced_Hydrograph_Test_18.n[]
General | Fraquency Curves | Results|
Output Labeling Time Window Modification User Specified Frequency Ordinates
DSS Data Nameis  FLOW
DSSRangeis 31JAN2099 - 12FEB2099 L2 TE T2 e T2 BREE
Change Label |FLOV | start Date 31Jan20929(.] Frequency In Percent
D53 Data Unit: —
ata Units are 7] End Date 1 (=] gg
Change Label 10
Number of Probabilities 4= 20
S 50
Number of Durations. SE User-Specified Probabilities for 100
User-Specified Durations Balanced Hydrographs 200
(1 Hour = 0.0417 Days) Frequency In Percent 333
Duration in Days 02 S
00417 98 950
10 99.0
10 20
2.0
30
5.0
10.0
Compute \ ‘ Plot Flow-Frequency | ‘ Plot Balanced Hydrograph | ‘ View Report ‘ oK Cancel

Figure B-126. General Tab Shown for Balanced Hydrograph Test 18.

Shown in Figure B-126 are the general settings for this curve combination
analysis. The Number of Durations was set to six: 0.0417-days (1-hour),
1-day, 2-days, 3-days, 5-days, and 10-days. These six durations are those
which will be used to “balance” throughout the analysis. The DSS Range
was set to 31Jan2099 through 12Feb2099, which is used to signify the
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hypothetical nature of the triangular hydrograph shape. This triangular
hydrograph was created using HEC-DSSVue and initially starts at 100 cfs
and increases to a peak of 101 cfs and then decreases to 100 cfs over the
course of 10 days, as shown in Figure B-127.

r‘@ Sinnemahaoning Creek-Triangular = | 8 &1
File Edit View
Q
101.04
100.8
1006
i)
Z 1004
T8
100.24
100.0
1|2|3|4|5|E|T|8|9|1D|11|12
| Feh2099
|— SIMREMAHCORMNG TRIAMGULAR SHAPE FLCAWY

Figure B-127. Hypothetical Triangular Hydrograph Used within Balanced
Hydrograph Test 18.

The number of probabilities was set to four: 0.2, 0.5, 1, and 2 percent
frequencies. Using four probabilities will result in the creation of four
balanced hydrographs. The frequency ordinates were left as the default
values.

Shown in Figure B-128 is the Balanced Hydrograph analysis editor with
the Frequency Curves tab selected. Frequency Curve Duration 1 was
manually defined using results from the Bulletin 17 analysis named
“Sinnemahoning B17C”. Frequency Curve Duration 1 corresponds to a
duration of 0.0417-days or 1-hour. It is assumed that the Log Pearson
Type III distribution that was fit within the “Sinnemahoning B17C”
Bulletin 17 analysis is indicative of a 0.0417-day duration. Log Pearson
Type 111 parameters were entered for Frequency Curve Duration 2,
Frequency Curve Duration 3, Frequency Curve Duration 4, Frequency
Curve Duration 5, and Frequency Curve Duration 6 using results from the
Volume Frequency analysis named “Sinnemahoning_VolumeFrequency”.
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Frequency Curve Duration 2 uses the 1-day results, Frequency Curve
Duration 3 uses the 2-day results, Frequency Curve Duration 4 uses the 3-
day results, Frequency Curve Duration 5 uses the 5-day results, and
Frequency Curve Duration 6 uses the 10-day results from the Volume
Frequency analysis. Figure B-129 shows the plotted frequency curves for
this analysis.

[ Balanced Hydrograph - Balanced Hydrograph Test 18 = [E=
Name: Balanced Hydrograph Test 18
Description: inr Creek-Using a Ty lar-shaped Hydrograph (=]
Flow Data Set.  sinnemahaning Creek-Triangular -
DSSFile Name: | C:APROJECTS\SSPIProjects\SSP_Examplesi\SSP_EXAMPLES. dss =
Report File: 3PP P_Examples\BalancedHydrograph\Balanced_f ph_Test_18\Balanced_Hydrograph_Test_18.n(.J)
General| Frequency Curves | Results
Frequency Curve Duration 1(0.0417)  Frequency Curve Duration 2 (1.0)  Frequency Curve Duration 3 (2.0)  Frequency Curve Duration 4 (3.0) ~ Frequency Curve Duration 5 (5.0)  Frequency Curve Duration 6 (10.0)
@ Manual Entry ) Manual Entry ) Manual Entry ) Manual Entry ) Manual Entry ) Manual Entry
() Enter LPIIl Statistics @ Enter LPIIl Statistics @ Enter LPIIl Statistics @ Enter LPIIl Statistics @ Enter LPIIl Statistics @ Enter LPIIl Statistics
Statistics Statistics Statistics Statistics Statistics Statistics
Mean 0 Mean 4.131 Mean: 4.058 Mean: 3.993 Mean 3.894 Mean 3.756
Standard Deviation: 0 Standard Deviation: 0.192 Standard Deviation: 0.178 Standard Deviation: 0.162 Standard Deviation: 0.149 Standard Deviation: 0.14
Skew, 0 Skew: 0.304 Skew: 0.2 Skew: 0.176 Skew: 0.1 Skew: 0.164
Frequency InP... Frequency Cur. Frequency In... Frequency C... Frequency In... Frequency C... FreguencyIn... Frequency C... FrequencyIn... Frequency C. FrequencyIn .. FrequencyC...
02 102267 5 02 568498 02 410829 02 31186.8 02 21926.4 02 15377 6
0.5 82575.8 0.5 478779 05 35469.2 05 273532 05 19578.5 05 13744.8
1.0 69561.6 1.0 416906 1.0 314819 1.0 24586.2 10 17846.0 10 125448
20 57969.9 20 35064.0 20 276926 20 219175 20 161413 20 11368.0
50 445398 5.0 280077 50 229377 50 18506.4 50 13907 4 50 98315|
10.0 35589.8 10.0 241245 10.0 19479.9 10.0 15974.4 10.0 12202.2 10.0 8663.5
200 274568 200 194585 200 160627 200 134206 200 104381 200 74572
50.0 173338 50.0 132216 50.0 112738 50.0 97331 50.0 77896 500 56516
80.0 11461.6 80.0 92733 80.0 80672 80.0 7169.0 80.0 5860.4 80.0 43371
90.0 93988 90.0 77989 90.0 68239 90.0 6147.2 90.0 5066.6 90.0 3795.1
95.0 80495 95.0 68019 95.0 59659 95.0 5431.0 95.0 45001 950 3407 4
99.0 61479 99.0 53409 99.0 46800 99.0 43372 99.0 3617.1 99.0 2800.8
Compute | [ Plot Flow-Frequency | [ PlotBalanced Hydrograph | [ ViewReport | Apply

Figure B-128. Frequency Curves Tab for Balanced Hydrograph Test 18.
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@ Frequency Curves for Balanced Hydrograph Test 18 . =AESN X

-

File Edit View

1000000.0

100000.0

FLOY

10000.04

T T
0.99849 0.99 na 0.& 0.1 001 0.001

Freguency
— 0.042-Day Duration — 1-Day Duration —— 2-Day Duration
3-Day Duration 5-Dray Duration 1 0-Dray Duration

Figure B-129. Plotted Frequency Curves for Balanced Hydrograph Test 18.

Press the Compute button to perform the analysis. Once the computations
have been completed, a message window will open stating Compute
Complete. Close this window and then select the Results tab. The results
tab should look Figure B-130. The left portion of the Results tab window
displays the computed balanced hydrographs in a table using the four
frequencies that were previously defined on the General tab. The right
portion of the Results tab displays all four balanced hydrographs in a plot.
To view the balanced hydrographs in a separate window, either click Plot
Balanced Hydrograph or double click on the plot within the Results tab.
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[ Balanced Hydrograph - Balanced Hydrograph Test 18 = [
MName: Balanced Hydrograph Test 18
D 2 innemahoning Creek - Using a Triangular-shaped Hydrograph =]
Flow Data Set.  Sinnemahoning Creek-Triangular ~
DS8File Name: | C\PROJECTS\SSPIProjects TestiSSP_Examples\SSP_EXANPLES.dss =]
ReportFile. acts\TestiSSP_Examples\BalancedHydrograph\Balanced_Hydrograph_Test_18\Balanced_Hydrograph_Test_18.mpt[.]
General | Frequency Curvasl RESUWS‘ i
Date Hydrograph Hydrograph Hydrograph Hydrograph Balanced Hydrograph Test 18 Results
(0.2 Percent Event) (0.5 Percent Event) (1 Percent Event) (2 Percent Event) 120,000
31 January 2099, 24:00 100.0 100.0 100.0 100.0| »
1 February 2099, 01:00 100.0 100.0 100.0 100.0] |
1 February 2099, 02:00 100.0 100.0 100.0 1000~ | d
1 February 2099, 03:00 100.0 100.0 100.0 100.0
1 February 2099, 04:00 100.0 100.0 100.0 100.0 a0.0004
1 February 2099, 05:00 100.0 100.0 100.0 100.0 '
1 February 2099, 06:00 100.0 100.0 100.0 100.0 o
1 February 2099, 07-00 100.0 100.0 100.0 100.0 S 50,000
1 February 2099, 08:00 100.0 100.0 100.0 100.0 =
1 February 2099, 09:00 100.0 100.0 100.0 100.0 g L
1 February 2099, 10:00 100.0 100.0 100.0 100.0 o 40,000
1 February 2099, 11:00 100.0 100.0 100.0 100.0
1 February 2099, 12:00 100.0 100.0 100.0 100.0 |
1 February 2099, 13:00 100.0 100.0 100.0 100.0 20,000
1 February 2099, 14:00 100.0 100.0 100.0 100.0
1 February 2099, 15:00 100.0 100.0 100.0 100.0 0
1 February 2099, 16:00 100.0 100.0 100.0 100.0 q [ A | 3 | a I 5 I 8 | 7 | 8 [ g ‘WU“H |12
1 February 2099, 17:00 100.0 100.0 100.0 100.0 | FolRER
1 February 2099, 18:00 100.0 100.0 100.0 100.0
1 February 2099, 19:00 100.0 100.0 100.0 100.0 022 Percert Event
1 February 2099, 20:00 100.0 100.0 100.0 100.0 05 Percert Event
1 February 2099, 21:00 100.0 100.0 100.0 100.0 Pr———
1 February 2099, 22:00 100.0 100.0 100.0 100.0
1 February 2099, 23:00 100.0 100.0 100.0 100.0 BlrereEiEe -
1 February 2009, 24:00 77185 76848 72575 65075 ~| |~ SINMEMAHONING TRIANGULAR SHAPE FLOWY k=
ol il ’
Compute ] [ Plot Flow-Frequency ] [ Plot Balanced Hydragraph ] | View Report \ Appl

Figure B-130. Results Tab for Balanced Hydrograph Test 18.

In addition to the tabular and graphical results, there is a report file that
shows input data and results. To review the report file, press the View
Report button at the bottom of the analysis window. When this button is
selected a text viewer will open the report file and display it on the screen.
Shown in Figure B-131 is the report file for Balanced Hydrograph Test
18.
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@ Balanced_Hydrograph_Test 18, rpt S ——"
File Edit Search Format

=

File: C\PROJECTS\SSP\Projects\TestiSSP_Examples\BalancedHydrograph\Balanced_Hydrograph_Test_18\Balanced_Hydrograph_Test_18.rpt

—— End of Input Data ———

0.2% Balanced Hydrograph Summary

0.0417-day Duration
Start Index: 168;

07 Feb 20983, 00:00
End Index: 168;

07 Feb 2093, 00:00
Average FLOW (cfs)

Base 101

Required 102,268

Final 102,268 0.00% error
Final/Base Ratio: 1,012.5495

1-day Duration
Start Index: 156;

06 Feb 2089, 12:00
End Index: 180;

07 Feb 2093, 12:00

Lverage FLOW (cfs)
Base

101
Required 56,850
Final 56,850 0.00% error
Final/Base Ratic: 563.14888

2-day Duration
Start Index: 144;

06 Feb 2099, 00:00
End Index: 182;

08 Feb 2093, 00:00
Average FLOW (cis)

Base 101

Required 41,083

Final 41,084 0.00% error
Final/Base Ratio: 407.17723

3-day Duration

ar S— -

n

m

05/16/2016 14:04 PM

12111

11

B-136

Figure B-131. Report File for Balanced Hydrograph Test 18.
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APPENDIX C

Bulletin 17C / Expected Moments
Algorithm Examples

This Appendix provides six examples using the Expected Moments
Algorithm (EMA) to fit the Log Pearson Type Il distribution to annual
maximum flow data sets. The multiple inputs and outputs are provided to
illustrate the use of selected options and to assist in verifying the correct
execution of the program.

These examples use the same data sets that are provided with the Bulletin
17C document (England, et al., 2015) which emphases the use of the
USGS PeakFQ Software (Veilleux, Cohn, Flynn, Mason, & Hummel,
2013). As shown in the example data sets, the HEC-SSP software
produces the same results as PeakFQ for these six data sets. In fact, the
current EMA implementation within HEC-SSP makes use of the same
computational code inherent within PeakFQ.

All of these test examples are provided with the software as a single HEC-
SSP study labeled "Bulletin 17C Examples”. You can install this study on
your computer by selecting the Help—> Install Example Data menu
option. After opening this study for the first time on your computer, you
must compute each example before viewing tabular and graphical results.

A brief description of each example is provided. In most cases the
computed at-site station skew is used in lieu of a weighted skew to more
clearly illustrate the effects of EMA and the other procedures outlined
within Bulletin 17C.

The example problems shown in this section are entitled:
. Systematic Record — Moose River at Victory, VT
. Analysis with Low Outliers — Orestimba Creek near Newman, CA
. Broken Record — Back Creek near Jones Springs, WV

1

2

3

4. Historical and Data — Arkansas River at Pueblo, CO

5. Crest Stage Gage Censored Data — Bear Creek at Ottumwa, IA
6

. Historic Data and Low Outliers — Santa Cruz River at Lochiel, AZ
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When the "Bulletin 17C Examples” study file is open, the screen will
appear as shown in Figure C-1. The following sections document each of

the example data sets.

[#] HEC-SSP 2.0 - Bulletin_17C_Examples

File Edit View Maps Data Analysis Results Tools Window Help

= [ i)

BFEES e i FREEOR

& Bulletin_17C_Examples

[ Base Map

M
Analysis

Bulletin 17

ATB BA7C Example 1
ATB BA7C Example 2
ATB B17C Example 3
7B B17C Example 4
478 BITC Example §
478 BITC Example 6

General Frequency Analysis
Volume Frequency Analysis
Duration Analysis

Coincident Frequency Analysis

Curve Cambination Analysis
Balanced Hydrograph Analysis
Data
Mogse River-Victory-FLOW-ANNUAL PEAK
Moose River-Victory-CODE-PEAK FLOW
Orestimba Graek-Newman-FLOW-ANNUAL PEAK
Back Creek-Jones Springs-FLOW-ANNUAL PEAK.
Back Creek-Jones Springs-CODE-PEAK FLOW
Arkansas River-Pueblo-Unregulated FLOW-ANNUAL PEAK|
Arkansas River-Pueblo-CODE-PEAK FLOW
Bear Creek-Ottumwa-FLOW-ANNUAL PEAK
Santa Cruz River-Lochie-FLOW-ANNUAL PEAK
ap

* Base Map

Santa Cruz RiverLochi s FLOWCANNUAL PRY.

«

()= (X

® No Additional Content

«

[ o

[ Study Bulletin_17C_Examples saved.

study | Maps | Files Messages

Coordinates: -66 east, 42 north

Figure C-1. Bulletin 17C Examples Study.
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Example 1: Systematic Record — Moose River at

Victory, VT

Example 1 illustrates the computation of a peak flow frequency curve
using EMA and Bulletin 17C procedures with an annual maximum series
comprised of systematic flood peaks. For this example, USGS gage
01134500 Moose River at Victory, Vermont is used. The Moose River is
located in the northeastern part of the state and flows mostly from north to
south through very hilly terrain. The Moose River basin is approximately
75 square miles of nearly all forest (England, et al., 2015). Historically, it
was an important logging area and some logging still continues today.
Attempts at farming in the basin have generally failed due to the presence
of shallow rocky soil. There are a small number of villages in the basin,
but overall it is sparsely populated with only a few miles of paved
roadway. There is also a large bog approximately a third of a mile
upstream from the gage. The bog is part of the 5,000 acre Victory Basin
Wildlife management area. While there is no streamflow regulation in the
basin, the bog attenuates peaks in the basin. The Moose River at Victory,
VT stream gage has an annual peak record consisting of 68 peaks
beginning in 1947 and ending in 2014, as shown in Figure C-2. The
annual peak flow record is tabulated within Table C-.

[E Moose River-Victory-FLOW-ANNUAL PEAK = | E )

File Edit View
5000 =

3
@ 4,500 @

4,000

3,600 =]

30007 © 1) o o

Flow (cfs)
[
w
=]
=

2,000+ e
156007 o o (=)
1,000+

500+

0 T T T T T T T
1940 1960 1970 1880 1940 2000 010

| S Wictory USGE FLOW-ANMNUAL PEAK

Figure C-2. Moose River at Victory, VT Annual Peak Flow Record.
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Table C-1. Moose River at Victory, VT Annual Peak Flow Record.

Date Flow (cfs) Date Flow (cfs)
13 Apr 1947 2080 21 Feb 1981 1570
28 Mar 1948 1670 18 Apr 1982 2890
28 Mar 1949 1480 04 May 1983 1840
21 Apr 1950 2940 31 May 1984 2950
05 Dec 1950 1560 17 Apr 1985 1380
02 Jun 1952 2380 31 Mar 1986 2350
27 Mar 1953 2720 31 Mar 1987 4180
23 Apr 1954 2860 06 Apr 1988 1700
15 Apr 1955 2620 06 Apr 1989 2200
30 Apr 1956 1710 18 Mar 1990 3430
22 Apr 1957 1370 24 Dec 1990 2270
21 Dec 1957 2180 23 Apr 1992 2180
04 Apr 1959 1160 17 Apr 1993 1900
29 Nov 1959 2780 17 Apr 1994 2760
24 Apr 1961 1580 06 Aug 1995 4536
08 Apr 1962 2110 24 Apr 1996 2160
22 Apr 1963 2160 02 Dec 1996 1860
15 Apr 1964 2750 31 Mar 1998 2680
14 Jun 1965 1190 18 Sep 1999 1540
26 Mar 1966 1560 11 May 2000 2110
03 Apr 1967 1800 25 Apr 2001 2950
24 Mar 1968 1600 14 Apr 2002 2410
29 Apr 1969 2400 30 Mar 2003 2230
25 Apr 1970 3010 28 Oct 2003 1980
04 May 1971 1490 04 Apr 2005 1610
05 May 1972 2920 17 Oct 2005 2640
01 Jul 1973 4940 24 Apr 2007 1930
22 Dec 1973 2550 20 Apr 2008 1940
20 Apr 1975 1250 04 Apr 2009 1810
02 Apr 1976 2670 24 Mar 2010 1900
31 Mar 1977 2020 01 Oct 2010 3140
10 May 1978 1460 20 Mar 2012 1370
26 Mar 1979 1620 20 Apr 2013 2180
10 Apr 1980 1460 16 Apr 2014 4250

A Bulletin 17 Analysis using EMA and Bulletin 17C procedures has been
developed for this example. To open the analysis, either double-click on
the analysis labeled “B17C Example 1” from the Study Explorer or from
the Analysis menu select open, then select “B17C Example 1” from the
list of available analyses. When “B17C Example 1” is selected, the
Bulletin 17 analysis editor will appear as shown in Figure C-3.

Shown in Figure C-3 are the general settings that were used to perform
this Bulletin 17 Analysis. As shown, the Skew option was set to use the
Weighted Skew. To use the weighted skew option, the user must enter a
value for the Regional Skew and the Regional Skew Mean Square Error
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(MSE). In this example, a regional skew of 0.44 was used along with a
Regional Skew MSE of 0.078.

[£] Bulletin 17 Editor - = =
Name: B17C Example 1
Description Example 1: Systematic Record - Moose River at Victory, VT ]
Flow Data Set: poose River-Victory-FLOW-ANNUAL PEAK =)
DSSFile Name: | c\PROJECTS\SSP_Testing\Projects\Bulletin_17C_ExamplesiBulletin_17C_Examples.dss =
Report File C:\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_1\B17C_Example_1.rpt )

General | Options | EMA Data | Tabular Resuits

Generalized Skew Plotting Position Confidence Limits
*) Use Station Skew CELIRE S0, @ Defaults (0.05, 0.95)
dian (AandB=0.3
@ Use Weighted Skew ~EEED RISy ") User Entered Values

Hazen (Aand B = 0.5) U Limit
. pper Limit:
_ Use Regional Skew @ HirschiStedinger

Regional Skew: 0.44 T ETETAD) Lower Limit:
Reg. Skew MSE 78
o ’ 0.078 Plotting position computed using formula Time Window Modification
(m-A)(n+1-A-B) = e
Expected Probablity Curve Where:

m=Rank, 1=l argest DSSRange is  13APR1947 - 16APR2014

M=Number of Years Start Date
AB=Constants

Compute Expected Prob. Curve

@ Do Mot Compute Expected Prob. Curve
End Date

Wethod for Computing Statistics and Confidence Limits
B: Low Outlier Test

@ 1TCEMA
= . @ Multiple Grubbs-Beck

7 178 Methods
Single Grubbs-Beck

Compute ‘ [ Plot Curve ] [ View Report ] [ Print ] Appl

Figure C-3. Bulletin 17 Analysis General Tab for “B17C Example 1.

No changes to the Options tab are necessary.

The EMA Data tab for this example is shown in Figure C-4. Since this
example uses an annual maximum series consisting entirely of systematic
data with a complete record, a single zero — inf perception threshold is
adequate. No modifications to the default flow ranges and data types are
necessary.
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[] Bulletin 17 Editor - of)
Name B17C Example 1
Description: Example 1: Systematic Record - Moose River at Victory, VT &
Flow Data Set | oose River-Victory-FLOW-ANNUAL PEAK -
DSEFile Name: | C.\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin_17C_Examples.dss =
ReportFile C:\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_1\B17C_Example_1.rpt D
| General I Dptionsl EMA Data ‘Tabu\ar Resu\ts‘
First Row in Table Defines the Absolute Time Window for EMA Analysis (start and end dates) 5,000 =}
| Perception Thresholds I
Start Year End Year Low Threshold High Threshald Comments A o
[+]
4,000
3,500 &
o
Apply Thresholds 30009 o DO o o}
Oo o
Flow Ranges oO o o o
Year Peak Low Value High Value Data Type 2 500 o
1947 2080.0 20800 2080.0) Svstematic - | @ o o @
1948 1670.0 1670.0 1670.0) Svstematic || o & o% o ° o
1949 1480.0 1480.0 1480.0) Svstematic = i o e
1350 2040.0 22400 2940.0|Systemalic ml 2 oo °®m
1951 1560.0 1560.0 1560.0| Systematic > o @ © o
1952 2380.0 2380.0 2380.0| Systematic - )o o P % 9 o
1953 2720.0 2720.0 2720.0|Systematic - 1,500 © oo 0
1954 2860.0 2860.0 2860.0| Systematic - c © c
1955 2620.0 26200 2620.0) Svstematic - o © ©
1956 1710.0 17100 1710.0) Svstematic - 1.000
1957 13700 1370.0 1370.0|Systematic - ' e 1680 1870 1480 1940 2000 30
1950 1960 1970 1980 19890 2000 2010
1958 2180.0 21800 2180.0| Systematic >
1959 1160.0 1160.0 1180.0) Systematic > O Data
1960 2780.0 2780.0 2780.0|Systematic -
1961 1580.0 1580.0 1580.0 Systematic - - Refresh
P— |
[ compute | [ Piotcuve | [ viewReport | [ Prnt | Apply

Figure C-4. Bulletin 17 Analysis EMA Data Tab for “B17C Example 1”.

Once all of the General and EMA Data tab settings are set or selected,
the user can press the Compute button to perform the analysis. Once the
computations have been completed, a message window will open stations
Compute Complete. Close this window and then select the Tabular
Results tab. The analysis window should look like Figure C-5.

As shown in Figure C-5, the Frequency Curve table contains the following
results:

e Percent Chance Exceedance
e Computed Curve (Log Pearson Type IlI results)
e Confidence Limits (5% and 95% chance exceedance)

On the bottom, left side of the results tab is a table of Statistics for the
observed station data (mean, standard deviation, and station skew) and
regional adjustment (regional skew, weighted skew, and adopted skew).
Also on the bottom, right side of the results tab is a Number of Events
table showing the number of historic events used in the analysis, number
of high outliers found, number of low outliers and zero flows found,
number of missing flows, number of systematic events, and the historic
period in years. In addition to the tabular results, a graphical plot of the
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computed frequency curves can be obtained by pressing the Plot Curve
button at the bottom of the analysis window. The Log Pearson Type IlI

distribution fit using EMA and Bulletin 17C procedures to the input

annual maximum flow data set, the 5% and 95% confidence limits, and the
annual maximum flow data set Hirsch/Stedinger plotting positions are

shown in Figure C-6.

[ Bulletin 17 Editor - ol =
Name: B17C Example 1
Description Example 1: Systematic Record - Moose River at Victory, VT )
Flow Data Set | \oose River-Victory-FLOW-ANNUAL PEAK -
D33 File Name: |C:\PROJECTSISSP_Testing\Projects\Bulletin_17C_ExamplesiBulletin_17C_Examples dss |}
Report File C\PROJECTS\38P_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_1\B17C_Example_1.rpt (9]
General | Options | EMA Data | Tabular Results
Frequency Curve for: Moose River-Victory-FLOW-ANNUAL PEAK
3 . - E Confidence Limits
ercent Chance omputed Curve .
Fl cf:
Exceedance Flow in cfs SIS
0.05 0.95
0z 63737 8937.7 5222 5
0.5 5559.9 7378.2 4684.2
1.0 4984.5 6352.2 4285.5
20 44395 5440.9 3891.9
5.0 3757.8 43875 33738
100 32624 3686.2 2976.9
200 277238 3047.3 25665.3
50.0 2083.5 2233.4] 1951.1
80.0 1616.6 1725.2 1507.5
90.0 14333 1535.1 13209
95.0 13057 1408.5 11844
99.0 11121 12311 966.3
Systemn Statistics MNumber of Events
Log Transform: Flow Event Number
Statistic Value Historic Events [i]
High Outliers
Mean 3.329
Standard Dev 0.140 hnw Ouﬂ':rs and Zero Flows g
Station Skew 0.397| R0 AR =
Redgional Skew 0.440 Hysler.napwc v:n = 58
Weighted Skew 0.421| (HistaricFerio
Adopted Skew 0.421
Compute ‘ I Plot Curve ] I View Report ] I Print I Appl

Figure C-5. Bulletin 17 Analysis Tabular Results Tab for “B17C Example 1.
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[Z7] Bulletin 17 Plot for B17C Example 1 o | o e S

File Edit View Window

Bulletin 17 Plot for B17C Example 1
Return Period

o7}

10000.0

1000.0+

Flow {cfs)

100.0 T T T T T T T 1
0.99 049 0.A 0z 01 0.02 0.005 0.001

Probahility

Computed Curve
— == 5 Percent Confidence Limit
=== 95 Percent Confidence Limit
o Observed Events (Hirsch-Stedinger plotting posttions )

Figure C-6. Plotted Frequency Curves for “B17C Example 1”.

Because the annual peak flow record contains only systematic peaks with
no historic information, no censored peaks, and no low outliers identified
using the Multiple Grubbs-Beck Test, the fitted peak flow frequency curve
using EMA and Bulletin 17C procedures is the same as that obtained using
Bulletin 17B procedures. However, due to the appropriate use of diverse
information within the Bulletin 17C procedures, the 5% and 95%
confidence limits are different when compared against results obtained
using Bulletin 17B procedures.

In addition to the tabular and graphical results, there is a report file that
shows the order in which the calculations were performed. To review the
report file, press the View Report button at the bottom of the analysis
window. When this button is selected, a text viewer will open the file and
display it on the screen. Shown in Figure C-7 is the report file.

The report file contains a listing of the input data, preliminary results,
outlier and historical data tests, additional calculations needed, and the
final frequency curve results. Different types and amounts of information
will show up in the report file depending on the data and the options that
have been selected for the analysis. The user should review the report file
to understand how the Bulletin 17C procedures were applied.
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@ B17C_Example_l.rpt @

File Edit Search Format

File: CI\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_1\B17C_Example_1.rpt

Bulletin 17B Freguency Analysis
06 Jan 2014 02:10 EM

——— Input Data ———

Analysis Name: B17C Example 1
Description: Example 1: Systematic Record - Moose River at Victory, VI

Data Set Name: Moose Biver-Victory-FLOW-ANNUAL PERK
D55 File Name: C:\PROJECTS\SSP_Testing\Projects\Bulletin 17C_Examples\Bulletin 17C_Examples.dss
D55 Pathname: /Moose River/Victory/FLOW-ANNUAL PERK/01janl300/IR-CENTURY/USGS/

Report File Name: C:\PROJECIS\SSF Testing\Projects\Bulletin 17C Examples‘\Bulletinl7Results\B17C Example 1\B17C Ex
XML File Name: C:\PROJECIS\SSP Testing\Projects\Bulletin 17C Examples\Bulletinl7Results\B17C Example 1\B17C_ Examp

Start Date:
End Date:

Skew Option: Use Weighted Skew

Regional Skew: 0.44

Regional Skew MSE: 0.078

Plotting Position Type: Hirsch-Stedinger

Upper Confidence Lewvel: 0.05
Lower Confidence Level: 0.95

Display ordinate values using 1 digits in fraction part of value

——- End of Input Data ——

<< EMA Representation of Data >>
Moose River-Victory-FLOW-RNNUAL PEAK

Low High

m

071/06/2016 1410 PM 111111 111

Figure C-7. Report File for “B17C Example 1”.
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Example 2: Analysis with Low Outliers — Orestimba
Creek near Newman, CA

Example 2 illustrates the computation of a peak flow frequency curve
using EMA and Bulletin 17C procedures with an annual maximum series
comprised of systematic flood peaks when low outliers (a.k.a. Potentially
Influential Low Flows, PILFs) are present.

For this example, USGS gage 11274500 Orestimba Creek near Newman,
CAis used. Orestimba Creek is a tributary to the San Joaquin River,
whose 134 sg. mi. drainage area lies on the eastern slope of the Diablo
Range section of the Coast Range Mountains of California. The drainage
basin has an average basin elevation of approximately 1,550 feet with
peak flows usually occurring in late winter. Orestimba Creek is one of the
few tributaries in the area to maintain a definite stream channel from the
foothills to the San Joaquin River (England, et al., 2015)

The Orestimba Creek near Newman, CA stream gage has an annual peak
record consisting of 82 peaks beginning in 1932 and ending in water year
2013. Of the 82 annual peaks, there are 12 years for which the annual
peak is 0 cfs. The annual maximum series is plotted in Figure C-8 and
tabulated in Table C-.

[ Orestimba Creek-Newman-FLOW-ANNUAL PEAK =RRSEl X

File Edit View
14,000

12,000 o

10,000

8,000

Flow (5fs)

6,000 o

oo
4,000

2,000 - 5 -

°
=] (=]

F . % o % oo Y-S ° @

T T T T T T
1940 1950 1960 1870 1980 1990 2000 2010

o o oo

| @ Newwman USGS FLOW-ANNUAL PEAK

Figure C-8. Orestimba Creek near Newman, CA Annual Peak Flow Record.
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Table C-2. Orestimba Creek near Newman, CA Annual Peak Flow Record.

Date Flow (cfs) Date Flow (cfs) Date Flow (cfs)
08 Feb 1932 4260 10 Feb 1960 448 30 Nov 1987 0
29 Jan 1933 345 30 Nov 1960 0 30 Nov 1988 0
01 Jan 1934 516 15 Feb 1962 1740 28 May 1990 4
08 Apr 1935 1320 01 Feb 1963 8300 24 Mar 1991 1260
13 Feb 1936 1200 22 Jan 1964 156 15 Feb 1992 888
13 Feb 1937 2180 06 Jan 1965 560 13 Jan 1993 4190
11 Feb 1938 3230 30 Dec 1965 128 20 Feb 1994 12
09 Mar 1939 115 24 Jan 1967 4200 10 Mar 1995 12000
27 Feb 1940 3440 30 Nov 1967 0 19 Feb 1996 3130
04 Apr 1941 3070 25 Jan 1969 5080 23 Jan 1997 3320
24 Jan 1942 1880 01 Mar 1970 1010 03 Feb 1998 9470
21 Jan 1943 6450 21 Dec 1970 584 09 Feb 1999 833
29 Feb 1944 1290 30 Nov 1971 0 14 Feb 2000 2550
02 Feb 1945 5970 11 Feb 1973 1510 05 Mar 2001 958
25 Dec 1945 782 03 Mar 1974 922 03 Jan 2002 425
30 Nov 1946 0 08 Mar 1975 1010 16 Dec 2002 2790
30 Nov 1947 0 30 Nov 1975 0 25 Feb 2004 2990
12 Mar 1949 335 30 Nov 1976 0 16 Feb 2005 1820
05 Feb 1950 175 17 Jan 1978 4360 02 Jan 2006 1630
03 Dec 1950 2920 21 Feb 1979 1270 30 Nov 2006 0
12 Jan 1952 3660 16 Feb 1980 5210 25 Jan 2008 2110
07 Dec 1952 147 29 Jan 1981 1130 17 Feb 2009 310
30 Nov 1953 0 05 Jan 1982 5550 20 Jan 2010 4400
19 Jan 1955 16 24 Jan 1983 6360 24 Mar 2011 4440
23 Dec 1955 5620 25 Dec 1983 991 30 Nov 2011 0
24 Feb 1957 1440 09 Feb 1985 50 24 Dec 2012 6250
02 Apr 1958 10200 19 Feb 1986 6990
16 Feb 1959 5380 06 Mar 1987 112

A Bulletin 17 Analysis using EMA and Bulletin 17C procedures has been
developed for this example. To open the analysis, either double-click on
the analysis labeled “B17C Example 2” from the Study Explorer or from
the Analysis menu select open, then select “B17C Example 2 from the
list of available analyses. When “B17C Example 2” is selected, the
Bulletin 17 analysis editor will appear as shown in Figure C-9.

Shown in Figure C-9 are the general settings that were used to perform
this Bulletin 17 Analysis. As shown, the Skew option was set to use the
Station Skew.
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[] Bulletin 17 Editor - (o=
MName: B17C Example 2
Description Example 2: Analysis with Low Outliers - Orestimba Creek near Newman, CA ]
Flow Data Set. | grestimba Creek-Newman-FLOW-ANNUAL PEAK -]
D85 File Name: | C:\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin_17C_Examples.dss =]
Report File CAPROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_2\B17C_Example_2.rpt [
General | Options | EMA Data | Tabular Results
Generalized Skew Plotting Position Confidence Limits
Weibull (A and B = 0) @ Defaults (0.05, 0.95)
Median (A and B = 0.3) -
© Use Weighted Skew : (©) User Entered Values
Hazen (A and B=0.5) U Limit
. pper Limi
~) Use Regional Skew @ Hirsch/Stedinger
Lower Limit
HEROIASIE ) Other (Specify A, B)
Reg. Skew MSE:
&g. skew i Plotting position computed using formula Time Window Modification
(m-A}{n+1-A-B) - R e
Expected Probablity Curve Where: IEET is 03FEB1932- 30NOV201
. i e 55 Range is 32 - 30NOV2013
Compute Expected Prob. Curve MERELy LLa[;est
N=Number of Years Start Date
® Do Not Compute Expected Prab. Curve AB=Canslants
A End Date
Wethod for Computing Statistics and Cenfidence Limits .
B Low Outlier Test
@ 17C EMA =
@ Multiple Grubbs-Beck
(@) 17B Methods
Single Grubbs-Beck
[ Compute I [ Plot Curve I [ View Report ] [ Print I Apply

Figure C-9. Bulletin 17 Analysis General Tab for “B17C Example 2”.

No changes to the Options tab are necessary.

The EMA Data tab for this example is shown in Figure C-10. Since this
example uses an annual maximum series consisting entirely of systematic
data with a complete record, a single zero — inf perception threshold is

adequate. No modifications to the default flow ranges and data types are

necessary.
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[] Bulletin 17 Editor - = [
Name B17C Example 2
Description: Example 2: Analysis with Low Qutliers - Qrestimba Creek near Newman, CA =
FlowData Set | Orestimba Creek-Newman-FLOW-ANNUAL PEAK -
DSEFile Name: | C\PROJECTSISSP_Testing\Projects\Bulletin_17C_Examples\Bulletin_17C_Examples.dss ]
ReportFile C:\PROJECTSVSSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_2\B17C_Example_2.rpt [:]
Genera\l Opt\onsl EMA Data |Tabular Resullsl
First Row in Table Defines the Absolute Time Window for EMA Analysis (start and end dates) 14,000
[ Perception Thresholds |
Start Year End Year Low Threshald High Threshold Comments
12,000 =
10,000 e
o
[+)
8,000+
Apply Thresholds o
o o
Flow Ranges 5,000 o
Year Peak Low Value High Value Data Type oo OO

. ~ - = yeTeTTTET - o

1999 833.0 833.0 833.0| Systematic - q o ©

2000 2550.0 2550.0 2550.0| Svstematic = 40004 o o

2001 958.0 958.0 958.0| Systematic - ' o o

2002 425.0 425.0 425.0|Systemalic - % 5 & P

2003 2790.0 2790.0 2790.0 | Systematic L [+)

2004 2990.0 2990.0 2990.0| Systematic - 20004 2o o

2005 1820.0 1820.0 1820.0 | Systematic - o o © o

2006 1630.0 1630.0 1630.0| Svstematic = @ o oe®o % o

2007 0.0 0.0 0.0| Svstematic - & oQ 0 [SIP

2008 2110.0 2110.0 2110.0[Systematic - ol G pEam @pe o]

2009 310.0 2100 210.0|Systematic = 1940 1960 1980 2000

2010 4400.0 44000 4400.0 | Systematic =1

2011 44400 44400 4440.0 | Systematic - \E‘ | O Dals

2012 0.0 0.0 0.0 Systematic =1

2013 6250.0 6250.0 6250.0] Svstematic = - Refresh

[ Compute I [ Plot Curve I [ View Report ] [ Print ] Apply

Figure C-10. Bulletin 17 Analysis EMA Data Tab for “B17C Example 2”.

Once all of the General and EMA Data tab settings are set or selected,
the user can press the Compute button to perform the analysis. Once the
computations have been completed, a message window will open stations
Compute Complete. Close this window and then select the Tabular
Results tab. The analysis window should look like Figure C-11.

In addition to the tabular results, a graphical plot of the computed

frequency curves can be obtained by pressing the Plot Curve button at the
bottom of the analysis window. The Log Pearson Type Il distribution fit
using EMA to the input annual maximum flow data set, the 5% and 95%
confidence limits, and the annual maximum flow data set Hirsch/Stedinger
and Median (for low outliers) plotting positions are shown in Figure C-12.
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[4] Bulletin 17 Editor - B17C Example 2 E (5w
Name: B17C Example 2|
Description Example 2: Analysis with Low Outliers - Orestimba Creek near Newman, CA =
Flow Data Set | Orestimba Creek-Newman-FLOW-ANMUAL PEAK -
D85 File Name' | C\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin_17C_Examples dss ()]
Report File C\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_2\B17C_Example_2.rpt (]
General | Options | EMA Data| Tabular Results
Frequency Curve for: Orestimba Creek-Newman-FLOW-ANNUAL PEAK
= T ® e Confidence Limits
ercent Chance omputed Curve
Fl cfs
Exceedance Flow in cis CRICS
0.05 095
0.2 18149.8 34202.4 12714.4
05 15800.3 279465 11469.3
1.0 138238 233635 10289.6
20 11689.3 18779.4 88845
5.0 8677.3 127866 67073
10.0 6328.3 8688.9 49135
200 4026.0 5281.2 31184
50.0 13391 1761.5 7691
20.0 3165 495.8 775
90.0 1285 2457 172
95.0 56.4 1338 40
99.0 9.5 39.6 0.2
System Statistics MNumber of Events
Log Transform: Flow Event Mumber
Statistic Value E‘Slhu[ji)c E_Vems 0
igh Outliers
Mean 3.023
Standard Dev 0.582 :;‘ow Dut\l\:s‘!rs and Zero Flows Eg
Station Skew -0.929| (Mesing Flows
- Systematic Events 82
Regional Skew Historic Period a2
Weighted Skew Istoric Perio
Adopted Skew -0.929

[ compute | [ Piotcune | [ viewRsport | [ Print | Apply

Figure C-11. Bulletin 17 Analysis Tabular Results Tab for “B17C Example 2”.

[ hl
[ Bulletin 17 Piot for B17C Example 2 [E=REE

File Edit View Window

Bulletin 17 Plot for B17C Example 2
Return Period

1.1 2 5 10 50 200 1000
1000000 1 1 1 1 1 L1

10000.0+

1000.0+

100.0

Flow {cfs)

10.04

1.09

01 T T T T T LA —
0.99 04 0.4 0z 01 0.02 0.0050.001

Frobahility

—— Computed Curve

H — == 5 Percent Confidence Limit

=== 95 Percent Confidence Limit
o Observed Events (Hirsch-Stedinger plotting posttions)
O Low Qutlier

Figure C-12. Plotted Frequency Curves for “B17C Example 2”.
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As shown in Figure C-12, the Multiple Grubbs-Beck Test identified a low
outlier threshold of 782 cfs. Thirty annual peak flows were identified as
being less than this threshold, as shown in Figure C-13. These annual
peak flows were then recoded to have a flow interval of zero — 782. The
perception threshold for the entire historical period was also adjusted to
correspond with the Multiple Grubbs-Beck Test low outlier threshold.
Consequently, the perception threshold was changed from zero — inf to
782 — inf, as shown in Figure C-14.

@ B17C_Example_2.rpt &J
File Edit Search Format
File: | C:A\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_2\B17C_Example_2.rpt
| 08 Mar 1875 1,010.0 | 44 1981 1,130.0 52.65 | s
| 30 Nov 13975 0.0 | 45 1975 1,010.0 53.84 |
| 30 Nowv 1978 0.0 | 48 1970 1,010.0 55.04 |
| 17 Jan 1378 4,360.0 | 47 1984 931.0 56.24 |
| 21 Feb 1979 1,270.0 | 43 2001 958.0 57.43 |
| 16 Feb 1980 5,210.0 | 49 1974 922.0 58.63 |
| 25 Jan 1981 1,130.0 | 50 1932 G88.0 59.83 |
| 05 Jan 1982 5,550.0 | 51 1339 833.0 6l.02 |
| 24 Jan 1983 6,360.0 | 52 1948 782.0 62.22 |
| 25 Dec 1983 991.0 | 53 1971 584.0* 63.96 |
| 05 Feb 18985 50.0 | 54 1965 560.0%* 65.17 |
| 19 Feb 1986 6,990.0 | 55 1934 516.0* 66.38 |
| 06 Mar 1987 112.0 | 56 1960 448.0% 67.60 |
| 30 Nowv 1987 0.0 | 57 2002 425.0% 8.81 |
| 30 Nov 18988 0.0 | 58 1933 345.0% 70.02 |
| 28 May 1930 4.0 | 59 1943 335.0% T1.24 |
| 24 Mar 1991 1,260.0 | &0 2009 310.0% 72.45 |
| 15 Feb 1832 888.0 | 61 1950 175.0% 73.67 |
| 13 Jan 1993 4,190.0 | 62 1964 156.0% 7T4.88 |
| 20 Feb 1994 2.0 | 63 1953 147.0* T6.09 |
| 10 Mar 1935 12,000.0 | 64 1966 128.0% 77.31 |
| 19 Feb 1996 3,130.0 | 65 1539 115.0* 78.52 |
| 23 Jan 1937 3,320.0 | 66 1987 112.0%* 78.73 |
| 03 Feb 1933 9,470.0 | 67 1985 50.0% 80.95 |
| 0% Feb 19838 833.0 | 1] 1855 16.0%* B82.16 |
| 14 Feb 2000 2,550.0 | 69 1994 12.0* B83.37 |
| 05 Mar 2001 958.0 | 70 1930 4.0% B4.59 |
| 03 Jan 2002 425.0 | 71 2012 0.0%* B85.80 |
| 16 Dec 2002 2,730.0 | 72 2007 0.0%* §g7.01 |
| 25 Feb 2004 2,93%0.0 | 73 19839 0.0% B88.23 |
| 16 Feb 2005 1,820.0 | 74 1988 0.0% B89.44 |
| 02 Jan 2006 1,630.0 | 75 1977 0.0% 90.66 |
| 30 Nov 2006 0.0 | 76 1976 0.0% 91.87 |
| 25 Jan 2008 2,110.0 | 77 1972 0.0%* 983.08 |
| 17 Feb 2009 3l0.0 | 78 1968 0.0% 94.30 |
| 20 Jan 2010 4,400.0 | 79 1961 0.0%* 95.51 |
| 24 Mar 2011 4,440.0 | &0 1954 0.0% 896.72 | £
| 30 Nov 2011 0.0 | a1 1948 0.0% 97.94 |
| 24 Dec 2012 6,250.0 | g2 1947 0.0%* 95,15 |
[ [—————————————————————————— |
* Qutlier
* Low cutlier plotting positions are computed using Median parameters.
<< Frequency Curve >> i
o T [3
ll 01/06/2016 16:33 PM 264:55._264:55 264:55 IJ

Figure C-13. Report File for “B17C Example 2” showing censored low outliers
and zero flows.
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@ B17C_Example_2.rpt [&J
File Edit Search Format
File: CI\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_2\B17C_Example_2.rpt
-
<< EMA Representation of Data >>
Orestimba Creek-Newman-FLOW-ANNUAL FERZK
| | WValue | Threshold | |
| Low High | Low High | Type |
|- — S |
| 1932 4,260.0 | 4,260.0 4,260.0 | 782.0 1.0E99 | Syst |
| 1933 345.0 | 1.0E-6& 782.0 | 782.0 1.0E3% | Syst |
| 1934 516.0 | 1.0E-6 782.0 | 782.0 1.0E99 | Syst |
| 1935 1,320.0 | 1,320.0 1,320.0 | 782.0 1.0E99 | Syst | )
| 1936 1,200.0 | 1,200.0 1,200.0 | 782.0 1.0E3% | Syst |
| 1837 2,180.0 | 2,180.0 2,180.0 | 782.0 1.0E%% | Syst | |
| 1938 3,230.0 | 3,230.0 3,230.0 | 782.0 1.0E99 | Syst | E
| 1939 115.0 | 1.0E-6 782.0 | 782.0 1.0E3% | Syst |
| 1940 3,440.0 | 3,440.0 3,440.0 | 782.0 1.0E8% | Syst |
| 1941 3,070.0 | 3,070.0 3,070.0 | 782.0 1.0E99 | Syst | b
| 1942 1,880.0 | 1,880.0 1,880.0 | 782.0 1.0E3% | Syst |
| 1943 6,450.0 | 6,450.0 6,450.0 | 782.0 1.0E9%9 | Syst |
| 1944 1,2%0.0 | 1,280.0 1,280.0 | 782.0 1.0E9% | Syst |
| 1945 5,970.0 | 5,970.0 9,970.0 | 782.0 1.0E9% | Syst |
| 1944 782.0 | 782.0 782.0 | 782.0 1.0E9%9 | Syst |
| 1947 o.o0 | 1.0E-6& 782.0 | 782.0 1.0E9% | Syst |
| 1948 0.0 | 1.0E-6& 782.0 | 782.0 1.0E9% | Syst |
| 19439 335.0 | 1.0E-& 782.0 | 782.0 1.0E99 | Syst |
| 1850 175.0 | 1.0E-6& 782.0 | 782.0 1.0E3% | Syst |
| 1851 2,920.0 | 2,920.0 2,920.0 | 782.0 1.0E99 | Syst |
| 1952 3,660.0 | 3,660.0 3,660.0 | 782.0 1.0E99 | Syst |
| 1953 147.0 | 1.0E-6& 782.0 | 782.0 1.0E3% | Syst |
| 1954 0.0 | 1.0E-& 782.0 | 782.0 1.0E%% | Syst |
| 1955 16.0 | 1.0E-& 782.0 | 782.0 1.0E99 | Syst |
| 1956 5,620.0 | 5,620.0 5,620.0 | 782.0 1.0E3% | Syst |
| 1857 1,440.0 | 1,440.0 1,440.0 | 782.0 1.0E8% | Syst |
| 1958 10,200.0 | 10,200.0 10,200.0 | 782.0 1.0E99 | Syst |
| 1959 5,380.0 | 5,380.0 5,380.0 | 782.0 1.0E3% | Syst |
| 1980 448.0 | 1.0E-& 782.0 | 782.0 1.0E9%9 | Syst |
| 1961 o.o0 | 1.0E-6& 782.0 | 782.0 1.0E9% | Syst |
| 1962 1,740.0 | 1,740.0 1,740.0 | 782.0 1.0E9% | Syst |
| 1963 &,300.0 | 8,300.0 8,300.0 | 782.0 1.0E9%9 | Syst |
| 1964 156.0 | 1.0E-6& 782.0 | 782.0 1.0E9% | Syst |
| 1965 560.0 | 1.0E-6& 782.0 | 782.0 1.0E9% | Syst |
| 1966 128.0 | 1.0E-& 782.0 | 782.0 1.0E99 | Syst |
| 1967 4,200.0 | 4,200.0 4,200.0 | 782.0 1.0E3% | Syst |
| 1368 0.0 | 1.0E-6 782.0 | 782.0 1.0E99 | Syst |
| 1969 5,080.0 | 5,080.0 5,080.0 | 782.0 1.0E99 | Syst | -
| NN n +
ll 01/06/2016 16:33 PM 264:55.264:55 264:55 m

Figure C-14. Report File for “B17C Example 2” showing recoded perception
threshold.
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Example 3: Broken Record - Back Creek near Jones
Springs, WV

Example 3 illustrates the computation of a peak flow frequency curve
using EMA and Bulletin 17C procedures with an annual maximum series
comprised of a broken record of systematic flood peaks.

For this example, USGS gage 01614000 Back Creek near Jones Springs,
West Virginia is used. Back Creek is a tributary to the Potomac River; the
235 square mile watershed lies within the Valley and Ridge province in
West Virginia (England, et al., 2015). Gage 01614000 has an annual peak
record consisting of 56 peaks beginning in 1929 and ending in 2012.
There are three “broken record” periods where the gage was discontinued:
1932-1937, 1976-1991, and 1999-2003. Thus, there are 28 years of
missing data at this gage during the period 1929-2012. There is a historic
flood that occurred outside the period of gaging record on March 17, 1936.
This flood is noted in the USGS Annual Water Data Report for this gage,
available in the peak-flow file, and there is historical information available
for this large flood (Grover, 1937).

The Back Creek near Jones Springs, WV stream gage has an annual peak
record consisting of 56 annual peaks. Of the 56 annual peaks, the October
1942 flood slightly exceeds the March 1936 historic flood peak. Based on
the historical flood information in Grover (1937) for the 1936 flood, and
the large regional floods and historical floods described by Wiley and
Atkins (2010) in West Virginia for the period 1888-1996, information
from the March 1936 flood can be used as a perception threshold to
represent the 28 years of missing information. The annual maximum
series is plotted in Figure C-15 and tabulated in Table C-.
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@ Back Creek-Jones Springs-FLOW-ANNUAL PEAK

—

(5] | S|

File Edit View

20,000
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Flow (cfs)
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T T T T
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| < Jones Springs USGS FLOW-ANMNUAL PEAK

Figure C-15. Back Creek near Jones Springs, WV Annual Peak Flow Record.

Table C-3. Back Creek near Jones Springs, WV Annual Peak Flow Record.

Date Flow (cfs) Date Flow (cfs)

17 Apr 1929 8750 20 Mar 1963 5190
23 Oct 1929 15500 10 Jan 1964 3960
08 May 1931 4060 06 Mar 1965 5600
17 Mar 1936 22000 21 Sep 1966 4670
04 Feb 1939 6300 08 Mar 1967 7080
20 Apr 1940 3130 17 Mar 1968 4640
06 Apr 1941 4160 02 Feb 1969 536

22 May 1942 6700 10 Jul 1970 6680
15 Oct 1942 22400 13 Nov 1970 8360
24 Mar 1944 3880 22 Jun 1972 18700
18 Sep 1945 8050 09 Dec 1972 5210
03 Jun 1946 4020 27 Dec 1973 4680
15 Mar 1947 1600 20 Mar 1975 7940
14 Apr 1948 4460 05 Mar 1993 11800
31 Dec 1948 4230 08 May 1994 8730
02 Feb 1950 3010 16 Jan 1995 2300
05 Dec 1950 9150 19 Jan 1996 13900
28 Apr 1952 5100 09 Nov 1996 4190
22 Nov 1952 9820 21 Mar 1998 6370
02 Mar 1954 6200 29 Sep 2004 9460
19 Aug 1955 10700 29 Mar 2005 6560
15 Mar 1956 3880 30 Nov 2005 2000
10 Feb 1957 3420 16 Apr 2007 5040
27 Mar 1958 3240 21 Apr 2008 7670
03 Jun 1959 6800 05 May 2009 4830
09 May 1960 3740 14 Mar 2010 9070
19 Feb 1961 4700 17 Apr 2011 10300
22 Mar 1962 4380 01 Mar 2012 4650
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A Bulletin 17 Analysis using EMA and Bulletin 17C procedures has been
developed for this example. To open the analysis, either double-click on
the analysis labeled “B17C Example 3” from the Study Explorer or from
the Analysis menu select open, then select “B17C Example 3” from the
list of available analyses. When “B17C Example 3” is selected, the
Bulletin 17 analysis editor will appear as shown in Figure C-16.

Shown in Figure C-16 are the general settings that were used to perform
this Bulletin 17 Analysis. As shown, the Skew option was set to use the
Station Skew.

[7] Bulletin 17 Editor - B17C Example 3 [=- [
Name B17C Example 3
Description: Example 3: Broken Record - Back Creek near Jones Springs, WV @
FlowData Set. | Back Creek-Jones Springs-FLOW-ANNUAL PEAK h
DSS File Name: | C:\PROJECTSISSP_Testing\Projects\Bulletin_17C_Examples\Bulletin_17C_Examples.dss =2
Report File: C\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_3\B17C_Example_3.rpt ]

General | Options | EMA Data | Tabular Results

Generalized Skew Plotting Position Confidence Limits
@ Use Station Skew S HE0) @ Defaults (005, 0.95)
Use Weighted Skaw Median (AandB=0.3) e B U TS

Hazen (A and B =0.5) U Limit
Upper Limi

Use Regional Skew Hirsch/Stedinger
Lower Limit

Regional Skew:

5 Other (Specify A, B)

LR SEIUIES Plotting position computed using formula

(m-A)(n+1-AB) Time Window Modification

Expected Probablity Curve Where:
DSS Range is 17APR1929 - 20APR2015
Compute Expected Prob. Curve
Start Date
Do Not Compute Expected Prob. Curve
A End Date
Method for Computing Statistics and Confidence Limits
B: Low Outlier Test

@ 17CEMA
’ @ Multiple Grubbs-Beck

17B Methods
Single Grubbs-Beck

Compute | | Plot Curve | | View Report | | Print | oK Cancel

Figure C-16. Bulletin 17 Analysis General Tab for “B17C Example 3”.

No changes to the Options tab are necessary.

The EMA Data tab for this example is shown in Figure C-17. This
example uses an annual maximum series consisting of both systematic
data along with an historical event in March 1936. Also, the record is
broken with multiple periods of missing with a complete record. Since
17C EMA requires a non zero — inf perception threshold for all periods of
missing data, a total of five perception thresholds are required. In this
case, the March 1936 event can be used to inform the perception
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thresholds for the periods of missing annual peak flow data. The use of a
perception threshold of 21000 — inf for these periods of missing data
implies that had a flood event occurred with a peak flow greater than
21,000 cfs, someone would have measured and recorded it. Once all five
perception thresholds have been entered as shown in Figure C-17, click
the Apply Thresholds button to assign the complementary flow ranges for
the periods of missing data.

Finally, the March 1936 Event should be set to the historical data type, as
denoted by a USGS peak flow rate qualification code of “7”.

[ Bulletin 17 Editor - B17C Example 3 El |
Name: B17C Example 3
Description: Example 3: Broken Record - Back Creek near Jones Springs, Wv &
Flow Data Set | Back Creek-Jones Springs-FLOW-ANNUAL PEAK -
DSSFile Name: | C:\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin_17C_Examples.dss =]
Report File CAPROJECTSVSSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_3\B817C_Example_3.rpt D
‘ Generall Dmlonsl EWAData | Tabular Results
First Row in Table Defines the Absclute Time Window for EMA Analysis (start and end dates)
Perception Thresholds o
[}
Start Year End Year Low Threshold High Threshold Comments o |
1929 2012 0.0 inf Total Record 300004
1932 1935 21000.0 inf|missing record '
1937 1935 21000.0 inf| missing record =]
1976 1992 21000.0 inf| missing record
1999/ 2003 21000.0 inf|missing record
p
16,0000+
o
A ]
pply Thresholds ol
© (s}
Flow Ranges 10,0004 £ o o
o
Year Peak Low Valug High Value Data Type o o o P
1929 8750.0 8750.0 8750 .0)Systematic | 9 o] °
1930 15500.0 15500.0 15500.0| Systematic - OO Q @ o o
1931 4060.0 4060.0 4060 0| Systematic == © [s]
1932 0.0 21000.0[Censore - 50004 © O oo S Sg g
1933 0.0 21000.0|Censore - o 050% o %o o
1934 0.0 21000.0|Censore - o o
1935 0.0 21000.0|Censore: - = o
1936 220000 22000.0 22000.0|Historical - o
1937 0.0 21000.0|Censored - g @
1938 0.0 21000.0|Censared - ' J | ! | j
1939 53000 53000 5300.0|Systematic - 1930 1940 1950 1960 1970 1880 1830 2000 2010
1940 3130.0 3130.0 3130.0 Systematic - mm— 9321935 S 19371933 m— 0761992 m— 19992003
1941 4160.0 4160.0 4160.0) Systematic - O Data
1942 6700.0 6700.0 6700.0]Svstematic -
1943 224000 22400.0 22400.0|Systematic -
A0A4A 2000 N Julat Ly i il Refresh
[ Compute ] [ Plot Curve ] [ Wiew Report ] [ Print I Apply

Figure C-17. Bulletin 17 Analysis EMA Data Tab for “B17C Example 3”.

Once all of the General and EMA Data tab settings are set or selected,
the user can press the Compute button to perform the analysis. Once the
computations have been completed, a message window will open stations
Compute Complete. Close this window and then select the Tabular
Results tab. The analysis window should look like Figure C-18.

In addition to the tabular results, a graphical plot of the computed
frequency curves can be obtained by pressing the Plot Curve button at the
bottom of the analysis window. The Log Pearson Type 111 distribution fit
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using EMA to the input annual maximum flow data set, the 5% and 95%
confidence limits, and the annual maximum flow data set Hirsch/Stedinger
and Median (for low outliers) plotting positions are shown in Figure C-19.

[] Bulletin 17 Editor - B17C Example 3 5 [
Name: B17C Example 3
Description Example 3: Broken Record - Back Creek near Jones Springs, WV =
FlowData 8et | Back Creek-Jones Springs-FLOW-ANNUAL PEAK -
DSSFile Name. |C\PROJECTSISSP Testing\Projects\Bulletin_17C_Examples\Bulletin_17C_Examples.dss =]
Report File: C\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_3\B17C_Example_3.rpt )
General OptionleMAData Tabular Results
Frequency Curve for: Back Creek-Jones Springs-FLOW-ANNUAL PEAK
= GE 3 =1 Confidence Limits
ercen ance ompute urve
Fi cf:
Exceedance Flow in cfs owin s
0.05 0.95
0.2 318553 623105 22898.5
0.5 26289.1 44789.5 19874.8
1.0 224798 34688.4 17605.7
20 189835 26718.2 15350.7
5.0 14789.2 18771.4 12384.0
10.0 11893.1 142811 10179.3
20.0 9179.0 10683.2 7967.8
50.0 5675.1 64927 4957 .4/
80.0 3576.5 4091.9 3064.8
90.0 2830.8 3263.0 2284.4/
95.0 23428 27493 17452
99.0 1657.9 2103.8 1020.4/
System Statistics Mumber of Events
Log Transform: Flow Event Number
Statistic value Historic Events 1
Wean 3.760 E‘g”g’”ﬁ!'ers SZeroFi 3
Standard Dev 0243 M"W L :rs anc.cero Tows %
Station Skew 0.144| [F=5Ng "‘gs - =
Regional Skew H’ ;“”"’F','L ":" S a1
Weighted Skew Istoric Peno
Adopted Skew 0.144
[ Compute ] [ PlotCurve | [ View Report ] [ Print ] Apply

Figure C-18. Bulletin 17 Analysis Tabular Results Tab for “B17C Example 3”.
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@ Bulletin 17 Plot for B17C Example 3

]

—

File Edit View Window

Return Period

o7}

Bulletin 17 Flot for B17C Example 3

1000

200
L

100000.0 : 4

10000.04

Flow {ofs)

1000.0

100.0 T T T

Frobahility

T T T T 1
02 041 0.02 0.0050.001

Computed Curve

—— = 3 Percent Confidence Limit

— — = 95 Percent Confidence Limit
8] Observed Events (Hirsch-Stedinger plotting postions)

Histaric: Data

O Loy Outlier

Figure C-19. Plotted Frequency Curves for “B17C Example 3.

As shown in Figure C-19, the Multiple Grubbs-Beck Test identified a low
outlier threshold of 2000 cfs. Two annual peak flows were identified as
being less than this threshold, as shown in Figure C-20. These annual
peak flows were then recoded to have a flow interval of zero — 2000. The
perception thresholds for the years in which an annual peak flow was
recorded were also adjusted to correspond with the Multiple Grubbs-Beck
Test low outlier threshold. Consequently, these perception thresholds
were changed from zero — inf to 2000 — inf, as shown in Figure C-21.
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s e
@ B17C_Example_3.apt “ r——- ﬂ
File Edit Search Format
File: | C\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_3\B17C_Example_3.rpt
| 08 Dec 1872 5,210.0 | 45 1964 3,960.0 T78.65 | -
| 27 Dec 1973 4,880.0 | 48 1956 3,880.0 80.42 |
| 20 Mar 1975 7,940.0 | 47 1944 3,880.0 g2.20 |
| 01 Jan 18978 — | 48 1960 3,740.0 83.97 |
| 01 Jan 1977 — | 49 1957 3,420.0 85.74 |
| 01 Jan 1978 - | 50 1958 3,240.0 87.52 |
| 01 Jan 18979 — | 51 1940 3,130.0 89.29 |
| 01 Jan 1880 — | 52 1950 3,010.0 91.06 |
| 01 Jan 1981 - | 53 1995 2,300.0 92.84 |
| 01 Jan 18982 — | 54 2008 2,000.0 94.481 |
| 01 Jan 18983 — | 55 1947 1,600.0% 96.99 |
| 01 Jan 1984 - | 56 1969 536.0* 98.7¢ |
| 01 Jan 1985 — | 57 2003 - -— |
| 01 Jan 1986 -—- | 58 2002 — — |
| 01 Jan 1987 -— | 58 2001 =— —_— |
| 01 Jan 1988 — | &0 2000 - -— |
| 01 Jan 1989 -— | 61 1995 — — |
| 01 Jan 1330 — | &2 1992 N S |
| 01 Jan 1931 — | 63 1991 - — |
| 01 Jan 1992 -—— | 64 1990 — — |
| 05 Mar 1933 11,800.0 | &5 1989 - -— |
| 08 May 1994 &,730.0 | 66 1988 - -— |
| 16 Jan 1995 2,300.0 | &7 1987 —— — |
| 15 Jan 1934 13,%00.0 | 1} 1986 - -— |
| 09 Nov 19394 4,1%0.0 | 69 1985 - — |
| 21 Mar 1998 &,370.0 | 70 1984 —— — |
| 01 Jan 193% — | 71 1983 - -— |
| 01 Jan 2000 — | 72 1982 -— -— |
| 01 Jan 2001 -— 1 73 1981 — — |
| 01 Jan 2002 — | 74 1980 - -— |
| 01 Jan 2003 — | 75 1979 -— -— |
| 29 Sep 2004 9,460.0 | T8 1978 —— — | i
| 29 Mar 2005 6,560.0 | 77 1977 - — |
| 30 Nov 2005 2,000.0 | 78 1976 —— — |
| 1& Apr 2007 5,040.0 | 749 1838 -— - |
| 21 Apr 2008 7,670.0 | a0 1937 == - | E
| 05 May 2009 4,830.0 | 81 1935 —— — |
| 14 Mar 2010 9,070.0 | g2 1934 - -— |
| 17 Zpr 2011 10,300.0 | 83 1933 - -— | Rl
| 01 Mar 2012 4,650.0 | &4 1932 —— — |
[ [—————————————————————————— |
* Qutlier
* Low ocutlier plotting positions are computed using Median parameters.
< | 1 | ,
01/0712016 16:27 PM 1111 11 II

Figure C-20. Report File for “B17C Example 3” showing censored low outliers.
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[ B17C_Example 3apt T =3

File Edit Search Format

File: | C:\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_3\B17C_Example_3.rpt
| 1941 4,160.0 | 4,160.0 4,160.0 | 2,000.0 1.0E99 | Syat | -
| 1942 &,700.0 | 6,700.0 6,700.0 | 2,000.0 1.0E99 | Syst |
| 1943 22,400.0 | 22,400.0 22,400.0 | 2,000.0 1.0E99 | Syst |
| 1944 3,880.0 | 3,880.0 3,880.0 | 2,000.0 1.0E99 | Syst |
| 1945 8,050.0 | 8,050.0 8,050.0 | 2,000.0 1.0E99 | Syst |
| 194a 4,020.0 | 4,020.0 4,020.0 | 2,000.0 1.0E99 | Syst |
| 1347 1,800.0 | 1.0E-6& 2,000.0 | 2,000.0 1.0E9% | Syst |
| 1948 4,460.0 | 4,460.0 4,460.0 | 2,000.0 1.0E99 | Syst |
| 1949 4,230.0 | 4,230.0 4,230.0 | 2,000.0 1.0E99 | Syst |

il |1 1950 3,010.0 | 3,010.0 3,010.0 | 2,000.0 1.0E99 | Syst | |
| 1951 9,150.0 | 9,150.0 9,150.0 | 2,000.0 1.0E99 | Syst |
| 1952 5,100.0 | 5,100.0 5,100.0 | 2,000.0 1.0E99 | Syst |
| 1853 4,820.0 | 59,820.0 9,820.0 | 2,000.0 1.0E%% | Syst |
| 1954 6,200.0 | 6,200.0 6,200.0 | 2,000.0 1.0E99 | Syst | £
| 1855 10,700.0 | 10,700.0 10,700.0 | 2,000.0 1.0E99 | Syat |
| 1956 3,880.0 | 3,880.0 3,880.0 | 2,000.0 1.0E99 | Syst |
| 1957 3,420.0 | 3,420.0 3,420.0 | 2,000.0 1.0E99 | Syst | i
| 1958 3,240.0 | 3,240.0 3,240.0 | 2,000.0 1.0E99 | Syat |
| 1959 &,800.0 | 6,800.0 6,800.0 | 2,000.0 1.0E99 | Syst |
| 1960 3,740.0 | 3,740.0 3,740.0 | 2,000.0 1.0E99 | Syst |
| 1381 4,700.0 | 4,700.0 4,700.0 | 2,000.0 1.0E99 | Syst |
| 1962 4,380.0 | 4,380.0 4,380.0 | 2,000.0 1.0E99 | Syst |
| 1963 5,190.0 | 5,190.0 5,190.0 | 2,000.0 1.0E99 | Syst |
| 1964 3,960.0 | 3,960.0 3,960.0 | 2,000.0 1.0E99 | Syst |
| 1965 5,600.0 | 5, 600.0 5,600.0 | 2,000.0 1.0E99 | Syst |
| 1968 4,670.0 | 4,670.0 4,670.0 | 2,000.0 1.0E99 | Syst |
| 1967 7,080.0 | 7,080.0 7,080.0 | 2,000.0 1.0E99 | Syst |
| 1968 4,640.0 | 4,640.0 4,640.0 | 2,000.0 1.0E99 | Syst |
| 19635 536.0 | 1.0E-6& 2,000.0 | 2,000.0 1.0E3% | Syst |
| 1870 6, 680.0 | 6,680.0 6,680.0 | 2,000.0 1.0E%% | Syst |
| 1871 g,360.0 | 8,360.0 g,360.0 | 2,000.0 1.0E99 | Syst |
| 1872 18,700.0 | 18,700.0 18,700.0 | 2,000.0 1.0E99 | Syat |
| 1973 5,210.0 | 5,210.0 5,210.0 | 2,000.0 1.0E99 | Syst |
| 1974 4,680.0 | 4,680.0 4,680.0 | 2,000.0 1.0E99 | Syst |
| 1875 7,940.0 | 7,940.0 7,940.0 | 2,000.0 1.0E99 | Syat |
| 1976 = | 1.0E-99 21,000.0 | 21,000.0 1.0E9%9 | Cens |
| 1877 —— 1.0E-99 21,000.0 | 21,000.0 1.0E9% | Cens |
| 1378 == [ 1.0E-99 21,000.0 | 21,000.0 1.0E99 | Cens |
| 1979 = | 1.0E-99 21,000.0 | 21,000.0 1.0E9%9 | Cens | |
| 1880 —— 1.0E-99 21,000.0 | 21,000.0 1.0E9% | Cens |
| 1381 == [ 1.0E-99 21,000.0 | 21,000.0 1.0E99 | Cens |
| 1982 = | 1.0E-99 21,000.0 | 21,000.0 1.0E99 | Cens |
| 1883 == [ 1.0E-99 21,000.0 | 21,000.0 1.0E3% | Cens |
| 1984 -— 1.0E-39 21,000.0 | 21,000.0 1.0E99 | Cens |
| 1985 = | 1.0E-99 21,000.0 | 21,000.0 1.0E99 | Cens |
| 13986 == [ 1.0E-99 21,000.0 | 21,000.0 1.0E3% | Cens | -
4 1 | 3

01/0712016 16:27 PM 1111 11 II

Figure C-21. Report File for “B17C Example 3" showing recoded perception
thresholds.
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Example 4: Historical Data — Arkansas River at Pueblo,

co

Example 4 illustrates the computation of a peak flow frequency curve
using EMA and Bulletin 17C procedures with an annual maximum series
comprised of systematic and historical flood events as well as paleoflood
information. The largest historic floods are described as interval data, and
multiple thresholds are needed to effectively extend the discontinued
stream gaging record after the dam was built.

A paleohydrologic bound of about 840 years (before water year 2004) was
estimated at this site for inclusion in the flood frequency curve. No
estimates of individual paleofloods were made at this site, due to the
relatively wide channel geometry and the lack of apparent stratigraphic
evidence of large paleofloods during a limited field study (England, et al.,
2015).

When fitting the Log Pearson Type Il distribution using either Bulletin
17B or Bulletin 17C procedures, an unregulated annual maximum series is
required. However, peak flow rates downloaded from the USGS website
do not always reflect unregulated conditions, as is the case with the
Arkansas River near Pueblo, CO (07099500) gage. Pueblo Dam, which
creates one of the largest reservoirs within Colorado, is immediately
upstream of this gaging station. The dam was constructed between 1970
and 1975 and began impacting the annual maximum series due to flood
control and water supply storage in water year 1974. As such, the annual
maximum series downloaded from the USGS website was altered to
reflect unregulated conditions for water year 1974 and 1975.

The modified annual maximum series is plotted in Figure C-22 and
tabulated in Table C-.
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@ Arkansas River-Pueblo-Unregulated FLOW-AMNUAL PEAK
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Figure C-22. Arkansas River near Pueblo, CO Annual Peak Flow Record

(Modified).
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Table C-4. Arkansas River near Pueblo, CO Annual Peak Flow Record (Modified).

Date Flow (cfs) Date Flow (cfs) Date Flow (cfs)

31 Jul 1895 6100 12 Jul 1923 25600 03 Aug 1951 9300
18 Aug 1896 16500 15 Jun 1924 6510 08 Jun 1952 4740
02 Jun 1897 4300 03 Jul 1925 4930 21 Jul 1953 6770
13 Jul 1898 7500 14 Jun 1926 4520 30 Jun 1954 10200
14 Aug 1899 8800 22 Jul 1927 12400 19 May 1955 11100
20 May 1900 7600 21 Jul 1928 7800 01 Aug 1956 8010
21 May 1901 11100 28 Jul 1929 10500 29 Jun 1957 9070
05 Aug 1902 30000 28 Aug 1930 6050 05 Jun 1958 4540
09 Jun 1903 10500 01 Sep 1931 3560 17 Jun 1959 2820
15 Aug 1904 8500 26 Jun 1932 4380 08 Jun 1960 5260
06 Aug 1905 8000 02 Aug 1933 8630 02 Aug 1961 5760
13 Jun 1906 11000 03 Aug 1934 2580 08 Jul 1962 3540
28 Jul 1907 6600 18 May 1935 9880 14 Aug 1963 8360
01 Aug 1908 7600 24 May 1936 11200 27 May 1964 2840
18 Aug 1909 5800 29 Aug 1937 9300 22 Aug 1965 23500
29 Jul 1910 8400 26 Aug 1938 11200 01 Aug 1966 10600
28 May 1911 3700 01 Jun 1939 2910 18 Jul 1967 5870
31 Jul 1912 10500 19 Aug 1940 3860 10 Aug 1968 5190
23 Jul 1913 7800 19 Jul 1941 7560 23 Aug 1969 6620
03 Aug 1914 7500 08 Jun 1942 10300 11 Aug 1970 6300
24 Jun 1915 17000 18 Aug 1943 3320 07 Jun 1971 3360
17 Jun 1916 8900 05 Jul 1944 5980 28 Jun 1972 3360
19 Jun 1917 6800 14 Aug 1945 9290 30 Jul 1973 6760
23 Jun 1918 9600 27 Aug 1946 7050 23 Jul 1974 5440
04 Sep 1919 6300 09 Jul 1947 7280 10 Jul 1975 10200
18 Jul 1920 8500 13 Jun 1948 10900 10 Jul 1976 12800
03 Jun 1921 91500 06 Jun 1949 12800

06 Aug 1922 8850 26 Jul 1950 8700

A Bulletin 17 Analysis using EMA and Bulletin 17C procedures has been
developed for this example. To open the analysis, either double-click on
the analysis labeled “B17C Example 4” from the Study Explorer or from
the Analysis menu select open, then select “B17C Example 4” from the
list of available analyses. When “B17C Example 4” is selected, the
Bulletin 17 analysis editor will appear as shown in Figure C-23. As
shown, the Skew option was set to use the Station Skew.
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[ Bulletin 17 Editor - B17C Example 4 = [
Name: B17C Example 4
Description: Example 4: Historical Data - Arkansas River at Pueblo, CO (8]
Flow Data Set :Arkansas River-Pueblo-Unregulated FLOW-ANMUAL PEAK b
DSS File Name: | ¢:APROJECTSISSP_Testing\Projects\Bulletin_17C_Examples\Bulletin_17C_Examples.dss =
Report File: C:PROJECTSISSP_Testing\Projects\Bulletin_17C_Examplas\Bulletin17Results\B17C_Example_4\B17C_Example_4.rpt =]

General | gptions | EMAData | Tabular Results

Generalized Skew Ploting Position Confidence Limits
@ Use Station Skew Weibull (A.and B =0) @ Defaults (0.05, 0.95)
@ Use Weighted Skew TEE RS0 (©) User Entered Values

Hazen (A and B =0.5) U Limit
pper Limit:
SRR ponal S ey @ Hirsch/Stedinger
i : Lower Limit:
Regional Skew: © Other (Speciy A, B)
Reg. Skew MSE

g ! Plotting position computed using formula - -
(m-A)(n+1-A-B) Time Window Modification

Expected Probablity Curve Where:
m-Rank, 1L argest DSS Rangeis 31JUL1895-10JUL1976
N=Number of Years Start Date

A.B=Constants

Compute Expected Prob. Curve

@ Do Mot Compute Expected Prob. Curve
End Date

Method for Computing Statistics and Confidence Limits )
B: Low Qutlier Test

@ 17C EMA a
o J (@ Multiple Grubbs-Beck

() 178 Methods .
Single Grubbs-Beck

Compute ‘ [ Plot Curve I [ View Report I [ Print ] Appl

Figure C-23. Bulletin 17 Analysis General Tab for “B17C Example 4”.

Commonly, within dam safety studies, estimates of flow or volume
frequency are required at extremely small exceedance probabilities. As
such, additional frequency ordinates (0.1- and 0.01-percent annual chance
exceedance probabilities) were specified on the Options tab, as shown in
Figure C-24.
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[Z] Bulletin 17 Editor - B17C Example 4 [-=- [E3m
MName: B17C Example 4
Description: Example 4: Historical Data - Arkansas River at Pueblo, CO )
Flow Data Set | Arkansas River-Pueblo-Unregulated FLOW-ANNUAL PEAK -
DSS File Name: | C:\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin_17C_Examples.dss ]
Report File CPROJECTS\SSP_Testing\Projects\Bulletin_17C_ExamplesiBulletin17Results\B17C_Example_4\817C_Example_4.rpt &
| General| Options | EMA Data | Tabular Results
Low Cutlier Threshold Historic Period Data User Specified Frequency Ordinates
["] Override Low Outlier Threshold Use Historic Data Use Values from Table Below
Value 1
Histaric Period Frequency in Percent
Start Year: 0.01
0.1
End Year. 0.2
Override High Outlier Threshold: 0.5
1.0
= 2.0
Historic Events 50
Water Year Peak 10.0
20.0
50.0
30.0
90.0
95.0
99.0
i Compute ‘ I Plot Curve J I View Report I I Print I OK Cancel

Figure C-24. Bulletin 17 Analysis Options Tab for “B17C Example 4”.

The EMA Data tab for this example is shown in Figure C-25. This
example uses an annual maximum series consisting of both systematic
data along with historical events and paleoflood information. Multiple
perception thresholds are needed to reasonably incorporate the various
historical and paleoflood information.

The default “Total Record” perception threshold should be modified to
reflect the additional paleoflood and post Pueblo Dam construction
information. A start year of 1165 and end year of 2004 along with a
perception threshold of zero — inf should be entered on the first line.

The second perception threshold relates to the non-exceedance
information obtained through the paleoflood analysis. A start and end
year of 1165 and 1858 should be entered, respectively, along with a
150,000 — inf perception threshold. This implies that no floods exceeded a
peak flow rate of 150,000 cfs from 1165 — 1858 even though there were
no gages present.

The third and fourth perception thresholds represent a period of historical
information from 1859 — 1892 where floods in excess of 40,000 cfs would
have been recorded had they occurred. Since a historical event was
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recorded in 1864, two perception thresholds should be used, one from
1859 — 1863 and one from 1865 — 1892. Both perception thresholds
should span from 40,000 — inf. Additionally, a historical flow event that
occurred in 1864 should be entered in the Flow Ranges table with a low
and high flow value of 41,000 and 60,000 cfs, respectively, to denote
uncertainty around the best-estimate of 50,500 cfs. The data type for this
event should be set to Historical.

The fifth perception threshold represents an additional period of historical
information from 1893 — 1894. A perception threshold of 19,900 — inf
should be entered for these two years. Two events that aren’t part of the
gage record occurred in 1893 and 1894. The 1893 event had a low and
high flow value of 20,000 and 25,000, respectively, with a best-estimate of
22,500. The 1894 event had a low and high flow value of 35,000 and
40,000, respectively, with a best-estimate of 37,500. Both events should
be entered in the Flow Ranges table and the data types should be set to
Historical.

The 1921 event should be entered as an historical event with uncertainty
around the best estimate of 91,500 cfs. A low and high value of 80,000
and 103,000 should be used.

The sixth and final perception threshold represents the period when the
stream gage was discontinued after the construction of Pueblo Dam. Itis
known that floods in excess of 20,000 cfs would have been recorded had
they occurred. Therefore, a perception threshold of 20,000 — inf should be
entered for these years.

Once all six perception thresholds have been entered as shown in Figure
C-25, click the Apply Thresholds button to assign the complementary
flow ranges for the periods of missing data.
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2] Bulletin 17 Editor - BLTC Exampled = =
Name: |B17C Example 4 |
Description |Example 4: Historical Data - Arkansas River at Pueblo, CO E]|
FlowData Set | arkansas River-Pueblo-Unregulaled FLOW-ANNUAL PEAK v/
D33 File Name: | CPROJECTS\SSPIProjects\TestiBulletin_17C_Examples\Bulletin_17C_Examples.dss ]|
Report File |C\F'ROJECTS\SSP'lejects\Test\BuHetianCfExamp\es\EluIIet\m7ResuIts\Bﬂ?CﬁExampleJ\EH707Examplef4.rpt D|
General | Options | EWA Data | Tabular Resunsl
First Row in Table Defines the Absolute Time Window for EMA Analysis (start and end dates) 160,000
[ Perception Thresholds |

Start Year End Year Low Threshaold High Threshold Comments 140,000
1165 150000.0 inf paleoflood nonexcee.
1859 40000.0 inf 1864 historical info 120,000
1865 40000.0 inf 1864 historical info
100,000
80,000
Apply Thresholds
Flow Ranges g0,000
Year Peak Low Value High Value Data Type
1165 0.0 150000.0|Censored »| - 40,000
1166 0.0 150000.0|Censore - E
1167 0.0 150000.0|Censore L 0g
1168 00 150000.0|Censore: - 20,000
1169 0.0 150000.0|Censore -
1170 0.0 150000.0|Censore -
1171 0.0 150000.0|Censore: - il
2 0.0 150000 Oj:eas046! = 1200 1300 1400 1500 1600 1700 1800 1800 2000
1173 0.0 150000.0|Censore -
1174 0.0 150000.0|Censore - —1E5-1858 3501863
1175 0.0 150000.0|Censore - m— 15551592 — 931804
1176 0.0 150000 0|Censore - 19772004 O Data
1177 0.0 150000.0|Censored - Flow Range Points
1178 0.0 150000.0|Censore: - d
1179 0.0 150000.0|Censore: -
11280 nn 160000 0l Cancara; =2 Seffcsh
[ Compute ] I Plot Curve I [ View Report I [ Print I [ oK ] [ Cancel ] | Apply

Figure C-25. Bulletin 17 Analysis EMA Data Tab for “B17C Example 4”.

Once all of the General and EMA Data tab settings are set or selected,
the user can press the Compute button to perform the analysis. Once the
computations have been completed, a message window will open stations
Compute Complete. Close this window and then select the Tabular
Results tab. The analysis window should look like Figure C-26.

In addition to the tabular results, a graphical plot of the computed
frequency curves can be obtained by pressing the Plot Curve button at the
bottom of the analysis window. The Log Pearson Type 111 distribution fit
using EMA to the input annual maximum flow data set, the 5% and 95%
confidence limits, and the annual maximum flow data set Hirsch/Stedinger
and Median (for low outliers) plotting positions are shown in Figure C-27.
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[ Bulletin 17 Editor - B17C Example 4 = [
Name: B17C Example 4
Description Example 4: Historical Data - Arkansas River at Puebla, CO )
Flow Data Set | arkansas River-Pueblo-Unregulated FLOW-ANNUAL PEAK -
D35 File Name: | C\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin_17C_Examples dss (]
Report File: C\PROJECTSISSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_4\B17C_Example_4.rpt =
General | Options I EMA Data| Tabular Results
Frequency Curve for: Arkansas River-Pueblo-Unregulated FLOW-ANMUAL PEAK
= cEn & T Confidence Limits
ercen ance " ompute urve N
Exceedance Flow in cfs RELAACH
0.05 0.95
0.01 1772714 544523.0 88850.5
0.1 86273.8 1743328 52090.4.
02 68831.1 124058.5 448494
05 50615.4, 79389.9 355752
1.0 39780.3 56850.4, 29551.7
2.0 309755 40895.8 24266.4
5.0 218241 26664.5 18204.4.
10.0 16389.0 19289.2 141122
20.0 11942.6 13698.8 10370.4.
50.0 71221 7980.8 6300.0
80.0 4735.0 5200.2 4316.3
90.0 3980.1 43728 3561.9
95.0 3514.4] 4033.2 3069.2
99.0 2903.2 3789.1 23324
System Statistics Mumber of Events
Log Transform: Flow Event Number
Statistic Value Historic Events 4
Wean 3ggp| HonOuiers -
Standard Dev 0.246 M“"" U 'FTFS and Zefo Flaws =
Station Skew 0.818 S‘Sf‘”g : “‘gs - a
Regional Skew H"Sf'.”ap'c ":”S 540
Weighted Skew Istoric Ferio
Adopted Skew 0.8318
Compute | I Plot Curve I [ View Report I [ Print ] Apply

Figure C-26. Bulletin 17 Analysis Tabular Results Tab for “B17C Example 4”.

@ Bulletin 17 Plot for B17C Example 4

[E=SEERC)

File Edit View Window

@ 11

Bulletin 17 Plot for B17C Example 4

Return Period
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1 L L 1 1

1000000.0 4 i

100000.04

Flow {cfs)

10000.0

1000.0 T T

T T T
0.0z

T LI T T
0.4 0201 0.002 0.0001

FPrabahility

—— Computed Curve

3 Percent Confidence Limit
95 Percent Confidence Limit

Floww Range Points

Historic Data

o Obzerved Events (Hirsch-Stedinger plotting posttions)

Figure C-27. Plotted Frequency

Curves for “B17C Example 4”.
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As is shown in Figure C-27, the Log Pearson Type I11 distribution is well
fit to the majority of the data. However, the largest flood event (June
1921) is underfit by the EMA-computed Log Pearson Type 1l curve. This
is likely due to the influence of the paleoflood information which
lengthens the historical record from 85 years to 840 years. Consequently,
the at-station skew coefficient is reduced which primarily affects the upper
end of the computed curve. Had the paleoflood information not been
included, a larger at-station skew coefficient would have been computed.
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Example 5: Crest Stage Gage Censored Data — Bear
Creek at Ottumwa, IA

Example 5 illustrates the computation of a peak flow frequency curve
using EMA and Bulletin 17C procedures with an annual maximum series
comprised of censored data with variable perception thresholds due to the
presence of a crest stage gage.

A crest stage gage is a simple, reliable device used to obtain the elevation
of the flood peak of a stream. Most commonly, a crest stage gage consists
of a vertical metal pipe containing a wood or aluminum staff held in a
fixed position with relation to a datum reference. At the bottom of the
pipe is a perforated cap containing regranulated cork. When the water in
the stream reaches and exceeds the height of the bottom cap (commonly
referred to as the gage base), water is able to enter the pipe. As the water
rises up the pipe, the cork floats on the water surface and as the water
reaches its peak and starts to recede, the cork adheres to the staff thereby
retaining the crest stage of the flood (England, et al., 2015). As a result,
crest stage gages provide a censored record of peak flows, as no annual
peak flow that results in a flood stage below the bottom cap of the pipe
will be recorded.

For this example, USGS gage 05489490 Bear Creek at Ottumwa, IA is
used. This gage is a crest stage gage and has a drainage area of 22.9
square miles. It is located in southeast lowa in the Southern lowa Drift
Plain land-form region which is characterized by rolling hills and deeply
carved stream channels (Prior, 1991). The stream banks and channel bed
are comprised of sand, silt, and clay materials that are prone to shifting
from hydrologic events.

The Bear Creek at Ottumwa, 1A stream gage has an annual peak record
consisting of 50 annual peaks. The historical record for this gage spans
from 1965 — 2014. The annual maximum series is plotted in Figure C-28
and tabulated in Table C-.
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E Bear Creek-Ottumwa-FLOW-ANNUAL PEAK

[=REC X

File Edit View

4,500

3,500 e

3,000

Flow (5fs)
e
&
=
=
:

2,000 °

15004 5

1,000+ o

500

T T T T T T T T
1970 1975 1980 19885 1980 1985 2000 2005 2010

| @ Oftumws USGE FLOW-SNNUAL PERK

Figure C-28. Bear Creek at Ottumwa, IA Annual Peak Flow Record.

Table C-5. Bear Creek at Ottumwa, |1A Annual Peak Flow Record.

Date Flow (cfs) Date Flow (cfs)
21 Sep 1965 4000 25 May 1990 3120
30 Nov 1965 1180 18 Apr 1991 1850
09 Jun 1967 2880 15 Sep 1992 1840
15 Oct 1967 1310 07 May 1993 2410
05 Jul 1969 1420 23 Jun 1994 1400
24 Jun 1970 3130 11 Apr 1995 1560
30 Nov 1970 1180 28 May 1996 3130
08 May 1972 1620 30 Nov 1996 714
19 Jan 1973 1570 18 Jun 1998 1940
19 May 1974 2060 05 Oct 1998 2840
30 Nov 1974 705 23 Jun 2000 3520
24 Apr 1976 3340 15 May 2001 2430
07 Aug 1977 3530 11 May 2002 2670
21 Jul 1978 2010 26 Jun 2003 560
29 Mar 1979 1830 27 Aug 2004 3000
17 Aug 1980 2240 12 Apr 2005 859
04 Jul 1981 2770 30 Nov 2005 710
03 Jul 1982 4030 23 Aug 2007 2390
08 Oct 1982 2180 11 May 2008 3160
08 Jun 1984 1780 27 Aug 2009 2520
04 Mar 1985 1610 09 Aug 2010 3750
19 Sep 1986 1910 14 Jun 2011 2600
31 May 1987 990 14 Apr 2012 1450
20 Feb 1988 899* 28 May 2013 3850
09 Sep 1989 1820 10 Sep 2014 1200

*gage height affected by backwater
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A Bulletin 17 Analysis using EMA and Bulletin 17C procedures has been
developed for this example. To open the analysis, either double-click on
the analysis labeled “B17C Example 5” from the Study Explorer or from
the Analysis menu select open, then select “B17C Example 5 from the
list of available analyses. When “B17C Example 5 is selected, the
Bulletin 17 analysis editor will appear as shown in Figure C-29. As

shown, the Skew option was set to use the Station Skew.

E Bulletin 17 Editor - BI7C Example 5

Name: B17C Example §

Description Example 5: Crest Stage Gage Censored Data - Bear Creek at Ottumwa, |A

FlowData Set | Bear Creek-Ottumwa-FLOW-ANNUAL PEAK

DSSFile Name: | C\PROJECTSISSP_Testing\Projects\Bulletin_17C_Examples\Bulletin_17C_Examples. dss

Report File: C\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_5\B17C_Example_5.rpt

General | Options | EMA Data | Tabular Resulis

Generalized Skew Plotting Position Confidence Limits

Weibull (A and B = 0)

@ Use Station Skew @ Defaults (0.05, 0.95)

Use Weighted Skew e et User Entered Values
Hazen (Aand B =0.5) u .
. Upper Limi
R R SR Hirschi/Stedinger
Lower Limit

R | 8k
egional Skew: Other (Specify A, B)

Reg. Skew MSE:
. § Plotting pesition computed using formula I
o . Time Window Modification
(m-A)(n+1-A-B)

Expected Probablity Curve Where:

m=Rank, 1=Largest L e

N=Mumber of Years Start Date
AB=Constants

Compute Expected Prob. Curve

Do Not Compute Expected Prob. Curve
End Date

Method for Computing Statistics and Confidence Limits .
B Low Outlier Test

@ 17TC EMA
’ @ Multiple Grubbs-Beck

17B Wethods
Single Grubbs-Beck

21SEP 1965 - 10SEP2014

Compute | | Plot Curve | ‘ View Report | ‘ Print ‘ oK Cancel

Figure C-29. Bulletin 17 Analysis General Tab for “B17C Example 5”.

No changes to the Options tab are necessary.

The EMA Data tab for this example is shown in Figure C-30. This

example uses an annual maximum series consisting entirely of systematic
data. However, physical changes to the actual gage base (i.e. minimum
recordable flow rate) occurred in 1973, 1992, 2002, 2003, 2004, 2006,
2010, and 2013. To take the possibility of annual peak flows occurring
below the gage base into account within the EMA framework, perception
thresholds are required for each change in the gage base. For instance, the
gage base was lowered from the initial setting of 1180 cfs to a gage base
of 705 cfs in 1973. The next gage base change occurred in 1992. This
requires a perception threshold of 705 — inf for water year 1973 — water
year 1991. For information related to a specific crest stage gage, such as
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the gage base, consult your local USGS office. A total of nine different
gage bases have been in effect for this gage. Including the first perception
threshold (which sets the start and end year of the analysis), this requires a
total of 10 perception thresholds. Once all five perception thresholds have
been entered as shown in Figure C-30, click the Apply Thresholds button
to assign the complementary flow ranges for the periods of missing data.

A peak flow rate below the gage base occurred in 1966, 1971, 1975, 1997,
and 2006, as signified by the USGS qualification code of 4. This implies
that the actual annual peak flow rate could have been between zero and
whatever the gage base was at the time. This requires a change to the flow
range table. For each of these years, a low value of zero and high value of
whatever the gage base was at the time should be entered. For instance, in
water year 1966, the annual peak flow rate was below the gage base of
1180 cfs. Therefore, the flow range for that year should be entered as zero
— 1180, as shown in Figure C-30. The other four water years in which an
annual peak flow was below the recordable limit should be entered in a
similar fashion within the flow range table.

[ Bulletin 17 Editor - B17C Example 5 = [
Name: B17C Example 5
Description Example 5: Crest Stage Gage Censored Data - Bear Creek at Otumwa, |A =)
Flow Data Set | Bear Creek-Ottumwa-FLOW-ANNUAL PEAK -
DSS File Name: | c\PROJECTS\SSP_Testing\Projects\Bulletin_17C_ExamplesiBulletin_17C_Examples. dss )
Report File C:\PROJECTSISSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_5\B17C_Example_5.rpt =)
‘ General | Dminnsl EMA Data | Tabular Resultsl
First Row in Table Defines the Absolute Time Window for EMA Analysis (start and end dates) 4,500
\ Perception Thresholds [
Start Year End Year Low Threshold High Threshold Commenis 4,000 o
s o o]
1965 1972, 1180.0 inf initial gage base ... | | o
1973 1991 705.0 inf gage base lower... 3,500 o
1992 2001 714.0 inf gage base raise o
2002 2002 7430 inflgage base raise__ |~ o o o ©
2002 2003 560.0 inf gage base lower. 3,0007 d &
o
o
o
i o
2,500 ° o o
° o
Apply Thresholds i o
__DDY 2,000 Oo o - 5
Flow Ranges o @
- Co o o
Year Peak Low Value High Value Data Type 1,600 o 3 o
1965 4000.0 4000.0 4000.0| Systematic -~ o
1966 1180.0 0.0 1180.0| Svstematic =7
1967 2880.0 2880.0 2880.0|Svstematic = 1,000 % o
1968 1310.0 13100 1310.0| Systematic =] = r Lo
1969 1420.0 1420.0 1420.0| Systematic - o |
1970 3130.0 31300 3130 0[Systemalic | 00
1971 1180.0 0.0 1180.0| Systematic -
1972 1620.0 1620.0 1620.0| Systematic -
1973 1570.0 1570.0 1570.0] Sustematic = J !
T G050 2060.0 2060.0[Sralematic = 1970 1975 1990 1985 1880 1995 2000 2005 2010
1975 705.0 0.0 705.0|Systematic - mm—gES.1072 5731001 m— 3922001 0022002
1213 g::gg ggggg gggg g vs ema:u: - 2003-2003 2004-2005 S D0052009 == 2010.2012
ystemalic hd
1978 2010.0 2010.0 2010.0| Systematic - 3204 @ Das
1979 1830.0 1830.0 1830.0| Svstematic = [—]
1980 22400 22400 2240 Nl Sustematic a Rsfiesh
i Compute ‘ I Plot Curnve ] I View Report ] I Print I Apply

Figure C-30. Bulletin 17 Analysis EMA Data Tab for “B17C Example 5.
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Once all of the General and EMA Data tab settings are set or selected,
the user can press the Compute button to perform the analysis. Once the
computations have been completed, a message window will open stations
Compute Complete. Close this window and then select the Tabular
Results tab. The analysis window should look like Figure C-31.

In addition to the tabular results, a graphical plot of the computed
frequency curves can be obtained by pressing the Plot Curve button at the
bottom of the analysis window. The Log Pearson Type Il distribution fit
using EMA to the input annual maximum flow data set, the 5% and 95%
confidence limits, and the annual maximum flow data set Hirsch/Stedinger
and Median (for low outliers) plotting positions are shown in Figure C-32.

[] Bulletin 17 Editor - B17C Bxample 5 E (5w
Name: B17C Example 5
Description Example 5: Crest Stage Gage Censored Data - Bear Creek at Ottumwa, [A =
Flow Data Set | Bear Creek-Ottumwa-FLOW-ANNUAL PEAK -
D33 File Name: |C:\PROJECTSISSP_Testing\Projects\Bulletin_17C_Examples\Bulletin_17C_Examplas. dss [}
Report File C\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_5\B17C_Example_5.rpt (]
General | Options I EMA Data| Tabular Results
Frequency Curve for: Bear Creek-Ottumwa-FLOW-ANNUAL PEAK
= S 3 — Confidence Limits
ercent Chance omputed Curve
Fl Cfe
Exceedance Flow in cfs el
0.05 0.95
0.2 5036.2 6977.3 42603
05 4801.5 6236.5 41463
1.0 4585.9 57047 40229
20 43291 51871 38514
5.0 3908.3 44991 35141
10.0 3507.4 3954.2 31475
200 3004.0 3365.1 26752
50.0 2061.3 2346.9 1766.0
80.0 1259.1 1477.0 840.6
90.0 925.6 11407 4941
95.0 698.7 918.3 3059
99.0 3849 603.0 102.0
System Statistics Number of Events
Log Transform: Flow Event Number
Statistic Value :‘S‘rs’[']': Svents 0
igh Outliers
Mean 3.279
Standard Dev 0933 how Out\le‘zrs and Zero Flows g
Station Skew 0925| [LER N @
Regional Skew yo SIS
\Welghted Skew Historic Period 50
Adopted Skew -0.925 Historic Period
Compute | [ Plot Curve I [ View Repaort ] [ Print I Apply

Figure C-31. Bulletin 17 Analysis Tabular Results Tab for “B17C Example 5”.
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[ [ Bulletin 17 Piot for B17C Example 5 - " =REC X
File Edit View Window
Bulletin 17 Plot for B17C Example &
— Return Period
B| 1.1 2 5 10 40 200 1000

10000.0 !

1000.0+

Flowe {cfs)

100.0 T

T T T T T 1
049 0.4 02 01 0.02 0.005 0.001

Probahility

—— Computed Curve

O Loy Outlier

— == 5 Percent Confidence Limit
=== 95 Percent Confidence Limit
o Observed Events (Hirsch-Stedinger plotting posttions )

Figure C-32. Plotted Frequency Curves for “B17C Example 5”.

As shown in Figure C-33, the Multiple Grubbs-Beck Test identified a low
outlier threshold of 1200 cfs. Nine annual peak flows were identified as

being less than this threshold, as shown in Figure C-32. These annual

peak flows were then recoded to have a flow interval of zero — 1200. The

perception thresholds for the years in which an annual peak flow was

recorded were also adjusted to correspond with the Multiple Grubbs-Beck

Test low outlier threshold. Consequently, these perception thresholds
were changed from zero — inf to 1200 — inf, as shown in Figure C-34.
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=
[ 817C_Example_S.rpt _— -
File Edit Search Format
File: | C\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_S5\B17C_Example_5.rpt
| 07 Rug 1977 3,530.0 | ak] 1967 2,880.0 25.38 | -
| 21 Jul 1878 2,010.0 | 14 1999 2,840.0 27.33 |
| 2% Mar 1979 1,830.0 | als 1981 2,770.0 29.29 |
| 17 Rug 1980 2,240.0 | 16 2002 2,670.0 31.24 |
| 04 Jul 1881 2,770.0 | 17 2011 2,600.0 33.19 |
| 03 Jul 1982 4,030.0 | 18 2009 2,520.0 35.14 |
| 08 Oct 1982 2,180.0 | 15 2001 2,430.0 37.10 |
| 08 Jun 1984 1,780.0 | 20 1993 2,410.0 39.05 |
| 04 Mar 1985 1,610.0 | 21 2007 2,390.0 41.00 |
| 1% Sep 1986 1,910.0 | 22 1980 2,240.0 42.95 |
| 31 May 1987 930.0 | 23 1383 2,180.0 44.90 |
| 20 Feb 1988 899.0 | 24 1974 2,060.0 46.86 |
| 09 Sep 1989 1,820.0 | 25 1978 2,010.0 48.81 |
| 25 May 1990 3,120.0 | 26 1998 1,940.0 50.76 |
| 18 Rpr 1991 1,850.0 | 27 1986 1,910.0 52.71 |
| 15 Sep 1892 1,840.0 | 28 1991 1,850.0 54.67 |
| 07 May 1993 2,410.0 | 29 1992 1,840.0 56.62 |
| 23 Jun 19394 1,400.0 | 30 1979 1,830.0 58.57 |
M [[I 11 RApr 1995 1,560.0 | 31 1989 1,820.0 60.52 |
| 28 May 1994 3,130.0 | 32 1984 1,780.0 62.48 |
| 30 Nowv 1994 714.0 | 33 1972 1,620.0 64.43 |
| 18 Jun 1998 1,940.0 | 34 1985 1,610.0 66.38 |
| 05 Oct 1938 2,840.0 | 35 1973 1,570.0 68.33 |
| 23 Jun 2000 3,520.0 | 36 1995 1,560.0 70.29 |
| 15 May 2001 2,430.0 | 37 2012 1,450.0 72.24 |
| 11 May 2002 2,670.0 | 38 1969 1,420.0 74.19 |
| 28 Jun 2003 560.0 | 39 1994 1,400.0 76.14 | T
| 27 Rug 2004 3,000.0 | 40 1968 1,310.0 78.10 |
| 12 Rpr 2005 859.0 | 41 2014 1,200.0 £80.05 |
| 30 Now 2005 710.0 | 42 1871 1,180.0*% B82.74 |
| 23 Rug 2007 2,390.0 | 43 1966 1,180.0*% &4.72 | =
| 11 May 2008 3,160.0 | 44 1987 990.0% 86.71 |
| 27 Rug 2009 2,520.0 | 45 1388 899.0% B88.69 |
| 0% Rug 2010 3,750.0 | 45 2005 859.0*% 90.67 |
| 14 Jun 2011 2,6800.0 | 47 1997 T14.0* 92.66 | B
| 14 Rpr 2012 1,450.0 | 48 2008 T10.0% 94.864 |
| 28 May 2013 3,850.0 | 45 1975 T05.0*% 96.63 | I
| 10 Sep 2014 1,200.0 | 50 2003 560.0% 98.61 | |
= | |
* Qutlier N
* Low outlier plotting positions are computed using Median parameters.
4 T | 3
011142016 11:30 AM 157:69.157:69 157:69
b

Figure C-33. Report File for “B17C Example 5” showing censored low outliers.
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-

-
[ B17C_Example_S.rpt

i

File Edit Search Format

File: C\PROJECTSSSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_S\B17C_Example_5.rpt

<< EMA Representation of Data >>
Bear Creek-Ottumwa-FLOW-ANNUAL FERK

| Value
| Year Peak | Low High
| __________
1965 4,000.0 | 4,000.0 4,000
1966 1,180.0 | 1.0E-6 1,200
1967 2,880.0 | 2,880.0 2,880
1988 1,310.0 | 1,310.0 1,310
1969 1,420.0 | 1,420.0 1,420
1970 3,130.0 | 3,130.0 3,130
1871 1,180.0 | 1.0E-6 1,200
1972 1,620.0 | 1,620.0 1,620
1973 1,570.0 | 1,570.0 1,570
1974 2,060.0 | 2,060.0 2,060
1875 705.0 | 1.0E-6 1,200
1976 3,340.0 | 3,340.0 3,340
1977 3,530.0 | 3,530.0 3,530
1978 2,010.0 | 2,010.0 2,010
1979 1,830.0 | 1,830.0 1,830
1980 2,240.0 | 2,240.0 2,240
1981 2,770.0 | 2,770.0 2,770
1982 4,030.0 | 4,030.0 4,030
1983 2,180.0 | 2,180.0 2,180
1984 1,780.0 | 1,780.0 1,780
1985 1,610.0 | 1,610.0 1,610
1986 1,910.0 | 1,910.0 1,910
1887 990.0 | 1.0E-6 1,200
1988 g99.0 | 1.0E-6 1,200
1929 1,820.0 | 1,820.0 1,820
1980 3,120.0 | 3,120.0 3,120
19391 1,850.0 | 1,850.0 1,850
1992 1,840.0 | 1,840.0 1,840
1993 2,410.0 | 2,410.0 2,410
1994 1,400.0 | 1,400.0 1,400
1985 1,560.0 | 1,560.0 1,560
1996 3,130.0 | 3,130.0 3,130
1997 714.0 | 1.0E-6 1,200
1998 1,940.0 | 1,940.0 1,940
1939 2,840.0 | 2,840.0 2,840
2000 3,520.0 | 3,520.0 3,520
2001 2,430.0 | 2,430.0 2,430
2002 2,670.0 | 2,670.0 2,670

Threshold |
Low High |
|

1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E99 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E99 |
1,200.0 1.0E9%9 |
1,200.0 1.0E99 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E99 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E99 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E99 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E99 |
1,200.0 1.0E9%9 |
1,200.0 1.0E99 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E9%9 |
1,200.0 1.0E99 |
a 1 |

1,200. .0ESS

<

n

m

01/11/2016 11:30 AM

157:69.157:69

157:69

Figure C-34. Report File for “B17C Example 5” showing recoded perception

thresholds.
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Example 6: Historic Data and Low Outliers — Santa
Cruz River at Lochiel, AZ

Example 6 illustrates the computation of a peak flow frequency curve
using EMA and Bulletin 17C procedures with an annual maximum series
comprised of systematic data and historical flood information that can be
used to extend the historical period.

For this example, USGS gage 09480000 Santa Cruz River near Lochiel,
AZ is used. The stream gage in question has an approximate 82.2 sg. mi.
contributing watershed with an annual peak record consisting of 65 peaks
beginning in water year 1949 and ending in water year 2013. A large
flood event occurred on October 9, 1977. This flood is noted in the USGS
Annual Water Data Report for this gage and there is historical information
available for this large flood indicating that this flood is the largest since
1927 (Aldridge & Eychaner, 1984).

Of the 65 annual peaks, the August 15, 1984 flood is equal to the October
1977 historic flood peak. Based on information contained within Aldridge
and Eychaner (1984) for the October 1977 flood, this event can be used as
a perception threshold to represent the 22 years of missing information
from 1927 to 1946. The annual maximum series is plotted in Figure C-35
and tabulated in Table C-.

[ santa Cruz River-Lochiel-FLOW-ANNUAL PEAK = (e

File Edit View
14,000

10,000

8,000

Flow (5f5)

6,000 =]

4,000

2,000+ @ | %, o

Ogp 0D oo @
o o C o o o
° Cg 9 e o @ e =]
o o 0on oa

0-r T T T T T
1950 1960 1970 1980 1990 2000 2010

| < Lochiel USGS FLOW-ANNUAL PEAK

Figure C-35. Santa Cruz River at Lochiel, AZ Annual Peak Flow Record.
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Table C-6. Santa Cruz River at Lochiel, AZ Annual Peak Flow Record.

Date Flow (cfs) Date Flow (cfs) Date Flow (cfs)

13 Sep 1949 1650 10 Aug 1971 2830 18 Jan 1993 4880
30 Jul 1950 4520 16 Jul 1972 2070 30 Aug 1994 478
02 Aug 1951 2560 30 Jun 1973 1490 12 Jul 1995 2020
16 Aug 1952 550 04 Aug 1974 1730 10 Jul 1996 1860
14 Jul 1953 3320 22 Jul 1975 3330 11 Sep 1997 2970
22 Jul 1954 1570 22 Jul 1976 3540 07 Jul 1998 1110
06 Aug 1955 4300 05 Sep 1977 1130 28 Jul 1999 4870
17 Jul 1956 1360 09 Oct 1977 12000 06 Aug 2000 2240
09 Aug 1957 688 25 Jan 1979 1060 22 Oct 2000 1080
07 Aug 1958 380 30 Jun 1980 406 04 Mar 2002 2
14 Aug 1959 243 15 Jul 1981 1110 14 Aug 2003 22
30 Jul 1960 625 11 Aug 1982 2640 05 Aug 2004 256
08 Aug 1961 1120 04 Mar 1983 1120 23 Aug 2005 73
29 Jul 1962 8 15 Aug 1984 12000 08 Aug 2006 5940
25 Aug 1963 2390 19 Jul 1985 850 19 Jul 2007 3060
09 Sep 1964 2330 29 Aug 1986 4210 23 Jul 2008 1180
12 Sep 1965 4810 10 Aug 1987 291 01 Jul 2009 1530
18 Aug 1966 1780 23 Aug 1988 804 31 Jul 2010 392
03 Aug 1967 1870 04 Aug 1989 871 13 Aug 2011 95
20 Dec 1967 986 17 Jul 1990 3510 28 Jul 2012 12
05 Aug 1969 484 26 Jul 1991 17 08 Sep 2013 612
03 Aug 1970 880 01 Aug 1992 483

A Bulletin 17 Analysis using EMA and Bulletin 17C procedures has been
developed for this example. To open the analysis, either double-click on

the analysis labeled “B17C Example 6” from the Study Explorer or from
the Analysis menu select open, then select “B17C Example 6 from the

list of available analyses. When “B17C Example 6” is selected, the
Bulletin 17 analysis editor will appear as shown in Figure C-36. As
shown, the Skew option was set to use the Station Skew.

C-43



Appendix C — Bulletin 17C / EMA Examples

HEC-SSP User's Manual

[ Bulletin 17 Editor - B17C Example 6

Name: B17C Example &

Description: Example 6: Historic Data and Low Outliers - Santa Cruz River at Lochiel, AZ

Flow Data Set | santa Cruz River-Lochiel-FLOW-ANNUAL PEAK

DSS File Name: | G:\PROJECTSISSP_Testing\Projects\Bulletin_17C_Examples\Bulletin_17C_Examples.dss

Report File C:\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_B\B17C_Example_6 rpt

General | Oplions | EMA Data | Tabular Resulls

Generalized Skew
@ Use Station Skew
Use Weighted Skew

Use Regional Skew
Regional Skew:

Reg. Skew MSE
Expected Probablity Curve
Compute Expected Prob. Curve
Do Not Compute Expected Prob. Curve

Wethed for Computing Statistics and Confidence Limits

Plotting Position

Weibull (A and B = 0)

Confidence Limits

@ Defaults (0.05, 0.95)

Median (A anc User Entered Values
Hazen (Aand B = 0.5)

Upper Limit:
HirschiStedinger

Lower Limit

Other (Specify A, B)

Plotting position computed using formula
(m-A)/(n+1-A-B)

Where:
m=Rank, 1=Largest
N=Number of Years
AB=Constants

Time Window Modification
DSS Rangeis 13SEP1949 - 08SEP2013
Start Date

End Date

B: Low Outlier Test
@ 17CEMA
g @ Multiple Grubbs-Beck
178 Methods single B
Single Grubbs-Beck
| Compute ‘ | Plot Curve ‘ | View Report | | Print | oK Cancel

Figure C-36. Bulletin 17 Analysis General Tab for “B17C Example 6”.

No changes to the Options tab are necessary.

The EMA Data tab for this example is shown in Figure C-37. This
example uses an annual maximum series consisting entirely of systematic
data along with historical information. As was previously mentioned,
historical information indicates that the October 1977 flood event was the
largest since at least 1927. This information can be used within EMA to
extend the historical record to a longer period through the use of a
perception threshold. Specifically, the first perception threshold should be
modified to start at water year 1927. Then, a second perception threshold
of 12000 — inf should be added for the period of missing data spanning
water years 1927 through 1948, as shown in Figure C-37. Once both
perception thresholds have been entered, click the Apply Thresholds
button to assign the complementary flow ranges for the periods of missing
data. No further changes to the flow range table are necessary.
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[=] Bulletin 17 Editor - B17C Example 6 = [
Name B17C Example 6|
Description: Example & Historic Data and Low Outliers - Santa Cruz River at Lochiel, AZ (=)
Flow Data 3et | santa Cruz River-LochielFLOW-ANNUAL PEAK -
DSSFile Name: | C:\PROJECTSISSP_Testing\Projects\Bulletin_17C_Examples\Bulletin_17C_Examples.dss )
Report File C\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_8\B17C_Example_6.rpt (9]
‘ Generall Dmmnsl EMAData | Tabular Results
FirstRow in Table Defines the Absolute Time Window for EMA Analysis (start and end dates) 14,000
‘ Perception Thresholds
Start Year End Year Low Threshold High Threshold Comments
12,000 oo
1927 1948 12000.0 inf| historical information
\ \ |
10,000
8,000
Apply Thresholds
Flow Ranges 6,000 o
Year Peak Low Value High Value Data Type
1927 0.0 12000.0|Censore - - o oo
1928 0.0 12000.0|Censore = © o o
1929 0.0 12000.0|Censore ]| 4,000
1930 0.0 12000.0|/Censore -| [+] 8 ©
1931 0.0 12000.0|Censore - o o o ©
1932 0.0 12000.0|Censore - e ] o
1933 0.0 12000.0|Censore - 2,000 b & %) @
1934 0.0 12000.0|Censore - % o d g
1935 0.0 12000.0|Censore - ol ® Wy O°
1936 0.0 12000.0|Censore - © la? o o g [}
n P
1937 0.0 12000.0|Censore - T T T T T T T
1938 0.0 12000.0|Censore - 1940 1960 1930 2000
1939 0.0 12000.0[Censore = —
1940 0.0 12000.0[Censore - taarsE e bea
1941 0.0 12000.0|Censore -
1042 nn 12000 0l Censare = fleiesh
[ Compute ] [ Plot Curve ] [ View Report ] [ Print I Apply

Figure C-37. Bulletin 17 Analysis EMA Data Tab for “B17C Example 6”.

Once all of the General and EMA Data tab settings are set or selected,
the user can press the Compute button to perform the analysis. Once the
computations have been completed, a message window will open stations
Compute Complete. Close this window and then select the Tabular
Results tab. The analysis window should look like Figure C-31.

In addition to the tabular results, a graphical plot of the computed
frequency curves can be obtained by pressing the Plot Curve button at the
bottom of the analysis window. The Log Pearson Type Il distribution fit
using EMA to the input annual maximum flow data set, the 5% and 95%
confidence limits, and the annual maximum flow data set Hirsch/Stedinger
and Median (for low outliers) plotting positions are shown in Figure C-32.
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[ Bulletin 17 Editor - BL7C Example 6 = [
Name B17C Example 6
Description: Example 6 Historic Data and Low Outliers - Santa Cruz River at Lochiel, AZ =]
FlowData Set | ganta Cruz River-Lochie-FLOW-ANNUAL PEAK -
DSSFile Name: | C\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bullstin_17C_Examples.dss =
Report File: C\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_6\B17C_Example_&.rpt =]
General I Options | EMA Data| Tabular Results
Frequency Curve for: Santa Cruz River-Lochigl-FLOW-ANNUAL PEAK
3 A& B E Confidence Limits
ercent Chance omputed Curve
Fl cfs
Exceedance Flow in s aies
0.05 0.95
02 161736 343394 10386.8
05 13147.7 23988.7 9021.7
1.0 109736 18040.8 78835
2.0 89136 13356.0 6658.0
5.0 6390.0 8688.8 49443
10.0 4651.9 6050.0 3647.2
200 30791 39381 24245
50.0 12786 1637.6 987.6
80.0 469.5 619.2 2832
90.0 2643 3733 118.6
95.0 160.1 249.0 52.8
99.0 58.4 119.0 9.3
System Statistics Mumber of Events
Log Transform: Flow Event Number
Statistic Value ﬁ‘s:][‘; tEI"EmS 0
igh Outliers
Mean 3.069
Standard Dev 0.490 ::dow .Dutl:rs and Zero Flows ;g
Station Skew -D.4p2| (AR =
Regional Skew Hystemaplc - v:n s a7
‘Weighted Skew staric Pena
Adopted Skew -0.462

| compute | [ Potcuve | [ viewRepot | [ Pprint |

Figure C-38. Bulletin 17 Analysis Tabular Results Tab for “B17C Example 6.

— ™
[ Bulletin 17 Plot for B17C Example 6 [E=REER

File Edit View Window

Bulletin 17 Plot for B17C Example &
Return Period

11 2 5 10 50 200100010000
100000.0 4 : L — L1111 I

10000.0+

1000.04

Flow {cfs)

100.0

10.04

T T T
0.49 0.9 0.5 0201 002 0.002 0.0001
Frobahility

—— Computed Curve

=== 5 Percent Confidence Limit

——— 93 Percent Confidence Limit
o Observed Events (Hirsch-Stedinger plotting posttions)
m] Loy Ctlier

Figure C-39. Plotted Frequency Curves for “B17C Example 6”.
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As shown in Figure C-40, the Multiple Grubbs-Beck Test identified a low
outlier threshold of 380 cfs. Ten annual peak flows were identified as
being less than this threshold, as shown in Figure C-39. These annual
peak flows were then recoded to have a flow interval of zero — 380. The
perception thresholds for the years in which an annual peak flow was
recorded were also adjusted to correspond with the Multiple Grubbs-Beck
Test low outlier threshold. Consequently, these perception thresholds
were changed from zero — inf to 380 — inf. The perception threshold for

the years in which there is only historical nonexceedance data (i.e. 1927 —
1948) were left at 12,000 - inf, as shown in Figure C-41.

@ B17C_Example_6.rpt

File:

File Edit Search Format

C\PROJECTS\SSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_8\B17C_Example_6&.rpt

4

17
0g
a7
14
30
08
29
25
0g
12
18
03
20
05
03
10
16
30
04
22

22

05
0g
25
30
15
11
04
15
15
29
10
23
04
17
26
01
18
30
12
10
11
a7

Jul 1956
Rug 1957
Rug 1958
Zug 1959
Jul 1980
Aug 1961
Jul 1962
kug 1963
Sep 1964
Sep 1965
Aug 1966
kug 1967
Dec 1967
Zug 1969
Aug 1870
Rug 1971
Jul 1872
Jun 1873
Rug 1974
Jul 1975
Jul 1876
Sep 1977
Oct 1977
Jan 15879
Jun 18580
Jul 1981
Rug 1982
Mar 1983
Iug 1984
Jul 1985
kug 1986
Rug 1987
Ikug 1988
RZug 1989
Jul 1930
Jul 19391
Rug 1992
Jan 1993
Iug 1994
Jul 1935
Jul 1994
Sep 1997
Jul 1398

1,360.0 | 30
688.0 | 31
3g0.0 | 32
243.0 | 33
625.0 | 34

1,120.0 | 35
7.6 1 36
2,390.0 | 37
2,330.0 | 38
4,810.0 | 39
1,780.0 | 40
1,870.0 | 41
986.0 | 42
484.0 | 43
820.0 | 44
2,830.0 | 45
2,070.0 | 46
1,490.0 | 47
1,730.0 | 48
3,330.0 | 49
3,540.0 | 50
1,130.0 | 51
12,000.0 | 52
1,060.0 | 53
406.0 | 54
1,110.0 | 55
2,640.0 | 56
1,120.0 | 57

12,000.0 | 58

850.0 | 59

4,210.0 | &0
201.0 | 61
804.0 | 62
871.0 | 63
3,510.0 | &4
17.0 | 65
483.0 | 66
4,880.0 | 67
478.0 | 68
2,020.0 | &9
1,860.0 | 70
2,970.0 | 71
1,110.0 | 72

2009
1973
1956
2008
1977
1983
1961
1958
1981
2001
1875
1968
1970
1989
1985
1988
1857
1960
2013
1852
1969
1952
1954
1980
2010
1958
1987
2004
1858
2011
2005
2003
1951
2012
1962
2002
1948
1947
1946
1945
1944
1943
15842

el e S R S

,530.

450
360
180
130

120.
120.

110

(ST ==
[ e e e e e e e e e e e e e e e e e e e e i e e

O oy oy OO0 OO0 D
=]

44.
46.
47.
49.
51
52.
54.
55.
57
58.
60.
6l.
63.
4.
66.
67.
69.
70.
7
7
7
7
7
7
g
g
S|
S|
0% 8
0* 8
0* g
0* 3
0* g
0% 85
6% 97
S Of .

M2 B3 D CD en R R WD OO oy L L R

s OO L DR

=1

82
44
96
48
01
53
05
57
0g
62
14
66

1
o

-1 py =
S WO

-1 Ry
SN L O oo e R D

1 D e WD s OO L0 0O L

-1 R

- R =]

o
w

m

3

01/11/2016 14:01 PM

61:82.61:82

61:82

Figure C-40. Report File for “B17C Example 6 showing censored low outliers.
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[7] B17C_Example_burpt B —— M
File Edit Search Format
File: | C:\PROJECTSISSP_Testing\Projects\Bulletin_17C_Examples\Bulletin17Results\B17C_Example_61817C_Example_6.rpt

<< EMA Representation of Data >> -
Santa Cruz River-Lochiel-FLOW-ZNNUAL FERE
| | Value | Threshold | |
| Year Peak | Low High | Low High | Type |
| | | -1 |
| 1327 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens | T
| 1928 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1929 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1930 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens | =
| 1931 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1932 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1933 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens | .
| 1934 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1935 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1936 -— | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1937 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1938 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1939 = | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1940 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1341 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1942 = | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |

W[ 1943 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1944 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1945 = | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1948 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1947 | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1948 = | 1.0E-99 12,000.0 | 12,000.0 1.0E99 | Cens |
| 1945 1,650.0 | 1,650.0 1,650.0 | 380.0 1.0E8% | Syst |
| 1950 4,520.0 | 4,520.0 4,520.0 | 380.0 1.0E99 | Syst |
| 1951 2,560.0 | 2,560.0 2,560.0 | 380.0 1.0E8% | Syst |
| 1952 550.0 | 550.0 550.0 | 380.0 1.0E8% | Syst |
| 1953 3,320.0 | 3,320.0 3,320.0 | 380.0 1.0E8% | Syst |
| 1954 1,570.0 | 1,570.0 1,570.0 | 380.0 1.0E8% | Syst |
| 1955 4,300.0 | 4,300.0 4,300.0 | 380.0 1.0E8% | Syst |
| 1956 1,360.0 | 1,360.0 1,360.0 | 380.0 1.0E8% | Syst |
| 1957 688.0 | 68E8.0 688.0 | 380.0 1.0E8% | Syst |
| 1958 380.0 | 380.0 380.0 | 380.0 1.0E8% | Syst |
| 1939 243.0 | 1.0E-6 380.0 | 380.0 1.0E99 | Syst |
| 1960 625.0 | 625.0 625.0 | 380.0 1.0E8% | Syst |
| 1961 1,120.0 | 1,120.0 1,120.0 | 380.0 1.0E8% | Syst |
| 1962 7.6 | 1.0E-& 380.0 | 380.0 1.0E8% | Syst |
| 1963 2,390.0 | 2,390.0 2,390.0 | 380.0 1.0E8% | Syst | -
4 1 | +

01/11/2016 14:01 PM 192:69.192:69 192:69
= =

Figure C-41. Report File for “B17C Example 6 showing recoded
perception thresholds
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APPENDIX D

Creating a Partial Duration Series

To use the partial duration frequency curve estimation options within a
General Frequency analysis, a partial duration series of flow rates or
stages must be constructed outside of HEC-SSP. This type of analysis is
commonly called “Peaks over Threshold”. The Find Peaks tool within
HEC-DSSVue is a useful tool that can be used to construct a partial
duration dataset from an input continuous dataset. The creation of a
partial duration series from a daily flow dataset is provided to illustrate the
use of the Find Peaks tool within HEC-DSSVue as well as the differences
between a partial duration series and an annual maximum series.

The data for this example is from Delaware River near Delaware Water
Gap, PA (gage number 01440200). This stream gage is located near the
site of a previously authorized but unconstructed large dam and reservoir
named Tocks Island, which, if constructed, would have provided flood
control, water supply, and hydropower benefits to the lower Delaware
River watershed. However, negative environmental concerns ultimately
derailed the construction of the Tocks Island Dam and Reservoir.
Property and flowage easements that were acquired in anticipation of
construction and impoundment of water was turned over to the National
Park Service in 1979 thereby creating the Delaware Water Gap National
Recreation Area. The project was officially deauthorized by Congress in
July 1992.

The Find Peaks tool can analyze any data set with a continuous record.
Commonly, data sets consisting of daily, hourly, or sub-hourly (i.e. 15-
minute) observations are used to derive partial duration series. For the
purposes of this example, a daily flow data series can be downloaded for
the Delaware River near Delaware Water Gap, PA gage from the USGS
website within HEC-SSP. Select a period spanning from 010ct1939 —
01Jan2015, as shown in Figure D-1. However, it is important to note that
data sets originating from different locations (i.e. USACE water control
databases) can be used by as well.
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Data Source | Detalls|

Data Type: | Time Series |
Location

~) HEC-DSS @ USGS Website ) WS Excel ~ Manual ) TextFile
USGS Website
Data Type: | paily - Start Date: | gqoct1939 End Date: |gqjanz015
Select Time Zone Option [”] Retrieve Period of Record

@ GMT - Store Data in UTC
) LST - Store Data in Local Std Time (LST) with no Time Zone set

) Local Time - Store data in Local time with Local Time Zone set

Get USGS Station ID's by State

Import USGS Basin Name Location Other Qualifier
Data Station ID's (A Part) (B Part) (F Part)
- - - -
] 01440200 ocks Island USGS -

Figure D-1. Downloading Daily Flow Data.

To use the Find Peaks tool, the appropriate Java plug-in (“Peaks.jar”) must
be present within the “..HEC-DSSVue\Plugins\” directory. By default,
this directory is located at either “C:\Program FilesS\HEC\HEC-

File Edit View Maps Data Analysis Results |Tools| Window Help

G Eo S @ 4 || HEC-DSSVue.

@ GeneralFrequency_Testing Plot Probability Lines

= . Analysis oot

- [+ L. Bulletin 17 prions...
+- | General Frequency Analysis BEA Console Qutput...
, Volume Frequency Analysis : .
= || Duration Analysis o T AT

DSSVue\Plugins” (for 32-bit versions of Windows XP, Vista, or 7) or
“C:\Program Files (x86)\HEC\HEC-DSSVue\Plugins” (for 64-bit versions
of Windows XP, Vista, or 7). The “Peaks.jar” file can be found on HEC’s
website here: http://www.hec.usace.army.mil/software/hec-
dssvue/plugins.aspx. Once the daily flow dataset has been downloaded
and the “Peaks.jar” file has been placed within the appropriate directory,
the DSS file associated with the HEC-SSP project can be by selecting
Tools | HEC-DSSVue within the HEC-SSP project. Alternatively, the
DSS file can be opened independently of HEC-SSP. Once the DSS file is
opened within HEC-DSSVue, there will be a record created with the
following part names: \TOCKS ISLAND\FLOW\1DAY\USGS.

There cannot be missing values within the data set for the selected Time
Window. The Estimate Missing Values tool within HEC-DSSVue’s Math
Functions can be used to fill in data gaps, if necessary.

Select the daily flow data set and then select Tools | Find Peaks, as shown
in Figure D-2.
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‘ GeneralFrequency Testing.dss - HEC-D55Vue —
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Figure D-2. Find Peaks Tool Location within HEC-DSSVue.

The Find Peaks tool requires multiple user inputs in order to determine
“hydrologically independent” peaks (or troughs), as described within EM
1110-2-1415 “Hydrologic Frequency Analysis”. For example, Figure D-3
shows a flow hydrograph at the Delaware Water Gap stream gage
(drainage area = 3,850 sq mi). The peak flow at 09Dec1950 is not
hydrologically independent; this peak was dependent upon the peak on
05Dec1950. The peak on 26Nov1950 can be considered hydrologically
independent. However, it is up to the user to decide whether the peak on
05Dec1950 is hydrologically independent.
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Figure D-3. Example of Hydrologically Independent Peaks.

The first user input within the Find Peaks tool asks whether the user
wishes to find peak values (maximums) or troughs (minimums), as shown
in Figure D-4. Select “Peaks”, which will display a new window asking
the user to specify a threshold (minimum) value. By default, the Find
Peaks tool will estimate a threshold value based upon the values contained
within the selected data set. The user may also leave the field blank which
will enable all values to be discernable as peak values.

The threshold value can be set to the minimum peak contained within the
associated annual maximum series in order to capture a large number of
peaks. However, this threshold value is watershed (and study) dependent.
For this example, enter 30000 within this field, indicating that all peak
values greater than 30,000 cfs will be carried forward as potential peaks,
as shown in Figure D-5.

The next dialog will require the user to input a minimum magnitude and
time differential. These two inputs preliminarily determine whether a
peak is truly “independent”. In order for a peak to be independent, the
flow/stage hydrograph must decrease (or increase when determining
independent minimums) by a certain magnitude or below a certain
threshold. Also, a certain amount of time must elapse before the peak can
be classified as independent. These values are location dependent as well
as reliant upon the study purposes. By default, the Find Peaks tool will
estimate a minimum magnitude and time differential based upon the
values contained within the selected data set.
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For the Delaware River near Delaware Water Gap, PA stream gage, the
drainage area is large. The contributing watershed requires approximately
one week (i.e. seven days) to return to baseflow. For smaller watersheds,
such as highly urbanized streams that exhibit an extremely fast rise and
fall in flow or stage, the time required to return to an approximate
baseflow may be on the order of hours, not days. For this example, the
minimum magnitude and time differential can be set to 10000 and 240, as
shown in Figure D-6. This implies that the hydrograph must decrease by
10,000 cfs and 10 days must elapse before a new peak can be considered
independent of a previous peak. Figure D-7 displays the threshold value,
minimum magnitude, and minimum time differential values for a three-
month time span at the stream gage in question.

Choose Peaks or Troughs I&

Do you want to find Peaks or Troughs?

| Peaks (rmaxs) | ITmughs (mins]‘ I CaMCEL

Figure D-4. Selection of Either Peaks or Troughs.

i =
Do want you to specify a minimum value for a peak (leave blank to report all peaks)?
30000

| ok || cancel

Figure D-5. Threshold Value Selection.

25—

A peak is identified by its differential magnitude on each side of the peak.
Enter the Minimurmn Differential Magnitude to define peak

and number of hours to lock at around the peak.

10000 240|

| ok || cancel

Figure D-6. Minimum Magnitude and Time Differential Selection.
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Figure D-7. Threshold Value, Minimum Magnitude, and Minimum Time

Differential.

Clicking OK results in the creation of an irregular time series record (i.e.
the date-time of occurance is saved along with the data value) that is

usable by HEC-SSP. The flow data set and peak data set are shown in a
separate window, as shown in Figure D-8.
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Figure D-8. Resulting Peak Flow Partial Duration Series.

As is shown in Figure D-9, this partial duration series contains peak flow
rates for multiple peak flow rates including the two extremely large peaks
that occurred in late August and early September, 2011 (corresponding to
the passage of Tropical Storm Irene and Tropical Storm Lee). By
definition, an annual maximum series only records a single peak flow rate
for each water year. Therefore, only the larger event (September 2011) is
stored within an annual maximum series.
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Figure D-9. Resulting Peak Flow Partial Duration Series and Annual Maximum
Series for 2008 - 2012.

This peak flow partial duration series data set can now be used within a
General Frequency analysis in HEC-SSP. However, it is up to the user to
review the peak flow partial duration series. The three criteria (threshold,
magnitude differential, and time differential) may not be adequate to
completely define all independent peaks for a given data set; some non-
independent peaks may need to be deleted while others may need to be
added.
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